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HOOFDSTUK1

Introductie voor de cursus

1.1 Voorwoord

Welkom bĳ onze cursus! We zullen u laten zien hoe QGIS gemakkelĳk en efficiënt te gebruiken. Als GIS nieuw voor
u is, zullen we u vertellen wat u nodig hebt om te kunnen beginnen. Als u al een ervaren gebruiker bent, zult u zien
hoe QGIS alle functies uitvoert die u verwacht van een programma voor GIS, en meer!

1.1.1 Waarom QGIS?

Waar informatie steeds meer ruimtelĳk bewust wordt, is er geen tekort aan gereedschappen die in staat zĳn enkele
of alle veel gebruikte functies voor GIS uit te voeren. Waarom zou iemand QGIS gebruiken boven een ander
softwarepakket voor GIS?
Hier zĳn slechts enkele van de redenen:

• Het is gratis, zoals in lunch. Installeren en gebruiken van het programma QGIS kost u een totaalbedrag van nul
geld. Geen initiële kosten, geen terugkerende kosten, helemaal niets.

• Het is vrĳ, zoals in vrĳheid. Wanneer u extra functionaliteit nodig hebt in QGIS, kunt u meer doen dan
alleen hopen dat het in de volgende uitgave wordt opgenomen. U kunt het ontwikkelen van een mogelĳkheid
sponsoren, of het zelf toevoegen als u bekend bent met programmeren.

• Het wordt doorlopend ontwikkelt. Omdat iedereen nieuwe mogelĳkheden kan toevoegen en bestaande kan
verbeteren, stagneert QGIS nooit. De ontwikkeling van een nieuw gereedschap kan zo snel gaan als u zelf
wilt.

• Uitgebreide hulp en documentatie is beschikbaar. Als u ergens mee zit kunt u de uitgebreide documentatie
bekĳken, u richten tot uw mede-QGIS-gebruikers, of zelfs tot de ontwikkelaars.

• Cross-platform. QGIS kan worden geïnstalleerd op macOS, Windows en Linux.
Nu u weet waarom u QGIS zou willen gebruiken, zullen deze oefeningen u laten zien hoe.
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1.1.2 Achtergrond

In 2008 brachten we Een kleine introductie in GIS, een volledig gratis, open bron-inhoud voor mensen die wilden
leren over GIS zonder te worden bedolven onder jargon en nieuwe terminologie. Het werd gesponsord door de Zuid-
Afrikaanse overheid en was een fenomenaal succes, met mensen van over de gehele wereld die ons vertelden hoe zĳ
het materiaal gebruikten voor het uitvoeren van trainingscursussen op universiteiten, zichzelf GIS leerden enzovoort.
‘Een kleine introductie’ is geen handleiding voor de software maar richt zich op een meer algemene tekst (hoewel we
QGIS in alle voorbeelden gebruikten) voor iemand die iets over GIS wil leren. Er is ook de handleiding voor QGIS
die een gedetailleerd functioneel overzicht van de toepassing QGIS verschaft. Die is echter niet gestructureerd als een
leidraad, maar meer als een gids voor verwĳzingen. Bĳ Linfiniti Consulting CC. geven we frequent trainingscursussen
en hebben we ons gerealiseerd dat een derde bron nodig is - een die de lezer stapsgewĳze leidt door het leren van de
sleutelaspecten van QGIS in een formaat trainer-trainee - wat ons aanzette tot het maken van dit werk.
Deze trainingshandleiding is bedoeld om alle materiaal te verschaffen voor een 5-daagse cursus over QGIS,
PostgreSQL en PostGIS. De cursus is gestructureerd met een inhoud die gelĳktĳdig geschikt is voor nieuwe,
gemiddelde en gevorderde gebruikers en veel oefeningen heeft, compleet met geannoteerde antwoorden door de
gehele tekst.

1.1.3 Licentie

De gratis QuantumGIS TrainingHandleiding van Linfiniti Consulting CC is beschikbaar onder de Creative Commons
Attribution 4.0 International Licentie. Rechten buiten het bereik van deze licentie zouden beschikbaar kunnen zĳn
op het hieronder vermelde.
We hebben deze QGIS trainingshandleiding gepubliceerd onder een liberale licentie die u toestaat dit werk gratis te
kopiëren, aan te passen en opnieuw te distribueren. Een volledige kopie van de licentie is beschikbaar aan het einde
van dit document. In eenvoudige woorden, de richtlĳnen voor het gebuik zĳn als volgt:

• U mag dit werk niet weergeven als uw eigen werk, of teksten met betrekking tot rechten van auteurs of credits
uit dit werk verwĳderem.

• U mag dit werk niet opnieuw distribueren onder meer beperkende rechten dan die waaronder het aan u werd
verschaft.

• Als u een substantieel gedeelte toevoegt aan het werk en teruggeeft aan het project (tenminste één complete
module) mag u uw naam toevoegen aan de lĳst van auteurs aan het einde van dit document (die zal verschĳnen
op de voorpagina)

• Als u kleine wĳzigingen en correcties toevoegt mag u zichzelf toevoegen aan de lĳst van deelnemers hieronder.
• Als u dit document in zĳn geheel vertaald mag u uw naam toevoegen aan de lĳst van de auteurs in de vorm
“Translated by Joe Bloggs”.

• Als u een module of les sponsort, mag u de auteur verzoeken om een vermelding daarvan op te nemen aan het
begin van elke bĳgedragen les, bĳv.:

Notitie: Deze les werd gesponsord door MegaCorp.

• Als u er niet zeker van bent wat u onder deze licentie mag doen, neem dan contact met ons op via
office@linfiniti.com en zullen we u adviseren of wat u van plan bent te doen acceptabel is.

• Als u dit werk publiceert onder een zichzelf publicerende site zoals https://www.lulu.com verzoeken we u de
winsten te doneren aan het project QGIS.

• U mag dit werk niet vercommercialiseren, tenzĳ met de uitdrukkelĳke toestemming van de auteurs. Voor de
duidelĳkheid: met vercommercialiseren bedoelen we dat u niet voor winst mag verkopen, geen afgeleide werken
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mag maken (bĳv. verkopen van inhoud om te gebruiken als artikelen in een tĳdschrift). De uitzondering hierop
is als alle winst wordt gegeven aan het project QGIS. U mag (en we moedigen u aan dat te doen) dit werk
gebruiken als een tekstboek bĳ het geven van trainingscursussen, zelfs als de cursus zelf commercieel van
nature is. Met andere woorden: het staat u vrĳ om geld te verdienen door het geven van een trainingscursus dat
dit werk als tekstboek gebruikt, maar u mag niet profiteren van de verkoop van het boek zelf - alle dergelĳke
winsten zouden ten goede moeten komen aan QGIS.

1.1.4 Hoofdstukken over sponsoring

Dit werk is geenszins bedoeld als een volledige verhandeling over alle dingen die u kunt doen met QGIS en we
moedigen anderen aan om nieuw materiaal toe te voegen om eventuele gaten te dichten. Linfiniti Consulting CC. kan
ook aanvullend materiaal voor u maken als een commerciële service, met dien verstande dat al dergelĳk geproduceerd
werk onderdeel zou moeten worden van de broninhoud en moeten worden gepubliceerd onder dezelfde licentie.

1.1.5 Auteurs

• Rüdiger Thiede - Rudi heeft het materiaal met instructies voor QGIS geschreven en delen van het materiaal
over PostGIS.

• Tim Sutton - Tim was de leider van het project en begeleidde dat en is co-auteur voor de delen over PostgreSQL
en PostGIS.

• Horst Düster (horst.duester@kappasys.ch ) - Horst is co-auteur van de delen over PostgreSQL en PostGIS
• Marcelle Sutton - Marcelle deed het proeflezen en gaf editoriaal advies gedurende het maken van dit werk.

1.1.6 Individuele meewerkenden

Vul hier uw naam in!

1.1.7 Sponsoren

• Cape Peninsula University of Technology

1.1.8 Bronbestanden en rapporteren van problemen

De bron van dit document is beschikbaar op GitHub QGIS Documentation repository. Consulteer GitHub.com voor
instructies over hoe het versiebeheerssysteem GIT te gebruiken.
Ondanks onze inspanningen zou het kunnen zĳn dat u enkele fouten vindt of enige informatie mist bĳ het volgen van
deze training. Rapporteer dat dan op https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Laatste versie

U kunt altĳd de laatste versie van dit document verkrĳgen door de online versie te bezoeken die deel uitmaakt van
de website voor de documentatie voor QGIS (https://www.qgis.org/resources/hub/#documentation).

Notitie: Dewebsite voor de documentatie bevat links naar zowel online- als PDF-versies van de Trainingshandleiding
en andere delen van de documentatie van QGIS.
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1.2 Over de oefeningen

Nu u weet waarom u QGIS zou willen gebruiken, kunnen we u laten zien hoe.

Waarschuwing: Deze cursus bevat instructies over het toevoegen, verwĳderen en wĳzigen van gegevenssets voor
GIS. We hebben voor dit doel gegevenssets om mee te trainen verschaft. Vóórdat u de hier beschreven technieken
toepast op uw eigen gegevens, zorg er dan altĳd voor dat u goede back-ups heeft!

1.2.1 Hoe deze handleiding te gebruiken

Elke tekst die er zo uitziet verwĳst naar iets wat u kunt zien in de gebruikersinterface van QGIS.
Tekst die er ► zo ► uitziet leidt u door menu’s.
Dit soort tekst verwĳst naar iets wat u kunt typen, zoals een opdracht, pad, of bestandsnaam.
Dit/soort/van.tekst verwĳst naar iets wat u kunt typen, zoals een opdracht, pad, of bestandsnaam.
Dit+dat verwĳst naar een sneltoets die is samengestelde uit twee toetsen.

1.2.2 Gestaffelde doelen voor de cursus

Deze cursus is gericht op verschillende niveaus van gebruikservaring. Afhankelĳk van in welke categorie u zich plaatst,
kunt u een verschillende set van uitkomsten voor de cursus verwachten. Elke categorie bevat informatie die essentieel
is voor de volgende, het is dus belangrĳk om eerst alle oefeningen te doen die behoren tot uw niveau van ervaring.

��� (Basisniveau) Basis

In deze categorie gaat de cursus er van uit dat u geen of weinig eerdere ervaring hebt met theoretische kennis van GIS
of de werking van GIS-software.
Beperkte theoretische achtergrond zal worden verschaft om het doel van een actie uit te leggen die u in het programma
zult uitvoeren, maar de nadruk ligt op het leren door te doen.
Wanneer u de cursus voltooid hebt, zult u een beter begrip hebben van demogelĳkheden van GIS, en hoe hun krachten
te gebruiken via QGIS.

��� (Gemiddeld niveau) Gemiddeld

In deze categorie wordt er van uitgegaan dat u kennis hebt van de werking en ervaring met het gebruik voor elke dag
hebt van GIS-software.
Voortbouwend op de instructies voor het niveau van de beginner zult u bekende dingen zien, als ook u bewust te
maken van gevallen waarin QGIS dingen op een iets andere manier doet dan andere software, die u ook gebruikt zou
kunnen hebben. U zult ook leren hoe functies voor analyses te gebruiken in QGIS.
Wanneer u de cursus voltooid, zou u er vertrouwen in moeten hebben QGIS te gebruiken voor alle functies die u
gewoonlĳk nodig hebt bĳ gebruik voor elke dag.

6 Hoofdstuk 1. Introductie voor de cursus
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��� (Gevorderd niveau) Gevorderd

Voor deze categorie wordt er van uitgegaan dat u ervaring hebt in het gebruiken van GIS-software, kennis hebt van
en ervaring met ruimtelĳke databases, gegevens te gebruiken op een server op afstand, misschien het schrĳven van
scripts voor analyses, etc.
Voortbouwend op de instructies voor de andere twee niveaus zullen u bekend laten worden met de benadering die de
interface van QGIS volgt, en zal er voor zorgen dat u weet hoe u toegang krĳgt tot de basisfuncties die u nodig hebt.
U zult ook zien hoe gebruik te maken van het systeem voor plug-ins in QGIS, toegang tot databases, enzovoort.
Wanneer u de cursus voltooid, zou u goed bekend moeten zĳn met de werking van QGIS voor gebruik voor elke dag,
als ook met zĳn meer gevorderde functies.

1.2.3 Gegevens

De voorbeeldgegevens die bĳ deze bron horen zĳn vrĳ beschikbaar en komen vanaf de volgende bronnen:
• gegevenssets Streets and Places van OpenStreetMap
• Property boundaries (urban and rural), water bodies van NGI
• SRTM DEM van CGIAR CSI

Download de voorbereide gegevensset vanaf de opslagplaats voor Trainingsgegevens en pak het bestand uit. Alle
benodigde gegevens worden verschaft in de map exercise_data.
Als u een instructeur bent, en meer relevante gegevens zou willen gebruiken, vindt u instructies voor het maken van
lokale gegevens in de appendix Voorbereiden gegevens voor oefeningen.

1.2. Over de oefeningen 7
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Module: Een basiskaart maken en verkennen

In deze module zult u een basiskaart maken die later zal worden gebruikt als basis voor meer demonstraties van de
functionaliteit van QGIS.

2.1 Les: Een overzicht van de interface

We zullen de gebruikersinterface van QGIS verkennen zodat u bekend raakt met de menu’s, werkbalken, kaartvenster
en lagenlĳst die de basisstructuur van de interface vormen.
Het doel voor deze les: Begrĳpen van de basisonderdelen van de gebruikersinterface van QGIS.

9
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2.1.1 ��� Probeer zelf: De basisbeginselen

De elementen die kunnen worden geïdentificeerd in de bovenstaande afbeelding zĳn:
1. Lagenlĳst / paneel Browser
2. Werkbalken
3. Kaartvenster
4. Statusbalk
5. Werkbalk zĳkant
6. balk Lokaliseren

��� De lijst Lagen

In de lagenlĳst kunt u op elk moment een lĳst zien van alle lagen die voor u beschikbaar zĳn.
Uitbreiden van samengevouwen items (door te klikken op de pĳl of het symbool plus ernaast) zal u meer informatie
verschaffen over het huidige uiterlĳk van de laag.
De laag zal, als u daar overheen gaat met de muisaanwĳzer, enige basisinformatie geven: laagnaam, type geometrie,
coördinaten referentiesysteem en het volledige pad van de locatie op uw apparaat.
Rechts-klikken op een laag zal u een menu geven met heel veel extra opties. U zult sommige ervan op korte termĳn
gaan gebruiken, kĳk dus even rond!

Notitie: Een vectorlaag is een gegevensset, gewoonlĳk van een specifiek soort object, zoals wegen, bomen, etc. Een
vectorlaag kan bestaan uit punten, lĳnen of polygonen.

10 Hoofdstuk 2. Module: Een basiskaart maken en verkennen
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��� Het paneel Browser

De Browser van QGIS is een paneel in QGIS waarmee u eenvoudig door uw database kunt bladeren. U heeft daarbĳ
toegang tot algemene vectorbestanden (bĳv. ESRI Shapefiles of bestanden van MapInfo ), databases (bĳv. PostGIS,
Oracle, SpatiaLite of MS SQL Server) en webservices WMS/WFS. U kunt ook gegevens van GRASS bekĳken.
Als u een project hebt opgeslagen zal het paneel Browser u ook snelle toegang verschaffen tot alle lagen die zĳn
opgeslagen in hetzelfde pad van het projectbestand in het item Thuis voor project.
U kunt daarnaast één of meer mappen instellen als Favorieten: zoek naar uw pad en als u de map eenmaal hebt
gevonden, klik er met rechts op en klik op Als Favoriet toevoegen. U zou dan uw map moeten kunnen zien
in het item Favorieten.

Tip: Het kan gebeuren dat de mappen die zĳn toegevoegd aan het item Favorieten een behoorlĳk lange naam hebben:
geen zorgen, klik met rechts op het pad en kies Favoriet hernoemen… om een andere naam in te stellen.

��� Werkbalken

Van de door u het meest gebruikte aantal gereedschappen kunnen werkbalken worden gemaakt voor basistoegang.
De werkbalk Project stelt u bĳvoorbeeld in staat een nieuw project op te slaan, te laden, af te drukken en te beginnen.
U kunt de interface gemakkelĳk aanpassen om alleen de gereedschappen te zien die u het meest gebruikt, door
werkbalken, zoals nodig, toe te voegen of te verwĳderen via het menu Beeld ►Werkbalken.
Zelfs als zĳ niet zichtbaar zĳn in een werkbalk blĳven al uw gereedschappen toegankelĳk via de menu’s. Als u
bĳvoorbeeld de werkbalk Project verwĳdert (die de knop Opslaan bevat), kunt u nog steeds uw kaart opslaan door te
klikken op het menu Project en dan te klikken op Opslaan.

��� Het kaartvenster

Dit is waar de kaart zelf wordt weergegeven en waar de lagen worden geladen. In het kaartvenster kunt u interactief
werkenmet de zichtbare lagen: in-/uitzoomen, de kaart verplaatsen, objecten selecteren en nog veel meer bewerkingen
die we nader zullen bekĳken in de volgende gedeelten.

��� De statusbalk

Toont u informatie over de huidige kaart. Stelt u ook in staat de schaal van de kaart, de oriëntatie van de kaart aan te
passen en de coördinaten van de muiscursor op de kaart te zien.

��� De zijbalk

Standaard bevat de werkbalk Zĳkant de knoppen om lagen te laden en alle knoppen om een nieuwe laag te maken.
maar onthoud dat u alle werkbalken kunt verplaatsen naar waar ze voor u meer comfortabel zĳn om mee te werken.

2.1. Les: Een overzicht van de interface 11
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��� De balk Lokaliseren

Op deze balk kunt u toegang krĳgen tot bĳna alle objecten van QGIS: lagen, laagobjecten, algoritmes, Favoriete
plaatsen, etc. Controleer alle verschillende opties in het gedeelte locator_options van de QGIS Gebruikershandleiding.

Tip: Met de sneltoets Ctrl+K krĳgt u snel toegang tot de balk.

2.1.2 ��� Probeer zelf: 1

Probeer de vier hierboven vermelde elementen te identificeren op uw eigen scherm, zonder naar het diagram hierboven
te kĳken. Kĳk of u hun namen en functies kunt identificeren. U zult meer bekend raken met deze elementen als u ze
in de komende dagen gaat gebruiken.

Antwoord
Ga terug naar de afbeelding die de lay-out van de interface laat zien en controleer of u de namen en functies van de
schermelementen hebt onthouden.

2.1.3 ��� Probeer zelf: 2

Probeer elk van deze gereedschappen op uw scherm te vinden. Wat zĳn hun doelen?

1.

2.

3.

4. (Her)teken

5.

Notitie: Als een van deze gereedschappen niet zichtbaar is op het scherm, probeer dan enkele werkbalken in te
schakelen die momenteel verborgen zĳn. Onthoud ook dat als er te weinig ruimte is op het scherm, een werkbalk
verkleind kan zĳn door enkele van zĳn gereedschappen te verbergen. U kunt de verborgen gereedschappen zichtbaar
maken door te dubbelklikken op de pĳlknop rechts in een dergelĳke verkleinde werkbalk. U kunt een Helptip zien
met de naam van elk gereedschap door de muiscursor enige tĳd boven het gereedschap te houden.

Antwoord
1. Opslaan als…

2. Zoomen naar la(a)g(en)

3. Selectie omdraaien

4. Renderen aan/uit

5. Lĳn meten
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2.1.4 Wat volgt?

Nu u bekend bent met de basisbeginselen van de interface van QGIS zullen we in de volgende les zien hoe enkele veel
voorkomende typen gegevens te laden.

2.2 Les: Uw eerste lagen toevoegen

We zullen de toepassing starten en een basiskaart maken om voor voorbeelden en oefeningen te gebruiken.
Het doel voor deze les: Beginnen met een voorbeeldkaart.

Notitie: Vóór het beginnen van deze oefening moet QGIS zĳn geïnstalleerd op uw computer. U zou ook de te
gebruiken voorbeeldgegevens al moeten hebben gedownload.

Start QGIS met de sneltoets op het bureaublad, menuitem, etc., afhankelĳk van hoe u de installatie ervan heeft
geconfigureerd.

Notitie: De schermafdrukken voor deze cursus werden genomen in QGIS 3.4 dat werd uitgevoerd op Linux.
Afhankelĳk van uw instellingen zouden de schermen die u tegenkomt er misschien ietwat anders uit kunnen zien.
Echter, al dezelfde knoppen zullen nog steeds beschikbaar zĳn en de instructies zullen op elk OS werken. U heeft
QGIS 3.4 (de laatste versie op het moment van schrĳven) nodig om deze cursus te gebruiken.

Laten we direct gaan beginnen!

2.2.1 ��� Volgen: Een kaart voorbereiden

1. Open QGIS. U zult een nieuwe, blanco kaart hebben.

2.2. Les: Uw eerste lagen toevoegen 13
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2. Het dialoogvenster Databronnen beheren stelt u in staat te laden gegevens te kiezen, afhankelĳk van het
gegevenstype.We zullen het gebruiken om onze gegevensset te laden: klik op de knop Databronnen beheren openen

.
Als u het pictogram niet kunt vinden, controleer dan of de werkbalk Databronnen beheren is ingeschakeld in
het menu Beeld ►Werkbalken.

3. Laad de vector gegevensset protected_areas.shp
1. Klik op de tab Vector.

2. Schakel het Type bron Bestand in.
3. Druk op de knop… naast Vectordatabron(nen).
4. Selecteer het bestand exercise_data/shapefile/protected_areas.shp in uw map voor

de training.
5. Klik op Openen. U zult het originele dialoogvenster zien waarin het bestandspad is ingevuld.

14 Hoofdstuk 2. Module: Een basiskaart maken en verkennen
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6. Klik hier ook op Toevoegen. De gegevens die u hebt gespecificeerd zullen nu worden geladen: u kunt
een item protected_areas zien in het paneel Lagen (linksonder) waarvan de objecten worden
weergegeven in het kaartvenster.

2.2. Les: Uw eerste lagen toevoegen 15
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Gefeliciteerd! U heeft nu een basiskaart. Het is nu een goed moment om uw werk op te slaan.

1. Klik op de knop Opslaan als:
2. Sla de kaart op in een map solution, naast exercise_data, en noem hem basic_map.qgz.

2.2.2 ��� Probeer zelf:

Herhaal de bovenstaande stappen en voeg de lagen places.shp en rivers.shp uit dezelfde map
(exercise_data/shapefile) toe aan de kaart.

Antwoord
In het hoofdgebied van het dialoogvenster zou u veel vormen met verschillende kleuren moeten zien. Elke vorm
behoort tot een laag die u op zĳn kleur kunt identificeren in het linkerpaneel (uw kleuren zouden anders kunnen zĳn
dan die in Fig. 2.1 hieronder):

Fig. 2.1: Een basiskaart

2.2.3 ��� Volgen: Vectorgegevens uit een database van GeoPackage laden

Databases stellen u in staat een grote hoeveelheid geassocieerde gegevens in één bestand op te slaan. U zou al bekend
kunnen zĳn met een beheerssysteem voor databases (DBMS) zoals LibreOffice Base of MS Access. Toepassingen
voor GIS kunnen ook gebruik maken van databases. GIS-specifieke DBMS-en (zoals PostGIS) hebben extra functies,
omdat zĳ ruimtelĳke gegevens moeten behandelen.
De open indeling GeoPackage is een container die u in staat stelt uw gegevens voor GIS (lagen) op te slaan in één
enkel bestand. Anders dan de indeling ESRI Shapefile (bĳv. de gegevensset protected_areas.shp die u eerder
laadde), kan één enkel bestand van GeoPackage verscheidene gegevens bevatten (zowel vector- en rastergegevens) in
verschillende coördinaten referentiesystemen, als ook tabellen zonder ruimtelĳke informatie; al deze mogelĳkheden
stellen u in staat gegevens eenvoudig te delen en duplicaten te voorkomen.
U dient eerst een verbinding te maken om een laag uit een pakket van GeoPackage te kunnen laden:

1. Klik op de knop Databronnen beheren openen.

16 Hoofdstuk 2. Module: Een basiskaart maken en verkennen

https://www.geopackage.org/


QGIS Training Manual

2. Klik, aan de linkerkant, op de tab GeoPackage.
3. Klik op de knop Nieuw en blader naar het bestand training_data.gpkg in de map exercise_data

dat u eerder downloadde.
4. Selecteer het bestand en druk op Openen. Het bestandspad wordt nu toegevoegd aan de lĳst met verbindingen

voor Geopackage, en verschĳnt in het keuzemenu.
U bent nu klaar om elke laag uit dit GeoPackage in te laden in QGIS.

1. Klik op de knop Verbinden. In het centrale deel van het venster zou u nu een lĳst moeten zien met alle lagen
die zĳn opgenomen in het bestand van GeoPackage.

2. Selecteer de laag roads en klik op de knop Toevoegen.

Een laag roads is toegevoegd aan het paneel Lagen met de objecten weergegeven in het kaartvenster.
3. Klik op Sluiten.

Gefeliciteerd! U heeft nu de eerste laag uit een GeoPackage geladen.

2.2.4 ��� Volgen: Vectorgegevens uit een database van SpatiaLite laden met
de Browser

QGIS verschaft toegang tot veel andere indelingen van databases. Net als GeoPackage, is de database-indeling
SpatiaLite een uitbreiding van de bibliotheek SQLite. En het laden van een laag uit een provider van SpatiaLite
volgt dezelfde regels als hierboven beschreven: Maak de verbinding –> Schakel die in –> Voeg de la(a)g(en) toe.
Waar dit één manier is om gegevens van SpatiaLite aan uw kaart toe te voegen, laten we eens een andere krachtige
manier verkennen om gegevens toe te voegen: de Browser.

1. Klik op het pictogram om het venster Databronnen beheren te openen.

2. Klik op de tab Browser.

2.2. Les: Uw eerste lagen toevoegen 17
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3. Op deze tab kunt u alle opslagschĳven zien die zĳn verbonden met uw computer, als ook items voor de meeste
tabs aan de linkerkant. Deze maken snelle toegang mogelĳk tot de verbonden databases of mappen.

Klik, bĳvoorbeeld, op het pictogram in het keuzemenu naast het item GeoPackage. U zult het bestand
training-data.gpkg zien waarmee we eerder verbonden (en de lagen ervan, indien uitgebreid).

4. Klik met rechts op het item SpatiaLite en selecteer Nieuwe verbinding….
5. Navigeer naar de map exercise_data, selecteer het bestand landuse.sqlite en klik op Openen.

Merk op dat een item landuse.sqlite is toegevoegd onder die van SpatiaLite.

6. Breid het item landuse.sqlite uit.

7. Dubbelklik op de laag landuse of selecteer en sleep het naar het kaartvenster en zet het daar neer.
Een nieuwe laag wordt toegevoegd aan het paneel Lagen en de objecten daarvan worden weergegeven in het
kaartvenster.

Tip: Schakel het paneel Browser in onder Beeld ► Panelen ► en gebruik het om uw gegevens toe te voegen. Het is
een handige sneltoets voor de tab Databronnen beheren ► Browser, met dezelfde functionaliteit.

Notitie: Vergeet niet om uw project regelmatig op te slaan! Het projectbestand bevat niet direct de gegevens, maar
het onthoud welke lagen u in uw kaart geladen heeft.
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2.2.5 ��� Probeer zelf: Meer vectorgegevens laden

Laad de volgende gegevenssets uit de map exercise_data in uw kaart met een van de hierboven uitgelegde
methoden:

• buildings

• water

Antwoord
Uw kaart zou zeven lagen moeten hebben:

• protected_areas

• places

• rivers

• roads

• landuse

• buildings (afkomstig uit training_data.gpkg) en
• water (afkomstig uit exercise_data/shapefile).

2.2.6 Volgen: De lagen opnieuw schikken

De lagen in uw lĳst Lagen worden in een bepaalde volgorde op de kaart getekend. De laag onder in de lĳst wordt als
eerste getekend en de laag aan de bovenkant wordt als laatste getekend. Door de volgorde, waarin zĳ in de lĳst zĳn
weergegeven, te wĳzigen, kunt u de volgorde wĳzigen waarin zĳ getekend worden.

Notitie: U kunt dit gedrag veranderen met het keuzevak Rendervolgorde controleren onder in het paneel
Laagvolgorde. We zullen deze mogelĳkheid echter nog niet verder bespreken.

De volgorde waarin de lagen zĳn geladen in de kaart is in dit stadium waarschĳnlĳk niet logisch. Het is mogelĳk dat
de laag met wegen volledig is verborgen omdat andere lagen er bovenop liggen.
Deze volgorde van lagen bĳvoorbeeld…

… zou resulteren in verborgen wegen en plaatsen, omdat zĳ onder de polygonen van de laag landuse liggen.
Dit probleem oplossen:

1. Klik en sleep een laag uit de lĳst met Lagen.
2. Schik ze opnieuw naar deze volgorde:
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U zult zien dat de kaart visueel nu meer betekenis heeft, met wegen en gebouwen die bovenop de regio’s van landuse
verschĳnen.

2.2.7 Conclusie

Nu heeft u uit verschillende bronnen alle lagen toegevoegd die u nodig heeft en een basiskaart gemaakt!

2.2.8 Wat volgt?

Nu bent u bekend met de basisfunctie van de knop Databronnen beheren openen, maar wat met al die andere? Hoe
werkt deze interface? Laten we, voordat we verder gaan, eens kĳken naar wat basale interactie met de interface van
QGIS. Dat is het onderwerp van de volgende les.

2.3 Les: Navigeren in het kaartvenster

Dit gedeelte zal zich focussen op basisgereedschappen voor navigatie in QGIS, om in het kaartvenster te navigeren.
Deze gereedschappen zullen u in staat stellen de lagen visueel te verkennen op verschillende schalen.
Het doel voor deze les: Leren hoe gereedschappen voor Verschuiven en Zoomen te gebruiken in QGIS en leren over
schaal van kaarten.

2.3.1 ��� Volgen: Gereedschappen voor basisnavigatie

Laten we, voordat we leren hoe te navigeren binnen het kaartvenster, enkele lagen toevoegen, die we tĳdens deze
handleiding kunnen verkennen.

1. Open een nieuw leeg project en gebruik de in Een kaart maken, geleerde stappen om de eerder bekeken lagen
protected_areas, roads en buildings in het project te laden. Het resultaat van de weergave zou
eruit moeten zien als in de snipper in Fig. 2.2 hieronder (de kleuren zĳn niet van belang):
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Fig. 2.2: Beschermde gebieden, wegen en gebouwen toegevoegd

Laten we eerst leren hoe het gereedschap Kaart verschuiven te gebruiken.

1. Zorg er voor dat, op de werkbalk Kaartnavigatie, de knop Kaart verschuiven is geactiveerd.
2. Verplaats de muis naar het midden van het gebied van het kaartvenster.
3. Klik met links en houdt die ingedrukt, en sleep de muis in een willekeurige richting om de kaart te verschuiven.

Laten we vervolgens inzoomen en de lagen, die we hebben geladen, eens nader bekĳken.

1. Klik, op de werkbalk Kaartnavigatie, op de knop Inzoomen.
2. Verplaats uw muis naar ongeveer het linksboven gelegen gebied van waar de grootste dichtheid aan gebouwen

en wegen is.
3. Klik met links en houdt ingedrukt.
4. Sleep dan de muis, die een rechthoek zal maken, en bedek het dichte gebied met gebouwen en wegen (Fig.

2.3).
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Fig. 2.3: Inzoomen

5. Laat de linkermuisknop los. Dit zal inzoomen op het gebied dat u hebt geselecteerd met uw rechthoek.

22 Hoofdstuk 2. Module: Een basiskaart maken en verkennen



QGIS Training Manual

6. Selecteer, om uit te zoomen, de knop Uitzoomen en voer dezelfde actie uit als welke u deed voor inzoomen.
Als u verschuift, inzoomt, of uitzoomt slaat QGIS deze weergaven op in een geschiedenis. Dit stelt u in staat terug te
vallen op een eerdere weergave.

1. Klik, op de werkbalk Kaartnavigatie, op de knop Vorig beeld om naar uw eerdere weergave te gaan.

2. Klik op de knop Volgend beeld om voorwaarts te gaan in uw geschiedenis.
Soms, na het verkennen van de gegevens, moeten we onze weergave herstellen naar het bereik van alle lagen. In plaats
van het gereedschap Uitzoomen meerdere keren te gebruiken, verschaft QGIS ons een knop om die actie voor ons
uit te voeren.

1. Klik op de knop Volledig uitzoomen.
Wanneer u in en uit zoomt, merk dan op dat de waarde van Schaal op de Statusbalk wĳzigt. De waarde Schaal geeft
de schaal van de kaart weer. In het algemeen geeft het getal rechts van : weer hoeveel keer kleiner het object is dat u
ziet in het kaartvenster, vergeleken met het feitelĳke object in de echte wereld.
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U kunt dit veld ook gebruiken om de schaal van de kaart handmatig in te stellen.
1. Klik, op de Statusbalk, op het tekstveld Schaal.
2. Typ in 50000 en druk op Enter. Dit zal de objecten in het kaartvenster opnieuw tekenen om de schaal weer

te geven die u hebt ingetypt.
3. Als alternatief, klik op de pĳl voor de opties van het veld Schaal om de vooraf ingestelde schalen voor de kaart

te bekĳken.

4. Selecteer 1:5000. Dit zal ook de schaal voor de kaart bĳwerken in het kaartvenster.
Nu kent u de basis voor het navigeren in het kaartvenster. Bekĳk de Gebruikershandleiding over Zoomen en
verschuiven om alternatieve manieren te leren voor het navigeren in het kaartvenster.

2.3.2 Conclusie

Weten hoe te navigeren in het kaartvenster is belangrĳk, omdat dat het mogelĳk maakt de lagen te verkennen en
visueel te inspecteren. Dit zou kunnen worden gedaan voor de eerste verkenning van de gegevens, of om de uitvoer
van een ruimtelĳke analyse te valideren.

2.4 Les: Symbologie

De symbologie van een laag is zĳn visuele uiterlĳk op een kaart. De basissterkte van GIS, boven andere manieren
van het weergeven van gegevens met ruimtelĳke aspecten, is dat met GIS u een dynamische visuele weergave heeft
van de gegevens waarmee u werkt.
Daarom is het visuele uiterlĳk van de kaart (die afhankelĳk is van de symbologie van de individuele lagen) zeer
belangrĳk. De eindgebruiker van de kaarten die umaaktmoet in staat zĳn om eenvoudig te zienwat de kaart weergeeft.
Net zo belangrĳk is dat u in staat moet zĳn de gegevens te verkennen, terwĳl u ermee werkt, en goede symbologie
helpt daar veel bĳ.
Met andere woorden: juiste symbologie hebben is geen luxe of leuk om te hebben. In feite is het essentieel voor u om
een GIS juist te gebruiken en kaarten en informatie te produceren die mensen kunnen gebruiken.
Het doel voor deze les: Symbologie te kunnen maken die u wilt gebruiken voor een willekeurige vectorlaag.
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2.4.1 ��� Volgen: Kleuren wijzigen

De symbologie van een laag wĳzigen: open zĳn Laageigenschappen. Laten we beginnen met het wĳzigen van de kleur
van de laag landuse.

1. Klik met rechts op de laag landuse in de Lagenlĳst.
2. Selecteer het menuitem Eigenschappen… in het menu dat verschĳnt.

Notitie: Standaard kunt u ook toegang krĳgen tot de eigenschappen van een laag door erop te dubbelklikken
in de Lagenlĳst.

Tip: De knop , direct boven het paneel Lagen, zal het paneel Laag opmaken openen. U kunt dit
paneel gebruiken om enkele eigenschappen van de laag te wĳzigen: standaard zullen wĳzigingen direct worden
toegepast.

3. Selecteer, in het venster Laageigenschappen, de tab Symbologie:

4. Klik op de knop Kleur selecteren naast het label Kleur. Een standaard dialoogvenster voor kleuren zal
verschĳnen.

5. Kies een grĳze kleur en klik op OK.
6. Klik opnieuw op OK in het venster Laageigenschappen en u zult zien dat de wĳziging van de kleur is toegepast

op de laag.
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2.4.2 ��� Probeer zelf:

Wĳzig de kleur van de laag water naar lichtblauw. Probeer het paneel Laag opmaken te gebruiken in plaats van het
menu Laageigenschappen.

Oplossing
• Verifieer dat de kleuren wĳzigen zoals u verwacht dat ze wĳzigen.

• Het is genoeg om de laag water in de legenda te selecteren en dan te klikken op de knop
Paneel Laag opmaken openen. Wĳzig de kleur naar een die past bĳ de laag water.

Wanneer u op maar één laag tegelĳk wilt werken en niet wilt dat de andere lagen u afleiden, kunt u een laag verbergen
door te klikken in het keuzevak naast zĳn naam in de Lagenlĳst. Als het vak leeg is, dan is de laag verborgen.

2.4.3 ��� Volgen: Symbool structuur wijzigen

Dit gaat tot dusverre prima, maar er is meer symbologie op een laag dan alleen de kleur ervan. Vervolgens willen we
de lĳnen elimineren, die tussen de verschillende gebieden van landuse bestaan, om de kaart visueel minder rommelig
te laten lĳken.

1. Open het venster Laageigenschappen voor de laag landuse.

Op de tab Symbologie zult u hetzelfde dialoogvenster zien als eerder. Deze keer echter gaat u meer doen
dan alleen snel de kleur wĳzigen.

2. Vergroot, in de boom van symboollagen, de keuzelĳst Vulling en selecteer de optie Standaard vulling:
3. Klik op de keuzelĳst Lĳnstĳl. Op dit moment zou die een korte lĳn moeten laten zien en de woorden

Doorlopende lĳn.
4. Wĳzig dit naar Geen Lĳn.
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5. Klik op OK.
Nu zal de laag landuse geen lĳnen tussen gebieden meer hebben.

2.4.4 ��� Probeer zelf:

• Wĳzig de symbologie van de laag water opnieuw zodat het een meer donkerblauwe rand heeft.
• Wĳzig de symbologie van de laag rivers naar een zinvolle weergave van waterwegen.

Onthoud: u kunt de knop Paneel Laag opmaken openen gebruiken en direct alle wĳzigingen zien. Dat paneel stelt u ook
in staat individuele wĳzigingen bĳ het symboliseren van een laag ongedaan te maken.

Antwoord
Uw kaart zou er nu zo uit moeten zien:
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Als u een gebruiker op het niveau Beginner bent, kunt u hier stoppen.
• Gebruik de methode hierboven om de kleuren n stĳlen voor alle resterende lagen te wĳzigen.
• Probeer natuurlĳke kleuren te gebruiken voor de objecten. Een weg zou bĳvoorbeeld niet rood of blauwmoeten
zĳn, maar grĳs of zwart.

• Het staat u vrĳ om te experimenteren met de verschillende instellingen voor Vullingstĳlen en Lĳnstĳl voor de
polygonen.
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2.4.5 ��� Volgen: Op schaal gebaseerde zichtbaarheid

Soms zult u vinden dat een laag niet geschikt is voor een opgegeven schaal. Een gegevensset van, bĳvoorbeeld, alle
werelddelen kan een laag detail hebben en niet heel nauwkeurig zĳn op straatniveau. Wanneer dat gebeurt wilt u in
staat zĳn de gegevensset te verbergen voor niet toepasselĳke schaalgrootten.
In ons geval zouden we kunnen besluiten om de gebouwen te verbergen van weergave op kleine schaalgrootten. Deze
kaart bĳvoorbeeld…

… is niet erg nuttig. De gebouwen zĳn moeilĳk te onderscheiden op die schaal.
Inschakelen van renderen gebaseerd op schaal:

1. Open het dialoogvenster Laageigenschappen voor de laag buildings.
2. Activeer de tab Rendering.
3. Schakel op schaal gebaseerd renderen in door te klikken op het keuzevak gelabeld Schaalafhankelĳke

zichtbaarheid:
4. Wĳzig de waarde Minimum naar 1:10.000.
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5. Klik op OK.
Test de effecten hiervan door in- en uit te zoomen op uw kaart, merk op wanneer de laag buildings verdwĳnt en
weer verschĳnt.

Notitie: U kunt uw muiswiel gebruiken om in stappen te zoomen. Als alternatief kunt de gereedschappen Zoomen
gebruiken om in een venster te zoomen:

2.4.6 ��� Volgen: Symboollagen toevoegen

Nu u weet hoe u eenvoudige symbologie voor lagen kunt wĳzigen, is de volgende stap om meer complexe symbologie
te maken. QGIS stelt u in staat dit te doen met behulp van symboollagen.

1. Ga terug naar de symbooleigenschappen van de laag landuse (door te klikken op Standaard vulling in de
boom met symboollagen).
In dit voorbeeld heeft het huidige symbool geen omtrek (d.i. het gebruikt de randstĳl Geen Lĳn).
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2. Selecteer het niveau Vulling in de boom en klik op de knop Symboollaag toevoegen. Het dialoogvenster zal
wĳzigen en er ongeveer uitzien zoals hier, met een nieuw toegevoegde symboollaag:
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Het zou er, bĳvoorbeeld, qua kleur iets anders uit kunnen zien, maar u gaat dat toch wĳzigen.
Nu is er een tweede symboollaag. Omdat het een effen kleur is zal het natuurlĳk het eerdere soort symbool volledig
bedekken. En het heeft de randstĳl Doorlopende lĳn, die we niet willen. Duidelĳk is dat dit symbool moet worden
gewĳzigd.

Notitie: Het is belangrĳk de kaartlaag en een symboollaag niet met elkaar te verwarren. Een kaartlaag is een vector
(of raster) die in de kaart is geladen. Een symboollaag maakt deel uit van het symbool dat wordt gebruikt om een
kaartlaag weer te geven. Deze cursus zal gewoonlĳk naar een kaartlaag verwĳzen als laag, maar een symboollaag zal,
om verwarring te voorkomen, altĳd een symboollaag worden genoemd.

Met de nieuwe laag Standaard vulling geselecteerd:
1. Stel, net als eerder, de randstĳl in op Geen lĳn.
2. Wĳzig de stĳl voor de vulling naar iets anders dan Doorgetrokken of Geen vulling. Bĳvoorbeeld:
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3. Klik op OK.
Nu kunt u uw resultaten bekĳken en ze eventueel nog iets verfĳnen. U kunt zelfs meerdere extra symboollagen
toevoegen en op die manier een soort textuur voor uw laag maken.

Het is leuk! Maar het heeft vermoedelĳk teveel kleuren om op een echte kaart te gebruiken…
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2.4.7 ��� Probeer zelf:

Onthoud om in te zoomen als dat nodig is, maak een eenvoudige, maar niet te afleidende textuur voor de laag
buildings met behulp van bovengenoemde methoden.

Antwoord
Pas uw laag buildings aan zoals u dat wilt, maar onthoud dat het eenvoudig moet zĳn de verschillende lagen apart
te onderscheiden op de kaart.
Hier is een voorbeeld:

2.4.8 ��� Volgen: Niveaus voor symbolen schikken

Wanneer symboollagen worden gerenderd, worden zĳ ook in een serie gerenderd, soortgelĳk aan de manier waarop
verschillende kaartlagen worden gerenderd. Dit betekent dat, in sommige gevallen, als u veel symboollagen in één
symbool heeft, dat onverwachte resultaten kan opleveren.

1. Geef de laag roads een extra symboollaag (met de methoden voor het toevoegen van symboollagen zoals
hierboven gedemonstreerd).

2. Geef de basislĳn een Lĳndikte van 1.5 en een zwarte kleur.
3. Geef de nieuwe, bovenste laag een dikte van 0,8 en een witte kleur.

U zult zien dat dit gebeurd:
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Wel, wegen hebben nu een straat-achtige symbologie, maar u ziet dat lĳnen elkaar overlappen op elke kuising. Dat is
helemaal niet wat we willen!
U kunt de niveaus van symbolen sorteren en daarmee beheren in welke volgorde de verschillende symboollagen
worden gerenderd om te voorkomen dat dit gebeurt,
De volgorde van de symboollagen wĳzigen:

1. Selecteer de bovenste laag Lĳn in de boom van de symboollagen.
2. Klik op Geavanceerd ► Symboollagen… aan de rechter onderzĳde van het venster.
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Dit zal een dialoogvenster openen zoals dit:

3. Selecteer Symboollagen tonen. U kunt dan de volgorde van de lagen van elk symbool instellen door het
overeenkomende nummer voor het niveau in te voeren. 0 is de onderste laag.
In ons geval willen we alleen de optie activeren, zoals dit:

Dit zal de witte lĳn bovenop de dikke zwarte lĳnranden renderen.
4. Klik tweemaal op OK om terug te keren naar de kaart.

De kaart zal er nu zo uitzien:
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Als u klaar bent, onthoud dan om het symbool zelf op te slaan om niet uw werk te verliezen als in de toekomst het
symbool opnieuw wĳzigt. U kunt de huidige stĳl van uw symbool opslaan door te klikken op de knop Stĳl opslaan…
aan de onderzĳde van het dialoogvenster Laageigenschappen. We zullen de indelingQGIS QML stĳlbestand gebruiken.
Sla uw stĳl op onder solution/styles/better_roads.qml. U kunt een eerder opgeslagen stĳl op elk
moment laden door te klikken op de knop Stĳl laden…. Onthoud, voordat u een stĳl wĳzigt, dat elke niet opgeslagen
stĳl die u vervangt verloren gaat.

2.4.9 ��� Probeer zelf:

Wĳzig het uiterlĳk van de laag roads opnieuw.
Maak de wegen smal en geel, met een dunne bleke grĳze rand en een dunne zwarte lĳn in het midden. Onthoud
dat u misschien de volgorde voor het renderen van de laag moet wĳzigen via het dialoogvenster Geavanceerd ►
Symboollagen….

Antwoord
U heeft drie symboollagen nodig om het vereiste symbool te maken:
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De onderste symboollaag is een brede doorgetrokken grĳze lĳn. Daar bovenop een enigszins dunnere doorgetrokken
gele lĳn en tenslotte een andere dunnere doorgetrokken zwarte lĳn.
Als uw symboollagen het bovenstaande weergeven, maar u krĳgt niet het resultaat dat u wilt:

1. Controleer of uw symboolniveaus er ongeveer zo uitzien:

2. Nu zou uw kaart er zo uit moeten zien:
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2.4.10 ��� Probeer zelf:

Symboollagen werken ook voor geclassificeerde lagen (d.i. lagen die meerdere symbolen hebben). Omdat we
classificatie nog niet behandeld hebben, zult u werken met enige rudimentaire vooraf geclassificeerde gegevens.

1. Maak een nieuw project en voeg alleen de gegevensset roads toe.
2. Pas het stĳlbestand advanced_levels_demo.qml, verschaft in exercise_data/styles, toe op

de laag. Dit kan worden gedaan met het combinatievak Stĳl ► Stĳl laden… aan de onderzĳde van het
dialoogvenster Laageigenschappen.

3. Zoom in op het gebied Swellendam.
4. Zorg er met behulp van symboollagen voor dat de randen van lagen in elkaar vloeien zoals in de afbeelding

hieronder:

2.4. Les: Symbologie 39



QGIS Training Manual

Antwoord
1. Pas uw symboolniveaus aan naar deze waarden:

1. Experimenteer met verschillende waarden om verschillende resultaten te krĳgen.
2. Open uw originele kaart opnieuw vóórdat u doorgaat met de volgende oefening.
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2.4.11 ��� Volgen: Typen symboollagen

In aanvulling op het instellen van vulkleuren en het gebruiken van vooraf gedefinieerde patronen, kunt u geheel andere
typen symboollagen gebruiken. Het enige type dat we tot op heden hebben gebruikt, was het type Standaard vulling.
De meer geavanceerde typen symboollagen stellen u in staat uw symbolen nog verder aan te passen.
Elk type vector (punt, lĳn en polygoon) heeft zĳn eigen set van typen symboollagen. Eerst zullen we kĳken naar de
typen die beschikbaar zĳn voor punten.

Typen symboollagen voor punt

1. Deselecteer alle lagen, met uitzondering van places`.
2. Wĳzig de symbool-eigenschappen voor de laag places`:

3. Een type symboollaag kan worden gekozen door in de boom van de symboollagen Standaard symbool te
selecteren uit de keuzelĳst Symboollaagtype:
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4. Onderzoek de verschillende opties die voor u beschikbaar zĳn en kies een symbool met de stĳl waarvan u denkt
dat die toepasselĳk is.

5. Indien u twĳfelt, gebruik dan een rond Standaard symbool met een witte rand en een bleke groene vulling, met
een Grootte van 3.00 en een Lĳndikte van 0.5.

Typen symboollagen voor lijn

De verschillende beschikbare opties voor lĳngegevens bekĳken:
1. Wĳzig het Type symboollaag voor de bovenste symboollaag van roads naar Markeringslĳn:
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2. Selecteer de laag Standaard symbool in de boom van de symboollagen. Wĳzig de eigenschappen voor het
symbool zodat ze overeenkomen met dit dialoogvenster:
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3. Selecteer de laag Symbolen-lĳn en wĳzig de interval naar 1.00:
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4. Controleer of de symboolniveaus correct zĳn (in het dialoogvensterGeavanceerd► Symboollagen dat we eerder
gebruikten) alvorens de stĳl toe te passen.

Als u de stĳl eenmaal heeft toegepast kĳk dan even naar de resultaten op de kaart. Zoals u kunt zien wĳzigen deze
symbolen van richting met de weg, maar buigen er niet altĳd mee. Dit is voor sommige doeleinden nuttig, maar niet
voor andere. Als u wilt, kunt u de symboollaag terug veranderen naar de manier waarop het eerder was.

Typen symboollagen voor polygoon

De verschillende beschikbare opties voor polygoongegevens bekĳken:
1. Wĳzig het Symboollaagtype voor de laag water, zoals eerder voor de andere lagen.
2. Onderzoek wat de verschillende opties in de lĳst kunnen.
3. Kies er een die u geschikt vindt.
4. Indien u twĳfelt, gebruik dan de Puntpatroonvulling met de volgende opties:
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5. Voeg een nieuwe symboollaag toe met een normale Standaard vulling.
6. Maak hem hetzelfde lichte blauw met een donkerblauwe rand.
7. Verplaats het tot onder de puntpatroonvulling-symboollaag met de knop Naar beneden:
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Als resultaat heeft u een symbool met textuur voor de laag met water, met het toegevoegde voordeel dat u de grootte
vorm en afstand van de individuele stippen die de textuur vormen kunt wĳzigen.

2.4.12 ��� Probeer zelf:

Pas een groene transparante vulkleur toe op de laag protected_areas en wĳzig de omtrek zodat het er uitziet
zoals dit:
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Antwoord
Hier zuĳn voorbeelden van de symboolstructuur:
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2.4.13 ��� Volgen: Symbologie voor geometrie-generator

U kunt de Symbologie voor geometrie-generator gebruiken met alle typen lagen (punten, lĳnen en polygonen). Het
resulterende symbool is direct afhankelĳk van het type laag.
Heel kort, de Symbologie voor geometrie-generator stelt u in staat enkele ruimtelĳke bewerkingen uit te voeren
binnen de symbologie zelf. U kunt bĳvoorbeeld een echte ruimtelĳke bewerking voor het zwaartepunt uitvoeren op
een polygonen-laag, zonder een puntenlaag te maken.
Meer nog, u heeft alle opties voor de opmaak om het uiterlĳk van het resulterende symbool te wĳzigen.
Laten we het eens proberen!

1. Selecteer de laag water.
2. Klik op Standaard vulling en wĳzig het Symboollaagtype naar Geometrie-generator.
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3. Vóór we beginnen met het schrĳven van de ruimtelĳke query moeten we het type geometrie kiezen voor de
uitvoer. In dit voorbeeld gaan we zwaartepunten maken voor elk object, wĳzig dus het type geometrie naar
Punt / Multipunt.

4. Laten we dan nu de query schrĳven in het paneel voor de query:

centroid($geometry)
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5. Wanneer u klikt op OK zult u zien dat de laag water is gerenderd als een puntenlaag! We hebben zojuist een
ruimtelĳke bewerking uitgevoerd binnen de laag op de symbologie zelf, is dat niet verbazingwekkend?
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Met de symbologie van de Geometrie-generator kunt u echt over de grenzen van normale symbologie gaan.

��� Probeer zelf:

Geometrie-generator is slechts een ander niveau symbool. Probeer een andere Standaard vulling toe te voegen onder
de Geometrie-generator.
Wĳzig ook het uiterlĳk van de Standaard markering van de symbologie van de Geometrie-generator.
Het uiteindelĳke resultaat zou er als volgt uit moeten zien:

2.4. Les: Symbologie 53



QGIS Training Manual

Antwoord

1. Klik op de knop om een ander Symboolniveau toe te voegen.

2. Verplaats het nieuwe symbool naar de onderzĳde van de lĳst door te klikken op de knop .
3. Kies een goede kleur om de waterpolygonen te vullen.
4. Klik op Markering van de Geometrie-generator symbologie en wĳzig de cirkel door een andere vorm zoals u

wilt.
5. Probeer te experimenteren met andere opties om meer nuttige resultaten te verkrĳgen.
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2.4.14 ��� Volgen: Een aangepaste vulling SVG maken

Notitie: Umoet de gratis software voor het bewerken van vectoren Inkscape hebben geïnstalleerd om deze oefening
te kunnen doen,

1. Start het programma Inkscape. U zult de volgende interface zien:

Dit zou u bekend kunnen voorkomen als u eerder andere programma’s voor het bewerken van
vectorafbeeldingen, zoals Corel, hebt gebruikt.
Eerst zullen we het werkvenster wĳzigen naar een grootte die toepasselĳk is voor een kleine textuur.

2. Klik op het menuitem Bestand►Documenteigenschappen. Dit zal u het dialoogvensterDocumenteigenschappen
tonen.

3. Wĳzig Eenheden naar px.
4. Wĳzig de Breedte en Hoogte naar 100.
5. Sluit het dialoogvenster als u klaar bent.
6. Klik op het menuitem Beeld ► Zoomen ► Pagina om de pagina te zien waar u mee werkt.
7. Selecteer het gereedschap Cirkel:
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8. Klik en sleep op de pagina om een ellips te tekenen. Houd de toets Ctrl ingedrukt terwĳl u tekent, om van
de ellips een cirkel te maken.

9. Klik met rechts op de cirkel die u zojuist gemaakt hebt en open zĳn opties Vulling en lĳn. U kunt het renderen
aanpassen, zoals:
1. Wĳzig de laag Vulling naar een lichtere kleur blauw.
2. Wĳs, op de tab Lĳnkleur, een donkerder kleur toe aan de rand.
3. En verklein de dikte van de rand op de tab Lĳnstĳl.
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10. Teken een lĳn met behulp van het gereedschap Potlood:
1. Klik eenmaal om de lĳn te beginnen. Houd Ctrl ingedrukt om het te laten ‘snappen’ in stappen van 15

graden.
2. Verplaats de aanwĳzer horizontaal en plaats een punt met één enkele klik.
3. Klik en snap aan het hoekpunt van de lĳn en maak een verticale lĳn, beëindig die met één enkele klik.
4. Verbindt de twee eindpunten met elkaar.
5. Wĳzig de kleur en breedte van het symbool Driehoek om het overeen te laten komen met de rand van de

cirkel en verplaats het indien nodig, zodat u eindigt met een symbool zoals dit:
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11. Als het symbool naar uw wensen is, sla het op als landuse_symbol in de map waar de cursus in staat, onder
exercise_data/symbols, als SVG-bestand.

In QGIS:
1. Open de Laageigenschappen voor de laag landuse.
2. Wĳzig, op de tab Symbologie, de structuur van het symbool door het Symboollaagtype te wĳzigen naar SVG-

vulling, zoals hieronder weergegeven.
3. Klik op de knop… en dan op Openen… om uw SVG-afbeelding te selecteren.

Het wordt toegevoegd aan de boom met symbolen en u kunt nu de verschillende karakteristieken ervan
aanpassen (kleuren, hoek, effecten, eenheden…).
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Als u eenmaal het dialoogvenster hebt gevalideerd, zouden objecten op de laag landuse nu moeten zĳn bedekt
door een verzameling symbolen, die een textuur weergeven zoals die op de volgende kaart. Als texturen niet zichtbaar
zĳn, dient u misschien in te zoomen op het kaartvenster of een grotere Breedte voor de textuur in te stellen in de
eigenschappen van de laag.
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2.4.15 ��� Volgen: Maskeren

De mogelĳkheid Maskeren stelt u in staat een symboollaag te maskeren met een andere symboollaag of label.
In de volgende oefening zullen we rendering configureren, zodat polygoonlabels het zwarte gedeelte van een lĳnenlaag
maskeren.

1. Laad het bestand selective_masking.qgs uit de gegevensset in de map exercise_data/
masking.

2. Open het venster Laageigenschappen voor de laag polys.
Op de tab Labels zult u zien dat Enkele labels al zĳn gedefinieerd.

3. Vanaf de tab Labels, selecteer het Masker (en niet Maskers in de lĳst van de algemene categorie)

4. Schakel labelmasker in door de optie Masker inschakelen te selecteren
Een bericht vertelt u dat het nu gedefinieerde labelmasker later kan worden geselecteerd als bronmasker om
andere symboollagen te maskeren. Laten we dat doen.

5. Klik op OK

6. Open het venster Laageigenschappen voor de laag lines.

7. Ga naar de tab Maskers

8. Klik op het keuzevak voor de zwarte gedeelten van de lĳn in de gemaskeerde symboollagen
Een bericht waarschuwt u dat u zowel de maskerlaag als de te maskeren symboollagen moet selecteren om in
staat te zĳn de configuratie voor het maskeren op te slaan. Nogmaals, laten we dat doen.

9. Klik op polys keuzevak Label masker

Het bericht verdwĳnt, u kunt nu uw configuratie veilig opslaan.
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10. Klik op OK

U kunt nu zien dat labels de zwarte gedeelten van de lĳnen maskeren, alleen het gele gedeelte nog zichtbaar.
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2.4.16 ��� Volgen: Maskeren met symbolen punt

Wewillen nu het zwarte gedeelte van de lĳnen maskeren die alleen zwarte vliegtuigen gebruiken, die de laag points
weergeven (d.i. categorieën punten B52 en Jet). Voor de zichtbaarheid kunt u de zichtbaarheid van de laag polys
uitschakelen.

1. Open het venster Laageigenschappen voor de laag points.

Op de tab Symbologie zult u zien dat een renderer Categorieën is gedefinieerd met 3 verschillende
symbolen, afhankelĳk van de waarde voor het veld Class.

2. Dubbelklik op het pictogram voor het vliegtuig B52, in de kolom Symbool

3. Klik op de knop Symboollaag toevoegen en selecteer het Symboollaagtype Masker

Een nieuwe hiërarchie Masker (symboollaag) > Markering (symbool) > Eenvoudige markering
(symboollaag) verschĳnt nu onder het bronsymbool Markering.
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Laten we nu een masker definiëren dat identiek is aan onze markering voor het vliegtuig, maar iets groter.
4. Selecteer de nieuw gemaakte symboollaag Eenvoudige markering en wĳzig zĳn Symboollaagtype naar

SVG-markering

5. Stel het pad naar het SVG-bestand in als hetzelfde als voor de reeds bestaande SVG-markering en de grootte
iets groter (24 millimeter is een vrĳ goede keuze voor dit gebruiksgeval).
De kleur voor het masker maakt hier niets uit, alleen de vorm wordt voor het maskeren gebruikt. De volgorde
van de symboollagen is in die situatie ook niet relevant.
U zult iets krĳgen zoals dit:

6. Herhaal dezelfde bewerkingen voor het symbool Jet.
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7. Klik op OK

8. Open het venster Laageigenschappen voor de laag lines.

9. Ga naar de tab Maskers.
Het keuzevak voor de zwarte gedeelten van de lĳnen voor de gemaskeerde symboollagen is al geselecteerd uit
onze eerdere configuratie.

10. Deselecteer het keuzevak voor Label masker polys en selecteer zowel Masker symboollaag B52 als Jet
11. Klik op OK

U kunt nu zien dat zwarte vliegtuigen de zwarte gedeelten van de lĳnen maskeren, met alleen het gele gedeelte nog
zichtbaar.
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2.4.17 Conclusie

Wĳzigen van de symbologie voor de verschillende lagen heeft een collectie vectorbestanden getransformeerd naar
een leesbare kaart. Niet alleen kunt u zien wat er gebeurt, het ziet er ook leuk uit!

2.4.18 Lees verder

Voorbeelden van mooie kaarten

2.4.19 Wat volgt?

Wĳzigen van symbolen voor gehele lagen is nuttig, maar de informatie die is opgenomen in elke laag is nog niet
beschikbaar voor iemand die deze kaart leest. Hoe heten de straten? Tot welke administratieve regio’s behoren
bepaalde gebieden? Wat zĳn de relatieve oppervlaktegebieden van de boerderĳen? Al deze informatie is nog steeds
verborgen. De volgende les zal uitleggen hoe u deze gegevens op uw kaart weergeeft.

Notitie: Heeft u onthouden om uw kaart regelmatig op te slaan?
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Module: Vectorgegevens classificeren

Classificeren van vectorgegevens stelt u in staat verschillende symbolen aan objecten toe te wĳzen (verschillende
objecten op dezelfde laag), afhankelĳk van hun attributen. Dit stelt iemand die de kaart gebruikt in staat om de
attributen van de verschillende objecten te zien.

3.1 Les: Vector attributengegevens

Vectorgegevens zĳn mogelĳkerwĳs de meest voorkomende soort gegevens die u zult tegenkomen bĳ het dagelĳks
gebruik van een GIS. Het vectormodel geeft de locatie en vorm van geografische objecten weer in punten, lĳnen en
polygonen (en voor 3D-gegevens ook oppervlakten en volumes), terwĳl hun andere eigenschappen zĳn opgenomen
als attributen (vaak weergegeven als een tabel in QGIS).
Tot nu toe zĳn geen van de wĳzigingen, die wĳ aan de kaart hebben verricht, beïnvloed door de objecten die worden
weergegeven. Met andere woorden, alle gebieden van het gebruik van het land zien er hetzelfde uit, en alle wegen
zien er hetzelfde uit. Bĳ het kĳken naar de kaart weten de kĳkers niets over de wegen die zĳ zien; alleen dat er een
weg met een bepaalde vorm in een bepaald gebied ligt.
Maar de gehele kracht van GIS is dat alle objecten die zichtbaar op de kaart staan ook attributen hebben. Kaarten in
een GIS zĳn niet slechts afbeeldingen. Zĳ vertegenwoordigen niet alleen objecten op locaties, maar ook informatie
over deze objecten.
Het doel voor deze les: De structuur van vectorgegevens te leren en de gegevensattributen van een object te
verkennen.

3.1.1 ��� Volgen: Attributen van lagen bekijken

Het is belangrĳk te weten dat de gegevens waarmee u gaat werken niet alleen weergeven waar objecten in de ruimte
staan, maar ook dat ze u vertellen wat die objecten zĳn.
Vanuit de vorige oefening zou u de laag protected_areas moeten zĳn geladen in uw kaart. Als die nog
niet is geladen, dan vindt u de gegevensset protected_areas.shp in de indeling ESRI Shapefile in de map
exercise_data/shapefile.
De polygonen geven de beschermde gebieden weer die bestaan uit de ruimtelĳke gegevens, maar we kunnen meer
te weten komen over de beschermde gebieden door de attributentabel te verkennen.
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1. Klik, in het paneel Lagen, op de laag protected_areas om die te selecteren.

2. Klik, in hetmenuKaartlagen, op de knop Attributentabel openen`(ook toegankelĳk via de knoppen van de bovenste werkbalken). Dit zal een nieuw venster openen dat de attributentabel van de laag ``protected_areas`

zal weergeven.

Een rĳ wordt een record genoemd en is geassocieerd met een object in het kaartvenster, zoals een polygoon.
Een kolom wordt een veld (of een attribuut) genoemd, en heeft een naam die helpt om het te beschrĳven,
zoals name of id. Waarden in de cellen worden attribuutwaarden genoemd. Deze definities worden veel
gebruikt in GIS, dus is het goed om ze te onthouden.
Op de laag protected_areas staan twee objecten, die de twee polygonen weergeven die we zien in het
kaartvenster.

Notitie: Om te kunnen begrĳpen wat de velden en attribuutwaarden weergeven, moet men misschien de
documentatie (of metadata) zoeken die de betekenis van de attribuutwaarden beschrĳft. Deze zĳn gewoonlĳk
beschikbaar bĳ de maker van de gegevensset.

Laten we vervolgens eens kĳken hoe een record in de attributentabel is gekoppeld aan een object polygoon die we
zien in het kaartvenster.

1. Ga terug naar het hoofdvenster van QGIS.

2. Klik, in het menu Bewerken ► Selecteren, op de knop Object(en) selecteren.
3. Zorg er voor dat de laag protected_areas nog steeds is geselecteerd in het paneel Lagen.
4. Verplaats uw muis naar het kaartvenster en klik met links op de kleinste van de twee polygonen. De polygoon

zal geel worden, wat aangeeft dat die is geselecteerd.
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5. Ga terug naar het venster Attributentabel, en u zou een record (rĳ) geaccentueerd moeten zien. Dat zĳn de
attribuutwaarden van de geselecteerde polygoon.
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U kunt ook een object selecteren in de Attributentabel.
1. Klik, in het venster Attributentabel, aan de uiterste linkerkant, op het rĳnummer van het record dat momenteel

niet geselecteerd is.

2. Ga terug naar het hoofdvenster van QGIS en kĳk naar het kaartvenster. U zou nu het grootste van de twee
polygonen geel gekleurd moeten zien.

3. Ga naar het venster Attributentabel en klik op de knop Alle objecten van de laag deselecteren om het object te
deselecteren.

Soms worden er heel veel objecten weergegeven in het kaartvenster en zou het moeilĳk kunnen zĳn om te zien welk
object in de Attributentabel is geselecteerd. Een andere manier om de locatie van een object te identificeren is om
het gereedschap Flitsmogelĳkheid te gebruiken.

1. Klik met rechts, in de Attributentabel, op de cel in de rĳ die de attribuutwaarde r2855697 voor het veld
full_id heeft.

2. Klik, in het contextmenu, op Flitsmogelĳkheid en kĳk dan in het kaartvenster.

U zou nu moeten zien dat de polygoon een aantal keren rood flikkert. Als u het niet zag, probeer het dan nog
eens.

Een ander handig gereedschap is het gereedschap Naar object zoomen, dat QGIS zegt naar het betrokken object te
zoomen.
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1. Klik met rechts, in de Attributentabel, op de cel in de rĳ die de attribuutwaarde r2855697 voor het veld
full_id heeft.

2. Klik, in het contextmenu, op Naar object zoomen

Kĳk naar het kaartvenster. De polygoon zou nu het bereik van het gebied van het kaartvenster moeten innemen.
U mag nu de attributentabel sluiten.

3.1.2 ��� Probeer zelf: Attributen van vectorgegevens verkennen

1. Hoeveel velden zĳn er beschikbaar in de laag rivers?
2. Vertel ons eens iets meer over de plaatsen town in uw gegevensset.
3. Open de attributentabel voor de laag places. Welk veld zou het meest nuttig zĳn om weer te geven in de vorm

van een label, en waarom?

Antwoord
• Er zouden 9 velden in de laag rivers moeten zĳn:

1. Selecteer de laag in het paneel Lagen.

2. Klik met rechts en kiesAttributentabel, of druk op de knop op dewerkbalk Attributen (het kan worden
ingeschakeld in het menu Beeld ► TWerkbalken).

3. Tel het aantal kolommen.
Een snellere benadering zou zĳn om dubbel te klikken op de laag rivers, de Laageigenschappen ► tab Velden
te openen, waar u een genummerde lĳst van de velden van de tabel zult vinden.

• Informatie over steden is beschikbaar in de laag places. Open de attributentabel daarvan zoals u deed met
die van de laag rivers: er zĳn twee objecten waarvan het attribuut place is ingesteld als town: Swellendam en
Buffeljagsrivier. U kunt opmerkingen toevoegen aan andere velden vanuit deze twee records, als u dat wilt.

• Het veld name is het meest nuttige om als labels weer te geven. Dat komt omdat al zĳn waarden uniek zĳn
voor elk object en zal hoogst onwaarschĳnlĳk waardenNULL bevatten. Als uw gegevens enkele waardenNULL
bevat, maak u geen zorgen omdat de meeste plaatsen van u namen hebben.
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3.1.3 Conclusie

U weet nu hoe u de attributentabel kunt gebruiken om te zien wat er echt in de gegevens staat die u gebruikt. Een
gegevensset zal alleen nuttig voor u zĳn als het de attributen heeft waar het u om gaat. Als u weet welke attributen
u nodig heeft, kunt u snel beslissen of u een bepaalde gegevensset kunt gebruiken, of dat u naar een andere moet
zoeken die wel de vereiste gegevens voor de attributen heeft.

3.1.4 Wat volgt?

Verschillende attributen zĳn nuttig voor verschillende doeleinden. Sommige ervan kunnen direct als tekst worden
weergegeven om door de gebruiker van de kaart te worden gezien. Hoe dit te doen leert u in de volgende les.

3.2 Les: Labels

Labels kunnen aan een kaart worden toegevoegd om elke soort informatie over een object weer te geven. Elke
vectorlaag kan labels met zich geassocieerd hebben. Deze labels zĳn afhankelĳk van de gegevens voor attributen
van een laag voor hun inhoud.
Het doel voor deze les: Nuttige en goed uitziende labels toe kunnen passen op een laag.

3.2.1 ��� Volgen: Labels gebruiken

Zorg er eerst voor dat de knop zichtbaar is in de gebruikersinterface:
1. Ga naar het menuitem Beeld ►Werkbalken

2. Zorg er voor dat het item Werkbalk Label een vinkje voor zich heeft staan. Als dat niet zo is, klik dan op het
itemWerkbalk Label om het te activeren.

3. Klik op de laag places in het paneel Lagen, zodat die wordt geaccentueerd
4. Klik op de knop op de werkbalk om de tab Labels van het paneel Laag opmaken te openen
5. Schakel van Geen labels naar Enkele labels

U zult moeten kiezen welk veld in de attributen zal worden gebruikt voor de labels. In de vorige les heeft u
besloten dat het veld name het meest geschikte voor dit doel was.

6. Selecteer name uit de lĳst Waarde:
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7. Klik op Apply

De kaart zou nu labels moeten hebben zoals deze:
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3.2.2 ��� Volgen: Opties voor labels wijzigen

Afhankelĳk van de stĳlen die u in eerdere lessen voor uw kaart koos, zou u kunnen vinden dat de labels niet
toepasselĳk zĳn opgemaakt en ofwel elkaar overlappen of te ver af staan van hun markeringen voor het punt.

Notitie: Boven gebruikte u de knop op deWerkbalk Label om het paneel Laag opmaken te openen. Net als met
Symbologie zĳn dezelfde opties voor labelen beschikbaar via zowel het paneel Laag opmaken, als het dialoogvenster
Laageigenschappen. Hier zult u het dialoogvenster Laageigenschappen gebruiken.

1. Open het dialoogvenster Laageigenschappen door dubbel te klikken op de laag places
2. Selecteer de tab Labels

3. Zorg er voor dat Tekst is geselecteerd in de lĳst met opties aan de linkerkant, werk dan de opties voor
tekstopmaak bĳ zodat die overeenkomen met die welke hier worden weergegeven:
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4. Klik op Apply

Dat lettertype zou groter en bekender kunnen zĳn voor gebruikers, maar de leesbaarheid ervan is nog steeds
afhankelĳk van welke lagen daaronder zĳn gerenderd. Laten we, om dit op te lossen, eens kĳken naar de optie
Buffer.

5. Selecteer Buffer uit de lĳst met opties aan de linkerkant
6. Selecteer het keuzevak naast Teken tekstbuffer, en kies dan de opties, zodat die overeenkomen met die welke

hier worden weergegeven:
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7. Klik op Apply

U zult zien dat dit een gekleurde buffer of rand toevoegt aan de labels met plaatsen, wat het eenvoudiger maakt
ze te zien op de kaart:
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Nu kunnen we de plaatsing van de labels in relatie tot hun puntmarkeringen aanpakken.
8. Selecteer Plaatsing uit de lĳst met opties aan de linkerkant
9. Selecteer Rondom punt en wĳzig de waarde voor Afstand naar 2.0Millimeters:
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10. Klik op Apply

U zult nu zien dat de labels niet langer hun puntmarkeringen overlappen.

3.2.3 ��� Volgen: Labels gebruiken in plaats van symbologie voor de laag

In veel gevallen hoeft de locatie van een punt niet heel specifiek te zĳn. Bĳvoorbeeld: de meeste punten in de
laag places verwĳzen naar gehele steden of voorsteden, en het specifieke punt dat is geassocieerd met dergelĳke
objecten is niet zo specifiek op een grote schaal. In feite is het opgeven van een punt dat te specifiek is vaak verwarrend
voor iemand die een kaart leest.
Een voorbeeld: op een kaart van de wereld zou het punt dat wordt opgegeven voor de Europese Unie bĳvoorbeeld
ergens in Polen kunnen liggen. Voor iemand die de kaart leest, zou het zien van een punt dat is gelabeld Europese
Unie in Polen, zou het kunnen lĳken dat de hoofdstad van de Europese Unie daarom in Polen ligt.
Het is vaak nuttig om de symbolen voor punten uit te schakelen en ze compleet te vervangen door labels om dus dit
soort misverstanden te voorkomen.
In QGIS kunt u dit doen door de positie van de labels te wĳzigen zodat ze direct worden gerenderd over de punten
waar zĳ naar verwĳzen.

1. Open de tab Labels van het dialoogvenster Laageigenschappen voor de laag places
2. Selecteer de optie Plaatsing uit de lĳst met opties

78 Hoofdstuk 3. Module: Vectorgegevens classificeren



QGIS Training Manual

3. Klik op de knop Op afstand van punt

Dit zal de opties Kwadrant onthullen die u kunt gebruiken om de positie van het label in relatie tot de
puntmarkering in te stellen. In dit geval willen we het label centreren op het punt, dus kies het kwadrant in
het centrum:

4. Verberg de symbolen voor de punten door, zoals gewoonlĳk, de Symbologie van de laag te bewerken, en stel
de grootte van de breedte en hoogte van Standaard symbool in op 0.0:
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5. Klik op Apply en u zult dit resultaat zien:
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Als u zou uitzoomen uit de kaart, zou u zien dat sommige van de labels verdwĳnen op grotere schalen om overlappen
te vermĳden. Soms is dat wat u wilt wanneer u met gegevenssets werkt die veel punten hebben, maar andere keren
zult u op deze manier nuttige informatie verliezen. Er is een andere mogelĳkheid voor het behandelen van dit soort
gevallen, die we in een latere oefening in deze les zullen behandelen. Voor nu, zoom uit en klik op de knop op
de werkbalk en kĳk wat er gebeurt.

3.2.4 ��� Probeer zelf: De labels aanpassen

• Herstel de instellingen voor label en symbool terug naar de puntmarkering en een afstand tot punt van 2.0
Millimeters.

Antwoord
Uw kaart zou nu de markeringspunten moeten weergeven en de labels zouden moeten zĳn verschoven met 2mm. De
stĳl van de markeringen en labels zouden allebei duidelĳk zichtbaar op de kaart moeten zĳn:
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• Stel de kaart in op de schaal 1:100000. U kunt dit doen door dit in te typen in het vak Schaal op de Statusbalk.
Pas uw labels aan, zodat zĳ geschikt zĳn om op deze schaal te worden bekeken.

Antwoord
Één mogelĳk oplossing heeft dit uiteindelĳke product:
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Om op dit resultaat uit te komen:
• Gebruik een grootte voor het lettertype van 10
• Gebruik voor plaatsing Rondom punt een afstand van 1.5 mm

• Gebruik een grootte voor de markering van 3.0 mm

• In aanvulling hierop, dit voorbeeld gebruikt de optie Afbrekingsteken:
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• Voer een spatie in dit veld in en klik op Toepassen om hetzelfde effect te bereiken. In ons geval zĳn sommige
plaatsnamen heel erg lang, wat resulteert in namen op meerdere regels, wat niet erg gebruikersvriendelĳk is. U
zou deze instelling meer toepasselĳk kunnen vinden voor uw kaart.
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3.2.5 ��� Volgen: Lijnen labellen

Nu u weet hoe het labelen werkt is er een aanvullend probleem. Punten en polygonen zĳn eenvoudig te labelen, maar
hoe gaat dat met lĳnen? Als u ze op dezelfde manier labelt als de punten, zouden uw resultaten er als volgt uitzien:

We zullen nu de labels voor de laag roads opnieuw opmaken, zodat zĳ eenvoudiger te begrĳpen zĳn.
1. Verberg de laag places zodat die u niet afleidt
2. Activeer Enkele labels voor de laag roads, zoals u hierboven deed voor places
3. Stel de Grootte van het lettertype in op 10, zodat u meer labels kunt zien
4. Zoom in op het stadsgebied Swellendam
5. Kies, op de tab Plaatsing van de tab Labels, de volgende instellingen:
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U zult waarschĳnlĳk merken dat de opmaak voor de tekst standaardwaarden heeft gebruikt en dat de labels als
consequentie daarvanmoeilĳk te lezen zĳn.Werk de Tekst bĳ om een donkergrĳze of zwarteKleur te gebruiken
en de Buffer om een lichtgele Kleur te gebruiken.
De kaart zal er ongeveer zoals deze uitzien, afhankelĳk van de schaal:
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U zult zien dat sommige namen van wegen meerdere malen verschĳnen en dat is niet altĳd nodig. Dit
voorkomen:

6. Kies, op de tab Labels in het dialoogvenster Laageigenschappen, de optie Rendering en selecteer Aan elkaar
verbonden lĳnen samenvoegen om labelduplicaten te voorkomen zoals weergegeven:
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7. Klik op OK

Een andere nuttige functie is om te voorkomen dat labels die worden getekend voor objecten te kort worden
om te worden opgemerkt.

8. Stel, in hetzelfde paneel Rendering, de waarde van Onderdruk labelen van objecten kleiner dan … in op 5.00
mm en bekĳk de resultaten als u op Apply klikt.
Probeer ook de verschillende instellingen voor Plaatsing uit. Zoals we eerder hebben gezien, is de optie
Horizontaal in dit geval geen goed idee, dus laten we in plaats daarvan de optie Gebogen gebruiken.

9. Selecteer de optie Gebogen in het paneel Plaatsing op de tab Labels

Hier is het resultaat:
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Zoals u kunt zien verbergt dit enkele labels die eerder zichtbaar waren, wegens de moeilĳkheid voor sommige ervan
om gebogen lĳnen voor wegen te volgen en nog steeds leesbaar te zĳn. Het maakt andere labels veel nuttiger, omdat
zĳ de wegen volgen in plaats van te zweven in de ruimte ertussen. U kunt beslissen om deze opties te gebruiken,
afhankelĳk van wat u denkt dat nuttiger is of er beter uitziet.

3.2.6 ��� Volgen: Data-bepaalde instellingen

1. Deactiveer het labelen voor de laag roads
2. Activeer opnieuw het labelen voor de laag places

3. Open de attributentabel voor places met de knop
Het heeft één veld wat nu voor ons van belang is: place, wat het type stadsgebied definieert voor elk record.
We kunnen deze gegevens gebruiken om de stĳlen voor labels te beïnvloeden.

4. Navigeer naar het paneel Tekst in het paneel Labels van places

5. Klik op de knop naast de knop voor cursieve tekst onder Stĳl en selecteer Bewerken… om de Expressie
Bouwer te openen:
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6. Dubbelklik, onder Velden en waarden, op place en klik dan op Alle unieke. Dit zal alle unieke waarden
vermelden van het veld place van deze laag. Voeg een = in de tekstbewerker in en dubbelklik dan op town.
Als alternatief, kunt u: "place" = 'town' direct in de tekstbewerker typen.

7. Klik twee keer op OK:
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Merk op dat de labels voor alle plaatsen waarvan het veld place overeenkomt met town cursief worden
weergegeven.

3.2.7 ��� Volgen: Data-bepaalde instellingen gebruiken

Notitie: We springen hier een stukje vooruit om enkele geavanceerde instellingen voor labelen te demonstreren. Op
het niveau voor gevorderden wordt aangenomen dat u weet wat het volgende betekent. Als u dat niet weet, laat dit
gedeelte dan rusten en kom later terug als u de vereiste materialen heeft behandeld.

1. Open de attributentabel voor places

2. Ga naar de modus Bewerken door te klikken op de knop

3. Voeg een nieuwe kolom toe met de knop
4. Configureer die als volgt:
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5. Gebruik dit om aangepaste lettergrootten in te stellen voor elk verschillend type plaats (elke sleutel in het veld
place`).

Antwoord
1. Nog steeds in modus Bewerken, stel de waarden FONT_SIZE in op wat uw voorkeur heeft. Het voorbeeld

gebruikt 16 voor steden, 14 voor voorsteden, 12 voor dorpen, en 10 voor nederzettingen.
2. Onthoud om de wĳzigingen op te slaan en verlaat de modus Bewerken
3. Ga terug naar de opties voor opmaken van Tekst voor de laag places en selecteer FONT_SIZE in het

Attribuutveld van de grootte voor het lettertype in de keuzelĳst data-bepaalde override:

Uw resultaten zouden, als u de bovenstaande waarden gebruikt, als dit moeten zĳn:
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3.2.8 ��� Meer mogelijkheden met labellen

We kunnen in deze cursus niet elk optie behandelen, maar onthoud dat de tab Label nog veel meer andere nuttige
functies heeft. U kunt schaalafhankelĳk renderen instellen, de prioriteit voor het afdrukken van labels in een laag
wĳzigen, en elke optie voor labelen instellen met behulp van attributen van lagen. U kunt zelfs de rotatie, XY-positie
en andere eigenschappen van een label instellen (als u velden voor attributen voor dat doel heeft toegewezen), en deze
eigenschappen bewerken met behulp van de gereedschappen die naast de belangrĳkste knop Laag-label opties staan:

(Deze gereedschappen zullen actief zĳn als de vereiste velden voor attributen bestaan en u in de modus Bewerken
bent.)
Het staat u uiteraard vrĳ om meer mogelĳkheden van het systeem voor labelen te verkennen.
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3.2.9 Conclusie

U heeft nu geleerd hoe u attributen van lagen gebruikt voor het maken van dynamische labels. Dit kan uw kaart veel
informatiever maken en meer stĳl geven!

3.2.10 Wat volgt?

Nu u weet hoe attributen een visueel verschil voor uw kaart kunnen maken, hoe zĳn ze te gebruiken om de symbologie
van objecten zelf te wĳzigen? Dat is het onderwerp voor de volgende les!

3.3 Les: Classificatie

Labels zĳn een goede manier om informatie te communiceren, zoals de namen van individuele plaatsen, maar zĳ
kunnen niet overal voor worden gebruikt. Laten we bĳvoorbeeld zeggen dat iemand wil weten waar elk gebied van
landuse voor wordt gebruikt. Met behulp van labels zou u dit krĳgen:

Dit maakt het labelen van de kaart moeilĳk te lezen en zelfs overweldigend als er onnoemelĳk veel verschillende
gebieden voor het gebruik van land op de kaart staan.
Het doel voor deze les: Leren om vectorgegevens effectief te classificeren.

3.3.1 ��� Volgen: Nominale gegevens classificeren

1. Open het dialoogvenster Laageigenschappen voor de laag landuse.
2. Ga naar de tab Symbologie

3. Klik op de keuzelĳst genaamd Enkel symbool en wĳzig het naar Categorieën:
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4. Wĳzig, in het nieuwe paneel,Waarde naar landuse en Kleurverloop naarWillekeurig kleurverloop.
5. Klik op de knop genaamd Classificeren

6. Klik op OK

U zult iets zien zoals dit:
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7. Klik op de pĳl (of plusteken) naast landuse in het panee; Lagen, u zult de categorieën zien uitgelegd:
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Nu zĳn onze polygonen voor het gebruik van land gekleurd en geclassificeerd, zodat gebieden met hetzelfde
gebruik van het land dezelfde kleur hebben.

8. Als u wilt, kunt u het symbool voor elk gebied voor gebruik van het land wĳzigen door te dubbelklikken op het
relevante kleurblok in het paneel Lagen of in het dialoogvenster Laageigenschappen:
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Merk op dat er één categorie is die leeg is:
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Deze lege categorie wordt gebruikt om objecten te kleuren die geen waarde voor het gebruik van het land gedefinieerd
hebben of die een waarde NULL hebben. Het kan nuttig zĳn om deze lege categorie te behouden, zodat gebieden met
een waarde NULL nog steeds worden weergegeven op de kaart. U wilt misschien de kleur wĳzigen naar een meer
opvallende om een blanco of NULL-waarde weer te geven.
Onthoud om uw kaart nu op te slaan zodat u uw welverdiende wĳzigingen niet verliest!

3.3.2 ��� Probeer zelf: Meer classificatie

Gebruik de kennis die u hierboven hebt opgedaan om de laag buildings te classificeren. Stel de categorie in op
het veld building en gebruik de kleurenbalk Spectraal.

Notitie: Onthoud om in te zoomen op een stadsgebied om de resultaten te zien.

3.3.3 ��� Volgen: Verhouding classificatie

Er zĳn vier typen classificatie: nominaal, ordinaal, interval en ratio.
Bĳ nominale classificatie zĳn de categorieën waarin de objecten worden geclassificeerd gebaseerd op namen; zĳ
hebben geen volgorde. Bĳvoorbeeld: namen van steden, codes voor buurten, etc. Symbolen die worden gebruikt voor
nominale gegevens zouden geen volgorde of grootte moeten impliceren.

• Voor punten kunnen we symbolen met een verschillende vorm gebruiken.
• Voor polygonen kunnen we verschillende typen arcering of verschillende kleuren gebruiken (vermĳd het mixen
van lichte en donkere kleuren).

• Voor lĳnen kunnen we verschillende typen streeppatronen, verschillende kleuren gebruiken (vermĳd het mixen
van lichte en donkere kleuren) en verschillende symbolen langs lĳnen gebruiken.
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Bĳ ordinale classificatie worden de categorieën geschikt in een bepaalde volgorde. Wereldsteden wordt bĳvoorbeeld
een rang gegeven afhankelĳk van hun belang voor de wereldhandel, reizen, cultuur, etc. Symbolen die worden gebruikt
voor ordinale gegevens zouden een volgorde, maar geen grootte, moeten impliceren.

• Voor punten kunnen we symbolen met lichte naar donkere kleuren gebruiken.
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker).
• Voor lĳnen kunnen we graduele kleuren gebruiken (van licht naar donker).

Bĳ classificatie op interval staan de getallen op een schaal met positieve, negatieve en nulwaarden. Bĳvoorbeeld:
hoogte boven/onder zeeniveau, temperatuur in graden Celsius. Symbolen die worden gebruikt voor gegevens met
interval zouden een volgorde en grootte moeten impliceren.

• Voor punten kunnen we symbolen variërende grootte gebruiken (van klein naar groot).
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker) of diagrammen van variërende
grootte toevoegen.

• Voor lĳnen kunnen we dikte gebruiken (van dun naar dik).
Bĳ ratio-classificatie staan de getallen op een schaal met alleen positieve en nulwaarden. Bĳvoorbeeld: temperatuur
boven absoluut nul (0 graden Kelvin), afstand vanaf een punt, de gemiddelde hoeveelheid verkeer in een bepaalde
straat per maand, etc. Symbolen die worden gebruikt voor gegevens met ratio zouden een volgorde en grootte moeten
impliceren.

• Voor punten kunnen we symbolen variërende grootte gebruiken (van klein naar groot).
• Voor polygonen kunnen we graduele kleuren gebruiken (van licht naar donker) of diagrammen van variërende
grootte toevoegen.

• Voor lĳnen kunnen we dikte gebruiken (van dun naar dik).
In het voorbeeld hierboven gebruiktenwe nominale classificatie om elk record op de laaglanduse, gebaseerd op zĳn
attribuut landuse, te kleuren. Nu zullen we ratio-classificatie gebruiken om de records per gebied te classificeren.
We gaan de laag opnieuw classificeren dus zullen bestaande klassen verloren gaan, indien zĳ niet zĳn opgeslagen. De
huidige classificatie opslaan:

1. Open het dialoogvenster Laageigenschappen
2. Klik op de knop Stĳl opslaan… in het keuzemenu Stĳl.
3. Selecteer Huidige hernoemen…, voer in land usage en druk op OK.

De categorieën en hun symbolen zĳn nu opgeslagen in de eigenschappen van de laag.
4. Klik nu op het item Toevoegen… van het keuzemenu Stĳl en maak een nieuwe stĳl, genaamd ratio. Dat zal

de nieuwe classificatie opslaan.
5. Sluit het dialoogvenster Laageigenschappen

We willen de gebieden voor het gebruik van het land classificeren op grootte, maar er is een probleem: zĳ hebben
geen veld voor de grootte, dus zullen we er een moeten maken.

1. Open de attributentabel voor de laag landuse.

2. Ga naar de modus Bewerken door te klikken op de knop Bewerken aan/uitzetten

3. Voeg, met de knop Nieuw veld, een nieuwe kolom toe van het type decimaal getal, genaamd AREA:
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4. Klik op OK

Het nieuwe veld zal worden toegevoegd (aan de uiterste rechterkant van de tabel; u zult misschien horizontaal
moeten scrollen om het te zien). Op dit moment bevat het echter geen gegevens, het heeft slechts veel waarden
NULL.
We moeten de gebieden berekenen om dit probleem op te lossen.

1. Open Veldberekening met de knop .
U krĳgt dit dialoogvenster:
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2. Selecteer Bestaande velden vernieuwen

3. Selecteer AREA in de keuzelĳst van de velden

4. Op de tab Expressie, vergroot de functiegroep Geometrie in de lĳst en zoek naar $area
5. Dubbelklik er op zodat het in het veld Expressie verschĳnt

6. Klik op OK

7. Scroll naar het veld AREA in de attributentabel en u zult zien dat het is gevuld met waarden (u moet
misschien op de kolomkop klikken om de gegevens te vernieuwen).

Notitie: Deze gebieden houden rekening met de instellingen voor eenheden van het project voor gebied, dus
zĳ zouden kunnen zĳn in vierkante meters of vierkante graden.

5. Druk op om uw bewerkingen op te slaan en schakel de modus Bewerken uit met Bewerken aan/uitzetten

6. Sluit de attributentabel
Nu we de gegevens hebben, kunnen we die gebruiken om de laag landuse te renderen.
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1. Open de tab Symbologie van het dialoogvenster Laageigenschappen voor de laag``landuse``
2. Wĳzig de stĳl voor de classificatie van Categorieën naar Gradueel

3. Wĳzig deWaarde naar AREA
4. Kies, onder Kleurverloop, de optie Nieuw kleurverloop maken…:

5. Kies Gradient (als het al niet geselecteerd is) en klik op OK. U zult dit zien:
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U zult dit gebruiken om gebieden aan te duiden, met kleine gebieden als Kleur 1 en grote gebieden als Kleur 2.
6. Kies toepasselĳke kleuren

In het voorbeeld ziet het resultaat er als volgt uit:
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7. Klik op OK

8. U kunt het kleurverloop opslaan door te selecteren Kleurverloop opslaan… op de tab Kleurverloop. Kies een
toepasselĳke naam voor het kleurverloop en klik op Opslaan. U zult nu gemakkelĳk in staat zĳn hetzelfde
kleurverloop te selecteren onder Alle kleurverlopen.

9. Kies, onder Modus, Gelĳk aantal (Kwantiel) .
10. Klik op Classificeren

Nu zult u iets hebben zoals dit:
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Laat alles zoals het is.
11. Klik op OK:
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3.3.4 ��� Probeer zelf: De classificatie verfijnen

• Wĳzig de waarden van Modus en Klassen totdat u een classificatie heeft die zinvol is.

Antwoord
De instellingen die u gebruikte zĳn misschien niet hetzelfde, maar met de waarde Klassen = 6 enModus = Natuurlĳke
grenzen (Jenks) (en natuurlĳk dezelfde kleuren gebruikend), zou de kaart er zo uitzien:

3.3.5 ��� Volgen: Op regel gebaseerde classificatie

Het is vaak nuttig om meerdere criteria voor een classificatie te combineren, maar helaas houdt normale classificatie
slechts rekening met één attribuut. Dat is waar op regels gebaseerde classificatie handig is.
In deze les zullen we de laag landuse weergeven op een manier om de stad Swellendam gemakkelĳk te kunnen
identificeren tussen de andere bewoonde gebieden, en tussen andere typen van gebruik van het land (gebaseerd op
hun gebied).

1. Open het dialoogvenster Laageigenschappen voor de laag landuse.
2. Schakel naar de tab Symbologie

3. Schakel de stĳl voor de classificatie naar Regel-gebaseerd
QGIS zal automatisch de regels weergeven die de huidige geïmplementeerde classificatie voor deze laag
weergeeft. Bĳvoorbeeld: na het voltooien van bovenstaande oefening zou u iets zoals dit kunnen zien:
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4. Klik en sleep om alle regels te selecteren

5. Gebruik de knop Geselecteerde regels verwĳderen om alle bestaande regels te verwĳderen
Laten we nu onze aangepaste regels toevoegen

1. Klik op de knop Regel toevoegen

2. Het dialoogvenster Regel bewerken verschĳnt dan
3. Voer Stad Swellendam in als Label

4. Klik op de knop naast het tekstvak Filter om de Expressie Bouwer te openen
5. Voer het criterium "name" = 'Swellendam' in en valideer dat

6. Terug in het dialoogvenster Regel bewerken, wĳs een donkere grĳsblauwe kleur toe om de belangrĳkheid van
de stad in de regio aan te geven en verwĳder de rand
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7. Klik op OK

8. Herhaal de stappen hierboven om de volgende regels toe te voegen:
1. Label Anders bewoond met het criterium "landuse" = 'residential' AND "name" <>

'Swellendam'. Kies een vale blauwgrĳze Vulkleur
2. Label Grote, niet bewoonde gebieden met het criterium "landuse" <> 'residential' AND

"AREA" >= 605000. Kies een middengroene kleur.

Deze filters zĳn exclusief, met dien verstande dat zĳ gebieden op de kaart uitsluiten (niet-bewoonde
gebieden die kleiner zĳn dan 605000 (vierkante meter) zĳn in geen enkele regel opgenomen).

3. We zullen de overblĳvende objecten vangen met een nieuwe regel, gelabeld Kleine, niet bewoonde
gebieden. Selecteer, in plaats van een filterexpressie, de radioknop Else. Geef deze categorie een
geschikte vaalgroene kleur.
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Uw regels zouden er nu zo uit moeten zien:

9. Pas deze symbologie toe
Uw kaart zal er ongeveer zo uitzien:
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Nu heeft u een kaart met Swellendam als het meest prominente woongebied en andere gebieden die geen woongebied
zĳn gekleurd overeenkomstig hun grootte.

3.3.6 Conclusie

Symbologie stelt ons in staat de attributen van een kaart weer te geven op een eenvoudig te lezenmanier. Het stelt zowel
ons, als de lezer van de kaart in staat, om de significantie van objecten te begrĳpen, met behulp van relevante attributen
die we kiezen. Afhankelĳk van de problemen die u tegenkomt, past u verschillende technieken voor classificeren toe
om ze op te lossen.

3.3.7 Wat volgt?

Nu hebben we een kaart die er goed uitziet, maar hoe krĳgen we die uit QGIS en in een indeling die we kunnen
afdrukken, of waarvan we een afbeelding of PDF kunnen maken? Dat is het onderwerp van de volgende les!
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Module: De kaarten opmaken

In deze module zult u leren hoe u de afdruklay-out van QGIS gebruikt om kwaliteitskaarten te maken met alle vereiste
kaartitems.

4.1 Les: Afdruklay-out gebruiken

Nu u een kaart heeft, dient u in staat te zĳn die af te drukken of het naar een document te exporteren. De reden
daarvoor is dat een kaartbestand in GIS geen afbeelding is. Het slaat meer de status van het programma van GIS op,
met verwĳzingen naar alle lagen, hun labels, kleuren, etc. Dus voor iemand die niet de gegevens heeft of hetzelfde
programma voor GIS (zoals QGIS), zal het kaartbestand nutteloos zĳn. Gelukkig kan QGIS zĳn kaartbestand
exporteren naar een indeling die ieders computer kan lezen, als ook de kaart afdrukken als umet een printer verbonden
bent. Zowel exporteren als afdrukken wordt afgehandeld via Afdruklay-out.
Het doel voor deze les: De Afdruklay-out van QGIS te gebruiken om een basiskaart te maken met alle vereiste
instellingen.

4.1.1 ��� Volgen: Lay-out beheren

QGIS stelt u in staat meerdere kaarten te maken met behulp van hetzelfde kaartbestand. Om die reden heeft het een
gereedschap genaamd Lay-out beheren.

1. Klik op het menuitem Project ► Lay-out beheren… om dit gereedschap te openen. U zult een blanco
dialoogvenster voor Lay-out beheren zien verschĳnen.
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2. Onder Nieuw uit sjabloon, selecteer Lege lay-out en klik op de knop Maken….
3. Geef de nieuwe lay-out de naam Swellendam en klik op OK.
4. U zult nu het venster Afdruklay-out zien:

U zou deze nieuwe lay-out ook kunnen maken via het menu Project ► Nieuwe afrduklay-out….
Welke route u ook nam, de nieuwe afrduklay-out is nu toegankelĳk in het menu Project ► Lay-outs ►, zoals in de
afbeelding hieronder.
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4.1.2 ��� Volgen: Basiskaart samenstellen

In dit voorbeeld was de lay-out al zoals we die wilden hebben. Zorg er voor dat die van u dat ook is.
1. Klik met rechts op het blad in het centrale deel van het venster voor de lay-out en kies Pagina-eigenschappen…

in het contextmenu.
2. Controleer of de waarden op de tab Item-eigenschappen zĳn ingesteld op het volgende:

• Grootte: A4
• Oriëntatie: Liggend

Nu heeft u de lay-out van de pagina zoals u die wilt hebben, maar deze pagina is nog steeds blanco. Er ontbreekt
duidelĳk een kaart. Laten we dat repareren!

3. Klik op de knop Kaart toevoegen.
U zult, met dit gereedschap geactiveerd, in staat zĳn een kaart op de pagina te plaatsen.

4. Klik en sleep een vak op de blanco pagina:
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De kaart zal verschĳnen op de pagina.
5. Verplaats de kaart door er op te klikken en rond te slepen:

6. Pas de grootte aan door op de vakken in de hoeken te klikken en te slepen:
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Notitie: Uw kaart zou er natuurlĳk heel anders uit kunnen zien! Dat is afhankelĳk van hoe uw eigen project
is opgezet. Maar geen zorgen! Deze instructies zĳn algemeen, dus zĳ werken hetzelfde ongeacht hoe de kaart
zelf eruit ziet.

7. Zorg er voor marges langs de randen te laten en een ruimte aan de bovenzĳde voor een titel.
8. Zoom in en uit op de pagina (maar niet de kaart!) met behulp van deze knoppen:

9. Zoom en verschuif de kaart in het hoofdvenster van QGIS. U kunt ook de kaart verschuiven met behulp van
het gereedschap Inhoud item verschuiven.
De kaartweergave wordt bĳgewerkt als in- of uitzoomt.

10. Als, om enige reden, de kaartweergave niet juist wordt bĳgewerkt, kunt u de kaart geforceerd vernieuwen door
op de knop Scherm vernieuwen te klikken.
Onthoud dat de grootte en positie die u voor de kaart heeft opgegeven niet bindend hoeven te zĳn. U kunt altĳd
terugkomen en het later wĳzigen als u niet tevreden bent. Voor nu dient u zich er van te vergewissen dat u uw
werk aan deze kaart heeft opgeslagen. U zult uw project moeten opslaan, omdat een Afdruklay-out in QGIS
deel uitmaakt van het hoofd-kaartbestand.

11. Ga naar Lay-out ► Project opslaan. Dit is een handige sneltoets voor die in het hoofd-dialoogvenster.
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4.1.3 ��� Volgen: Een titel toevoegen

Nu ziet uw kaart er op de pagina goed uit, maar uw lezers/gebruikers wordt nog niet verteld wat er gaande is. Zĳ
hebben een soort context nodig, wat is wat u hen verschaft door middel van het toevoegen van kaartitems. Laten we
eerst een titel toevoegen.

1. Klik op de knop Label toevoegen

2. Klik op de pagina, boven de kaart, accepteer de voorgestelde waarden in het dialoogvenster Nieuw item
Eigenschappen en een label zal boven de kaart verschĳnen.

3. Pas de grootte aan en plaats het in het midden boven aan de pagina. Het kan op dezelfde manier worden
aangepast en verplaatst als waarop u de grootte van de kaart aanpaste en die verplaatste.
Als u de titel verplaatst, zult u merken dat er hulplĳnen verschĳnen om u te helpen de titel in het midden van
de pagina te plaatsen.
Er is echter ook een gereedschap op de werkbalk Acties om u te helpen de titel relatief aan de kaart (niet de
pagina) te plaatsen:

4. Klik op de kaart om het te selecteren
5. Houdt Shift ingedrukt op uw toetsenbord en klik op het label, zodat zowel de kaart als het label zĳn

geselecteerd.

6. Zoek naar de knop Geselecteerde items links uitlĳnen en klik op de pĳl voor het keuzemenu ernaast om de opties
voor plaatsing weer te geven en klik op Midden uitlĳnen:

Nu is het frame van het label gecentreerd aan de kaart, maar niet de inhoud ervan. De inhoud van het label
centreren:
1. Selecteer het label door er op te klikken.
2. Klik op de tab Item-eigenschappen in het zĳpaneel van het venster Afdruklay-out.
3. Wĳzig de tekst van het label naar “Swellendam”:
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4. Gebruik deze interface om het lettertype en de optie voor uitlĳning in te stellen in het gedeelte Uiterlĳk:
1. Kies een groot, maar zinnig, lettertype (het voorbeeld zal het standaard lettertype met een grootte

van 36 gebruiken)
2. Stel Horizontale uitlĳning in op Centreren.

U kunt ook de kleur van het lettertype wĳzigen, maar het is waarschĳnlĳk het beste om die zwart te laten
staan, zoals de standaard is.

5. De standaardinstelling is om geen kader toe te voegen rondom het tekstvak van de titel. Als u echter een
kader wilt toevoegen, kunt u dat zo doen:
1. Scroll, op de tab Item-eigenschappen, naar beneden tot u de optie Frame ziet.
2. Klik op het keuzevak Frame om het kader in te schakelen. U kunt ook de kleur en breedte van het

kader wĳzigen.
In dit voorbeeld zullen we het kader niet inschakelen, dus is dit tot dusverre onze pagina:
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Om er voor te zorgen dat u niet per ongeluk deze elementen verplaatst nu ze uitgelĳnd zĳn, kunt u de items op
hun plaats vastzetten:
1. Selecteer zowel het label als de kaartitems

2. Klik op de knop Geselecteerde items vastzetten op de werkbalk Acties.

Notitie: Klik op de knop Alle items losmaken op de werkbalk Acties om de items opnieuw te kunnen
bewerken.

4.1.4 ��� Volgen: Een legenda toevoegen

De lezer van de kaart moet ook in staat zĳn te zien welke verschillende dingen op de kaart eigenlĳk betekenen. In
sommige gevallen, zoals de plaatsnamen, is dit nogal duidelĳk. In andere gevallen is het moeilĳker te raden, zoals
voor de kleuren van de bossen. Laten we een nieuwe legenda toevoegen.

1. Klik op de knop Legenda toevoegen

2. Klik op de pagina om de legenda neer te zetten, accepteer de voorgestelde waarden in het dialoogvensterNieuw
item Eigenschappen.

3. Een legenda wordt toegevoegd aan de pagina van de lay-out, de symbologie van de lagen weergevend zoals
ingesteld in het hoofddialoogvenster.

4. Zoals gewoonlĳk kunt u klikken op het item en dat verplaatsen naar waar u dat wilt:
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4.1.5 ��� Volgen: Items voor legenda aanpassen

Niet alles op een legenda is noodzakelĳk, dus laten we enkele niet gewenste items verwĳderen.
1. Op de tab Item-eigenschappen vindt u het paneel Items voor Legenda.

2. Deselecteer het vak Automatisch bĳwerken, wat u in staat stelt de items voor de legenda direct te bewerken
3. Selecteer het item met buildings.

4. Verwĳder het uit de legenda door te klikken op de knop
U kunt ook items hernoemen.

1. Selecteer een laag uit dezelfde lĳst.

2. Klik op de knop Geselecteerde item-eigenschappen bewerken.
3. Hernoem de lagen naar``Plaatsen``, Wegen en straten, Oppervlaktewater, en Rivieren.

U kunt ook de volgorde van de items wĳzigen.

4.1. Les: Afdruklay-out gebruiken 121



QGIS Training Manual

De legenda zal waarschĳnlĳk breder worden door de nieuwe namen voor de lagen, dus u wilt misschien de legenda
en of de kaart verplaatsen. Dit is het resultaat:
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4.1.6 ��� Volgen: Uw kaart exporteren

Notitie: Heeft u onthouden om uw werk regelmatig op te slaan?

Tenslotte is de kaart gereed om te worden geëxporteerd! U zult de knoppen voor exporteren zien in de
linkerbovenhoek van het venster Afdruklay-out:

• Lay-out afdrukken: is verbonden met een printer. Omdat de opties voor de printer zullen verschillen, afhankelĳk
van het model printer waarmee u werkt, is het waarschĳnlĳk beter om de handleiding van de printer of een
algemene gids over afdrukken te raadplegen voor meer informatie over dit onderwerp.
De andere knoppen stellen u in staat de kaart te exporteren naar een bestand.

• Als afbeelding exporteren: geeft u een selectie van verschillende algemene indelingen voor afbeeldingen om uit te
kiezen. Dit is waarschĳnlĳk de eenvoudigste optie, maar de afbeelding die het maakt is “dood” en moeilĳk te
bewerken.

• Als SVG exporteren: Als u uw kaart stuurt naar een cartograaf (die de kaart misschien vóór publicatie wil
bewerken), is het het beste om als een SVG te exporteren. SVG staat voor “Scalable Vector Graphic” en
kan worden geïmporteerd in programma’s als Inkscape of andere software voor het bewerken van vector-
afbeeldingen.

• Als PDF exporteren: Als u de kaart naar een cliënt moet sturen, is het het meest voorkomend om een PDF te
gebruiken, omdat het eenvoudiger is om afdrukopties voor een PDF in te stellen. Sommige cartografen zouden
ook PDF kunnen prefereren, als zĳ een programma hebben dat hen in staat stelt deze indeling te importeren
en te bewerken.

Voor onze doeleinden gaan we een PDF gebruiken.

1. Klik op de knop Als PDf exporteren

2. Kies een locatie om op te slaan en een bestandsnaam, zoals gewoonlĳk. Het volgende dialoogvenster zal worden
weergegeven.
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3. U kunt nu veilig de standaardwaarden gebruiken en klikken op Opslaan.
QGIS zal doorgaan met het exporteren van de kaart en een bericht sturen naar de bovenzĳde van het
dialoogvenster Afdruklay-out zodra het is voltooid.

4. Klik op de hyperlink in het bericht om de map waar de PDF is opgeslagen, in het bestandsbeheer van uw
systeem, te openen

5. Open het en bekĳk hoe uw lay-out er uitziet.
Is alles OK? Gefeliciteerd met uw eerste voltooide kaartproject van QGIS!

6. Is er iets niet naar uw zin? Ga terug naar het venster van QGIS, maak de noodzakelĳke aanpassingen en
exporteer opnieuw.

7. Onthoud om uw kaart regelmatig op te slaan.

124 Hoofdstuk 4. Module: De kaarten opmaken



QGIS Training Manual

4.1.7 Conclusie

Nu hebt u geleerd een lay-out voor een statische basiskaart te maken. We gaan een stap verder en maken een kaartlay-
out die zich dynamisch aanpast, met meer items voor de lay-out.

4.2 Les: Een dynamische afdruklay-out maken

Nu u hebt geleerd een lay-out voor een basiskaart te maken, gaan we een stap verder en maken een kaartlay-out die
zich dynamisch aanpast aan ons kaartbereik en aan de eigenschappen van de pagina, bĳv. als u de grootte van de
pagina wĳzigt. Ook de datum van maken zal zich dynamisch aanpassen.

4.2.1 ��� Volgen: Een dynamisch kaartvenster maken

1. Laad de ESRI Shapefile-indeling gegevenssets protected_areas.shp, places.shp, rivers.shp
en water.shp in het kaartvenster en pas de eigenschappen ervan aan naar uw eigen wensen.

2. Nadat alles volgens uw wensen is gerenderd en gesymboliseerd, klik op het pictogram Nieuwe afdruklay-out in
de werkbalk of kies Project ► Nieuwe afdruklay-out. U zult naar een nieuwe titel worden gevraagd voor
de nieuwe afdruklay-out.

3. We willen een kaartlay-out maken die bestaat uit een kop en een kaart van de regio nabĳ Swellendam, Zuid-
Afrika. De lay-out zou een marge van 7,5 mm moeten hebben en de kop zou 36 mm hoog moeten zĳn.

4. Maak een kaartitem, genaamd hoofdkaart in het kaartvenster en ga naar het paneel Lay-out. Scroll naar
beneden naar het gedeelte Variabelen en zoek het gedeelte Lay-out. Hier stellen we enkele variabelen in die
u overal in de dynamische afdruklay-out kunt gebruiken. Ga naar het paneel Lay-out en scroll naar beneden
naar het gedeelte Variabelen. De eerste variabele zal de marge definiëren. Druk op de knop en typ de
naam sw_layout_margin in. Stel de waarde in op 7.5. Druk opnieuw op de knop en typ de naam
sw_layout_height_header in. Stel de waarde in op 36.

5. Nu bent u klaar om de positie en de grootte van het kaartvenster automatisch te maken door middel van de
variabelen. Zorg er voor dat het kaartitem is geselecteerd, ga naar het paneel Item-eigenschappen en scroll naar
beneden en open het gedeelte Positie en grootte. Klik op Data-bepaalde override voor X en kies, uit het item
Variabelen, @sw_layout_margin.

6. Klik op Data-bepaalde override voor Y, kies Bewerken… en typ de volgende formule in:

to_real(@sw_layout_margin) + to_real(@sw_layout_height_header)

7. U kunt de grootte van het kaartitem maken met de variabelen voor Breedte en Hoogte. Klik op
Data-bepaalde override voor Breedte en kies opnieuw Bewerken…. Vul de volgende formule in:

@layout_pagewidth - @sw_layout_margin * 2

Klik op Data-bepaalde override voor Hoogte en kies Bewerken…. Typ hier in de formule:

@layout_pageheight - @sw_layout_height_header - @sw_layout_margin * 2

8. We zullen ook een rastermaken dat de coördinaten van het bereik van het hoofd-kaartvenster bevat. Ga opnieuw
naar Item-eigenschappen en kies het gedeelte Rasters. Voeg een raster in door te klikken op de knop . Klik
op Raster aanpassen… en stel de Interval voor X, Y en Verspringing in overeenkomstig de schaal voor de kaart
die u koos in het hoofd-kaartvenster van QGIS. Het Type raster Kruis is zeer geschikt voor ons doel.
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4.2.2 ��� Volgen: Een dynamische koptekst maken

1. Voeg een rechthoek in die de kop zal bevatten met de knop Vorm toevoegen. Voer in het paneel Items de naam
header in.

2. Ga opnieuw naar de Item-eigenschappen en open het gedeelte Positie en grootte. Gebruik Data-bepaalde override,
kies de variabele sw_layout_margin voor X als ook voor Y. Breedte zal worden gedefinieerd door de
expressie:

@layout_pagewidth - @sw_layout_margin * 2

en Hoogte door de variabele sw_layout_height_header.
3. We zullen één horizontale lĳn en twee verticale lĳnen invoegen om de kop op te delen in verschillende gedeelten

met behulp van het Item Knoop toevoegen. Maak een horizontale lĳn en twee verticale lĳnen en noem ze
Horizontale lijn, Verticale lijn 1 Verticale lijn 2.
1. Voor de horizontale lĳn:

1. Stel X in op de variabele sw_layout_margin
2. Stel de expressie voor Y in op:

@sw_layout_margin + 8

3. Stel de expressie voor Breedte in op:

@layout_pagewidth - @sw_layout_margin * 3 - 53.5

2. Voor de eerste verticale lĳn:
1. Stel de expressie voor X in op:

@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Stel Y in op de variabele sw_layout_margin
3. De hoogte moet hetzelfde zĳn als de kop die we gemaakt hebben, dus stel Hoogte in op de variabele

sw_layout_height_header.
3. De tweede verticale lĳn wordt links van de eerste geplaatst.

1. Stel de expressie voor X in op:

@layout_pagewidth - @sw_layout_margin * 2 - 83.5

2. Stel Y in op de variabele sw_layout_margin
3. De hoogte moet hetzelfde zĳn als de andere verticale lĳn, dus stel Hoogte in op de variabele

sw_layout_height_header.
De afbeelding hieronder geeft de structuur weer van onze dynamische lay-out. We zullen de gebieden, die door
de lĳnen worden gevormd, vullen met enkele elementen.
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4.2.3 ��� Volgen: Labels voor de dynamische koptekst maken

1. De titel van uw project van QGIS kan automatisch worden ingevoegd. De titel is ingesteld in de
Projecteigenschappen. Voeg een label in met de knop Label toevoegen en voer de naam project title
(variable) in. In de Algemene eigenschappen van het paneel Item-eigenschappen voer in de expressie:

[%@project_title%]

Stel de positie van het label in.
1. Gebruik voor X de expressie:

@sw_layout_margin + 3

2. Gebruik voor Y de expressie:

@sw_layout_margin + 0.25

3. Gebruik voor Breedte de expressie:

@layout_pagewidth - @sw_layout_margin *2 - 90

4. Voer 11.25 in voor de Hoogte

Stel, onder Uiterlĳk, de grootte van het lettertype in op 16 pt.
2. Het tweede label zal een beschrĳving bevatten van de kaart die u gemaakt hebt. Voeg opnieuw een label in en

noem die map description. Voer, in de Algemene eigenschappen, de tekst beschrijving kaart
in. In de Algemene eigenschappen zullen we ook opnemen:

printed on: [%format_date(now(),'dd.MM.yyyy')%]

Hier gebruikten we twee functies Datum en Tijd (now en format_date).
Stel de positie van het label in.
1. Gebruik voor X de expressie:
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@sw_layout_margin + 3

2. Gebruik voor Y de expressie:

@sw_layout_margin + 11.5

3. Het derde label zal informatie bevatten over uw organisatie. Eerst zullen we enkele variabelen maken in het
menu Variabelen van de Item-eigenschappen. Ga naar het menu Lay-out, klik elke keer op de knop en voer
de namen o_department, o_name , o_adress en o_postcode in. Voer op de tweede regel informatie
in over uw organisatie. We zullen deze variabelen gebruiken in het gedeelte Algemene eigenschappen.
Voer in Algemene eigenschappen in:

[% @o_name %]
[% @o_department %]
[% @o_adress %]
[% @o_postcode %]

Stel de positie van het label in.
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Gebruik voor Y de expressie:

@sw_layout_margin + 15.5

3. Gebruik voor Breedte 49.00
4. Gebruik voor Hoogte de expressie:

@sw_layout_height_header - 15.5
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4.2.4 ��� Volgen: Afbeeldingen aan de dynamische koptekst toevoegen

1. Gebruik de knop Afbeelding toevoegen om een afbeelding boven uw label organisatie informatie te
plaatsen. Definieer, na het invoeren van de naam organisatie logo, de positie en grootte van het logo:
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin - 49.5

2. Gebruik voor Y de expressie:

@sw_layout_margin + 3.5

3. Gebruik voor Breedte 39.292
4. Gebruik voor Hoogte 9.583

U moet, om een logo van uw organisatie te hebben, uw logo opslaan in uw thuismap en het pad invoeren onder
Algemene eigenschappen ► Bron afbeelding.

2. Onze lay-out heeft nog steeds een noordpĳl nodig. Deze zal ook worden ingevoegd met Noordpĳl toevoegen.
We zullen de standaard noordpĳl gebruiken. Definieer de positie:
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Gebruik voor Y de expressie:

@sw_layout_margin + 9
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3. Gebruik voor Breedte 21.027
4. Gebruik voor Hoogte 21.157

4.2.5 ��� Volgen: De schaalbalk voor de dynamische koptekst maken

1. Klik, om een schaalbalk in de kop in te voegen, op Schaalbalk toevoegen en plaats die in de rechthoek boven de
noordpĳl. In Kaart onder de Algemene eigenschappen kies uw hoofdkaart (Kaart 1). Dit betekent dat
de schaal automatisch wĳzigt overeenkomstig het bereik dat u kiest in het hoofdvenster van QGIS. Kies de Stĳl
Numeriek. Dit betekent dat we een eenvoudige schaal invoegen, zonder een schaalbalk. De schaal heeft nog
steeds een positie en grootte nodig.
1. Gebruik voor X de expressie:

@layout_pagewidth - @sw_layout_margin * 2 - 78

2. Gebruik voor Y de expressie:

@sw_layout_margin + 1

3. Gebruik voor Breedte 25
4. Gebruik voor Hoogte 8

5. Plaats het Referentiepunt in het midden.
Gefeliciteerd! U hebt uw eerste dynamische kaartlay-out gemaakt. Kĳk naar de lay-out en controleer of alles er
uitziet zoals u wilt! De dynamische kaartlay-out reageert automatisch als u de pagina eigenschappen wĳzigt. Als u
bĳvoorbeeld de grootte van de pagina wĳzigt van DIN A4 naar DIN A3, klik dan op de knop Scherm vernieuwen en
het ontwerp van de pagina wordt aangepast.
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4.2.6 Wat volgt?

Op de volgende pagina zal u een opdracht worden gegeven om uit te voeren. Die zal u in staat stellen de technieken
die u tot nu heeft geleerd in praktĳk te brengen.

4.3 Opdracht 1

Open uw bestaande kaartproject en bekĳk dat aandachtig. Als u kleine fouten ziet of dingen die u eerder had willen
repareren, doe dat dan nu.
Stel uzelf, tĳdens het aanpassen van uw kaart, steeds vragen. Is deze kaart eenvoudig te lezen en te begrĳpen voor
iemand die niet bekend is met de gegevens? Als ik deze kaart op het internet zou zien, of op een poster, of in een
tĳdschrift, zou hĳ dan mĳn aandacht trekken? Zou ik deze kaart willen lezen als het niet de mĳne was?
Als u deze cursus doet op het ★☆☆ Basis of ★★☆ Gemiddelde niveau, lees de technieken van de meer gevorderde
gedeelten door. Als u iets ziet wat u in uw kaart zou willen hebben, waarom dan niet proberen om het te
implementeren?
Als deze cursus aan u wordt gepresenteerd, zou de cursusleider u kunnen vragen een uiteindelĳke versie van uw kaart
in te leveren, geëxporteerd naar PDF, voor evaluatie. Als u deze cursus voor uzelf doet, wordt aanbevolen dat u uw
eigen kaart evalueert met behulp van dezelfde criteria. Uw kaart zal worden geëvalueerd op het algehele uiterlĳk en
symbologie van de kaart zelf, als ook het uiterlĳk en de opmaak van de kaartpagina en items. Onthoud dat de nadruk
voor evaluatie van het uiterlĳk van kaarten altĳd gemak in gebruik is. Hoe netter de kaart eruit ziet en hoe eenvoudiger
hĳ in een glimp is te begrĳpen, des te beter.
Veel plezier bĳ het aanpassen!

4.3.1 Conclusie

De eerste vier modules hebben u geleerd een vectorkaart te maken en op te maken. In de volgende vier modules
zult u leren hoe u QGIS gebruikt voor een volledige analyse in GIS. Dit zal zĳn inclusief het maken en bewerken
van vectorgegevens; analyseren van vectorgegevens; gebruiken en analyseren van rastergegevens en het gebruiken van
GIS om een probleem van begin tot eind op te lossen, met behulp van bronnen voor zowel raster- als vectorgegevens.
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Module: Vectorgegevens maken

Het maken van kaarten met behulp van bestaande gegevens is slechts het begin. In deze module zult u leren hoe u
bestaande vectorgegevens kunt aanpassen en geheel nieuwe gegevenssets te maken.

5.1 Les: Een nieuwe vector gegevensset maken

De gegevens die u gebruikt moeten ergens vandaan komen. Voor de meeste algemene toepassingen bestaan de
gegevens al; maar hoe meer bĳzonder en speciaal het project, hoe minder aannemelĳk het is dat de gegevens al
beschikbaar zullen zĳn. In dergelĳke gevallen zult u uw eigen gegevens moeten maken.
Het doel voor deze les: Een nieuwe vector gegevensset maken.

5.1.1 ��� Volgen: Het dialoogvenster Laag maken

Vóór u nieuwe vectorgegevens kunt toevoegen dient u een vector gegevensset te hebben om ze aan toe te kunnen
voegen. In ons geval zult u beginnen door geheel nieuwe gegevens te maken, in plaats van het bewerken van een
bestaande gegevensset. Daarom dient u eerst uw eigen nieuwe gegevensset te definiëren.

1. Open QGIS en maak een nieuw, blanco project.
2. Navigeer naar en klik op het menu-item Kaartlagen ► Laag maken ► Nieuwe Shapefile-laag. U krĳgt het

dialoogvenster Nieuwe Shapefile-laag gepresenteerd dat u in staat stelt een nieuwe laag te definiëren.
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3. Klik op… voor het veld Bestandsnaam. Een dialoogvenster voor opslaan zal verschĳnen.
4. Navigeer naar de map exercise_data.
5. Sla uw nieuwe laag op als school_property.shp.

Het is belangrĳk om in dit stadium te beslissen welk soort gegevensset u wilt. Elk verschillend type vectorlaag
wordt “anders gebouwd” op de achtergrond, dus als u de laag eenmaal hebt gemaakt, kunt u het type niet meer
wĳzigen.
Voor de volgende oefening zullen we nieuwe objectenmaken die gebieden beschrĳven. Voor dergelĳke objecten
moet u een polygoon gegevensset maken.

6. Selecteer, voor Type geometrie, Polygoon uit het keuzemenu.
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Dit heeft geen invloed op de rest van het dialoogvenster, maar het zorgt er voor dat het juiste type geometrie
zal worden gebruikt als de vector gegevensset wordt gemaakt.
Het volgende veld stelt u in staat het Coördinaten ReferentieSysteem, of CRS, te specificeren. CRS is een
methode van het associëren van numerieke coördinaten aan een positie op het oppervlak van de Aarde. Bekĳk
de gebruikershandleiding over Werken met projecties om eer te weten te komen.
Voor dit voorbeeld zullen we het standaard CRS gebruiken dat is geassocieerd aan dit project, wat WGS84 is.

Vervolgens is er een collectie van velden gegroepeerd onderNieuw veld. Standaard heeft een nieuwe laag slechts
één attribuut, het veld id (wat u zou moeten zien in de Lĳst met velden) onderin. Echter, om de gegevens die u
gaat maken bruikbaar te maken, dient u in feite iets te zeggen over de objecten die u gaat maken in deze nieuwe
laag. Voor onze huidige doelen is het voldoende om één veld, genaamd name, toe te voegen dat Text data
zal bevatten en zal worden beperkt tot een tekstlengte van 80 tekens.

7. Repliceer onderstaande instellingen en klik op de knop Aan lĳst met velden toevoegen:

8. Controleer of uw dialoogvenster zou er nu ongeveer zo uit ziet:
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9. Klik op OK

De nieuwe laag zou moeten verschĳnen in uw paneel Lagen.

5.1.2 ��� Volgen: Databronnen

Wanneer u nieuwe gegevens maakt, is het duidelĳk dat het moet gaan over objecten die echt op de grond bestaan.
Daarom dient u uw informatie ergens vandaan te halen.
Er bestaan vele verschillende manieren om gegevens over objecten te verkrĳgen. U zou bĳvoorbeeld een GPS kunnen
gebruiken om punten vast te leggen in de echte wereld en dan later de gegevens in QGIS importeren. Of u zou punten
kunnen meten met behulp van een theodoliet, en de coördinaten handmatig kunnen invoeren om nieuwe objecten te
maken. Of u zou het proces voor digitaliseren kunnen gebruiken om objecten te traceren vanaf gegevens die vanaf
afstand zĳn opgenomen, zoals satellietbeelden of luchtfotografie.
Voor ons voorbeeld zult u de benadering voor digitaliseren gebruiken. Voorbeelden van raster gegevenssets worden
meegeleverd, dus u dient ze te importeren als dat nodig is.
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1. Klik op de knop Databronnen beheren openen.

2. Selecteer Raster aan de linkerkant.
3. Klik, in het paneel Bron, op de knop…:
4. Navigeer naar exercise_data/raster/.
5. Selecteer het bestand 3420C_2010_327_RGB_LATLNG.tif.
6. Klik op Openen om het dialoogvenster te sluiten.

7. Klik op Toevegen en Close. Een afbeelding zal in uw kaart worden geladen.
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8. Als u geen luchtfoto ziet verschĳnen, selecteer de nieuwe laag, klik met rechts en kies Op kaartlaag inzoomen
in het contextmenu.
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9. Klik op de knop Inzoomen en zoom naar het hieronder in blauw geaccentueerde gebied:
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Nu bent u klaar om deze drie velden te gaan digitaliseren:
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Laten we, voordat we beginnen, de laag school_property verplaatsen tot boven de luchtfoto.
1. Selecteer de laag school_property in het paneel Lagen en sleep hem naar boven.

U moet naar de modus Bewerken gaan om te kunnen beginnen met digitaliseren. GIS-software vereist dit in het
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algemeen om te voorkomen dat u per ongeluk belangrĳke gegevens bewerkt of verwĳdert. De modus Bewerken
wordt individueel in- of uitgeschakeld voor elke laag.
Modus Bewerken inschakelen voor de laag school_property:

1. Klik op de laag school_property in het paneel Lagen om hem te selecteren.

2. Klik op de knop Bewerken aan/uitzetten.
Als u deze knop niet kunt vinden, controleer dan of de werkbalk Digitaliseren is ingeschakeld. Er zou een
vinkje moeten staan naast het menu-item Beeld ►Werkbalken ► Digitaliseren.
Zodra u in de modus Bewerken bent, zult u zien dat enkele gereedschappen voor digitaliseren actief zĳn
geworden:

• Object polygoon toevoegen

• Gereedschap Punten

Andere relevante knoppen zĳn nog steeds inactief, maar zullen actief worden wanneer we beginnen met
interacties op onze nieuwe gegevens.
Merk op dat de laag school_property in het paneel Lagen nu het pictogram Potlood heeft, wat aangeeft
dat hĳ in modus Bewerken staat.

3. Klik nu op de knop Object polygoon toevoegen om te beginnenmet het digitaliseren van de velden van onze school.
Het zal u opgevallen zĳn dat uw muiscursor een kruisdraad is geworden. Dit stelt u in staat om de punten die
u zult digitaliseren nauwkeuriger te plaatsen. Onthoud dat u, zelfs wanneer u het gereedschap Digitaliseren op
uw kaart gebruikt, kunt in- en uitzoomen door te draaien met het muiswiel, en u kunt verschuiven door het
muiswiel ingedrukt te houden en over de kaart te slepen.
Het eerste object dat u zult digitaliseren is het athletics field:

4. Start het digitaliseren door te klikken op een punt ergens langs de rand van het veld.
5. Plaats meer punten door te klikken verder langs de rand, totdat de vorm die u tekent het veld volledig bedekt.
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6. Klik met rechts na het plaatsen van uw laatste punt om het tekenen van de polygoon te voltooien. Dit zal het
object voltooien en u het dialoogvenster Attributen laten zien.

7. Vul de waarden in zoals hieronder:

5.1. Les: Een nieuwe vector gegevensset maken 143



QGIS Training Manual

8. Klik op OK en u heeft een nieuw object gemaakt!

9. Selecteer, in het paneel Lagen, de laag school_property.
10. Klik met rechts en kies Attributentabel openen in het contextmenu
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In de tabel zult u het object zien dat u zojuist hebt toegevoegd. Terwĳl u in modus Bewerken bent, kunt de
gegevens van de attributen bĳwerken door te dubbelklikken op de cel die u wilt bĳwerken.
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11. Sluit de attributentabel.

12. Klik op de knop Wĳzigingen laag opslaan om het nieuwe object, dat we net gemaakt hebben, op te slaan.
Onthoud dat als u een vergissing maakte tĳdens het digitaliseren van een object, kunt u dat altĳd nog bewerken als
u het maken ervan voltooid heeft. Als u een fout maakte, ga dan door met digitaliseren totdat u klaar bent met het
maken van het object hierboven. Dan:

1. Klik op de knop Gereedschap Punten.
2. Ga met de muis over een punt dat u wilt verplaatsen en klik met links op het punt.
3. Verplaats de muis naar de juiste locatie voor het punt, en klik met links. Dit zal het punt naar de nieuwe locatie

verplaatsen.
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Dezelfde procedure kan worden gebruikt om een lĳnsegment te verplaatsen, maar dan dient u over het
middelpunt van het llĳnsegment te gaan.

Als u een wĳziging ongedaan wilt maken, kunt u drukken op de knop Ongedaan maken of op Ctrl+Z.

4. Onthoud om uw wĳzigingen op te slaan door te klikken op de knop Wĳzigingen laag opslaan.

5. Klik, als u klaar bent met bewerken, op de knop Bewerken aan/uitzetten, om uit de modus Bewerken te gaan.
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5.1.3 ��� Probeer zelf: Polygonen digitaliseren

Digitaliseer de school zelf en het bovenste veld. Gebruik deze afbeelding om u te helpen:

Onthoud dat elk nieuw object een unieke waarde id moet hebben!

Notitie: Wanneer u klaar bent met het toevoegen van objecten aan een laag, onthoud dan om de bewerkingen op te
slaan en de modus Bewerken te verlaten.

Notitie: U kunt de vulling, de omtrek en plaatsen van labels van school_property opmaken met behulp van
de technieken die werden geleerd in eerdere lessen.
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5.1.4 ��� Volgen: Tabel Punten bewerken gebruiken

Een ander manier om de objecten te bewerken is door het handmatig invoeren van de feitelĳke coördinaatwaarden
voor elk punt, met de tabel Punten bewerker.

1. Zorg er voor dat u in modus Bewerken bent voor de laag school_property.

2. Klik, indien die nog niet geactiveerd is, op de knop Gereedschap Punten.
3. Ga met de muis over een van de objecten polygoon die u op de laag school_property hebt gemaakt en

klik er met rechts op. Dit zal het object selecteren en een venster Punten bewerker zal openen.

Notitie: Deze tabel bevat de coördinaten voor de punten van het object. Merk op dat er zeven punten voor dit
object zĳn, maar er zĳn er slechts zes visueel geïdentificeerd in het kaartgebied. Bĳ nadere beschouwing zult
u merken dat rĳ 0 en 6 identieke coördinaten hebben. Dat zĳn de begin- en eindpunten van de geometrie van
het object, en zĳn vereist om een gesloten object polygoon te maken.

4. Klik en sleep een vak over een punt, of meerdere punten, van het geselecteerde object.
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De geselecteerde punten zullen wĳzigen naar de kleur blauw en de tabel Punten bewerker zal de
corresponderende rĳen geaccentueerd hebben, die de coördinaten van de punten bevatten.
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5. Dubbelklik met links, om een coördinaat bĳ te werken, op de cel in de tabel die u wilt bewerken en voer de
bĳgewerkte waarde in. In dit voorbeeld is de X-coördinaat van rĳ 4 bĳgewerkt van 20.4450 naar 20.4444.
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6. Druk, na het invoeren van de bĳgewerkte waarde, op de toets Enter om de wĳziging door te voeren. U zult het
punt in het kaartvenster zien verplaatsen naar de nieuwe locatie.

7. Klik, als u klaar bent met bewerken, op de knop Bewerken aan/uitzetten, om uit de modus Bewerken te gaan, en
sla uw gegevens op.

5.1.5 ��� Probeer zelf: Lijnen digitaliseren

We gaan twee routes digitaliseren die nog niet zĳn gemarkeerd op de laag roads; één is een pad de ander is een spoor.
Ons pad loopt langs de zuidelĳke rand van de wĳk Railton, beginnend en eindigend op gemarkeerde wegen:
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Ons spoor is iets meer naar het zuiden:
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1. Als de laag roads nog niet op uw kaart staat, voeg dan de laag roads toe vanuit het bestand voor GeoPackage
training-data.gpkg, opgenomen in de map exercise_data van de trainingsgegevens die u hebt
gedownload. U kunt ��� Volgen: Vectorgegevens uit een database van GeoPackage laden bekĳken om te zien
hoe.

2. Maak een nieuwe ESRI Shapefile lĳn gegevensset, genaamd routes.shp in de map exercise_data,
met de attributen id en type. (gebruik de benadering hierboven om u te leiden.)

3. Activeer modus Bewerken voor de laag routes.

4. Klik, omdat u werkt met een object lĳn, op de knop Object lĳn toevoegen om de modus voor het digitaliseren
van lĳnen te initiëren.

5. Digitaliseer, één per keer, het pad en het spoor op de laag routes. Probeer de routes zo nauwkeurig mogelĳk
te volgen door het toevoegen van punten langs bochten of koerswĳzigingen.

6. Stel de attribuutwaarde type in op path of track.
7. Gebruik het dialoogvenster Laageigenschappen om opmaak aan uw routes toe te voegen. Het staat u vrĳ

verschillende stĳlen voor paden en sporen te gebruiken.
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8. Sla uw bewerkingen op en schakel de modus Bewerken uit door te drukken op de knop Bewerken aan/uitzetten.

Antwoord
De symbologie doet er niet toe, maar de resultaten zouden er min of meer zo uit moeten zien:

5.1.6 Conclusie

Nu weet u hoe u objecten kunt maken! Deze cursus behandelt niet het toevoegen van punt-objecten, omdat dat niet
echt nodig is als u eenmaal met meer gecompliceerde objecten heeft gewerkt (lĳnen en polygonen). Het werkt exact
hetzelfde, behalve dat u slechts één keer klikt waar u het punt wilt plaatsen, geef het zoals gewoonlĳk zĳn attributen
en dan is het object gemaakt.
Weten hoe digitaliseren werkt is belangrĳk omdat het een veel voorkomende activiteit in programma’s van GIS is.

5.1.7 Wat volgt?

Objecten in een laag van GIS zĳn niet slechts afbeeldingen, maar objecten in de ruimte. Bĳvoorbeeld: aaneensluitende
polygonen weten waar zĳ in relatie tot elkaar staan. Dit wordt topologie genoemd. In de volgende les zult u een
voorbeeld zien van waarom dit handig kan zĳn.
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5.2 Les: Topologie voor objecten

Topologie is een handig aspect van vector gegevenslagen, omdat het fouten zoals overlappen of gaten minimaliseert.
Bĳvoorbeeld: als twee objecten een rand delen en u bewerkt de rand met behulp van topologie, dan hoeft u niet
eerst het ene object te bewerken, dan een ander en dan zorgvuldig de randen op elkaar af te stemmen zodat zĳ
overeenkomen. In plaats daarvan kunt u hun gedeelde rand bewerken en beide objecten zullen tegelĳkertĳd wĳzigen.
Het doel voor deze les: Topologie begrĳpen door middel van voorbeelden.

5.2.1 ��� Volgen: Snappen

Snappenmaakt het bewerken van topologie gemakkelĳker. Dit maakt het mogelĳk uwmuiscursor aan andere objecten
te snappen, terwĳl u digitaliseert. Opties voor snappen instellen:

1. Navigeer naar het menu-item Project ► Opties voor snappen….
2. Stel uw dialoogvenster Instellingen voor snappen in project in op het activeren van de laag landusemet Type

vertex en tolerantie 12 pixels:

3. Zorg er voor dat het vak in de kolom Voorkom overlappen is geselecteerd.
4. Verlaat het dialoogvenster.

5. Selecteer de laag landuse en ga naar de modus Bewerken ( )
6. Controleer (onder Beeld ►Werkbalken) dat uw werkbalk Geavanceerd digitaliseren is ingeschakeld.
7. Zoom naar dit gebied (schakel indien nodig lagen en labels in):

5.2. Les: Topologie voor objecten 157



QGIS Training Manual

8. Digitaliseer dit nieuwe (fictionele) gebied in rood:

9. Indien gevraagd, geef het een OGC_FID van 999, maar het staat u vrĳ de andere waarden ongewĳzigd te laten.
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Als u voorzichtig bent tĳdens het digitaliseren en de cursor toestaat te snappen aan de punten van aanliggende
gebieden, zult u merken dat er geen gaten zĳn tussen uw nieuwe gebieden de bestaande gebieden ernaast.

10. Denk aan de gereedschappen Ongedaan maken en Opnieuw op de werkbalk Geavanceerd digitaliseren.

5.2.2 ��� Volgen: Correcte topologische objecten

Objecten van topologie moeten soms bĳgewerkt worden. In ons voorbeeldgebied is een gebied bos geworden, dus
moet de laag landuse worden bĳgewerkt. We zullen daarom enkele objecten bos uitbreiden en samenvoegen in dit
gebied:

In plaats van het maken van nieuwe polygonen om de bosgebieden samen te voegen, gaan we het gereedschap Punten
gebruiken om bestaande polygonen te bewerken en samen te voegen.

1. Ga naar de modus Bewerken (als die niet al actief is)

2. Selecteer het gereedschap Gereedschap Punten

3. Kies een bosgebied, selecteer een punt en verplaats die naar een naastgelegen punt, zodat de twee objecten bos
elkaar raken:
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4. Klik en sleep de knopen totdat zĳ op hun plaats snappen.
De juiste topologische rand ziet er uit zoals dit:
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Ga door en voeg nog enkele gebieden samen met het gereedschap Punten.

U kunt ook het gereedschap Object polygoon toevoegen gebruiken om het gat te vullen tussen de twee polygonen
bos. Als u Overlappen vermĳden hebt ingeschakeld, hoeft u niet elk enkele punt toe te voegen - zĳ zullen
automatisch worden toegevoegd als uw nieuwe polygoon de bestaande overlapt.
Als u onze voorbeeldgegevens gebruikt, zou u een bosgebied moeten hebben dat er ongeveer zo uitziet:

Maak u geen zorgen als u meer, minder of andere bosgebieden heeft samengevoegd.

5.2.3 ��� Volgen: Gereedschap: Object vereenvoudigen

Doorgaand op dezelfde laag zullen we het gereedschap Object vereenvoudigen testen:
1. Klik er op om het te activeren.
2. Klik op één van de gebieden die u heeft samengevoegd met ofwel het gereedschap Punten of het gereedschap

Object toevoegen. U zult dit dialoogvenster zien:
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3. Pas de Tolerantie aan en zie wat er gebeurt:

Dit stelt u in staat het aantal punten te reduceren.
4. Klik op OK
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Het voordeel van dit gereedschap is dat het u een eenvoudige en intuïtieve interface verschaft voor veralgemeniseren.
Maar weet dat het gereedschap topologie beschadigt. De vereenvoudigde polygoon deelt niet langer grenzen met zĳn
aanliggende polygonen, zoals zou moeten. Dus is dit gereedschap beter geschikt voor zelfstandige objecten.
Vóórdat u doorgaat, zet de polygoon terug naar zĳn originele status door de laatste wĳziging ongedaan te maken.

5.2.4 ��� Probeer zelf: Gereedschap: Ring toevoegen

Het gereedschap Ring toevoegen stelt u in staat een interne ring aan een object polygoon toe te voegen (een gat in de
polygoon te zagen), zolang als het gat volledig is opgenomen binnen de polygoon (raken van de grens is OK). Als u
bĳvoorbeeld de buitengrenzen van Zuid-Afrika heeft gedigitaliseerd en u moet een gat toevoegen voor Lesotho, zou
u dit gereedschap gebruiken.
Als u experimenteert met het gereedschap, zou u kunnen merken dat de huidige opties voor snappen zouden kunnen
voorkomen dat u een ring in de polygoon kunt maken. U wordt dus geadviseerd om snappen uit te schakelen voordat
u een gat maakt.

1. Schakel snappen voor de laag landuse uit met de knop Snappen inschakelen (of gebruik de sneltoets s).

2. Gebruik het gereedschap Ring toevoegen om een gat in het midden van een geometrie polygoon te maken.

3. Teken een polygoon over het doelobject, alsof u het gereedschap Polygoon toevoegen gebruikt.
4. Wanneer u met rechts klikt, zal het gat zichtbaar worden.

5. Verwĳder het gat dat u zojuist gemaakt hebt met het gereedschap Ring verwĳderen. Klik in het gat om het te
verwĳderen.

Antwoord
De exacte vorm doet er niet toe, maar u zou een gat in het midden van uw object moeten krĳgen, zoals dit:
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• Maak uw bewerking ongedaan voordat u doorgaat met de oefening voor het volgende gereedschap.

5.2.5 ��� Probeer zelf: Gereedschap: Deel toevoegen

Het gereedschap Deel toevoegen stelt u in staat een nieuw gedeelte voor een object te maken, dat niet direct is
verbonden met het hoofdobject. Als bĳvoorbeeld de grenzen van het vasteland van Zuid-Afrika heeft gedigitaliseerd,
maar u heeft de Prince Edward Islands nog niet toegevoegd, zou u dit gereedschap gebruiken om ze te maken.

1. Selecteer de polygoon waaraan u het deel wilt toevoegen door het gereedschap
Objecten selecteren per gebied of met een enkele klik te gebruiken.

2. Gebruik het gereedschap Deel toevoegen om een gebied dat er buiten ligt toe te voegen.

3. Verwĳder het deel dat u net hebt gemaakt met het gereedschap Deel verwĳderen.

Notitie: Klik in het deel om het te verwĳderen.

Antwoord
1. Selecteer eerst het Bontebok National Park:

2. Voeg nu uw nieuwe deel toe:
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3. Maak uw bewerking ongedaan voordat u doorgaat met de oefening voor het volgende gereedschap.

5.2.6 ��� Volgen: Gereedschap: Objecten vervormen

Het gereedschap Objecten vervormen wordt gebruikt om een object polygoon groter te maken of een deel ervan weg
te snĳden (langs de grens).
Vergropten:

1. Selecteer de polygoon door het gereedschap Objecten selecteren per gebied of met een enkele klik te gebruiken.
2. Klik met links binnen de polygoon om te beginnen met het tekenen.
3. Teken een vorm tot buiten de polygoon. Het laatste punt zou weer binnen de polygoon moeten liggen.
4. Klik met rechts om de vorm te voltooien:
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Dit zal een soortgelĳk resultaat geven als:

Een deel wegsnĳden:

1. Selecteer de polygoon door het gereedschap Objecten selecteren per gebied of met een enkele klik te gebruiken.
2. Klik buiten de polygoon.
3. Teken een vorm binnen de polygoon. Het laatste punt zou weer buiten de polygoon moeten liggen.
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4. Klik met rechts buiten de polygoon:

Het resultaat van bovenstaande:
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5.2.7 ��� Volgen: Gereedschap: Objecten splitsen

Het gereedschap Objecten splitsen is soortgelĳk aan het gereedschap Objecten vervormen, behalve dat het geen van de
twee gedeelten verwĳdert. In plaats daarvan behoudt het ze allebei.
We zullen het gereedschap gebruiken om een hoek van een polygoon af te splitsen.

1. Selecteer de laag landuse en schakel snappen er opnieuw voor in.

2. Selecteer het gereedschap Objecten splitsen en klik op een punt om te beginnen met het tekenen van een lĳn.
3. Teken de grenslĳn.
4. Klik op een punt aan de “tegenoverliggende” zĳde van de polygoon die u wilt afsplitsen en klik met rechts om

de lĳn te voltooien:

5. Op dit punt zou het lĳken alsof er niet is gebeurd. Maar onthoud dat de laag landuse is gerenderd zonder
grenslĳnen, dus de nieuwe lĳn voor het delen zal niet worden weergegeven.

6. Gebruik het gereedschap Objecten selecteren per gebied of met een enkele klik om het deel te selecteren dat u zojuist
afgesplitst hebt, het nieuwe object zal nu worden geaccentueerd.
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5.2.8 ��� Volgen: Gereedschap: Objecten samenvoegen

Nu zullen we het object, dat u zojuist heeft afgesplitst, opnieuw samenvoegen met het resterende deel van de polygoon:

1. Experimenteer met de gereedschappen Geselecteerde objecten samenvoegen en
Attributen van geselecteerde objecten samenvoegen.

2. Let op de verschillen.

Antwoord
• Gebruik het gereedschap Geselecteerde objecten samenvoegen, zorg er wel voor dat u eerst de beide polygonen
selecteert die u wilt samenvoegen.

• Gebruik het object met deOGC_FID van 1 als de bron van uw attributen (klik op dat item in het dialoogvenster,
en klik dan op de knop Attributen uit geselecteerde object nemen):

Als u een andere gegevensset gebruikt, is het hoogst waarschĳnlĳk dat de OGC_FID`van uw originele polygoon niet
``1` zal zĳn. Kies eenvoudigweg een object dat een OGC_FID heeft.
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Gebruiken van het gereedschap Attributen van geselecteerde objecten samenvoegen zal afzonderlĳke geometrieën
behouden, maar ze dezelfde attributen geven.

5.2.9 Conclusie

Het bewerken van topologie is een krachtig gereedschap dat u in staat stelt objecten snel en gemakkelĳk te maken en
aan te passen, er intussen voor zorgend dat zĳ topologisch juist blĳven.

5.2.10 Wat volgt?

Nu weet u hoe u gemakkelĳk de vorm van objecten kunt digitaliseren, maar het toevoegen van attributen is nog
steeds een ander verhaal! Hierna zullen we u tonen hoe u formulieren kunt gebruiken, wat het bewerken van attributen
eenvoudiger en meer effectief maakt.

5.3 Les: Formulieren

Wanneer u nieuwe gegevens toevoegt via digitaliseren, zult u geconfronteerd worden met een dialoogvenster dat u de
attributen voor dat object laat invullen. Dit dialoogvenster is echter, als standaard, niet erg netjes om naar te kĳken.
Dat kan gebruiksproblemen veroorzaken, in het bĳzonder als u zeer grote gegevenssets heeft om te maken, of als u
wilt dat andere mensen u helpen digitaliseren en zĳ de standaard formulieren verwarrend vinden.
Gelukkig laat QGIS u uw eigen aangepaste dialoogvensters voor een laag maken. Deze les laat u zien hoe.
Het doel voor deze les: Een formulier voor een laag maken.
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5.3.1 ��� Volgen: QGIS gebruiken’ Functionaliteit Formulieren ontwerpen

1. Selecteer de laag roads in het paneel Lagen
2. Ga, zoals eerder, naar modus Bewerken

3. Open de attributentabel van de laag roads
4. Klik met rechts op een willekeurige cel in de tabel. Een kort menu zal verschĳnen dat het item Formulier openen

bevat.
5. Klik er op om het formulier te zien dat QGIS maakt voor deze laag

Uiteraard zou het leuker zĳn om dit te kunnen doen als we naar de kaart kĳken, in plaats van altĳd naar een specifieke
straat te moeten zoeken in de Attributentabel.

1. Selecteer de laag roads in het paneel Lagen

2. Klik, met het gereedschap Objecten identificeren, op een straat in de kaart.
3. Het paneel Identificatieresultaten opent en geeft een boomweergave van de waarden van de velden en andere

algemene informatie over het aangeklikte object weer.
4. Selecteer, aan de bovenzĳde van het paneel, het keuzevak Automatisch formulier openen voor resultaten van

enkele objecten in het menu Instellingen objecten identificeren.
5. Klik nu opnieuw op een straat in de kaart. Naast het eerdere dialoogvenster Identificatieresultaten, zult u het nu

bekende formulier zien:

6. Elke keer als u op een enkel object klikt met het gereedschap Objecten identificeren, komt het formulier naar
voren zolang het keuzevak Auto openen formulier is geselecteerd.
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5.3.2 ��� Probeer zelf: Het formulier gebruiken om waarden te bewerken

Als u in de modus Bewerken bent kunt u dit formulier gebruiken om de waarden van de attributen van het object te
bewerken.

1. Activeer de modus Bewerken (als die al niet actief is).

2. Klik, met het gereedschap Objecten identificeren, op de hoofdweg die door Swellendam loopt:

3. Bewerk zĳn waarde highway naar secondary.
4. Schakel de modus Bewerken uit en sla uw wĳzigingen op
5. Open de Attributentabel en merk op dat de waarde is bĳgewerkt in de attributentabel en daarom ook in de

brongegevens

5.3.3 ��� Volgen: Veldtypen voor formulieren instellen

Het is aardig om dingen met behulp van een formulier te bewerken, maar u moet nog steeds alles met de hand
invoeren. Gelukkig hebben formulieren verschillende soorten zogenoemde widgets die u in staat stellen gegevens op
diverse verschillende manieren te bewerken.

1. Open de Eigenschappen… van de laag roads

2. Schakel naar de tab Velden. U zult dit zien:
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3. Schakel naar de tab Formulier attributen. U zult dit zien:

4. Klik op de rĳ oneway en kies Keuzevak als Type Widget in de lĳst met opties:
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5. Klik op OK

6. Ga naar de modus Bewerken (als de laag roads al niet in de modus Bewerken staat)

7. Klik op het gereedschap Objecten identificeren

8. Klik op dezelfde hoofdweg die u eerder al koos
U zult nu zien dat het attribuut oneway een keuzevak ernaast heeft staan met de opties True (geselecteerd) of False
(niet geselecteerd).

5.3.4 ��� Probeer zelf:

Stel een meer toepasselĳk formulierwidget in voor het veld highway.

Antwoord
Voor het TYPE is er natuurlĳk een beperkt aantal types dat een weg kan hebben, en als u de attributentabel voor deze
laag controleert, zult u zien dat zĳ vooraf gedefinieerd zĳn.

1. Stel de widget in opWaardenkaart en klik op Gegevens uit laag laden.
2. Selecteer roads in het keuzemenu Label en highway voor zowel de optieWaarde als Omschrĳving:
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3. Klik driemaal op OK.
4. Als u het gereedschap Objecten identificeren nu op een straat gebruikt terwĳl de modus Bewerken actief is, zou

het dialoogvenster dat u krĳgt er zo uit moeten zien:
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5.3.5 ��� Probeer zelf: Testgegevens maken

U kunt ook uw eigen aangepaste formulier volledig vanaf de grond opbouwen.
1. Maak een enkele puntlaag genaamd test-data met twee attributen:

• naam (tekst)
• leeftĳd (integer)

2. Leg enkele punten vast op uw nieuwe laag met behulp van de gereedschappen voor digitaliseren, zodat u
enige gegevens heeft om mee te werken. U zou, elke keer dat u een nieuw punt vastlegt, moeten worden
geconfronteerd met het standaardformulier voor QGIS voor gegenereerde attributen.

Notitie: U moet misschien Snappen uitschakelen als dat nog steeds is ingeschakeld vanuit eerdere taken.
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5.3.6 ��� Volgen: Een nieuw formulier maken

Nu willen we ons eigen aangepaste formulier maken voor de fase van het vastleggen van de attribuut-gegevens. U
moet QT Designer hebben geïnstalleerd om dit te kunnen doen (alleen nodig voor degene die de formulieren maakt).

1. Start QT Designer.
2. Maak, in het dialoogvenster dat verschĳnt, een nieuw dialoogvenster:

3. Zoek naar de Widget Box langs de linkerzĳde van uw scherm (standaard). Het bevat een item genaamd Line
Edit.

4. Klik en sleep dit item op uw formulier. Dit maakt een nieuw Line Edit in het formulier.
5. Met het nieuwe element Line Edit geselecteerd, zult u zĳn properties zien langs de rand van uw scherm

(standaard aan de rechterzĳde):
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6. Stel zĳn naam in op naam.
7. Maak, met behulp van dezelfde benadering, een nieuw Spin Box en stel zĳn naam in op leeftijd.
8. Voeg een Label toe met de tekst Nieuwe persoon toevoegen in een vet lettertype (kĳk in de properties

van het object om te zien hoe deze in te stellen). Als alternatief wilt u misschien de titel van het dialoogvenster
zelf instellen (in plaats van het toevoegen van een label).

9. Voeg een Label toe voor uw tekstveld en uw draaiveld.
10. Schik de elementen naar uw eigen wensen.
11. Klik op een willekeurige plek in uw dialoogvenster.
12. Zoek naar de knop Lay Out in a Form Layout (standaard in een werkbalk langs de bovenzĳde van het scherm).

Dit maakt automatisch uw dialoogvenster op.
13. Stel de maximumgrootte van het dialoogvenster (in zĳn eigenschappen) in op 200 (breedte) bĳ 150 (hoogte).
14. Uw formulier zou er nu ongeveer zo uit moeten zien:
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15. Sla uw nieuwe formulier op als exercise_data/forms/add_people.ui
16. Als het opslaan is voltooid kunt u Qt Designer sluiten

5.3.7 ��� Volgen: Het formulier koppelen aan uw laag

1. Ga terug naar QGIS
2. Dubbelklik op de laag test-data in de legenda om toegang te krĳgen tot de eigenschappen ervan.
3. Klik op de tab Formulier attributen in het dialoogvenster Laageigenschappen
4. In de keuzelĳst Attribuut editor layout, selecteer Geef een UI-bestand op.
5. Klik op de knop ellipsis en kies het bestand add_people.ui dat u zojuist heeft gemaakt:

6. Klik op OK in het dialoogvenster Laageigenschappen
7. Ga naar de modus Bewerken en leg een nieuw punt vast
8. Wanneer u dat doet zult u worden geconfronteerd met uw aangepaste dialoogvenster (in plaats van het algemene

dat QGIS gewoonlĳk maakt).
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9. Als u klikt op een van uw punten met het gereedschap Objecten identificeren, kunt u nu het formulier oproepen
door met rechts te klikken in het venster Identificatieresultaten en te kiezen Object-formulier bekĳken uit het
contextmenu.

10. Als u in de modus Bewerken staat voor deze laag, zal dat contextmenu Formulier Object bewerken in plaats
daarvan weergeven, en u kunt dan de attributen aanpassen in het nieuwe formulier zelfs na het initiële
vastleggen.

5.3.8 Conclusie

Met behulp van formulieren kunt u het leven voor uzelf eenvoudiger maken bĳ het bewerken of maken van gegevens.
Door typen widgets te bewerken of een geheel nieuw formulier uit het niets te maken, kunt u de ervaring beheren
van iemand die nieuwe gegevens voor die laag digitaliseert, daarbĳ het minimaliseren van misverstanden en onnodige
fouten.

5.3.9 Lees verder

Als u het gevorderde gedeelte hierboven heeft voltooid en kennis hebt van Python, wilt u misschien dit blog-item
bekĳken over het maken van eigen aangepaste objectformulieren met Python-logica, wat geavanceerde functies
mogelĳk maakt inclusief validatie van gegevens, automatisch aanvullen, etc.

5.3.10 Wat volgt?

Openen van een formulier bĳ het identificeren van een object is één van de standaard acties die QGIS kan uitvoeren.
U kunt het echter ook opdragen aangepaste acties, die u definieert, direct uit te voeren. Dat is het onderwerp van de
volgende les.

5.4 Les: Acties

Nu u de standaard actie hebt gezien in de vorige les, is het tĳd om uw eigen acties te definiëren.
Een actie is iets dat gebeurt wanneer u op een object klikt. Het kan zeer veel extra functionaliteit aan uw kaart
toevoegen, wat u, bĳvoorbeeld, in staat stelt aanvullende informatie op te halen over een object. Toewĳzen van acties
kan een geheel nieuwe dimensie aan uw kaart toevoegen!
Het doel voor deze les: Leren hoe aangepaste acties toegevoegd worden.
In deze les zult u de laag school_property gebruiken, die u eerder maakte. De voorbeeldgegevens bevatten foto’s van
elk van de drie eigendommen die u digitaliseerde. Wat we zullen gaan doen is elk eigendom associëren met zĳn
afbeelding. Dan zullen we een actie maken die de afbeelding van het eigendom zal openen bĳ het klikken op het
eigendom.

5.4.1 ��� Volgen: Een veld voor afbeeldingen toevoegen

De laag school_property heeft nog geen manier om een afbeelding met een eigendom te associëren. Voor dit
doel zullen we eerst een veld maken.

1. Open het dialoogvenster Laageigenschappen.
2. Klik op de tab Velden.
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3. Schakel naar modus Bewerken:

4. Voeg een nieuwe kolom toe:

5. Voer de waarden in zoals hieronder:
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6. Ga, als het veld is gemaakt, naar de tab Formulier attributen en selecteer het veld afbeelding.
7. Stel Type widget in op Bĳlage:

8. Klik op OK in het dialoogvenster Laageigenschappen.
9. Gebruik het gereedschap Objecten identificeren om op één van de drie objecten te klikken in de laag

school_property.
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Omdat u nog steeds in de modus Bewerken staat, zou het dialoogvenster actief moeten zĳn en er uitzien zoals
dit:

10. Klik op de knop Bladeren (de… naast het veld afbeelding).
11. Selecteer het pad naar uw afbeelding. De afbeeldingen staan in exercise_data/

school_property_photos/ en zĳ hebben dezelfde naam als de objecten waarmee zĳ geassocieerd
zouden moeten worden.

12. Klik op OK.
13. Associeer alle afbeeldingen met de juiste objecten met behulp van deze methode.
14. Sla uw bewerkingen op en verlaat de modus Bewerken.

5.4.2 ��� Volgen: Een actie maken

1. Open de tab Acties voor de laag school_property, en klik op de knop Een nieuwe actie toevoegen.
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2. Voer, in het dialoogvenster Nieuwe actie toevoegen, de woorden Afbeelding weergeven in het veld
Omschrĳving in:
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Wat vervolgens moet worden gedaan is afhankelĳk van uw besturingssysteem, dus kies de toepasselĳke koers
om te volgen:

• Windows
Klik op de keuzelĳst Type en kies Open.

• Ubuntu Linux
Onder Actie, schrĳf eog voor de Gnome Image Viewer, of schrĳf display om ImageMagick te
gebruiken. Onthoud om een spatie achter de opdracht te plaatsen!

• macOS
1. Klik op de keuzelĳst Type en kies Mac.
2. Onder Actie, schrĳf open. Vergeet niet een spatie achter de opdracht te plaatsen!

Nu kunt u doorgaan met het schrĳven van de opdracht.
U wilt de afbeelding openen en QGIS weet waar de afbeelding staat. Alles wat het moet doen is is de Actie
vertellen waar de afbeelding staat.

3. Selecteer afbeelding uit de lĳst:
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4. Klik op de knop Toevoegen. QGIS zal de frase [% "image" %] toevoegen aan het veld Tekst voor actie.
5. Klik op OK om het dialoogvenster Nieuwe actie toevoegen te sluiten
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6. Klik op OK om het dialoogvenster Laageigenschappen te sluiten
Nu is het tĳd om de nieuwe actie testen:

1. Klik op de laag school_property in het paneel Lagen zodat die wordt geaccentueerd.

2. Zoek de knop Object-actie uitvoeren (op de werkbalk Attributen);
3. Klik op de pĳl naar beneden aan de rechterkant van deze knop. Er is tot nu slechts één actie gedefinieerd voor

deze laag, die u zojuist gemaakt heeft.

4. Klik op de knop zelf om dit gereedschap te activeren.
5. Klik, met behulp van dit gereedschap, op één van de de drie schooleigendommen.

De afbeelding voor dat eigendom zou moeten openen.

5.4.3 ��� Volgen: Zoeken op internet

Laten we aannemen dat we naar de kaart kĳken en meer willen weten over een gebied waar een boerderĳ in ligt.
Veronderstel dat u niets weet van het betreffende gebied en dat u algemene informatie erover wilt weten. Uw eerste
impuls, overwegende dat u op dit moment een computer gebruikt, zou waarschĳnlĳk zĳn de naam van het gebied te
googelen. Laten we dus QGIS vertellen om dat automatisch voor ons te doen!

1. Open de attributentabel voor de laag landuse.
We zullen het veld name gebruiken voor elk van onze gebieden voor grondgebruik om met Google te zoeken.

2. Sluit de attributentabel.
3. Ga terug naar Acties in Laageigenschappen.
4. Klik op de knop Standaard acties maken om enkele vooraf gedefinieerde acties toe te voegen.
5. Verwĳder alle acties, behalve de actie URL openen met de verkorte naam Zoeken op het web met behulp van

attribuutwaarde, met de knop De geselecteerde actie verwĳderen eronder.
6. Dubbelklik op de resterende actie om die te bewerken
7. Wĳzig de Omschrĳving naar Google zoeken, en verwĳder de inhoud van het veld Verkorte naam.
8. Zorg er voor dat Kaartvenster bĳ de geselecteerde Bereiken actie staat.

Wat vervolgens moet worden gedaan is afhankelĳk van uw besturingssysteem, dus kies de toepasselĳke koers
om te volgen:

• Windows
Kies, onder Type, Open. Dit zal Windows vertellen om een internetadres te openen in uw standaard
browser, zoals Internet Explorer.

• Ubuntu Linux
OnderActie, schrĳf xdg-open. Dit zal Ubuntu vertellen om een Internetadres te openen in uw standaard
browser, zoals Chrome of Firefox.

• macOS
Onder Actie, schrĳf open. Dit zal macOS vertellen om een internetadres te openen in uw standaard
browser, zoals Safari.
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Nu kunt u doorgaan met het schrĳven van de opdracht
Welke opdracht u hierboven ook gebruikte, u moet het vervolgens vertellen welk internetadres geopend moet
worden. U wilt Google bezoeken en automatisch naar een frase zoeken.
Wanneer u gewoonlĳk Google gebruikt, voert u uw zoekvraag in de zoekbalk van Google in. Maar in dit geval
wilt u dat uw computer dat voor u doet. De manier waarop u Google vertelt naar iets te zoeken (als u niet
direct de zoekbalk wilt gebruiken) is door uw internetbrowser het adres https://www.google.com/
search?q=SEARCH_PHRASE, waar `SEARCH_PHRASE is waarnaar u wilt zoeken, op te geven. Omdat
we nog niet weten naar welke frase we gaan zoeken, voeren we alleen het eerste gedeelte (zonder de te zoeken
frase) in.

9. Schrĳf, in het veld Actie, https://www.google.com/search?q=. Onthoud om een spatie toe te
voegen aan uw initiële opdracht, vóórdat u dit schrĳft!
Nu wilt u dat QGIS aan de browser vertelt dat Google moet zoeken naar de waarde van name voor het object
waarop u klikt.

10. Selecteer het veld name.
11. Klik op de knop Toevoegen
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Wat dit betekent is dat QGIS de browser gaat openen en het gaat verzenden naar het adres https://www.
google.com/search?q=[% "name" %]. [% "name" %] vertelt QGIS om de inhoud van het veld
[% "name" %] te gebruiken als de frase om naar te zoeken.
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Dus als, bĳvoorbeeld, het gebied voor grondgebruik waarop u klikt, is genaamd Marloth Nature
Reserve, dan zal QGIS de browser sturen naar https://www.google.com/search?
q=Marloth%20Nature%20Reserve, wat er voor zal zorgen dat uw browser Google bezoekt dat
op zĳn beurt zal zoeken naar “Marloth Nature Reserve”.

12. Als u dat nog niet gedaan heeft, stel dan alles in zoals hierboven is uitgelegd.
13. Klik op OK om het dialoogvenster Nieuwe actie toevoegen te sluiten
14. Klik op OK om het dialoogvenster Laageigenschappen te sluiten

Testen van de nieuwe actie.

1. Klik, met de laag landuse actief in het paneel Lagen, op de pĳlknop rechts naast de knop Object-actie uitvoeren,
en selecteer de enige voor deze laag gedefinieerde actie (Google zoeken).

2. Klik op een willekeurig gebied voor grondgebruik dat u kunt zien op de kaart. Uw browser zal nu openen en
zal een zoekactie van Google starten voor de stad die is opgenomen als de waarde name voor dat gebied.

Notitie: Als uw actie niet werkt, controleer dan of alles juist is ingevoerd; typefouten komen veel voor bĳ dit soort
werk!

5.4.4 ��� Volgen: Een webpagina direct openen in QGIS

Hierboven heeft u gezien hoe u een webpagina opent in een externe browser. Er zĳn enkele tekortkomingen aan deze
benadering met dien verstande dat het een onbekende afhankelĳkheid toevoegt – hebben de eindgebruikers de vereiste
software om de actie op hun systeem uit te kunnen voeren? Zoals u heeft gezien hebben zĳ niet noodzakelĳkerwĳze
dezelfde soort basisopdracht voor hetzelfde soort actie, als u niet weet welk OS zĳ zullen gebruiken. Met sommige
versies van een OS, zouden de bovenstaande opdrachten mogelĳk helemaal niet werken. Dit zou een onoverkomelĳk
probleem kunnen zĳn.
QGIS staat echter bovenop de ongelooflĳk krachtige en veelzĳdige bibliotheek Qt. Ook kunnen acties van QGIS
willekeurige, getokeniseerde (d.i. variabele informatie gebruikend, gebaseerd op de inhoud van een veldattribuut)
opdrachten van Python zĳn!
Nu zult u zien hoe u een actie van Python gebruikt om een webpagina weer te geven. Het is hetzelfde algemene idee
als het openen van een site in een externe browser, maar het vereist geen browser op het systeem aan de zĳde van de
gebruiker, omdat het de klasse Qt QWebView gebruikt (wat een op een webkit gebaseerd HTML-widget is) om de
inhoud in een pop-upvenster weer te geven.
Laten we deze keer Wikipedia gebruiken. Dus de URL die u nodig heeft, zal er uitzien als deze:
https://wikipedia.org/wiki/SEARCH_PHRASE

De laag-actie maken:
1. Open het dialoogvenster Laageigenschappen en ga naar de tab Acties.
2. Start een nieuwe actie met de volgende eigenschappen:

• Type: Python
• Omschrĳving: Wikipedia
• Bereik: Object, Kaartvenster
• Tekst actie:

from qgis.PyQt.QtCore import QUrl
from qgis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView(None)
myWV.load(QUrl('https://wikipedia.org/wiki/[%name%]'))
myWV.show()
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Er gebeuren hier een aantal verschillende dingen:
• [%name%] zal worden vervangen door de feitelĳke waarde van het attribuut wanneer de actie wordt
uitgevoerd (zoals eerder).

• De code maakt eenvoudigweg een nieuwe instance van QWebView, stelt de URL ervan in en roept dan
show() aan om het als een venster zichtbaar te maken op het bureaublad van de gebruiker.

U zou deze benadering ook kunnen gebruiken om een afbeelding weer te geven, zonder het vereiste dat
gebruikers een bepaald programma voor het bekĳken van die afbeelding op hun systeem hebben staan.

3. Probeer de hierboven beschreven methoden te gebruiken om een pagina van Wikipedia te laden met de actie
Wikipedia die u zojuist gemaakt heeft.
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5.4.5 Conclusie

Acties stellen u in staat uw kaart extra functionaliteit te geven, handig voor de eindgebruiker die dezelfde kaart bekĳkt
in QGIS. Wegens het feit dat aangeroepen processen shell-opdrachten kunnen zĳn voor elk besturingssysteem, als
ook voor Python, is er geen limiet in termen van functies die u zou kunnen inbouwen!

5.4.6 Wat volgt?

Nu u verschillende methoden voor het maken van vectorgegevens heeft gedaan, zult u leren hoe u deze gegevens
analyseert om problemen op te lossen. Dat is het onderwerp van de volgende module.
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Module: Vectoranalyse

Nu u enkele objecten heeft bewerkt, zou u moeten willen weten wat er nog meer mee gedaan kan worden. Het hebben
van objecten met attributen is aardig, maar als alles is gezegd en gedaan, vertelt dit u eigenlĳk niet meer of minder
dan een normale kaart zonder GIS.
Het belangrĳkste voordeel van een GIS is dit: een GIS kan vragen beantwoorden.

Voor de drie volgende modules, zullen we trachten een onderzoeksvraag te beantwoorden met behulp van functies van
GIS. Bĳvoorbeeld; u bent een makelaar en u zoekt naar een woonhuis in Swellendam voor cliënten die de volgende
criteria hebben:

1. Het moet in Swellendam liggen.
2. Het moet op een redelĳke rĳafstand van een school (zeg 1 km) liggen.
3. Het moet meer dan 100 vierkant meter in grootte zĳn.
4. Dichter dan 50 m vanaf een hoofdweg.
5. Dichter dan 500 m vanaf een restaurant.

Binnen de volgende modules, zullen we de kracht van gereedschappen voor analyse in GIS optuigen om geschikte
boerderĳen voor deze nieuwe ontwikkeling tot woonhuis te lokaliseren.

6.1 Les: Gegevens opnieuw projecteren en transformeren

Laten we het nog eens hebben over Coördinaten ReferentieSystemen (CRS-en).We hebben dit eerder kort behandeld,
maar we hebben niet besproken wat het in de praktĳk betekent.
Het doel voor deze les: Vector-gegevenssets opnieuw projecteren en transformeren.
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6.1.1 ��� Volgen: Projecties

Het CRS waarin alle gegevens en ook de kaart nu staan wordtWGS84 genoemd. Dit is een vrĳ algemeen Geografisch
CoördinatenSysteem (GCS) voor het weergeven van gegevens. Maar er is een probleem, zoals we zullen zien.

1. Sla uw huidige kaart op
2. Open dan de wereldkaart die u kunt vinden onder exercise_data/world/world.qgs.
3. Zoom in naar Zuid Afrika met behulp van het gereedschap Inzoomen

4. Probeer een schaal in te stellen in het veld Schaal, dat in de Statusbalk staat, aan de onderzĳde van het scherm.
Terwĳl u boven Zuid Afrika bent, stel deze waarde in op 1:5 000 000 (één tot vĳf miljoen).

5. Schuif over de kaart terwĳl u een oogje houdt op het veld Schaal

Ziet u dat de schaal verandert? Dat komt omdat u zich verplaatst vanaf het ene punt waarop u inzoomde met 1:5
000 000, dat in het midden van uw scherm stond. Voor alles rondom dat punt is de schaal anders.
Denk aan een wereldbol om dit te begrĳpen. Die heeft lĳnen lopen van Noord naar Zuid. Deze lĳnen voor de
lengtegraad staan ver van elkaar af aan de evenaar, maar ontmoeten elkaar aan de polen.
In een GCS werkt u met deze bol, maar uw scherm is plat. Wanneer u de bol op een plat oppervlak probeert weer te
geven, treedt vervorming op, soortgelĳk aan die welke zal optreden als u een tennisbal opent en die probeert plat te
maken. Wat dit betekent op een kaart is dat de lĳnen voor de lengtegraad op gelĳke afstand van elkaar blĳven, zelfs
aan de polen (waar zĳ verondersteld worden samen te komen). Dit betekent dat, als u op uw kaart vanaf de evenaar
weg reist, de schaal van de objecten die u ziet groter en groter worden. Wat dit voor ons in de praktĳk betekent is dat
er geen constante schaal op uw kaart is!
Laten we in plaats daarvan een geProjecteerd Coördinaten Systeem (PCS) gebruiken, om dit op te lossen. Een PCS
“projecteert” of converteert de gegevens op een manier die het mogelĳk maakt dat de schaal wĳzigt en corrigeert
die. Daarom, om de schaal constant te houden, zouden we onze gegevens opnieuw moeten projecteren en een PCS
gebruiken.

6.1.2 ��� Volgen: Direct opnieuw projecteren

Standaard projecteert QGIS uw gegevens “direct” opnieuw. Wat dit betekent is dat, zelfs als de gegevens zelf in een
ander CRS staan, QGIS ze kan projecteren alsof ze in een CRS van uw keuze staan.

U kunt het CRS van het project wĳzigen door te klikken op de knop Huidig CRS aan de rechteronderzĳde van QGIS.
1. Typ, in het dialoogvenster dat verschĳnt, het woord global in het veld Filter. Een aantal CRS-en zouden in

het veld Vooraf gedefinieerde Coördinaten ReferentieSystemen eronder moeten verschĳnen.
2. SelecteerWGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 door erop te klikken, en klik dan op OK.

Merk op hoe de vorm van Zuid Afrika verandert. Alle projecties werken door de uiterlĳke vormen van objecten
op aarde te wĳzigen.

3. Zoom opnieuw in naar een schaal van 1:5 000 000, zoals eerder.
4. Schuif over de kaart.

Merk op dat de schaal nu hetzelfde blĳft!
“Direct” opnieuw projecteren wordt ook gebruikt voor het combineren van gegevenssets die in verschillende CRS-en
staan.

1. Voeg een andere vectorlaag aan uw kaart toe die alleen gegevens voor Zuid Afrika heeft. U vindt die als
exercise_data/world/RSA.shp.

2. Laad die. Een snelle manier om het CRS ervan te zien is door met de muis over de laag in de legenda te gaan.
Het is EPSG:3410.
Wat valt u op?
De laag is zichtbaar, zelfs als het een ander CRS heeft dan die van continents.
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6.1.3 ��� Volgen: Een gegevensset opslaan naar een ander CRS

Soms moet u een bestaande gegevensset exporteren naar een ander CRS. Zoals we zullen zien in de volgende les, als u
afstandsberekeningen moet maken op de laag, is het altĳd beter om de laag in een geprojecteerd coördinatensysteem
te hebben.
Onthoud dat ‘direct’ opnieuw projecteren is gerelateerd aan het project en niet aan enkelvoudige lagen. Dit betekent
dat een laag een ander CRS kan hebben dan het project, zelfs al ziet u het op de correcte positie.
U kunt de laag gemakkelĳk exporteren naar een ander CRS.

1. Voeg de gegevensset buildings uit training_data.gpkg toe
2. Klik met rechts op de laag buildings in het paneel Lagen
3. Selecteer Exporteren► Objecten opslaan als… in het menu dat verschĳnt. U zult het dialoogvenster Vectorlaag

opslaan als… te zien krĳgen.
4. Klik op de knop Bladeren naast het veld Bestandsnaam.
5. Navigeer naar exercise_data/ en specificeer de naam voor de nieuwe laag als

buildings_reprojected.shp.
6. Wĳzig de waarde van het CRS. Alleen de recent gebruikte CRS-en zullen worden weergegeven in het

keuzemenu. Klik op de knop CRS selecteren naast het keuzemenu.
7. Het dialoogvenster Keuze Coördinaten ReferentieSysteem zal nu verschĳnen. Zoek in het veld Filter daarvan

naar 34S.
8. SelecteerWGS 84 / UTM zone 34S | EPSG:32734 uit de lĳst
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9. Laat de andere opties ongewĳzigd. Het dialoogvenster Vectorlaag opslaan als… ziet er nu als volgt uit:
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10. Klik op OK

U kunt nu de oude en nieuwe projecties van de laag vergelĳken en zien dat zĳ in twee verschillende CRS-en staan,
maar dat zĳ elkaar nog steeds overlappen.
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6.1.4 ��� Volgen: Uw eigen projectie maken

Er zĳn nog veel meer projecties dan die welke standaard zĳn opgenomen in QGIS. U kunt ook uw eigen projecties
maken.

1. Begin een nieuwe kaart
2. Laad de gegevensset world/oceans.shp
3. Ga naar Extra ► Aangepaste projecties… en u zult dit dialoogvenster zien:

4. Klik op de knop Nieuw CRS toevoegen om een nieuwe projectie te maken
5. Een interessante projectie om te gebruiken is genaamd Van der Grinten I. Voer die naam in in het veld

Naam.
Deze projectie geeft de Aarde weer op een cirkelvormig veld in plaats van op een rechthoekig, zoals de meeste
andere projecties doen.

6. SelecteerWKT (Aanbevolen) in Formaat.
7. Voeg de volgende tekenreeks toe aan het veld Parameters:

PROJCRS["unknown",
BASEGEOGCRS["unknown",

DATUM["unknown",
ELLIPSOID["unknown",6371000,0,

LENGTHUNIT["metre",1,
ID["EPSG",9001]]]],

PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],

CONVERSION["unknown",
METHOD["Van Der Grinten"],

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
PARAMETER["Longitude of natural origin",0,

ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8802]],

PARAMETER["False easting",0,
LENGTHUNIT["metre",1],
ID["EPSG",8806]],

PARAMETER["False northing",0,
LENGTHUNIT["metre",1],
ID["EPSG",8807]]],

CS[Cartesian,2],
AXIS["(E)",east,

ORDER[1],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]],
AXIS["(N)",north,

ORDER[2],
LENGTHUNIT["metre",1,

ID["EPSG",9001]]]]

8. Klik op OK

9. Klik op de knop Huidig CRS aan de rechterkant van de statusbalk om het CRS voor het project te wĳzigen
10. Kies uw nieuwe gedefinieerde projectie (zoek naar de naam ervan in het veld Filter)
11. Bĳ het toepassen van deze projectie, zal de kaart opnieuw geprojecteerd worden als:
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6.1.5 Conclusie

Verschillende projecties zĳn handig voor verschillende doeleinden. Door de juiste projectie te kiezen kunt u er voor
zorgen dat de objecten op uw kaart nauwkeurig worden weergegeven.

6.1.6 Lees verder

Materiaal voor het gedeelte Gevorderd van deze les is afkomstig uit dit artikel.
Lees meer informatie over Coördinaten ReferentieSystemen.

6.1.7 Wat volgt?

In de volgende les zult u leren hoe u vectorgegevens kunt analyseren met de verschillende gereedschappen voor
vectoranalyse in QGIS.

6.2 Les: Vectoranalyse

Vectorgegevens kunnen ook worden geanalyseerd om te onthullen hoe verschillende objecten met elkaar omgaan in
de ruimte. Er zĳn vele aan analyse gerelateerde functies, dus zullen we ze niet allemaal behandelen. In plaats daarvan
zullen we een vraag stellen en die proberen op te lossen met behulp van de gereedschappen die QGIS verschaft.
Het doel voor deze les. Een vraag stellen en die beantwoorden met behulp van gereedschappen voor analyse.
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6.2.1 ��� Het proces van GIS

Vóór we beginnen zou het handig zĳn om een kort overzicht te geven van een proces dat gebruikt kan worden om elk
probleem op te lossen. De manier om dat te doen is:

1. Benoem het probleem
2. Haal de gegevens op
3. Analyseer het probleem
4. Geef de resultaten weer

6.2.2 ��� Het probleem

Laten we het proces beginnen door een probleem te benoemen om op te lossen. U bent bĳvoorbeeld een makelaar
en u zoekt naar een woning in Swellendam voor cliënten die de volgende criteria hebben:

1. Het moet in Swellendam liggen
2. Het moet op een redelĳke rĳafstand van een school (zeg 1 km) liggen
3. Het moet meer dan 100 vierkante meter in grootte zĳn
4. Dichter dan 50 m vanaf een hoofdweg
5. Minder dan 500 m vanaf een restaurant

6.2.3 ��� De gegevens

We hebben de volgende gegevens nodig om deze vragen te kunnen beantwoorden:
1. De woningen (gebouwen) in het gebied
2. De wegen in en rondom de stad
3. De locaties van scholen en restaurants
4. De grootte van gebouwen

Deze gegevens zĳn beschikbaar via OSMen u zou kunnen besluiten dat ook de gegevensset die u voor deze handleiding
heeft gebruikt voor deze les ook kan worden gebruikt.
Als u gegevens van een ander gebied wilt downloaden, ga dan naar Hoofdstuk Introductie om te lezen hoe dat te doen.

Notitie: Hoewel downloads van OSM consistente velden voor de gegevens hebben, kunnen de bedekking en de
details variëren. Als u ziet dat de door u gekozen regio, bĳvoorbeeld, geen informatie bevat over restaurants, zou u
misschien een andere regio moeten kiezen.

6.2.4 ��� Volgen: Een nieuw project starten en de gegevens ophalen

We moeten eerst de gegevens laden om mee te werken.
1. Begin een nieuw project binnen QGIS
2. Als u wilt, kunt u een achtergrondkaart toevoegen. Open de Browser en laad de kaart voor de achtergrond OSM

uit het menu XYZ Tiles.
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3. In de database voor GeoPackage training_data.gpkg vindt u de meeste gegevenssets die we zullen
gebruiken voor dit hoofdstuk:
1. buildings
2. roads
3. restaurants
4. schools

Laad ze, en ook landuse.sqlite.
4. Zoom in op het bereik van de laag om Swellendam, Zuid-Afrika te kunnen zien.

Voor we doorgaan moeten we de laag roads filteren om slechts een paar specifieke typen wegen te hebben om
mee te werken.
Enkele wegen in de gegevenssets van OSM zĳn vermeld als unclassified, tracks, path en footway.
We willen die uit onze gegevensset van wegen weglaten en focussen op de andere typen wegen, meer geschikt
voor deze oefening.
Meer nog, de gegevens van OSM zouden niet overal bĳgewerkt kunnen zĳn en we willen ook de waarden NULL
uitsluiten.

5. Klik met rechts op de laag roads en kies Filteren….
6. In het dialoogvenster dat opent filteren we deze objecten met de volgende expressie:

"highway" NOT IN ('footway', 'path', 'unclassified', 'track') AND "highway" IS␣
↪→NOT NULL

De samenvoeging van de twee operatoren NOT en IN sluit alle objecten uit die deze attribuutwaarden in het
veld highway hebben staan.
IS NOT NULL gecombineerd met de operator AND sluit wegen zonder waarde in het veld highway uit.
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Merk het pictogram op naast de laag roads. Het helpt u te onthouden dat op deze laag een filter is
geactiveerd en dat enkele objecten dus niet beschikbaar zouden kunnen zĳn in het project.

De kaart met alle gegevens zou er ongeveer als volgt uit moeten zien:

6.2.5 ��� Probeer zelf: CRS van lagen wijzigen

We moeten we het CRS van de lagen wĳzigen, omdat we binnen onze lagen afstanden gaan meten. We moeten, om
dit te doen, elke laag op zĳn beurt selecteren, de laag opslaan naar een nieuwe met onze nieuwe projectie, en dan die
nieuwe laag in onze kaart importeren.
U heeft veel verschillende opties, u kunt bĳvoorbeeld elke laag exporteren als een nieuw gegevensset in de indeling
ESRI Shapefile, u kunt de lagen toevoegen aan een bestaand bestand van GeoPackage of u kunt een nieuw bestand
voor GeoPackage maken en dat vullen met de nieuw geprojecteerde lagen. We zullen de laatste optie laten zien, zodat
training_data.gpkg schoon blĳft. Het staat u vrĳ de beste werkwĳze voor uzelf te kiezen.

Notitie: In dit voorbeeld gebruiken we het CRS WGS 84 / UTM zone 34S, maar u zou een UTM CRS moeten
gebruiken dat meer toepasselĳk is voor uw regio.

1. Klik met rechts op de laag roads in het paneel Lagen
2. Klik op Exporteren –> Objecten opslaan als…

3. Kies in het dialoogvenster Vectorlaag opslaan als GeoPackage als Indeling
4. Klik op… van de Bestandsnaam en noem het nieuwe GeoPackage vector_analysis
5. Wĳzig de Laagnaam naar roads_34S
6. Wĳzig het CRS naarWGS 84 / UTM zone 34S

7. Klik op OK:
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Dit zal de nieuwe database voor GeoPackage maken en de laag roads_34S toevoegen.
8. Herhaal dit proces voor elke laag door een nieuwe laag te maken in het bestand van GeoPackage

vector_analysis.gpkg met “_34S” toegevoegd aan de originele naam.
Op macOS, druk op de knopVervangen in het dialoogvenster dat opent om toe te staan dat QGIS het bestaande
GeoPackage overschrĳft.

Notitie: Wanneer u er voor kiest om een laag op te slaan naar een bestaand GeoPackage, zal QGIS die laag
toevoegen aan de bestaande lagen het GeoPackage, als daar geen laag met dezelfde naam al reeds bestaat.

9. Elk van de oude lagen uit het project verwĳderen
10. Als u eenmaal het proces voor alle lagen heeft voltooid, klik dan met rechts op een laag en klik op Zoom naar

laag om de kaart te focussen op het gebied waarin we geïnteresseerd zĳn.
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Nuwe de gegevens vanOSMhebben geconverteerd naar eenUTM-projectie, kunnenwe onze berekeningen beginnen.

6.2.6 ��� Volgen: Analyseren van het probleem: Afstanden van scholen en
wegen

QGIS stelt u in staat afstanden te berekenen tussen elk vectorobject.
1. Zorg er voor dat alleen de lagen roads_34S en buildings_34S zichtbaar zĳn (om de kaart te

vereenvoudigen, terwĳl u werkt).
2. Klik op Processing ► Toolbox om de analytische bron van QGIS te openen. Als basis: alle algoritmes (voor

vector- en raster-) analyses zĳn in deze Toolbox beschikbaar.
3. We beginnen met het gebied te berekenen rondom roads_34S door het algoritme Buffer te gebruiken. U

kunt dat vinden in de groep Vector geometrie.
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Of u kunt buffer typen in het zoekmenu in het bovenste gedeelte van de Toolbox:

4. Dubbelklik erop om het dialoogvenster van het algoritme te openen
5. Selecteer roads_34S als Invoerlaag, stel Afstand in op 50 en gebruik de standaardwaarden voor de rest van

de parameters.
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6. De standaard Afstand is in meters, omdat onze gegevensset voor invoer in een geprojecteerd Coördinaten
Systeem staat dat meter gebruikt als zĳn basis maateenheid. U kunt het combinatievak gebruiken om andere
geprojecteerde eenheden te gebruiken, zoals kilometers, yards, etc.

Notitie: Als u probeert een buffer te maken op een laag met een Geografisch CoördinatenSysteem,
zal Processing u waarschuwen en voorstellen om de laag opnieuw te projecteren in een metrisch
CoördinatenSysteem.

7. Standaard maakt Processing tĳdelĳke lagen en voegt die toe aan het paneel Lagen. U kunt het resultaat ook
toevoegen aan de database van GeoPackage door:
1. Te klikken op de knop… en te kiezen voor Opslaan naar GeoPackage…

2. Noem de nieuwe laag roads_buffer_50m
3. Sla het op in het bestand vector_analysis.gpkg
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8. Klik op Uitvoeren, en sluit dan het dialoogvenster Buffer
Nu zal uw kaart er ongeveer zo uitzien:
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Als uw nieuwe laag boven in de lĳst Lagen staat, zal het waarschĳnlĳk veel van uw kaart verbergen, maar dit geeft u
alle gebieden in uw regio die binnen 50 m van een weg liggen.
Merk op dat er binnen uw buffer bepaalde gebieden zĳn, die overeenkomen met elke weg. Om dit probleem op te
lossen:

1. Deselecteer de laag roads_buffer_50m en maak de buffer opnieuw met Resultaten samenvoegen ingeschakeld:
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2. Sla de uitvoer op als roads_buffer_50m_dissolved

3. Klik op Uitvoeren en sluit het dialoogvenster Buffer
Als u de laag eenmaal aan het paneel Lagen heeft toegevoegd, zal het er zo uitzien:
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Nu zĳn er geen onnodige onderverdelingen meer.

Notitie: De Verkorte Help aan de rechterkant van het dialoogvenster legt uit hoe het algoritme werkt. Als u meer
informatie nodig hebt, klik dan gewoon op de knop Help in het onderste gedeelte om een meer gedetailleerde
handleiding voor het algoritme te openen.

6.2.7 ��� Probeer zelf: Afstand van scholen

Gebruik dezelfde benadering als hierboven en maak een buffer voor uw scholen.
Het moet 1 km in straal zĳn. Sla de nieuwe laag op in het bestand vector_analysis.gpkg als
schools_buffer_1km_dissolved.

Antwoord
• Uw dialoogvenster voor de buffer zou er zo uit moeten zien:
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De Buffer afstand is 1 kilometer.
• De waarde Te schatten segmenten is ingesteld op 20. Dit is optioneel, maar het wordt aanbevolen, omdat het de
buffers voor de uitvoer gladder laat lĳken. Vergelĳk dit:
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Met dit:
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De eerste afbeelding laat de buffer zien met de waarde voor Te schatten segmenten ingesteld op 5 en de tweede laat
de waarde zien die ingesteld is op 20. In ons voorbeeld is het verschil subtiel, maar u kunt zien dat de randen van de
buffer gladder zĳn met de hogere waarde.

6.2.8 ��� Volgen: Overlappende gebieden

Nu hebben we gebieden geïdentificeerd waar de weg minder dan 50 m verwĳderd is en gebieden waar een school
binnen 1 km ligt (directe lĳn, niet via de weg). Maar natuurlĳk willen we alleen de gebieden waar aan beide criteria
wordt voldaan. We zullen het gereedschap Kruising moeten gebruiken om dat te kunnen doen. U vindt het onder de
groep Vector op elkaar leggen in Processing –> Toolbox.

1. Gebruik de twee lagen met buffers als Invoerlaag en Overleglaag, kies vector_analysis.gpkg
GeoPackage in Kruisingmet Laagnaam road_school_buffers_intersect. Laat de rest zoals wordt
voorgesteld (standaard).
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2. Klik op Uitvoeren.
In de afbeelding hieronder, de blauwe gebieden zĳn waar aan beide criteria voor de afstand wordt voldaan.
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3. U kunt de twee bufferlagen verwĳderen en alleen die ene behouden waar zĳ overlappen, omdat dat is wat we
in eerste instantie echt wilden weten:
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6.2.9 ��� Volgen: De gebouwen uitnemen

Nu heeft u het gebied dat de gebouwen moet overlappen. Vervolgens wilt u de gebouwen in dat gebied uitnemen.
1. Zoek naar het menuitem Vector selectie ► Extract by location in de Toolbox van Processing
2. Selecteer buildings_34S in Objecten uitnemen uit. Selecteer kruisen met inWaar de objecten (geometrisch

voorvoegsel), selecteer de laag met de kruisingen van de buffers in Door objecten te vergelĳken van. Sla op naar
vector_analysis.gpkg, en noem de laag well_located_houses.

3. Klik op Uitvoeren en sluit het dialoogvenster
4. U zult waarschĳnlĳk vinden dat er niet veel lĳkt te zĳn veranderd. Als dat zo is, verplaats dan de laag

well_located_houses tot boven in de lagenlĳst en zoom dan in.
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De rode gebouwen zĳn die welke voldoen aan onze criteria, terwĳl de groene gebouwen er niet aan voldoen.
5. Nu heeft u twee afzonderlĳke lagen en kunt u buildings_34S uit de lagenlĳst verwĳderen.

6.2.10 ��� Probeer zelf: Onze gebouwen verder filteren

We hebben nu een laag die ons alle gebouwen binnen 1 km van een school en binnen 50 m vanaf een weg toont. We
moeten nu die selectie verkleinen om ons alleen gebouwen te tonen die binnen 500 m vanaf een restaurant liggen.
Maak, met behulp van de hierboven beschreven processen, een nieuwe laag, genaamd houses_restaurants_500m die
uw laag well_located_houses verder filtert om alleen die gebouwen te laten zien die binnen 500 m van een restaurant
liggen.

Antwoord
We gaan door een proces mt twee stappen om de nieuwe laag houses_restaurants_500m te maken:

1. Maak eerst een buffer van 500m rondom de restaurants en voeg de laag toe aan de kaart:
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2. Neem vervolgens de gebouwen uit binnen dat gebied van de buffer:
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Uw kaart zou nu alleen die gebouwen moeten laten zien die binnen 50m van een weg liggen, 1km vanaf een school
en 500m vcanaf een restaurant:
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6.2.11 ��� Volgen: Gebouwen met de juiste grootte selecteren

We moeten hun grootte berekenen om te zien welke gebouwen de juiste grootte hebben (groter dan 100 vierkante
meter).

1. Selecteer de laag houses_restaurants_500m en open Veldberekening door te klikken op de knop
Veldberekening openen in de hoofdwerkbalk of in het venster van de attributentabel

2. Selecteer Nieuw veld aanmaken, stel de Naam voor veld in op AREA, kies Decimaal getal (real) als Type voor
veld, en kies $area uit de groep Geometrie.

Het nieuwe veld AREA zal de oppervlakte van elk gebouw in vierkante meters bevatten.
3. Klik op OK. Het veld AREA is toegevoegd aan het einde van de attributentabel.

4. Klik opnieuw op de knop Bewerken aan/uitzetten om het bewerken te voltooien en sla uw gegevens op als daarnaar
gevraagd wordt.

5. Stel, op de tab Bron van de laageigenschappen, het Provider objectfilter in op "AREA >= 100.
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6. Klik op OK.
Uw kaart zou nu alleen die gebouwen moeten laten zien die overeenkomen met uw begincriteria en die groter zĳn
dan 100 vierkante meter.

6.2.12 ��� Probeer zelf:

Sla uw oplossing op als een nieuwe laag, met de benadering die u hierboven hebt geleerd om dat te doen. Het bestand
zou moeten worden opgeslagen in dezelfde database van GeoPackage, met de naam solution.
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6.2.13 Conclusie

Met de benadering van probleemoplossing voor GIS, samen met de gereedschappen voor vectoranalyse van QGIS,
was u in staat een probleem met meerdere criteria snel en gemakkelĳk op te lossen.

6.2.14 Wat volgt?

In de volgende les, zullen we kĳken naar de berekening van de kortste afstand over wegen, van het ene punt naar een
ander.

6.3 Les: Netwerkanalyse

Berekenen van de kortste afstand tussen twee punten is een veel voorkomend gebruik voor GIS. Gereedschappen
hiervoor zĳn te vinden in de Toolbox van Processing.
Het doel voor deze les: leren algoritmes voor Netwerk-analyses te gebruiken.

6.3.1 ��� Volgen: De gereedschappen en de gegevens

U vindt alle algoritmes voor netwerkanalyses in het menu Processing ► Netwerkanalyse. U kunt zien dat er vele
gereedschappen beschikbaar zĳn:
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Open het project exercise_data/network_analysis/network.qgz. Het bevat twee lagen:
• network_points

• network_lines

De laag network_lines heeft al een stĳl die u helpt het netwerk van wegen te begrĳpen.

Het gereedschap Kortste pad verschaft manieren om ofwel het kortste of het snelste pad te berekenen tussen twee
opgegeven punten van een netwerk:

• begin- en eindpunten geselecteerd op de kaart
• beginpunt geselecteerd op de kaart en eindpunten genomen uit een puntenlaag
• beginpunten genomen uit een puntenlaag en eindpunt geselecteerd op de kaart

Laten we beginnen.

6.3.2 ��� Kortste pad (punt naar punt) berekenen

Het menu Netwerkanalyse ► Kortste pad (punt naar punt) stelt u in staat de kortste afstand te berekenen tussen twee
handmatig geselecteerde punten op de kaart.
In dit voorbeeld zullen we het kortste (niet snelste) pad tussen twee punten.

1. Open het algoritme Kortste pad (punt naar punt)

2. Selecteer network_lines voor Vectorlaag die netwerk weergeeft

3. Kies Kortste in Te berekenen type pad

Gebruik deze twee punten als begin- en eindpunt voor de analyse:
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4. Klik op de knop… naast Startpunt en kies de locatie die is getagd met Starting Point in de afbeelding.
Schakel de opties voor snappen in voor een nauwkeurige selectie. Het veld wordt gevuld met de coördinaten
van het aangeklikte punt.

5. Doe hetzelfde, maar kies nu de locatie die is getagd met Ending point voor Eindpunt
6. Klik op de knop Uitvoeren:

7. Een nieuwe lĳnenlaag wordt gemaakt die het kortste pad weergeeft tussen de gekozen punten. Deselecteer de
laag network_lines om het resultaat beter te kunnen zien:
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8. Open de attributentabel van de uitvoerlaag. Die bevat drie velden, die de coördinaten van het start- en eindpunt
weergeven en de kosten.
We kozen Kortste als Te berekenen type pad, dus vertegenwoordigen de kosten de afstand, in
kaarteenheden, tussen de twee locaties.
In ons geval is de kortste afstand tussen de twee gekozen punten ongeveer 1000 meter:

Nu u weet hoe het gereedschap te gebruiken, test nog enkele andere locaties.

6.3.3 ��� Probeer zelf: Snelste pad

Probeer, met dezelfde gegevens van de eerdere oefening, het snelste pad tussen de twee punten te berekenen.
Hoeveel tĳd heeft u nodig om van het begin- naar het eindpunt te gaan?

Antwoord
1. Open Netwerkanalyse ► Kortste pad (punt naar punt) en vul het dialoogvenster als volgt:
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2. Zorg er voor dat Te berekenen type pad is ingesteld op Snelste.
3. Klik op Uitvoeren en sluit het dialoogvenster.
4. Open nu de attributentabel van de uitvoerlaag. Het veld cost bevat de reistĳd tussen de twee punten (als fractie

van uren):

6.3.4 ��� Volgen: Geavanceerde opties

Laten we nog wat meer opties verkennen van de gereedschappen voor Netwerkanalyse. In de vorige oefening
berekenden we de snelste route tussen twee punten. Zoals u zich kunt voorstellen is de tĳd afhankelĳk van de snelheid
van reizen.
We zullen dezelfde lagen en begin- en eindpunten gebruiken als in de vorige oefeningen.

1. Open het algoritme Kortste pad (punt naar punt)

2. Vul Invoerlaag, Beginpunt (x, y) en Eindpunt (x, y) in zoals we eerder deden
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3. Kies Snelste als het Te berekenen type pad

4. Open het menu Gevorderde parameters

5. Wĳzig de Standaard snelheid (km/u) van de standaardwaarde 50 naar 4
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6. Klik op Uitvoeren

7. Sluit, als het algoritme is voltooid, het dialoogvenster en open de attributentabel van de uitvoerlaag.
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Het veld cost bevat de waarde overeenkomstig de parameter voor de snelheid die u hebt gekozen. We kunnen
het veld cost converteren van uren met fracties naar de meer leesbare waarde minuten.

8. Open Veldberekening door te klikken op het pictogram .
9. Voeg een nieuw veld toe om de kosten voor het pad op te slaan in minuten.

Dat is alles! Nu weet u hoeveel minuten u nodig hebt om van het ene punt bĳ het andere te komen als de gehele
netwerksnelheid 4 km/u is.

6.3.5 ��� Snelste pad met snelheidsbeperking

Het gereedschap Netwerkanalyse heeft nog andere interessante opties. Als we kĳken naar de volgende kaart:
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we zouden de snelste route willen weten, rekening houdende met de snelheidsbeperkingen voor elke weg (de labels
geven de maximumsnelheid in km/u weer). Het kortste pad zonder rekening te houden met de snelheidsbeperkingen
zou natuurlĳk het paarse pad zĳn. Maar op die weg is de maximumsnelheid 20 km/u, terwĳl u op de groene weg 100
km/u mag!
Zoals we in de eerste oefening deden zullen we Netwerkanalyse ► Kortste pad (punt naar punt) gebruiken en zullen
we handmatig de begin- en eindpunten kiezen.

1. Open het algoritme Netwerkanalyse ► Kortste pad (punt naar punt)

2. Selecteer network_lines voor de parameter Vectorlaag die netwerk weergeeft

3. Kies Snelste als het Te berekenen type pad

4. Selecteer Beginpunt (x, y) en Eindpunt (x, y) zoals we eerder deden
5. Open het menu Gevorderde parameters

6. Kies het veld speed als de parameter Snelheidsveld. Met deze optie zal het algoritme rekening houden met de
snelheidsbeperkingen op elke weg.
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7. Klik op de knop Uitvoeren

8. Schakel de laag network_lines uit, om het resultaat beter te kunnen zien
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Zoals u kunt zien komt de snelste route niet overeen met de kortste.

6.3.6 ��� Servicegebied (vanuit laag)

Het algortimeNetwerkanalyse► Servicegebied (vanuit laag) kan antwoord geven op de vraag: gegeven een puntenlaag,
wat zĳn alle te bereiken gebieden binnen een opgegeven afstand of tĳdwaarde?

Notitie: Het algoritme Netwerkanalyse ► Servicegebied (vanaf punt) is hetzelfde algoritme, maar stelt u in staat
handmatig het punt op de kaart te kiezen.

Gegeven een afstand van 250 meter willen we weten hoever we vanuit elk punt het netwerk op kunnen gaan op de
laag network_points.

1. Deselecteer alle lagen, behalve network_points
2. Open het algoritme Netwerkanalyse ► Servicegebied (vanuit laag)

3. Selecteer network_lines voor Vectorlaag die netwerk weergeeft

4. Kies network_points voor Vectorlaag met startpunten

5. Kies Kortste in Te berekenen type pad

6. Voer 250 in voor de parameter Reiskosten
7. Klik op Uitvoeren en sluit het dialoogvenster
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De uitvoerlaag geeft het maximale pad aan dat u kunt bereiken vanuit de puntobjecten, gegeven een afstand
van 250 meter:

6.3. Les: Netwerkanalyse 235



QGIS Training Manual

Leuk hè?

6.3.7 Conclusie

Nu weet u hoe u het algoritme Netwerkanalyse kunt gebruiken om problemen met kortste en snelste paden op te
lossen.
We zĳn nu klaar om enkele ruimtelĳke statistieken uit te voeren op gegevens van vectorlagen. Daar gaan we!

6.3.8 Wat volgt?

Vervolgens zult u zien hoe u algoritmes voor ruimtelĳke statistieken uitvoert op vector gegevenssets.

6.4 Les: Ruimtelijke statistieken

Notitie: Les ontwikkeld door Linfiniti en S Motala (Cape Peninsula University of Technology)

Ruimtelĳke statistieken stellen u in staat te analyseren en te begrĳpen wat er gaande is in een bepaalde vector
gegevensset. QGIS bevat vele nuttige gereedschappen voor statistische analyses.
Het doel voor deze les: Weten hoe de ruimtelĳke statistische gereedschappen in de Toolbox van Processing te
gebruiken.

236 Hoofdstuk 6. Module: Vectoranalyse



QGIS Training Manual

6.4.1 ��� Volgen: Een gegevensset voor testen maken

We zullen een willekeurige set punten maken, om een gegevensset te krĳgen waar we mee kunnen werken.
U heeft, om dat te doen, een polygoon gegevensset nodig die het bereik van het gebied, waarin u de punten wilt
maken, definieert.
We zullen het gebied gebruiken dat wordt bedekt door straten.

1. Begin een nieuw project.
2. Voeg uw laag roads toe, als ook srtm_41_19 (hoogtegegevens) te vinden in exercise_data/

raster/SRTM/.

Notitie: U zou kunnen merken dat de laag SRTMDEM een ander CRS heeft dan die van de laag roads. QGIS
projecteert beide lagen in één enkel CRS. Voor de volgende oefeningen is dit verschil niet van belang, maar
het staat u vrĳ een laag opnieuw te projecteren (zoals eerder weergegeven in deze module).

3. Open de Toolbox van Processing

4. Gebruik het gereedschap Vector geometrie ► Minimum begrenzing geometrie om een gebied te maken dat alle
wegen omsluit door Convex Hull te kiezen als Type geometrie:

Zoals u weet maakt Processing , als u geen uitvoer specificeert, tĳdelĳke lagen. Het is aan u om de lagen
onmiddellĳk op te slaan of op een later moment.
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Willekeurige punten genereren

• Maak in dit gebied 100 willekeurige punten met het gereedschap Vector maken ► Willekeurige punten binnen
grenzen van laag, met een minimum afstand van 0.0:

Notitie: Het gele waarschuwingsteken vertelt u dat die parameter afstanden betreft. De laag Begrenzing
geometrie staat in een Geografisch coördinatensysteem en het algoritme herinnert u daar slechts aan. Voor
dit voorbeeld zullen we deze parameter niet gebruiken, dus kunt u het negeren.

Verplaats, indien nodig, de gemaakte willekeurige punten naar bovenaan in de legenda om hem beter te kunnen zien:
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Een monster uit de gegevens

U dient het algoritme Rasteranalye ► Monster rasterwaarden te gebruiken om een gegevensset met monsters uit het
raster te nemen. Dit gereedschap neemt monsters uit het raster op de locaties van de punten en voegt de rasterwaarden
toe in nieuwe veld(en), afhankelĳk van het aantal banden in het raster.

1. Open het dialoogvenster voor het algoritme Monsters rasterwaarden

2. Selecteer Willekeurige punten als de laag die de monsterpunten bevat en het SRTM-raster als de
band waaruit de waarden moeten komen. De standaardnaam voor het nieuwe veld is rvalue_N, waar N het
nummer is van de rasterband. U kunt de naam van het voorvoegsel wĳzigen als u dat wilt.
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3. Klik op Uitvoeren

Nu kunt u de gegevens voor het monster uit het rasterbestand controleren in de attributentabel van de laag
Monsterpunten.Zĳ zullen in een nieuw veld staan, met de naam die u hebt gekozen.
Een mogelĳke laag voor het monster wordt hier weergegeven:
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De monsterpunten zĳn op hun veld rvalue_1 geclassificeerd, zodat rode punten op een hogere hoogte liggen.
U zult deze monsterlaag gaan gebruiken voor de rest van de statistische oefeningen.

6.4.2 ��� Volgen: Basisstatistieken

Nu nog de basisstatistieken voor deze laag ophalen.

1. Klik op het pictogram Statistisch overzicht weergeven op de werkbalk Attributen. Een nieuw paneel zal openen.
2. Specificeer, in het dialoogvenster dat verschĳnt, de laag Monsterpunten als de bron.
3. Selecteer het veld rvalue_1 in het combinatievak voor velden. Dit is het veld waarvoor u de statistieken wilt

berekenen.
4. Het paneel Statistieken zal automatisch worden bĳgewerkt met de berekende statistieken:
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Notitie: Ukunt de waarden kopiëren door te klikken op de knop Statistieken naar klembord kopiëren en de resultaten
in een werkblad plakken.

5. Sluit het paneel Statistieken indien gereed
Veel verschillende statistieken zĳn beschikbaar:
Telling

Het aantal monsters/waarden.
Som

De waarden bĳ elkaar opgeteld.
Gemiddelde

De gemiddelde waarde is eenvoudigweg de som van de waarden, gedeeld door het aantal waarden.
Mediaan

Als u alle waarden schikt van de kleinste tot de grootste, is de middelste waarde (of het gemiddelde van de
twee middelste waarden als N een even getal is) de mediaan van de waarden.

St afw (pop)
De standaardafwĳking. Geeft een indicatie over hoe dicht de waarden zĳn geclusterd rondom het gemiddelde.
Hoe kleiner de standaardafwĳking, hoe meer waarden neigen naar het gemiddelde.

Minimum
De laagste waarde.

Maximum
De hoogste waarde.

Bereik
Het verschil tussen de laagste en de hoogste waarden.

Kw1
Eerste kwartiel van de gegevens.

Kw3
Derde kwartiel van de gegevens.

Ontbrekende (null) waarden
Het aantal ontbrekende waarden.

6.4.3 ��� Volgen: Statistieken berekenen van afstanden tussen punten

1. Maak een nieuwe tĳdelĳke puntenlaag.
2. Ga naar modus Bewerken en digitaliseer drie punten ergens tussen de andere punten.

Gebruik, als alternatief, dezelfde methode voor het maken van willekeurige punten als hiervoor, maar
specificeer slechts drie punten.

3. Sla uw nieuwe laag op als distance_points in de indeling die u wilt.
Statistieken maken over de afstand tussen punten in de twee lagen:

1. Open het gereedschap Vector-analyse ► Afstandsmatrix.
2. Selecteer de laag distance_points als de invoerlaag en de laag Monsterpunten als de doellaag.
3. Set their id field as unique field references
4. Change the Output matrix type option into Summary distance matrix.
5. set value of Use only the nearest (k) target points to 2.
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6. Als u wilt, kunt u de uitvoerlaag opslaan als een bestand of alleen het algoritme uitvoeren en de tĳdelĳke
uitvoerlaag later opslaan.

7. Klik op Uitvoeren om de laag voor de afstandsmatrix te maken.
8. Open de attributentabel van de gemaakte laag: waarden verwĳzen naar de afstanden tussen de objecten van

Afstandsmatrix en hun twee dichtstbĳzĳnde punten op de laag Monsterpunten:

With these parameters, the Distance Matrix tool calculates distance statistics for each point of the input layer with
respect to their two nearest points in the target layer. The fields of the output layer contain the mean, standard
deviation, minimum and maximum for the calculated distances.
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For further testing, you may want to modify the Output matrix type option or the number of target points.

6.4.4 ��� Volgen: Analyse Nearest Neighbor (binnen laag)

Een ‘Dichtstbĳzĳnde buur’-analyse uitvoeren op een puntenlaag:
1. Kies Vector-analyse ► ‘Dichtstbĳzĳnde buur’-analyse.
2. Selecteer, in het dialoogvenster dat verschĳnt, de laag Random samples en klik op Uitvoeren.
3. De resultaten zullen verschĳnen in het paneel van Processing Resultaten bekĳken.

4. Klik op de blauwe link om de HTML- pagina met de resultaten te bekĳken:
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6.4.5 ��� Volgen: Gemiddelde coördinaten

De gemiddelde coördinaten van een gegevensset verkrĳgen:
1. Start Vector-analyse ► Gemiddelde coördin(a)t(en)

2. Specificeer, in het dialoogvenster dat verschĳnt,Willekeurige punten als Invoerlaag, en laat de optionele keuzen
ongewĳzigd.

3. Klik op Uitvoeren.
Laten we dit eens vergelĳken met de centrale coördinaat van de polygoon die werd gebruikt om het willekeurige
monster te maken.

1. Start Vector geometrie ► Zwaartepunten

2. Selecteer, in het dialoogvenster dat verschĳnt, Begrenzing geometrie als de invoerlaag.
Zoals u kunt zien vallen de gemiddelde coördinaten (roze punt) en het middelpunt van het gebruikte gebied (in groen)
niet noodzakelĳkerwĳze samen.
Het zwaartepunt is het barycenter van de laag (het barycenter van een vierkant is het midden van het vierkant), terwĳl
de gemiddelde coördinaten het gemiddelde weergeven van alle coördinaten van de knopen.
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6.4.6 ��� Volgen: Afbeelding histogrammen

Het histogram van een gegevensset geeft de verdeling van de waarden ervan weer. De eenvoudigste manier om dit in
QGIS te demonstreren is via het histogram van een afbeelding, beschikbaar in het dialoogvenster Laageigenschappen
van elke afbeeldingslaag (raster gegevensset).

1. Klik, in uw paneel Lagen, met rechts op de laag srtm_41_19.
2. Selecteer Eigenschappen
3. Kies de tabHistogram. U moet misschien op de knopHistogram herberekenen klikken om de grafiek te maken.

U zult een grafiek zien die verdeling van de frequentie van de rasterwaarden weergeeft.
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4. De grafiek kan met de knop Plot opslaan worden geëxporteerd als een afbeelding
5. U kunt meer gedetailleerde informatie over de laag vinden op de tab Informatie (het gemiddelde en maximum

waarde zĳn geschat, en zouden niet exact kunnen zĳn).
De gemiddelde waarde is 332.8 (geschat op 324.3), en de maximum waarde is 1699 (geschat op 1548)! U kunt
zoomen in het histogram. Het histogram ziet er verticaal gecomprimeerd uit, omdat er heel veel pixels met de waarde
0 zĳn. Door in te zoomen om alles, behalve de piek op 0, te bedekken zult u meer details zien:
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Notitie: Als de waarden gemiddelde enmaximum niet hetzelfde zĳn als hierboven, kan dat komen door de berekening
van de waarden min/max. Open de tab Symbologie en vergroot het menu Instellingen min / max waarden. Kies
Min / max en klik op Apply.

Onthoud dat een histogram u de verdeling van de waarden laat zien en dat niet alle waarden noodzakelĳkerwĳze ook
zichtbaar zĳn in de grafiek.
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6.4.7 ��� Volgen: Ruimtelijke interpolatie

Laten we zeggen dat u een collectie monsterpunten heeft van waaruit u gegevens wilt extrapoleren. U heeft misschien
toegang tot de gegevenssetMonsterpunten die we eerder gemaakt hebben en wil een idee krĳgen over hoe het terrein
eruit ziet.

1. Start, om te beginnen, het gereedschap GDAL ► Rasteranalyse ► Raster (IDW met zoeken naar Nearest
neighbor) in de Toolbox van Processing.

2. Selecteer ``Monsterpunten``als Puntenlaag
3. Stel Gewogen macht in op 5.0
4. Stel, in Gevorderde parameters, rvalue_1 in voor Z-waarde uit veld

5. Klik tenslotte op Uitvoeren en wacht tot de verwerking is voltooid.
6. Sluit het dialoogvenster

Hier is een vergelĳking van de originele gegevensset (links) met die welke we hebben gemaakt uit onze monsterpunten
(rechts). Die van u kan er anders uitzien vanwege de willekeurige herkomst van de locatie van de monsterpunten.

Zoals u kunt zien zĳn 100 monsterpunten niet echt genoeg om een gedetailleerde impressie van het terrein te maken.
Het geeft een zeer algemeen idee, maar het kan ook misleidend zĳn.

6.4.8 ��� Probeer zelf: Verschillende methoden voor interpolatie

1. Gebruik de hierboven weergegeven processen om een nieuwe set van 10.000 willekeurige punten te maken

Notitie: Als het aantal punten echt heel groot is kan de verwerkingstĳd behoorlĳk oplopen.

2. Gebruik deze punten om een monster te nemen uit de originele DEM
3. Gebruik het gereedschap Raster (IDW met zoeken naar Nearest neighbor) op deze gegevensset
4. Stel Macht en Afvlakken respectievelĳk in op 5.0 en 2.0.

De resultaten (afhankelĳk van de positie van uw willekeurige punten) zal er min of meer zo uitzien:
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Dit is een betere weergave van het terrein, vanwege de hogere dichtheid van monsterpunten. Onthoud: meer monsters
geven betere resultaten.

6.4.9 Conclusie

QGIS heeft een aantal gereedschappen voor het analyseren van ruimtelĳke statistische eigenschappen van
gegevenssets.

6.4.10 Wat volgt?

Nu we vectoranalyse hebben behandeld, waarom niet eens kĳken wat er met rasters gedaan kan worden? Dat is wat
we zullen gaan doen in de volgende module!
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Module: Rasters

We hebben eerder rasters gebruikt voor het digitaliseren, maar rastergegevens kunnen ook direct worden gebruikt. In
deze module zult u zien hoe dat wordt gedaan in QGIS.

7.1 Les: Werken met rastergegevens

Rastergegevens zĳn heel anders dan vectorgegevens. Vectorgegevens hebben verschillende objecten met geometrieën
die zĳn geconstrueerd uit punten en misschien verbonden met lĳnen en/of gebieden. Rastergegevens echter zĳn als
een afbeelding. Hoewel het verschillende eigenschappen van objecten in de echte wereld kan weergeven, bestaan
deze objecten niet als afzonderlĳke objecten. In plaats daarvan worden zĳ weergegeven door pixels met verschillende
waarden.
Gedurende deze module gaat u rastergegevens gebruiken om uw bestaande GIS-analyse aan te vullen.
Het doel voor deze les: Leren hoe te werken met rastergegevens in QGIS.

7.1.1 ��� Volgen: Rastergegevens laden

Rastergegevens kunnen met dezelfde methoden worden geladen als die we gebruikten voor vectorgegevens. We
adviseren echter het paneel Browser te gebruiken.

1. Open het paneel Browser en breidt de map exercise_data/raster uit.
2. Laadt alle gegevens in deze map:

• 3320C_2010_314_RGB_LATLNG.tif

• 3320D_2010_315_RGB_LATLNG.tif

• 3420B_2010_328_RGB_LATLNG.tif

• 3420C_2010_327_RGB_LATLNG.tif

U zou de volgende kaart moeten zien:
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Daar hebben we ze - vier luchtfoto’s die ons gehele gebied bedekken.

7.1.2 ��� Volgen: Een virtueel raster maken

Zoals u hier kunt zien ligt uw laag voor de oplossing over alle vier de foto’s. Wat dit betekent is dat u altĳd moet
werken met alle vier rasters. Dat is niet ideaal; het zou beter zĳn om slechts één bestand te hebben om mee te werken.
Gelukkig stelt QGIS u in staat om exact dat te doen en zonder de noodzaak om feitelĳk een nieuw rasterbestand te
maken. U kunt een Virtueel rastermaken. Dit wordt vaak een Catalogus genoemd, wat zĳn functie verklaart. Het is
niet echt een nieuw raster. In plaats daarvan is het een manier om uw bestaande rasters te beheren in één catalogus:
één bestand voor gemakkelĳke toegang.
Voor het maken van een catalogus zullen we de Processing ► Toolbox gebruiken.

1. Open het algoritme Virtueel raster bouwen uit GDAL ► Raster diversen;
2. Klik, in het dialoogvenster dat verschĳnt, op de knop… naast de parameter Input layers en selecteer alle lagen

of gebruik de knop Alles selecteren;
3. Deselecteer Elk invoerbestand in een afzonderlĳke band plaatsen. Let op de code die is gegenereerd aan de

onderzĳde van het dialoogvenster onder Aanroep console GDAL/OGR. Dat is de opdracht die zal worden
uitgevoerd als u klikt Uitvoeren. De tekst wordt bĳgewerkt als u de verschillende opties in het dialoogvenster
wĳzigt.

Notitie: Onthoud dat u de tekst kunt kopiëren en plakken in de OSGeo Shell (Windows-gebruiker) of
Terminal (Linux- en OSX-gebruikers) om de opdracht uit te voeren. U kunt ook een script maken voor
elke opdracht van GDAL. Dit is bĳzonder handig wanneer de procedure veel tĳd vergt of wanneer u specifieke
taken in schema wilt zetten. Gebruik de knopHelp ommeer hulp te krĳgen voor de syntaxis van de opdrachten.

4. Klik tenslotte op Uitvoeren.

Notitie: Zoals u al weet uit de eerdere modules maakt Processing standaard tĳdelĳke lagen. Klik, onder Virtueel, op
de knop… om het bestand op te slaan.
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Ukunt nu de originele vier rasters uit het paneel Lagen verwĳderen en alleen het uitvoerraster van de virtuele catalogus
behouden.
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7.1.3 ��� Rastergegevens transformeren

De bovenstaande methoden stellen u in staat gegevenssets virtueel samen te voegen met behulp van een catalogus
en ze opnieuw “direct” te projecteren. Echter, als u gegevens instelt die u geruime tĳd niet zal gebruiken, zou het
meer efficiënt zĳn om nieuwe rasters te maken die al samengevoegd en opnieuw geprojecteerd zĳn. Dat verbetert de
uitvoering bĳ het gebruiken van de rasters in een kaart, maar het kan enige tĳd duren om het in het begin in te stellen.

Rasters opnieuw projecteren

OpenWarp (opnieuw projecteren) uit GDAL ► Rasterprojecties.
U kunt ook virtuele rasters (catalogussen) opnieuw projecteren, multithreaded verwerken inschakelen, en meer.
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Rasters samenvoegen

Wanneer u een nieuwe rasterlaag moet maken en die op schĳf opslaan kunt u het algoritme Merge gebruiken.

Notitie: Afhankelĳk van hoeveel rasterbestanden u samenvoegt en hun resolutie, kan het nieuw gemaakte
rasterbestand behoorlĳk groot zĳn. Overweeg daarom om een rastercatalogus te maken, zoals beschreven in het
gedeelte Een virtueel raster maken.

1. Klik op het algoritme Merge uit het menu GDAL ► Raster diversen.
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2. Gebruik, zoals we deden voor het Een virtueel raster maken, de knop … om te kiezen welke lagen u wilt
samenvoegen.
U kunt ook een Virtueel raster als invoer specificeren, en dan zullen alle rasters waaruit dat bestaat worden
verwerkt.

3. Als u de bibliotheek GDAL kent, kunt u ook uw eigen opties toevoegen door het menu Gevorderde parameters
te openen.
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7.1.4 Conclusie

QGIS maakt het eenvoudig om rastergegevens in uw huidige projecten op te nemen.

7.1.5 Wat volgt?

Vervolgens zullen we rastergegevens gebruiken die geen luchtfoto’s zĳn en zien hoe symboliseren ook handig is in het
geval van rasters.

7.2 Les: Symbologie van rasters wijzigen

Niet alle rastergegevens zĳn luchtfoto’s. Er zĳn vele andere vormen van rastergegevens en, in veel van deze gevallen,
is het essentieel om ze juist te symboliseren, zodat zĳ op de juiste manier zichtbaar en bruikbaar worden.
Het doel voor deze les De symbologie voor een rasterlaag wĳzigen.

7.2.1 ��� Probeer zelf:

1. Gebruik het paneel Browser en laadt srtm_41_19.tif, te vinden onder exercise_data/raster/
SRTM/.

2. Zoom naar het bereik van deze laag door er met rechts op te klikken in het paneel Lagen en te selecteren Op
kaartlaag inzoomen.

Deze gegevensset is een Digital Elevation Model (DEM). Het is een kaart van de hoogte van het terrein, wat ons
bĳvoorbeeld in staat stelt te zien waar de bergen en valleien zĳn.
Waar elke pixel van de gegevensset uit het vorige gedeelte kleurinformatie bevatte, in een DEM bevat elke pixel
waarden voor hoogte.
Als de DEM eenmaal is geladen, zult u zien dat het een weergave in grĳswaarden is:
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QGIS heeft automatisch de pixelwaarden van de afbeelding opgerekt om redenen van visualisatie en we zullen meer
leren over hoe dit werkt als we doorgaan.

7.2.2 ��� Volgen: Symbologie van rasterlagen wijzigen

U heeft twee verschillende opties om de symbologie van het raster te wĳzigen:
1. In het dialoogvenster Laageigenschappen, door met rechts te klikken op de laag in de boom met lagen en de

optie Eigenschappen te selecteren. Schakel dan over naar de tab Symbologie

2. Door te klikken op de knop Paneel Laag opmaken openen direct boven het paneel Lagen (sneltoets F7). Dit zal

het paneel Laag opmaken openen waar u kunt schakelen naar de tab Symbologie.
Kies de methode die uw voorkeur heeft om mee te werken.
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7.2.3 ��� Volgen: Enkelbands grijs

Wanneer u een rasterbestand laadt, is het geen fotoafbeelding zoals die uit het vorige gedeelte, de standaard stĳl is
ingesteld op een grĳswaarden kleurverloop.
Laten we enkele van de mogelĳkheden van deze renderer verkennen.

Het standaard kleurverloop Kleurovergang is ingesteld op Zwart naar wit, wat betekent dat pixels met lage
waarden zwart zĳn en pixels met hoge waarden zĳn wit. Probeer deze instelling te wĳzigen naar Wit naar zwart
en bekĳk de resultaten.
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Zeer belangrĳk is de parameter Contrastverbetering: standaard is die ingesteld op 'Stretch' tot MinMax, wat
betekent dat de pixelwaarden zĳn uitgestrekt tot de minimum- en maximumwaarden.
Kĳk naar het verschil met de verbetering (links) en zonder (rechts):

Maar wat zĳn de minimale en maximale waarden die zouden moeten worden gebruikt voor het uitrekken? Die
zĳn momenteel vermeld onder Instellingen min / max-waarden. Er zĳn veel manieren om de minimum- en
maximumwaarden te berekenen en te gebruiken voor het uitstrekken:

1. Door gebruiker gedefinieerd: u voert de waarden Min en Max handmatig in
2. Cumulatieve telling deel: dit is nuttig als u enkele extreem lage of hoge waarden hebt. Het deelt de 2% (of de

waarde die u kiest) van deze waarden
3. Min / max: de echte of geschatte minimum en maximum waarden van het raster;
4. Gemiddelde +/- standaard afwĳking: de waarden zullen worden berekend overeenkomstig de gemiddelde

waarde en de standaardafwĳking

7.2.4 ��� Volgen: Enkelbands pseudokleur

Grĳswaarden zĳn niet altĳd geweldige stĳlen voor rasterlagen. Laten we eens proberen de laag DEM wat meer kleur
te geven.

• Wĳzig het Rendertype naar een Enkelbands pseudokleur. Selecteer een ander Kleurverloop, als de geladen
standaardkleuren u niet bevallen

• Klik op de knop Classificeren om een nieuwe kleurclassificatie te maken
• Als het nog niet automatisch is gemaakt, klik dan op de knop OK om deze classificatie toe te passen op de
DEM
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U zult zien dat het raster er als volgt uitziet:
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Dit is een interessante manier om naar de DEM te kĳken. U zult nu zien dat de waarden van het raster weer opnieuw
juist zĳn weergegeven, van blauw voor de lagere gebieden naar rood voor de hogere.

7.2.5 Volgen: Transparantie wijzigen

Soms kan het wĳzigen van de transparantie van de gehele rasterlaag u helpen om andere lagen te zien die worden
bedekt door het raster zelf en het te bestuderen gebied beter te begrĳpen.
Schakel, om de transparantie van het gehele raster te wĳzigen, over naar de tab Transparantie en gebruik de schuif
van Globale doorzichtbaarheid om de opaciteit te verlagen:
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Nog interessanter is het wĳzigen van de transparantie van enkele pixelwaarden. Bĳvoorbeeld in het raster dat we
gebruikten kunt u een homogene kleur zien in de hoeken. Ga naar Aangepaste opties voor transparantie op de tab
Transparantie om deze pixels als transparant in te stellen.

• Door te klikken op de knop Voeg handmatig waarden in kunt u een bereik vanwaarden toevoegen en het percentage
voor hun transparantie instellen

• Voor enkele waarden is de knop Waarden uit weergave toevoegen nog nuttiger

• Klik op de knop Waarden uit weergave toevoegen. Het dialoogvenster verdwĳnt en u kunt interactief met de kaart
werken;

• Klik op de homogene kleur in een hoek van de DEM
• U zult zien dat de tabel van de transparantie wordt gevuld met de aangeklikte waarden:
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• Klik op OK om het dialoogvenster te sluiten en uw wĳzigingen te bekĳken.

Ziet u? De hoeken zĳn nu 100% transparant.
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7.2.6 Conclusie

Dit zĳn enkele van de basisfuncties om u te laten beginnen met symbologie voor rasters. QGIS geeft u nog veel
meer andere opties, zoals het symboliseren van een laag met paletten/unieke waarden die verschillende banden in
verschillende kleuren in eenmultispectrale afbeelding weergeven of een automatisch effect van schaduw op de heuvels
maken (alleen nuttig met rasterbestanden van DEM).

7.2.7 Verwijzing

De gegevensset van SRTM werd verkregen vanaf de website CGIAR CSI .

7.2.8 Wat volgt?

Nuwe kunnen zien dat onze gegevens juist zĳn weergegeven, kunnen we onderzoeken hoe ze verder zĳn te analyseren.

7.3 Les: Terreinanalyse

Bepaalde typen rasters stellen u in staat meer inzicht te verkrĳgen over het terrein dat zĳ weergeven. Digital
Elevation Models (DEM’s) zĳn in dit opzicht in het bĳzonder bruikbaar. In deze les zult u gereedschappen voor
terreinanalyses gebruiken om meer uit te vinden over het te bestuderen gebied voor het eerder voorgestelde te
ontwikkelen woongebied.
Het doel voor deze les: Gereedschappen voor terreinanalyses gebruiken om meer informatie over het terrein te
verkrĳgen.

7.3.1 ��� Volgen: Een schaduw voor heuvels berekenen

We gaan dezelfde DEM-laag gebruiken als in de vorige les. Als u nieuw aan dit hoofdstuk begint, gebruik dan het
paneel Browser en laad het bestand raster/SRTM/srtm_41_19.tif.
DeDEM-laag toont u de hoogten in het terrein, maar het kan er somswat abstract uitzien. Het bevat alle 3D-informatie
over het terrein die u nodig heeft, maar het ziet er niet uit als een 3D-object. Het is mogelĳk een schaduw voor heuvels
te berekenen, wat een raster is dat de kaart weergeeft met behulp van licht en een schaduw om het uiterlĳk van een
3D-afbeelding aan te nemen, om een betere indruk van het terrein te krĳgen.
We gaan de algoritmes in het menu Raster ► Raster terreinanalyse gebruiken.

1. Klik op het menu Schaduw voor heuvels

2. Het algoritme stelt u in staat de positie van de lichtbron te specificeren: Azimut heeft waarden van 0 (Noord)
via 90 (Oost), 180 (Zuid) en 270 (West), terwĳl de Verticale hoek instelt hoe hoog de lichtbron is (0 tot en met
90 graden).

3. We zullen de volgende waarden gebruiken:
• Z factor op 1.0
• Azimut (horizontale hoek) op 300.0°
• Verticale hoek op 40.0°
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4. Sla het bestand op in een nieuwe map exercise_data/raster_analysis/ met de naam
hillshade.tif

5. Klik tenslotte op Uitvoeren

U zult nu een nieuwe laag, genaamd hillshade, hebben die er uitziet zoals dit:
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Dat ziet er leuk en 3D uit, maar kunnen we dit verbeteren? Op zichzelf ziet de schaduw voor de heuvels er uit als een
gipsafdruk. Kunnen we het op een of andere manier gebruiken met onze, meer kleurrĳke, rasters? Natuurlĳk kunnen
we dat, door de schaduw voor de heuvels er overheen te leggen.

7.3.2 ��� Volgen: Een schaduw voor heuvels gebruiken als overleg

Een schaduw voor heuvels kan heel bruikbare informatie verschaffen over het zonlicht op een bepaald moment van de
dag. Maar het kan ook voor esthetische doeleinden gebruikt worden om de kaart er beter uit te laten zien. De sleutel
hiertoe is de schaduw voor de heuvels in te stellen op bĳna geheel transparant.

1. Wĳzig de symbologie van de originele laag srtm_41_19 om het schema Pseudokleur te gebruiken, zoals in de
eerdere oefening.

2. Verberg alle lagen met uitzondering van de lagen srtm_41_19 en hillshade.
3. Klik en sleep srtm_41_19 tot onder de laag hillshade in het paneel Lagen.
4. Stel de laag hillshade in op transparant door te klikken op de tab Transparantie in de Laageigenschappen.
5. Stel de Globale transparantie in op 50%:

U krĳgt een resultaat zoals dit:

6. Schakel de laag hillshade uit en weer in in het paneel Lagen om het verschil dat het maakt te zien.
Met het op deze manier gebruiken van een schaduw voor heuvels, is het mogelĳk de topografie van het landschap te
verbeteren. Als het effect voor u niet sterk genoeg lĳkt te zĳn, kunt u de transparantie van de laag hillshade vergroten;
maar natuurlĳk geldt: hoe helderder de schaduw van de heuvels wordt, hoe vager de kleuren erachter zullen zĳn. U
dient een balans te vinden die voor u werkt.
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Onthoud om het project op te slaan als u gereed bent.

7.3.3 Volgen: De beste gebieden zoeken

Denk even terug aan het probleem van de makelaar dat we bespraken in de les Vectoranalyse. Laten we ons eens
voorstellen dat de kopers een gebouw willen kopen en een kleinere woning willen bouwen op het land. We weten dat,
in de zuidelĳke hemisfeer, een ideaal gebied voor ontwikkeling gebieden erin moet hebben die:

• uitkĳken op het noorden
• met een helling van minder dan 5 graden
• Maar als de helling minder is dan 2 graden, dan is het aspect niet van belang.

Laten we de beste gebieden voor ze zoeken.

7.3.4 ��� Volgen: Helling berekenen

Helling informeert u over hoe steil het terrein is. Als u bĳvoorbeeld huizen wilt bouwen op het land daar, heeft u land
nodig dat relatief vlak is.
U moet het algoritme Helling van Processing ► Raster terreinanalyse gebruiken om de helling te berekenen.

1. Open het algoritme
2. Kies srtm_41_19 als de Hoogtelaag

3. Houd de Z factor op 1.0
4. Sla de uitvoer op als een bestand met de naam slope.tif in dezelfde map als de hillshade.tif
5. Klik op Uitvoeren

Nu zult u de helling van het terrein zien, elke pixel bevat de overeenkomende waarde voor de helling. Zwarte pixels
geven vlak terrein aan en witte pixels steil terrein:
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7.3.5 ��� Probeer zelf: Aspect berekenen

Aspect is de richting van het kompas waarop de helling van het terrein uitkĳkt. Een aspect van 0 betekent dat de
helling uitkĳkt op het noorden, 90 op het oosten, 180 op het zuiden en 270 op het westen.
Omdat deze studie plaatsvindt in de zuidelĳke hemisfeer, zouden gebouwen ideaal gesprokenmoeten worden gebouwd
op een helling die uitkĳkt op het noorden, zodat zĳ in het zonlicht blĳven.
Gebruik het algoritme Aspect van Processing ► Raster terreinanalyse om de laag aspect.tif te krĳgen en die op
te slaan naast slope.tif.

Antwoord
Stel uw dialoogvenster Aspect als volgt in:
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Uw resultaat:
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7.3.6 ��� Volgen: Aspect, dat uitkijkt op het noorden, zoeken

Nu heeft u rasters die u zowel de helling als het aspect weergeven, maar u heeft geen manier om te weten te komen
waar tegelĳkertĳd aan ideale voorwaarden wordt voldaan. Hoe zou deze analyse worden uitgevoerd?
Het antwoord ligt in de Rasterberekeningen.
QGIS heeft verschillende rasterberekeningen beschikbaar:

• Raster ► Rasterberekeningen

• In Processing:
– Rasteranalyse ► Raster calculator

– GDAL ► Raster diversen ► Rasterberekeningen

– SAGA ► Raster calculus ► Raster calculator

Elk gereedschap leidt tot dezelfde resultaten, maar de syntaxis kan enigszins verschillen en de beschikbaarheid van
operatoren kan variëren.
We zullen Rasteranalyse ► Raster calculator in de Toolbox van Processing gebruiken

1. Open het gereedschap door er dubbel op te klikken.
• Het bovenste gedeelte aan de linkerkant van het dialoogvenster vermeldt alle geladen rasterlagen als
name@N waar name de naam is van de laag en N de band is.

• In het bovenste gedeelte aan de rechterkant ziet u veel verschillende operatoren. Neem even de tĳd om
er aan te denken dat een raster een afbeelding is. U zou het moeten zien als een 2D-matrix, gevuld met
getallen.

2. Noord ligt op 0 (nul) graden, dus voor het terrein dat op het noorden uitkĳkt moet het aspect groter zĳn dan
270 graden of minder dan 90 graden. Daarom is de formule:

aspect@1 <= 90 OR aspect@1 >= 270

3. Nu dient u de details voor het raster in te stellen, zoals de celgrootte, bereik en CRS. Dat kan handmatig
worden gedaan of het kan automatisch worden ingesteld door een Referentielaag te kiezen. Kies voor
deze laatste optie door te klikken op de knop… naast de parameter Reference layer(s).

4. Kies in het dialoogvenster voor de laag aspect, omdat we een laag willen met dezelfde resolutie.
5. Sla de laag op als aspect_north.tif.

Het dialoogvenster zou er nu zo uit moeten zien:
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6. Klik tenslotte op Uitvoeren.
Uw resultaat zal dit zĳn:
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De waarden voor de uitvoer zĳn 0 of 1. Wat betekent dat? Voor elke pixel in het raster geeft de formule die we
schreven terug of die overeenkomt met de voorwaarden of niet. Daarom zal het uiteindelĳke resultaat False (0) en
True (1) zĳn.

7.3.7 ��� Probeer zelf: Meer criteria

Nu u het aspect heeft gedaan, maak twee nieuwe lagen uit de DEM.
• De eerste zal gebieden identificeren waar de helling minder is dan of gelĳk is aan 2 graden.
• De tweede is soortgelĳk, maar de helling zou minder of gelĳk moeten zĳn aan 5 graden.
• Sla ze op onder exercise_data/raster_analysis/ als slope_lte2.tif en slope_lte5.
tif.

Antwoord
• Stel uw dialoogvenster Raster calculator als volgt in:
• de volgende expressie: slope@1 <= 2

• de laag slope als de Verwĳzingslaag

7.3. Les: Terreinanalyse 275



QGIS Training Manual

• Voor de versie met 5 graden, vervang de 2 in de expressie en benoem het bestand met 5.
Uw resultaten:

• 2 graden:
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• 5 graden:
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7.3.8 ��� Volgen: Resultaten van rasteranalyse combineren

Nu heeft u drie rasterlagen gemaakt uit de DEM:
• aspect_north: het terrein kĳkt uit op het noorden
• slope_lte2: de helling is 2 graden of minder
• slope_lte5: de helling is 5 graden of minder

Waar aan de voorwaarde wordt voldaan, is de pixelwaarde 1. Ergens anders is het 0. Daarom, als u deze rasters
vermenigvuldigt, zullen de pixels, die een waarde van 1 voor allemaal hebben, een waarde van 1 krĳgen (de rest zal
0 krĳgen).
De voorwaarden, waaraan moet worden voldaan, zĳn:

• gelĳk aan of minder dan 5 graden helling, het terrein moet op het noorden liggen
• gelĳk aan of minder dan 2 graden helling, de richting waarop het terrein uitkĳkt is niet van belang.

Daarommoet u zoeken naar gebieden waar de helling vĳf graden of minder is AND het terrein uitkĳkt op het noorden;
OR de helling is 2 graden of minder. Dergelĳk terrein zou geschikt zĳn voor ontwikkeling.
De gebieden berekenen die voldoen aan deze criteria:

1. Open opnieuw de Raster calculator opnieuw
2. Gebruik deze expressie in Expressie:
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( aspect_north@1 = 1 AND slope_lte5@1 = 1 ) OR slope_lte2@1 = 1

3. Stel de parameter Reference layer(s) in als aspect_north (het maakt niet uit of u een andere kiest - zĳ zĳn
allemaal berekend vanuit srtm_41_19)

4. Sla de uitvoer op onder exercise_data/raster_analysis/ als all_conditions.tif.
5. Klik op Uitvoeren

Het resultaat:

Hint: De eerdere stappen zouden kunnen worden vereenvoudigd met de volgende opdracht:

((aspect@1 <= 90 OR aspect@1 >= 270) AND slope@1 <= 5) OR slope@1 <= 2
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7.3.9 ��� Volgen: Het raster vereenvoudigen

Zoals u in bovenstaande afbeelding kunt zien, staan in de gecombineerde analyse vele kleine gebieden die voldoen
aan de voorwaarden (in wit). Maar deze zĳn niet echt bruikbaar voor onze analyse, omdat ze te klein zĳn om er iets
op te bouwen. Laten we deze kleine onbruikbare gebieden verwĳderen.

1. Open het gereedschap Sieve (GDAL ► Rasteranalyse in de Toolbox van Processing)
2. Stel Invoerlaag in op all_conditions, en Gezeefd op all_conditions_sieve.tif (onder

exercise_data/raster_analysis/).
3. Stel Drempel in op 8 (minimaal acht aaneengesloten pixels), en selecteer 8-connectedness gebruiken.

Als de verwerking is voltooid, zal de nieuwe laag worden geladen.
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Wat is er aan de hand? Het antwoord ligt in de metadata van het nieuwe rasterbestand.
4. Bekĳk de metadata onder de tab Informatie van het dialoogvenster Laageigenschappen. Kĳk naar de waarde

STATISTICS_MINIMUM:
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Dit raster, net zoals die waaruit het is afgeleid, zou alleen de waarden 1 en 0 zou moeten hebben, maar het
heeft ook een heel groot negatief getal. Onderzoek van de gegevens geeft aan dat dit getal optreedt als een
waarde null. Omdat we alleen gebieden willen die niet uitgefilterd werden, zullen we deze waarden null op nul
instellen.

5. Open de Raster calculator en bouw deze expressie:

(all_conditions_sieve@1 <= 0) = 0

Dit zal alle niet-negatieve waarden behouden, en de negatieve getallen instellen op nul, wat alle gebieden met
de waarde 1 intact zal laten.

6. Sla de uitvoer op onder exercise_data/raster_analysis/ als all_conditions_simple.
tif.

Uw uitvoer ziet er uit zoals dit:

Dit is wat er verwacht werd: een vereenvoudigde versie van de eerdere resultaten. Onthoud dat als de resultaten die u
van een gereedschap krĳgt niet zĳn wat u er van verwacht, het bekĳken van de metadata (en vectorattributen indien
van toepassing) essentieel kan blĳken te zĳn om het probleem op te lossen.

7.3.10 ��� Volgen: Het raster opnieuw classificeren

We hebben het gereedschap Raster calculator gebruikt om berekeningen op rasterlagen te maken. Er is nog een ander
krachtig gereedschap dat we kunnen gebruiken om informatie uit bestaande lagen uit te nemen.
Terug naar de laag aspect. We weten nu dat die numerieke waarden heeft in het bereik van 0 tot en met 360.
Wat we willen doen is om deze laag opnieuw te classificeren naar andere afzonderlĳke waarden (van 1 tot en met 4),
afhankelĳk van het aspect:

• 1 = Noord (van 0 tot 45 en van 315 tot 360);
• 2 = Oost (van 45 tot 135)
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• 3 = Zuid (van 135 tot 225)
• 4 = West (van 225 tot 315)

Deze bewerking kan worden uitgevoerd met de Raster calculator, maar de formule zou enorm lang worden.
Het alternatieve gereedschap is het gereedschap Opnieuw classificeren op tabel in Rasteranalyse in de Toolbox van
Processing.

1. Open het gereedschap
2. Kies aspect als de Rasterlaag
3. Klik op de … van Tabel voor opnieuw classificeren. Een tabel-achtig dialoogvenster zal openen waar u de

minimum, maximum en nieuwe waarden voor elke klasse kunt kiezen.
4. Klik op de knop Regel toevoegen en voeg 5 rĳen toe. Vul elke rĳ in zoals in de volgende afbeelding en klik op

OK:

De door het algoritme gebruikte methode, hoe de drempelwaarden van elke klasse te behandelen, wordt
gedefinieerd door Grenzen bereik.

5. Sla de laag op als reclassified.tif in de map exercise_data/raster_analysis/
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6. Klik op Uitvoeren

Wanneer u de eigen laag aspect vergelĳkt met de reclassified, zĳn er geen grote verschillen. Maar door eens naar de
legenda te kĳken, kunt u zien dat de waarden lopen van 1 tot en met 4 .
Laten we deze laag eens een betere stĳl geven.

1. Open het paneel Laag opmaken

2. Kies Gepaletteerd/Unieke waarden, in plaats van Enkelbands grĳs
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3. Klik op de knop Classificeren om automatisch de waarden op te halen en ze nieuwe willekeurige kleuren toe te
wĳzen:

De uitvoer zou er nu ongeveer zo uit moeten zien (u kunt andere kleuren hebben omdat die willekeurig werden
gemaakt):
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Met dit opnieuw classificeren en de toegepaste gepaletteerde stĳl op de laag kunt u direct de gebieden van aspect
onderscheiden.

7.3.11 ��� Volgen: Het raster bevragen

Anders dan vectorlagen hebben rasterlagen geen attributentabel. Elke pixel bevat één of meer numerieke waarden
(afhankelĳk van enkelbands of multiband rasters).
Alle rasterlagen die we gebruikten in deze oefening bestaan uit slechts één enkele band. Afhankelĳk van de laag
zouden pixelwaarden de waarden voor hoogte, aspect of helling weer kunnen geven.

Hoe kunnen we de rasterlaag bevragen om de waarde van één enkele pixel op te halen? We kunnen de knop
Objecten identificeren gebruiken!

1. Selecteer het gereedschap op de werkbalk Attributen.
2. Klik op een willekeurige locatie op de laag srtm_41_19. Identificatieresultaten zal verschĳnen met de waarde

van de band op de aangeklikte locatie:
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3. U kunt de uitvoer van het paneel Identificatieresultaten wĳzigen van de huidige modus boom naar een tabel
door Tabel te selecteren in het menuWeergave aan de onderzĳde van het paneel:

Klikken op elke pixel om de waarde van het raster te verkrĳgen zou op den duur vervelend kunnen worden. We
kunnen de plug-in Value Tool gebruiken om dit probleem op te lossen.

1. Ga naar Plug-ins ► Plug-ins beheren en installeren…

2. Typ, op de tab Alles, value t in het zoekvak
3. Selecteer de plug-in Value Tool, druk op Plug-in installeren en dan Close het dialoogvenster.
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Het nieuwe paneel Value Tool zal verschĳnen.

Tip: Als u het paneel sluit kunt u het opnieuw openen door het in te schakelen in het menu Beeld ► Panelen
► Value Tool of door te klikken op het nieuwe pictogram op de werkbalk.

4. Selecteer, om de plug-in te gebruiken, het keuzevak Enable en zorg er voor dat de laag srtm_41_19 actief
(geselecteerd) is in het paneel Lagen.

5. Verplaats de cursor over de kaart om direct de waarde van de pixels te zien.
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6. Maar er is meer. De plug-in Value Tool maakt het voor u mogelĳk alle actieve rasterlagen in het paneel Lagen
te bevragen. Stel de lagen aspect en slope opnieuw in als actief en ga met de muis over de kaart:

7.3.12 Conclusie

U heeft gezien hoe u alle soorten analyseproducten uit een DEM kunt halen. Dit omvat berekeningen voor schaduw
voor heuvels, helling en aspect. U heeft ook gezien hoe de rasterberekeningen te gebruiken voor verdere analyses
en het combineren van deze resultaten. Tenslotte leerde u hoe een laag opnieuw te classificeren en de resultaten te
bevragen.

7.3.13 Wat volgt?

Nu heeft u twee analyses: de vectoranalyse die u de potentieel geschikte bouwplaatsen laat zien, en de rasteranalyse die
u het potentieel geschikte terrein laat zien. Hoe kunnen deze worden gecombineerd om tot een uiteindelĳk resultaat
voor dit rp0obleem te komen? Dat is het onderwerp voor de volgende les, die begint in de volgende module.
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Module: De analyse completeren

U heeft nu twee halve analyses: een gedeelte vector en een gedeelte raster. In deze module zult u zien hoe ze te
combineren. U zult de analyse voltooien en de uiteindelĳke resultaten presenteren.

8.1 Les: Conversie van raster naar vector

Converteren tussen de indelingen raster en vector stelt u in staat gebruik te maken van zowel raster- als vectorgegevens
bĳ het oplossen van een probleem in GIS, als ook het gebruiken van de verschillende methoden voor analyse uniek
voor deze twee vormen van geografische gegevens. Dit vergroot de flexibiliteit die u heeft voor het overwegen van
gegevensbronnen en verwerkingsmethoden voor het oplossen van een probleem in GIS.
U moet het ene type gegevens converteren naar het andere om een raster- en vectoranalyse te combineren. Laten we
het rasterresultaat uit de vorige les converteren naar een vector.
Het doel voor deze les: Het rasterresultaat in een vector krĳgen die kan worden gebruikt om de analyse te voltooien.

8.1.1 ��� Volgen: Gereedschap Raster naar vector

Begin met de kaart uit de vorige module, raster_analysis.qgs. Daar zou u all_conditions_simple.
tif moeten hebben die werd berekend gedurende de vorige oefeningen.

• Klik op Raster ► Conversie ► Vectoriseren (Raster naar vector). Het dialoogvenster van het gereedschap zal
verschĳnen.

• Stel het in zoals dit:
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• Wĳzig de veldnaam (die de waarden van het raster beschrĳft) naar suitable.
• Sla de laag op onder exercise_data/residential_development als all_terrain.shp.

Nu heeft u een vectorbestand dat alle waarden van het raster bevat, maar de enige gebieden waarin u geïnteresseerd
bent zĳn die welke geschikt zĳn; d.i. die polygonen waarvan de waarde van suitable 1 is. U kunt de stĳl van deze laag
wĳzigen als u een betere visualisatie ervan wilt.

8.1.2 ��� Probeer zelf:

Bekĳk de module over vectoranalyse nog eens.
• Maak een nieuw vectorbestand dat alleen de polygonen bevat waar suitable de waarde 1 heeft.
• Sla het nieuwe bestand op onder exercise_data/residential_development/ als
suitable_terrain.shp.

Antwoord
1. Open de Querybouwer door met rechts te klikken op de laag all_terrain in het paneel Lagen, en selecteer de

tab Eigenschappen ► Bron.
2. Bouw dan de query "suitable" = 1.
3. Klik op OK om alle polygonen eruit te filteren die niet voldoen aan deze voorwaarde. Wanneer bekeken over

het originele raster, zouden de gebieden perfect moeten overlappen:
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4. U kunt deze laag opslaan door met rechts te klikken op de laag all_terrain in het paneel Lagen en te kiezen
Opslaan als…, en dan door te gaan zoals in de instructies staat.

8.1.3 ��� Volgen: Gereedschap Vector naar raster

Hoewel niet nodig voor ons huidige probleem, is het handig om de tegengestelde conversie van die welke we hiervoor
hebben uitgevoerd te kennen. Converteer het vectorbestand suitable_terrain.shp dat u zojuist in de vorige
stap heeft gemaakt naar raster.

• Klik op Raster ► Conversie ► Rasteriseren (Vector naar raster) om dit gereedschap te starten, en stel het dan
in zoals in de schermafdruk hieronder:
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• Invoerlaag is all_terrain.
• Veldnaam is suitable.
• Eenheden grootte uitvoerraster is Pixels.
• Breedte en Hoogte zĳn respectievelĳk 837 en 661.
• Haal het Uitvoerbereik op vanaf de laag all_terrain.
• Stel uitvoerbestand Gerasteriseerd in op exercise_data/residential_development/
raster_conversion.tif.

Notitie: De grootte van de uitgevoerde afbeelding is hier gespecificeerd om hetzelfde te zĳn als het originele raster
dat werd geconverteerd naar een vector. Open de metadata (tabMetadata in de Laag-eigenschappn) om de dimensies
van een afbeelding te bekĳken.

• Klik op OK in het dialoogvenster om het conversieproces te beginnen.
• Wanneer het voltooid is, bewonder dan het succes door het nieuwe raster te vergelĳken met het originele. Zĳ
zouden exact gelĳk moeten zĳn, pixel voor pixel.
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8.1.4 Conclusie

Converteren tussen indelingen voor raster en vector stelt u in sraat de toepasbaarheid van gegevens te vergroten en
hoeft niet te leiden tot verlies van gegevens.

8.1.5 Wat volgt?

Nu we de resultaten van de terreinanalyse beschikbaar hebben in vectorindeling, kunnen zĳ worden gebruikt om het
probleem op te lossen van welke gebouwen te overwegen voor de stedelĳke ontwikkeling.

8.2 Les: Combineren van de analyses

Het gebruiken van de gevectoriseerde resultaten van de rasteranalyse stelt u in staat alleen die gebouwen te selecteren
die op geschikt terrein staan.
Het doel voor deze les: De gevectoriseerde terreinresultaten gebruiken om geschikte bouwplaatsen te selecteren.

8.2.1 ��� Probeer zelf:

1. Sla uw huidige kaart op (raster_analysis.qgs).
2. Open de kaart waarin eerder de vectoranalyse is uitgevoerd (u zou het bestand moeten hebben opgeslagen als

analysis.qgs).
3. Schakel, in het paneel Lagen, deze lagen in:

• hillshade,
• solution (of buildings_over_100)

4. In aanvulling op deze lagen, die al in de kaart zouden moeten zĳn geladen van toen u daarin nog werkte, voeg
ook de gegevensset suitable_terrain.shp toe.

5. Als u enkele lagen mist zou u ze moeten vinden in exercise_data/residential_development/
6. Gebruik het gereedschap Kruising (Vector► Geoprocessing-gereedschap) om een nieuwe vectorlaag, genaamd

new_solution.shp, te maken die alleen die gebouwen bevat die kruisen met de laag suitable_terrain.
U zou nu een laag moeten hebben die bepaalde gebouwen als uw oplossing laat zien, bĳvoorbeeld:
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8.2.2 ��� Probeer zelf: De resultaten inspecteren

Kĳk naar elk gebouw in uw laag new_solution. Vergelĳk ze met de laag suitable_terrain door de symbologie voor de
laag new_solution te veranderen zodat het alleen de omtrekken heeft. Wat valt u op aan sommige gebouwen? Zĳn zĳ
alleen geschikt omdat zĳ kruisen met de laag suitable_terrain? Waarom wel of waarom niet? Welke zou u beoordelen
als ongeschikt?

Antwoord
Het zou u kunnen zĳn opgevallen dat enkele gebouwen in uw laag new_solution “in plakjes zĳn gesneden” door
het gereedschap Kruising. Dit laat zien dat slechts een gedeelte van het gebouw - en daarom alleen een gedeelte van
het eigendom - ligt op geschikt terrein. We kunnen daarom met reden die gebouwen elimineren uit onze gegevensset.

8.2.3 ��� Probeer zelf: De analyse verfijnen

U kunt uit de resultaten aflezen dat sommig gebouwen die werden opgenomen niet echt geschikt waren, dus kunnen
we nu de analyse verfĳnen.
We willen er zeker van zĳn dat onze analyse alleen die gebouwen oplevert die geheel binnen de laag suitable_terrain
vallen. Hoe zou u dit bereiken? Gebruik één of meer gereedschappen voor Vectoranalyse en onthoud dat onze
gebouwen allemaal groter zĳn dan 100 m².

Antwoord
Op dit moment zou uw analyse er ongeveer zo uit moeten zien:
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Overweeg een rond gebied, voor 100 meter aaneengesloten in alle richtingen.

Als het groter is dan 100 meter in straal, dan zal het aftrekken van 100 meter van de grootte (in alle richtingen)
resulteren in een deel in het midden wordt overgelaten.
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Daarom kunt u een interner buffer van 100 meter op uw bestaande laag suitable_terrain uitvoeren. De uitvoer van de
functie Buffer zal, alles wat overblĳft van de originele laag, gebieden weergeven waarnaast geschikt terrein is voor
minstens 100 meter breed.
Ter demonstratie:

1. Ga naar Vector ► Geoprocessing-gereedschap ► Buffer… om het dialoogvenster Buffer te openen.
2. Stel het in zoals dit:
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3. Gebruik de laag suitable_terrain met 10 segmenten en een afstand voor de buffer van -100. (De afstand is
automatisch in meters, omdat uw kaart een geprojecteerd CRS gebruikt.)

4. Sla het uitvoerbestand op onder exercise_data/residential_development/ als
suitable_terrain_continuous100m.shp.

5. Verplaats, indien nodig, de nieuwe laag tot boven uw originele laag suitable_terrain.
Uw resultaten zullen er ongeveer zo uitzien:
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6. Gebruik nu het gereedschap Selecteren op plaats (Vector ► Onderzoeks-gereedschap ► Selecteren op plaats).
7. Stel het als volgt in:

8. Selecteer objecten in new_solution die kruisen met objecten in suitable_terrain_continuous100m.shp.
Dit is het resultaat:

300 Hoofdstuk 8. Module: De analyse completeren



QGIS Training Manual

De gele gebouwen zĳn geselecteerd. Hoewel sommige van de gebouwen gedeeltelĳk buiten de nieuwe laag
suitable_terrain_continuous100m vallen, liggen zĳ wel binnen de originele laag suitable_terrain en voldoen
daarom aan al onze eisen.

9. Sla de selectie op onder exercise_data/residential_development/ als final_answer.
shp.

8.2.4 Conclusie

U heeft nu de originele onderzoeksvraag beantwoord, en kunt een mening bieden (met redenen omkleed,
geruggesteund door de analyses) voor een aanbeveling met betrekking tot welk gedeelte te ontwikkelen.

8.2.5 Wat volgt?

Vervolgens zult u deze resultaten presenteren als deel van uw tweede opdracht.

8.3 Opdracht

Maak, met behulp van de afdruklay-out, een nieuwe kaart die de resultaten van uw analyse weergeeft. Neem deze
lagen er in op:

• places (met labels),
• hillshade,
• solution (of new_solution),
• roads en
• ofwel aerial_photos of DEM.
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Schrĳf een korte verklarende tekst om erbĳ te voegen. Neem in die tekst de criteria op die werden gebruikt in de
overweging om een huis aan te kopen en aanvullend te ontwikkelen, als ook een verklaring voor uw aanbeveling over
welke gebouwen geschikt zĳn.

8.4 Les: Extra oefening

In deze les zult u door een volledige analyse in QGIS worden geleid.

Notitie: Les ontwikkeld door Linfiniti Consulting (Zuid-Afrika) en Siddique Motala (Cape Peninsula University of
Technology)

8.4.1 Definitie van het probleem

U krĳgt de taak om gebieden in en rondom Cape Peninsula te vinden die een geschikte woonomgeving zĳn voor een
zeldzame fĳnbos plantensoort. Het bereik van uw onderzoeksgebied bedekt Kaapstad en de Cape Peninsula tussen
Melkbosstrand in het noorden en Strand in het zuiden. Botanisten hebben u voorzien van de volgende voorkeuren
voor de betreffende plantensoort:

• Het groeit op hellingen die uitkĳken op het oosten
• Het groeit op hellingen met een verloop tussen 15% en 60%
• Het groeit in gebieden die een totale jaarlĳkse regenval hebben van > 1000 mm
• Het kan alleen worden gevonden op een afstand van tenminste 250 m van een menselĳke nederzetting
• Het gebied met vegetatie waarin het voorkomt zou tenminste een omvang moeten hebben van 6000m2

Als student aan de universiteit heeft u er in toegestemd de plant te zoeken op vier verschillende geschikte stukken
land vanaf uw. U wilt de vier geschikte gebieden gebruiken die het dichtst bĳ de Universiteit van Kaapstad zĳn, ten
opzichte van waar u woont. Gebruik uw vaardigheden in GIS om te bepalen waar u zou moeten zoeken.

8.4.2 Overzicht van de oplossing

De gegevens voor deze oefening zĳn te vinden in de map exercise_data/more_analysis.
U gaat de vier meest geschikte gebieden zoeken die het dichtst bĳ de universiteit van Kaapstad liggen.
De oplossing zal omvatten:

1. Analyseren van een DEM om de hellingen te zoeken die uitkĳken op het oosten en de hellingen met het juiste
verloop

2. Analyseren van een raster voor de regenval om de gebieden te vinden met de juiste hoeveelheid regen
3. Analyseren van de vectorlaag Zoning om gebieden te vinden die verwĳderd liggen van menselĳke

nederzettingen en van de juiste grootte zĳn
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8.4.3 Volgen: Instellen van de kaart

1. Klik op de knop Huidig CRS in de uiterste rechterbenedenhoek van het scherm. Gebruikg, onder de tab CRS
van het scherm dat verschĳnt, het gereedschap “Filter” om te zoeken naar “33S”. Selecteer het itemWGS 84 /
UTM zone 33S (met EPSG-code 32733).

2. Klik op OK

Fig. 8.1: Instellen van het CRS

3. Sla het project op door te klikken op de knop op de werkbalk Project opslaan, of gebruik het menu-item Project
► Opslaan als….
Sla het op in een nieuwe map genaamd Rasterprac, die u ergens op uw computer zou moeten maken. U
zou in die map ook alle lagen die u maakt moeten opslaan. Sla het project op als uw_naam_fynbos.qgs.
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8.4.4 Gegevens in de kaart laden

In order to process the data, you will need to load the necessary layers (street names, zones, rainfall, DEM, districts)
into the map canvas.

Voor vectors…

1. Klik op de knop Databronnen beheren openen op de werkbalk Databronnen beheren en schakel naar de tab
Vector in het dialoogvenster dat verschĳnt, of gebruik het menuitem Kaartlagen ► Laag toevoegen ►
Vectorlaag toevoegen….

2. Zorg er voor dat Bestand is geselecteerd
3. Klik op de knop… om te bladeren naar vector gegevensset(s)
4. Open, in het dialoogvenster dat verschĳnt, de map exercise_data/more_analysis/Streets.
5. Selecteer het bestand Street_Names_UTM33S.shp
6. Klik op Openen.

Het dialoogvenster sluit en geeft het originele dialoogvenster weer, met het bestandspad gespecificeerd in het
tekstveld naast Vector databron(nen). Dit stelt u in staat er voor te zorgen dat het juiste bestand is geselecteerd.
Het is ook mogelĳk het bestandspad handmatig in het veld in te voeren, als u dat zou willen.

7. Klik op Toevoegen. De vectorlaag zal worden geladen in uw kaart. De kleur ervan wordt automatisch
toegewezen. U zult die later wĳzigen.

8. Hernoem de laag naar Streets
1. Klik er met rechts op in het paneel Lagen (standaard is dat het paneel aan de linkerkant van het scherm)
2. Klik op Laag hernoemen in het dialoogvenster dat verschĳnt en hernoem het, druk op de toets Enter

indien gereed
9. Herhaal het proces van het toevoegen van de vector, maar selecteer deze keer het bestand

Generalised_Zoning_Dissolve_UTM33S.shp in de map Zoning.
10. Hernoem het naar Zoning.
11. Laad ook de vectorlaag admin_boundaries/Western_Cape_UTM33S.shp in uw kaart.
12. Hernoem die naar Districts.

Voor rasters…

1. Klik op de knop Databronnen beheren openen en schakel naar de tab Raster in het dialoogvenster dat verschĳnt,
of gebruik het menuitem Kaartlagen ► Laag toevoegen ► Rasterlaag toevoegen…

2. Zorg er voor dat Bestand is geselecteerd
3. Navigeer naar het toepasselĳke bestand, selecteer het en klik op Openen

4. Doe dit voor elk van de twee rasterbestanden, DEM/SRTM.tif en Rainfall/reprojected/
rainfall.tif.

5. Hernoem het raster SRTM naar DEM en het raster voor de regenval naar Rainfall (met een hoofdletter aan
het begin)
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8.4.5 Wijzigen van de volgorde van lagen

Klik en sleep de lagen op en neer in het paneel Lagen om de volgorde waarin zĳ verschĳnen op de zodanig dat u
zoveel mogelĳk lagen kunt zien.
Nu alle gegevens zĳn geladen en op de juiste wĳze zichtbaar zĳn, kan de analyse beginnen. Het is het beste als de
bewerking clippen als eerste wordt uitgevoerd. Dit om er voor te zorgen dat er geen verwerkingskracht wordt verspilt
in het berekenen van waarden in gebieden die toch niet gebruikt gaan worden.

8.4.6 Zoek naar de juiste districten

Vanwege het eerder vermelde gebied van onderzoek moeten we onze districten beperken tot de volgende:
• Bellville

• Cape

• Goodwood

• Kuils River

• Mitchells Plain

• Simon Town

• Wynberg

1. Klik met rechts op de laag Districts in het paneel Lagen.
2. Selecteer, in het menu dat verschĳnt, het menu-item Filteren…. Het dialoogvenster Querybouwer verschĳnt.
3. U zult nu een query gaan bouwen om alleen de kandidaat-districten te selecteren:

1. Dubbelklik, in de lĳst Velden, op het veld NAME_2 om het te laten verschĳnen in het tekstveld Provider-
specifieke filter-expressie onderin

2. Klik op de knop IN om het toe te voegen aan de SQL-query
3. Open de haakjes
4. Klik op de knop Alles onder de (momenteel lege) lĳstWaarden.

Na korte tĳd zal dit de lĳstWaarden vullen met de waarden van het geselecteerde veld (NAME_2).
5. Dubbelklik op de waarde Bellville in de lĳstWaarden om die toe te voegen aan de SQL-query.
6. Voeg een komma toe en dubbelklik om het district Cape toe te voegen
7. Herhaal de vorige stap voor de resterende districten
8. Sluit de haakjes

Fig. 8.2: Querybouwer
De uiteindelijke query zou moeten zijn (de volgorde van de districten binnen de haakjes is niet van belang):

"NAME_2" in ('Bellville', 'Cape', 'Goodwood', 'Kuils River',
'Mitchells Plain', 'Simon Town', 'Wynberg')

Notitie: U zou ook de operator OR kunnen gebruiken, de query zou er dan zo uitzien:

"NAME_2" = 'Bellville' OR "NAME_2" = 'Cape' OR
"NAME_2" = 'Goodwood' OR "NAME_2" = 'Kuils River' OR
"NAME_2" = 'Mitchells Plain' OR "NAME_2" = 'Simon Town' OR
"NAME_2" = 'Wynberg'
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1. Klik twee keer op OK.
De in uw kaart weergegeven districten beperken zich nu tot die in de lĳst hierboven.

8.4.7 Clippen van de rasters

Nu u een beperkt gebied heeft, kunt u de rasters tot dit gebied clippen.
1. Open het dialoogvenster om te clippen door het menuitem Raster► Extractie► Raster op maskerlaag clippen…

te selecteren.
2. Selecteer, in de keuzelĳst Invoerlaag, de laag DEM.
3. Selecteer, in de keuzelĳst Maskeerlaag, de laag Districts.
4. Scroll naar beneden en specificeer een locatie voor de uitvoer in het tekstveld Geclipt (masker) door te klikken

op de knop Selecteren… en te kiezen voor. Opslaan als bestand…

1. Navigeer naar de map Rasterprac
2. Voer een bestandsnaam in - DEM_clipped.tif
3. Sla op

5. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

Laat, nadat de bewerking voor het clippen is voltooid, het dialoogvenster Raster op maskerlaag clippen open,
om in staat te zĳn het geclipte gebied opnieuw te gebruiken

7. Selecteer de rasterlaag Rainfall in de keuzelĳst Invoerlaag en sla uw uitvoer op als
Rainfall_clipped.tif

8. Wĳzig geen van de andere opties. Laat alles hetzelfde en klik op Uitvoeren.
9. Nadat de tweede bewerking om te clippen is voltooid, kunt u het dialoogvenster Raster op maskerlaag clippen

sluiten
10. Sla de kaart op
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Fig. 8.3: Kaartweergave met gefilterde vector, geclipt raster en opnieuw gesorteerde lagen

Uitlijnen van de rasters

Voor onze analyse moeten de rasters hetzelfde CRS hebben en moeten zĳ worden uitgelĳnd.
Eerst wĳzigen we de resolutie van onze gegevens voor de regenval naar 30 meter (pixelgrootte):

1. Zorg er voor dat, in het paneel Lagen, Rainfall_clipped de actieve laag is (d.i. hĳ is geaccentueerd door
erop te klikken)

2. Klik op het menu-item Raster ► Projecties ► Warp (opnieuw projecteren)… om het dialoogvenster Warp
(opnieuw projecteren)… te openen

3. Onder Te gebruiken methode voor resamplen, selecteer Bilineair (2x2 kernel) uit het keuzemenu
4. Stel Resolutie uitvoerbestand in geo-verwezen eenheden van doel in op 30
5. Scroll naar beneden naar Opnieuw geprojecteerd en sla de uitvoer op in uw map rainfall/reprojected

als Rainfall30.tif.
6. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd

Fig. 8.4: Warp (Opnieuw projecteren) Rainfall_clipped

Daarna lĳnen we de DEM uit:
1. Zorg er voor dat, in het paneel Lagen, DEM_clipped de actieve laag is (d.i. hĳ is geaccentueerd door erop

te klikken)
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2. Klik op het menu-item Raster ► Projecties ► Warp (opnieuw projecteren)… om het dialoogvenster Warp
(opnieuw projecteren)… te openen

3. Onder Doel-CRS, selecteer Project CRS: EPSG:32733 - WGS 84 / UTM zone 33S uit het keuzemenu
4. Onder Te gebruiken methode voor resamplen, selecteer Bilineair (2x2 kernel) uit het keuzemenu
5. Stel Resolutie uitvoerbestand in geo-verwezen eenheden van doel in op 30
6. Scroll naar beneden naar Temaken uitvoerbereiken met geo-verwĳzingen voor uitvoerbestand. Gebruik de knop

aan de rechterkant van het tekstvak om te selecteren Uit laag berekenen ► Rainfall30.
7. Scroll naar beneden naar Opnieuw geprojecteerd en sla de uitvoer op in uw map DEM/reprojected als

DEM30.tif.
8. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd

De symbologie voor de lagen moet gewĳzigd worden om op de juiste wĳze te kunen zien wat er gebeurt,

8.4.8 Wijzigen van de symbologie van vectorlagen

1. Klik met rechts, in het paneel Lagen, op de laag Streets

2. Selecteer Eigenschappen uit het menu dat tevoorschĳn komt
3. Schakel naar de tab Symbologie in het dialoogvenster dat verschĳnt
4. Klik op het item Lĳn in de bovenste widget
5. Selecteer een symbool uit de lĳst eronder of stel een nieuwe in (kleur, transparantie, …)
6. Klik op OK om het dialoogvenster Laageigenschappen te sluiten. Dit zal het renderen van de laag Streets

wĳzigen.
7. Volg een soortgelĳk proces voor de laag Zoning en kies er een toepasselĳke kleur voor

8.4.9 Wijzigen van de symbologie van rasterlagen

Symbologie voor rasterlagen is enigszins anders.
1. Open het dialoogvenster Laageigenschappen voor de rasterlaag Rainfall30

2. Schakel naar de tab Symbologie. U zult zien dat dit dialoogvenster voor de stĳl heel anders is dan de versie die
werd gebruikt voor vectorlagen.

3. Vergroot Instellingen min / max waarden

4. Zorg er voor dat de knop Gemiddelde +/- standaardafwĳking is geselecteerd
5. Zorg er voor dat de waarde in het toepasselĳke vak 2.00 is
6. Voor Contrastverbetering, zorg er voor dat er staat ‘Stretch’ tot MinMax

7. Voor Kleurovergang, wĳzig het naarWit naar zwart

8. Klik op OK

Fig. 8.5: Symbologie raster

Het raster “Rainfall30” zou, indien zichtbaar, van kleur moeten veranderen, wat u in staat stelt de verschillende
waarden voor helderheid voor elke pixel te zien

9. Herhaal dit proces voor de laag DEM30, maar stel de standaardafwĳking die moet worden gebruikt voor het
uitrekken in op 4.00.
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8.4.10 De kaart opruimen

1. Verwĳder de originele lagen Rainfall en DEM, als ook Rainfall_clipped en DEM_clipped, uit
het paneel Lagen:

• Klik met rechts op deze lagen en selecteer Verwĳder.

Notitie: Dit zal niet de gegevens uit uw opslagapparaat verwĳderen, ze worden alleen uit uw kaart
verwĳderd.

2. Sla de kaart op
3. U kunt nu de vectorlagen verbergen door het vak naast ze in het paneel Lagen leeg te maken. Dit zorgt er voor

dat de kaart sneller wordt gerenderd en u enige tĳd bespaart.

8.4.11 De schaduw voor heuvels maken

U zult een algoritme moeten gebruiken dat speciaal werd geschreven voor dit doel om de schaduw voor heuvels te
maken.

1. Zorg er voor dat, in het paneel Lagen, DEM30 de actieve laag is (d.i. hĳ is geaccentueerd door erop te klikken).
2. Klik op het menu-item Raster ► Analyse ► Schaduw voor heuvels… om het dialoogvenster Schaduw voor

heuvels te openen
3. Scroll naar beneden naar Schaduw voor heuvels en sla de gegevens op in uw map Rasterprac als

hillshade.tif

4. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
5. Klik op Uitvoeren

6. Wacht tot de verwerking is voltooid.

Fig. 8.6: Rasteranalyse Schaduw voor heuvels

De nieuwe laag hillshade is verschenen in het paneel Lagen.
1. Klik met rechts op de laag hillshade in het paneel Lagen en roep het dialoogvenster Eigenschappen op
2. Klik op de tab Transparantie en stel de schuifbalk Globale doorzichtbaarheid in op 20%
3. Klik op OK

4. Let op het effect als de transparante hillshade wordt weergegeven over de geclipte DEM. U zou misschien de
volgorde van uw lagen moeten wĳzigen, of de laag Rainfall30 uit moeten schakelen om het effect te zien.

8.4.12 Helling

1. Klik op het menu-item Raster ► Analyse ► Helling… om het dialoogvenster voor het algoritme Helling te
openen

2. Selecteer DEM30 als Invoerlaag

3. Selecteer Helling weergeven in procenten in plaats van in graden. Helling kan worden uitgedrukt in
verschillende eenheden (percentage of graden). Onze criteria suggereren dat de plant, waarin we geïnteresseerd
zĳn, groeit op hellingen met een verloop tussen 15% en 60%. We moeten er dus voor zorgen dat de gegevens
voor onze helling worden weergegeven als procenten.
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4. Specificeer een toepasselĳke bestandsnaam en locatie voor uw uitvoer.
5. Zorg er voor dat het vak Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

Fig. 8.7: Rasteranalyse Helling

De afbeelding voor de helling wordt berekend en toegevoegd aan de kaart. Zoals gewoonlĳk is het gerenderd in
grĳswaarden. Wĳzig de symbologie naar een meer kleurrĳke:

1. Open het dialoogvenster Eigenschappen voor de laag (zoals gewoonlĳk via het menu voor rechts-klikken van
de laag)

2. Klik op de tab Symbologie

3. Waar het zegt Enkelbands grĳs (in de keuzelĳst Rendertype), wĳzig die naar Enkelbands pseudokleur
4. Kies Gemiddelde +/- standaardafwĳking x voor Instellingen min / max waarden met een waarde van 2.0
5. Selecteer een geschikt Kleurverloop
6. Klik op Uitvoeren

8.4.13 Probeer zelf: Aspect

Gebruik dezelfde benadering als voor het berekenen van de helling, maar selecteer Aspect… in het menu Raster ►
Analyse.
Denk er aan om het project regelmatig op te slaan.

8.4.14 Rasters opnieuw classificeren

1. Kies Raster ► Rasterberekeningen…

2. Specificeer uw map Rasterprac als de locatie voor de Uitvoerlaag (klik op de knop …), en sla het op als
slope15_60.tif

3. Zorg er voor dat het vak Voeg resultaat toe aan project is geselecteerd.
In de lĳst Rasterbanden aan de linkerkant, ziet u alle rasterlagen in uw paneel Lagen. Als uw laag voor de helling
is genaamd slope, zal die zĳn vermeld als slope@1. Dat geeft band 1 van het raster slope aan.

4. De helling moet tussen 15 en 60 graden zĳn.
Bouw, met behulp van de items in de lĳst en de knoppen in de interface, de volgende expressie:

(slope@1 > 15) AND (slope@1 < 60)

5. Stel het veld Uitvoerbestand in op een toepasselĳke locatie en bestandsnaam.
6. Klik op Uitvoeren.

Fig. 8.8: Rasterberekeningen Helling

Zoek nu naar het juiste aspect (uitkĳkend op het oosten: tussen 45 en 135 graden) met behulp van dezelfde
benadering.
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1. Bouw de volgende expressie:

(aspect@1 > 45) AND (aspect@1 < 135)

U zult weten of het heeft gewerkt als alle hellingen die op het oosten uitkĳken wit zĳn gekleurd in het resulterende
raster (het lĳkt er bĳna op alsof zĳ worden verlicht door het zonlicht in de morgen).
Zoek op dezelfde manier naar de juiste regenval (meer dan 1000 mm). Gebruik de volgende expressie:

Rainfall30@1 > 1000

Nu u alle drie criteria elk in afzonderlĳke rasters heeft, moet u ze combineren om te zien welke gebieden voldoen
aan alle criteria. De rasters zullen met elkaar worden vermenigvuldigd om dat te doen. Wanneer dit gebeurt zullen
alle overlappende pixels met de waarde 1 de waarde 1 behouden (d.i. de locatie voldoet aan de criteria), maar als een
pixel in één van de drie rasters de waarde 0 heeft (d.i. de locatie voldoet niet aan de criteria), dan zal het 0 zĳn in het
resultaat. Op deze manier zal het resultaat alleen de overlappende gebieden bevatten die voldoen aan alle toepasselĳke
criteria.

8.4.15 Rasters combineren

1. Open de Rasterberekeningen (Raster ► Rasterberekeningen…)
2. Bouw de volgende expressie (met de toepasselĳke namen voor uw lagen):

[aspect45_135] * [slope15_60] * [rainfall_1000]

3. Stel de locatie voor de uitvoer in op de map Rasterprac
4. Noem het uitvoerraster aspect_slope_rainfall.tif

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

Het nieuwe raster geeft nu op de juiste manier de gebieden weer waar aan alle drie criteria wordt voldaan.
Sla het project op.

Fig. 8.9: Kaartweergave waar aan alle drie de criteria wordt voldaan

Het volgende criterium waaraan moet worden voldaan is dat het gebied 250 m van stedelĳke gebieden moet liggen.
We zullen aan dit vereiste voldoen door er voor te zorgen dat de gebieden die we berekenen binnen landelĳke gebieden
liggen en 250 m of meer vanaf de rand van het gebied ligt. Maar, dan moeten we wel eerst de landelĳke gebieden
zoeken.

8.4.16 Landelijke gebieden zoeken

1. Verberg alle lagen in het paneel Lagen
2. Geef de vectorlaag Zoning weer
3. Klik er met rechts op en open het dialoogvenster Attributentabel. Merk de vele verschillende manieren op

waarin het land is opgedeeld. We willen de landelĳke gebieden isoleren. Sluit de Attributentabel.
4. Klik met rechts op de laag Zoning en selecteer Filteren… om het dialoogvenster Querybouwer op te roepen
5. Bouw de volgende query:
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"Gen_Zoning" = 'Rural'

Bekĳk de eerdere instructies als u het even niet weet.
6. Klik op OK om het dialoogvenster Querybouwer te sluiten. De query zou één object terug moeten geven.

Querybouwer Zonering
U zou de polygonen voor landelĳke gebieden moeten zien uit de laag Zoning. U zult deze op moeten slaan.

1. Selecteer, in het contextmenu van Zoning, Exporteren ► Objecten opslaan als….
2. Sla uw laag op in de map Rasterprac
3. Noem het uitvoerbestand rural.shp
4. Klik op OK

5. Sla het project op
Nu moet u de gebieden uitsluiten die binnen 250m vanaf de rand van de landelĳke gebieden liggen. Doe dat door
een negatieve buffer te maken, zoals hieronder uitgelegd.

8.4.17 Een negatieve buffer maken

1. Klik op het menu-item Vector ► Geoprocessing-gereedschap ► Buffer…

2. Selecteer, in het dialoogvenster dat verschĳnt, de laag rural als uw invoer vectorlaag (Alleen geselecteerde
objecten gebruiken zou niet moeten zĳn geselecteerd)

3. Stel Afstand in op -250. De negatieve waarde betekent dat de buffer een interne buffer zal zĳn. Zorg er voor
dat in het keuzemenu de eenheden in meters zĳn.

4. Selecteer Resultaat samenvoegen

5. Plaats, in Gebufferd, het uitvoerbestand in de map Rasterprac, en noem het rural_buffer.shp
6. Klik op Opslaan

7. Klik op Uitvoeren en wacht tot de verwerking is voltooid
8. Sluit het dialoogvenster Buffer.

Zorg er voor dat uw buffer correct werkte door te zien hoe de laag rural_buffer verschilt van de laag
rural. U moet misschien de volgorde van tekenen veranderen om het verschil te kunnen zien.

9. Verwĳder de laag rural
10. Sla het project op
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Fig. 8.10: Kaartweergave met landelijke buffer

Nu moet u uw vectorlaag rural_buffer combineren met het raster aspect_slope_rainfall. We zullen
de gegevensindeling van een van de lagen moeten wĳzigen om ze te kunnen combineren. In dit geval zult u de raster
vectoriseren, omdat vectorlagen handiger zĳn als we gebieden willen berekenen.

8.4.18 Het raster vectoriseren

1. Klik op het menu-item Raster ► Conversie ► Polygoniseren (raster naar vector)….
2. Selecteer het raster aspect_slope_rainfall als Invoerlaag
3. Stel Naam van het te maken veld in op geschikt (de standaard veldnaam is DN - Digitaal nummergegevens)
4. Sla de uitvoer op. Onder Gevectoriseerd, selecteer Opslaan als bestand. Stel de locatie in op Rasterprac en

noem het bestand aspect_slope_rainfall_all.shp.

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Klik op Uitvoeren

7. Sluit het dialoogvenster als de verwerking voltooid is
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Fig. 8.11: Raster naar vector

Alle gebieden van het raster zĳn gevectoriseerd, dus u moet alleen de gebieden selecteren die de waarde 1 in het veld
suitable hebben. (Digital Number)

1. Open het dialoogvenster Querybouwer (klik met rechts op - Filteren…) voor de nieuwe vectorlaag
2. Bouw deze query:

"suitable" = 1

3. Klik op OK

4. Nadat u er zeker van bent dat de query voltooid is (en alleen de gebieden die voldoen aan alle drie criteria,
d.i. met een waarde van 1, zichtbaar zĳn), maak een nieuw vectorbestand uit de resultaten, met Exporteren ►
Objecten opslaan als… in het contextmenu van de laag

5. Sla het bestand op in de map Rasterprac
6. Noem het bestand aspect_slope_rainfall_1.shp
7. Verwĳder de laag aspect_slope_rainfall_all uit uw kaart
8. Sla uw project op

Wanneer we een algoritme gebruiken om een raster te vectoriseren, maakt het algoritme soms wat wordt genoemd
“Ongeldige geometrieën”, d.i. er zĳn lege polygonen, of polygonen met fouten erin, die in de toekomst moeilĳk te
analyseren zullen zĳn. We moeten dus het gereedschap “Geometrieën repareren” gebruiken.
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8.4.19 Geometrieën repareren

1. Zoek, in de Processing Toolbox, naar “Geometrieën repareren”, en druk op Uitvoeren…

2. Selecteer voor de Invoerlaag aspect_slope_rainfall_1
3. Onder Gerepareerde geometrieën, selecteer Opslaan als bestand. Stel de locatie in op Rasterprac en noem

het bestand fixed_aspect_slope_rainfall.shp.

4. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
5. Klik op Uitvoeren

6. Sluit het dialoogvenster als de verwerking voltooid is
Nu u het raster hebt gevectoriseerd, en de resulterende geometrieën hebt gerepareerd, kunt u de criteria voor ligging,
helling en regenval combineren met het criterium voor de afstand tot een menselĳke nederzetting door de kruisingen
te zoeken van de laag fixed_aspect_slope_rainfall en de laag rural_buffer.

8.4.20 Bepalen van de kruising van vectors

1. Klik op het menu-item Vector ► Geoprocessing-gereedschap ► Kruising…

2. Selecteer, in het dialoogvenster dat verschĳnt, de laag rural_buffer als Invoerlaag
3. Selecteer voor de Overleglaag de laag fixed_aspect_slope_rainfall
4. Plaats, in Kruising, het uitvoerbestand in de map Rasterprac
5. Noem het uitvoerbestand rural_aspect_slope_rainfall.shp
6. Klik op Opslaan

7. Klik op Uitvoeren en wacht tot de verwerking is voltooid
8. Sluit het dialoogvenster Kruising.

Zorg er voor dat het zoeken van de kruisingen juist heeft gewerkt door te zien dat alleen de overlappende
gebieden zĳn overgebleven.

9. Sla het project op
Het volgende criteria op de lĳst is dat het gebied groter moet zĳn dan 6000 m2. U zult nu de polygoon-gebieden
berekenen om de gebieden te identificeren die de juiste grootte hebben voor dit project.

8.4.21 Het gebied voor elke polygoon berekenen

1. Open het rechtsklik-menu van de nieuwe vectorlaag
2. Selecteer Attributentabel openen

3. Klik op de knop modus Bewerken aan-/uitzetten aan de linkerbovenzĳde van de tabel, of druk op Ctrl+e.

4. Klik op de knop Veldberekening openen op de werkbalk aan de bovenzĳde van de tabel, of druk op Ctrl+i

5. Zorg er voor dat, in het dialoogvenster dat verschĳnt, Nieuw veld aanmaken is geselecteerd, en stel de
Naam voor veld in op area. Het type voor het veld zou een decimaal getal (real) moeten zĳn. Stel Precisie in
op 1 (één decimaal).

6. Typ in het gebied Expressie:

$area
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Dit betekent dat de veldberekening het gebied van elke polygoon in de vectorlaag zal berekenen en ze dan zal
vermelden in een nieuwe kolom met een geheel getal (genaamd area) met de berekende waarde.

Fig. 8.12: Veldberekening

7. Klik op OK

8. Herhaal deze stap voor een ander veld genaamd id. Typ in het gebied Expressie:

$id

Dit zorgt er voor dat elke polygoon een unieke ID heeft ter identificatie.

9. Klik opnieuw op de knop modus Bewerken aan-/uitzetten en sla uw gegevens op als daarnaar gevraagd wordt
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Fig. 8.13: Attributentabel met kolommen area en id

8.4.22 Gebieden met een bepaalde grootte selecteren

Nu de gebieden bekend zĳn:
1. Bouw een query (zoals gewoonlĳk) om alleen de polygonen te selecteren die groter zĳn dan 6000 m². De

query is:

"area" > 6000

2. Sla de selectie op in de map Rasterprac als een nieuwe vectorlaag, genaamd suitable_areas.shp.
U heeft nu de geschikte gebieden die voldoen aan alle criteria voor de habitat van de zeldzame fynbos-plant, waaruit
u de vier gebieden kunt kiezen die het dichtst bĳ de universiteit van Kaapstad liggen.

8.4.23 Digitaliseren van de universiteit van Kaapstad

1. Maak, net als eerder, een nieuwe vectorlaag in de map Rasterprac, maar selecteer deze keer de waarde
Punt als Type geometrie en noem de laag university.shp

2. Zorg er voor dat het in het juiste CRS (Project CRS:EPSG:32733 - WGS 84 / UTM zone 33S)
staat

3. Voltooi het maken van de nieuwe laag (klik op OK)
4. Verberg alle lagen, met uitzondering van de nieuwe laag university en de laag Streets.
5. Voeg een achtergrondkaart toe (OSM):

1. Ga naar het paneel Browser en navigeer naar XYZ Tiles ► OpenStreetMap

2. Sleep en zet het item OpenStreetMap neer aan de onderzĳde van het paneel Lagen
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Zoek, met uw internetbrowser, de locatie op van de universiteit van Kaapstad. Gegeven de unieke topografie
van Kaapstad, is de universiteit een zeer herkenbare locatie. Onthoud, voordat u teruggaat naar QGIS, waar de
universiteit is gelegen en wat er in de buurt ligt.

6. Zorg er voor dat op de laag Streets is geklikt, en dat de laag university is geaccentueerd in het paneel
Lagen

7. Navigeer naar het menu-item Beeld ►Werkbalken en zorg er voor dat Digitaliseren is geselecteerd. U zou dan
een pictogram voor de werkbalk moeten zien met een potlood erop ( Bewerken aan-/uitzetten). Dat is de knop
Bewerken aan-/uitzetten.

8. Klik op de knop Bewerken aan-/uitzetten om naar demodus Bewerken te gaan. Dat stelt u in staat een vectorlaag
te bewerken

9. Klik op de knop Object Punt toevoegen, die dichtbĳ de knop Bewerken aan/uitzetten zou moeten staan
10. Met het gereedschap Object Punt toevoegen geactiveerd, klik met links op uw beste schatting voor de locatie

van de universiteit van Kaapstad
11. Geef een uniek geheel getal op als daarnaar gevraagd wordt voor de id
12. Klik op OK

13. Klik op de knop Wĳzigingen laag opslaan

14. Klik op de knop Bewerken aan-/uitzetten om uw sessie voor bewerkingen te beëindigen
15. Sla het project op

8.4.24 Zoek de locaties die het dichtst bij de universiteit van Kaapstad liggen

1. Ga naar de Toolbox van Processing, zoek naar het algoritme Koppel attributen op dichtstbĳzĳnde (Vector
algemeen ► Koppel attributen op dichtstbĳzĳnde) en voer het uit

2. Invoerlaag zou university moeten zĳn, en Invoerlaag 2 suitable_areas

3. Stel een toepasselĳke locatie voor de uitvoer en een naam in (Samengevoegde laag)
4. Stel Maximum dichtstbĳzĳnde buren in op 4

5. Zorg er voor dat Uitvoerbestand openen na uitvoeren algoritme is geselecteerd
6. Laat de rest van de parameters op hun standaard instellingen staan
7. Klik op Uitvoeren

De resulterende puntenlaag zal vier objecten bevatten - zĳ zullen allemaal de locatie van de universiteit hebben en de
attributen daarvan, en, in aanvulling daarop, de attributen van de nabĳgelegen geschikte gebieden (inclusief de id),
en de afstand tot die locatie.

1. Open de attributentabel van het resultaat van het samenvoegen
2. Onthoud de id van de vier meest nabĳ gelegen geschikte gebieden, en sluit dan de attributentabel
3. Open de attributentabel van de laag suitable_areas
4. Bouw een query om alleen de vier geschikte gebieden te selecteren die het dichtst bĳ de universiteit liggen

(selecteer ze met het veld id)
Dit is het uiteindelĳke antwoord op de onderzoeksvraag.
Maak, voor als u het inlevert, een volledig gelabelde lay-out die de semi-transparante laag hillshade over een
aantrekkelĳk raster van uw keuze (zoals de DEM of de laag slope bĳvoorbeeld) bevat. Neem ook de polygoon
en de laag suitable_areas, waarop de vier geschikte gebieden, die het dichtst bĳ de universiteit liggen, zĳn
geaccentueerd. Volg alle best practices voor cartografie bĳ het maken van uw kaart voor de uitvoer.
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Module: Plug-ins

Plug-ins stellen u in staat de functionaliteit die QGIS biedt uit te breiden. In deze module zal u worden getoond hoe
plug-ins te activeren en te gebruiken.

9.1 Les: Plug-ins installeren en beheren

U zult moeten weten hoe u ze moet downloaden, installeren en activeren om te kunnen beginnen met het gebruiken
van plug-ins, U zult leren hoe u Plug-in installeren en Plug-in Manager moet gebruiken om dit te doen.
Het doel voor deze les: Het systeem van plug-ins in QGIS begrĳpen en gebruiken

9.1.1 ��� Volgen: Plug-ins beheren

1. Klik op het menu-item Plug-ins ► Plug-ins beheren en installeren om Plug-ins te openen.
2. Zoek, in het dialoogvenster dat opent, naar de plug-in Processing:
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3. Klik in het vak naast deze plug-in en deselecteer het om hem te deactiveren.
4. Klik op Sluiten.
5. Kĳkend naar het menu zult u zien dat het menu Processing nu is verdwenen. Dit betekent dat veel van de functies

voor het verwerken, die u eerder gebruikt heeft, zĳn verdwenen! Kĳk bĳvoorbeeld naar de menu’s Vector ►
en Raster►. Dit komt omdat zĳ deel uitmaken van de plug-in Processing, die moet zĳn geactiveerd om hem te
kunnen gebruiken.

6. Open opnieuw Plug-ins beheren en installeren en activeer de plug-in Processing opnieuw door te klikken in het
keuzevak ernaast.

7. Close het dialoogvenster. Het menu Processing zou weer beschikbaar moeten zĳn.

9.1.2 ��� Volgen: Nieuwe plug-ins installeren

De lĳst met plug-ins die u kunt activeren en deactiveren wordt gevormd door de plug-ins die u momenteel heeft
geïnstalleerd. Nieuwe plug-ins installeren:

1. Selecteer de optieNiet geïnstalleerd in het dialoogvenster Plug-ins beheren en installeren. De voor u beschikbare
plug-ins om te installeren zullen hier zĳn vermeld. Deze lĳst zal variëren afhankelĳk van de instelling van uw
bestaande systeem.
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2. Zoek informatie over de plug-in door die te selecteren in de lĳst.

3. Installeer plug-ins, die u wilt gebruiken, door te klikken op de knop Plug-in installeren onder het paneel met
informatie over de plug-in.

Notitie: Als de plug-in een fout heeft zal die zĳn vermeld op de tab Ongeldig. U kunt dan contact opnemen met de
eigenaar van de plug-in om het probleem te repareren.
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9.1.3 ��� Volgen: Aanvullende opslagplaatsen voor plug-ins configureren

De plug-ins die voor u beschikbaar zĳn om te installeren zĳn afhankelĳk van welke opslagplaatsen voor plug-ins u
heeft geconfigureerd om te gebruiken.
Plug-ins voor QGIS worden online opgeslagen in opslagplaatsen. Standaard is alleen de officiële opslagplaats actief,
wat betekent dat u alleen toegang heeft tot plug-ins die daar zĳn vermeld. Gegeven de diversiteit van de beschikbare
gereedschappen zal deze opslagplaats aan de meeste van uw behoeften kunnen voldoen.
Het is echter mogelĳk om meer plug-ins uit te proberen dan alleen de standaard. U zult om te beginnen aanvullende
opslagplaatsen moeten configureren. Om dat te doen:

1. Open de tab Extra in het dialoogvenster Plug-ins beheren en installeren:

2. Klik op Toevoegen om een nieuwe opslagplaats te zoeken en toe te voegen.
3. Geef een Naam en URL op voor de nieuwe opslagplaats die u wilt configureren en zorg er voor dat het vak

Ingeschakeld is geselecteerd.
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4. U zult nu de nieuwe opslagplaats voor plug-ins zien vermeld in de lĳst met geconfigureerde opslagplaatsen voor
plug-ins

5. U kunt ook de optie selecteren om Experimentele plug-ins weer te geven door het vak Ook de experimentele
plug-ins tonen te selecteren.

6. Als u nu terugschakelt naar de tab Niet geïnstalleerd, zult u zien dat aanvullende plug-ins beschikbaar zĳn om
te installeren.
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7. Klik, om een plug-in te installeren, er op in de lĳst en dan op de knop Plug-in installeren.

9.1.4 Conclusie

Installeren van plug-ins in QGIS zou eenvoudig en effectief moeten zĳn!

9.1.5 Wat volgt?

Vervolgens zullen we u als voorbeelden enkele handige plug-ins laten zien.

9.2 Les: Handige plug-ins voor QGIS

Nu u plug-ins kunt installeren, inschakelen en uitschakelen, kunnen we eens zien hoe dat u in de praktĳk kan helpen
door naar enkele voorbeelden van handige plug-ins te kĳken.
Het doel voor deze les: Uzelf bekend te laten worden met de interface voor plug-ins en enkele handige plug-ins te
leren kennen.

9.2.1 ��� Volgen: De plug-in QuickMapServices

De plug-in QuickMapServices is een eenvoudige en gemakkelĳk te gebruiken plug-in die basiskaarten toevoegt aan
uw project van QGIS. Hĳ heeft veel verschillende opties en instellingen. Laten we enkele van zĳn mogelĳkheden
verkennen.

1. Begin een nieuwe kaart en voeg de laag roads uit het GeoPackage training_data.
2. Installeer de plug-in QuickMapServices.
3. Klik opWeb► QuickMapServices. Het eerste menu vermeld verschillende providers van kaarten (OSM, NASA)

met beschikbare kaarten:
4. Klik op een item en u zou de basiskaart in uw project laden.

Leuk! Maar een van de sterke punten van QMS is om toegang te verschaffen tot veel gegevensproviders. Laten we
ze toevoegen.
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1. Klik opWeb ► QuickMapServices ► Settings

2. Ga naar de tab More services.
3. Lees het bericht op deze tab zorgvuldig door en als u daarmee akkoord gaat, klik dan op de knopGet Contributed

pack.
4. Klik op Opslaan.
5. Als u nu het menuWeb► QuickMapServices opnieuw opent zult u zien dat er meer providers beschikbaar zĳn.

6. Kies degene die het beste aan uw wensen voldoet!, en laad de gegevens in het project!
Het is ook mogelĳk te zoeken door de nu beschikbare gegevensproviders

1. Open de tab Zoeken van de plug-in door te klikken op Web ► QuickMapServices ► Search QMS. Deze optie
van de plug-in stelt u in staat de beschikbare basiskaarten te filteren op het huidige bereik van het kaartvenster
of met een zoekwoord.

2. Klik op Filter by extent en u zou één beschikbare service moeten zien. Indien geen service wordt gevonden,
zoom uit en verschuif over de wereld (of uw eigen locatie) of zoek met een sleutelwoord.

3. Klik op de knop Add naast een teruggegeven gegevensset om die te laden.
4. De basiskaart zal worden geladen en u zult een achtergrond hebben voor de kaart.
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9.2.2 ��� Volgen: De plug-in QuickOSM

De plug-in QuickOSM stelt u in staat gegevens van OpenStreetMap te downloaden met een ongelofelĳk eenvoudige
interface.

��� Volgen: De plug-in Snelle query gebruiken

1. Begin een nieuwe leeg project en voeg de laag roads uit het GeoPackage training_data.
2. Installeer de plug-inQuickOSM plugin. De plug-in voegt twee nieuwe knoppen toe aan de werkbalk van QGIS

en is toegankelĳk vanuit het menu Vector ► QuickOSM.
3. Open het dialoogvenster van QuickOSM. De plug-in heeft veel verschillende tabs: wĳ zullen de Snel query

gebruiken.
4. U kunt specifieke objecten downloaden door een algemene Sleutel te kiezen of meer specifiek zĳn en een

specifiek paar Sleutel enWaarde kiezen.

Tip: als u niet bekend bentmet het systeem van Sleutel enWaarde, klik dan op de knopHulpmet sleutel/waarde.
Het zal een webpagina openen met een volledige beschrĳving van dit concept van OpenStreetMap.

5. Zoek naar railway in het menu Sleutel en laat het veld Waarde leeg: we gaan dus alle objecten railway
downloaden, zonder enige waarden te specificeren.

6. Selecteer Layer Extent in de volgende keuzelĳst en kies roads.
7. Klik op de knop Query uitvoeren.
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Na enkele seconden zal de plug-in alle objecten die in OpenStreetMap zĳn getagd als railway downloaden en ze
direct in de kaart laden.
Niets meer! Alle lagen zĳn geladen in de legenda en worden weergegeven in het kaartvenster.

Waarschuwing: QuickOSM maakt een tĳdelĳke laag bĳ het downloaden van de gegevens. Als u ze permanent
wilt opslaan, klik op het pictogram naast de laag en kies die optie die uw voorkeur heeft. Als alternatief kunt
u het menu Geavanceerd in QuickOSM openen en in het menu Map kiezen waar u de gegevens wilt opslaan.

��� Volgen: Het programma QuickOSM Query

De snelste manier om gegevens te downloaden vanuit de plug-in QuickOSM is met de tab Snel query en enkele
parameters in te stellen. Maar wat als u meer specifieke gegevens nodig hebt?
Als u een OpenStreetMap querymeester bent kunt u de plug-in QuickOSM ook gebruiken met uw persoonlĳke
query’s.
QuickOSM heeft een ongelofelĳke parser voor gegevens die, samen met het fantastische programma voor de query
van Overpass, u gegevens laten downloaden voor uw specifieke wensen.
Bĳvoorbeeld: we willen de bergpieken downloaden die behoren tot een specifieke berggebied, bekend als de
Dolomieten.
U kunt deze taak niet naar behoren uitvoeren met de tab Snel query, u dient meer specifiek te zĳn en uw eigen query
te schrĳven. Laten we eens proberen dat te doen.

1. Begin een nieuw project.
2. Open de plug-in QuickOSM en klik op de tab Query.
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3. Kopieer en plak de volgende code in het venster van de query:

<!--
This shows all mountains (peaks) in the Dolomites.
You may want to use the "zoom onto data" button. =>
-->
<osm-script output="json">
<!-- search the area of the Dolomites -->
<query type="area">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<!-- get all peaks in the area -->
<query type="node">
<area-query/>
<has-kv k="natural" v="peak"/>

</query>
<print mode="body" order="quadtile"/>
<!-- additionally, show the outline of the area -->
<query type="relation">
<has-kv k="place" v="region"/>
<has-kv k="region:type" v="mountain_area"/>
<has-kv k="name:en" v="Dolomites"/>

</query>
<print mode="body" order="quadtile"/>
<recurse type="down"/>
<print mode="skeleton" order="quadtile"/>
</osm-script>

Notitie: Deze query is geschreven in een XML-achtige taal. Als u meer gewend bent aan Overpass QL dan
kunt u uw query in die taal schrĳven.

4. En klik op Query uitvoeren:
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De laag met bergpieken zal worden gedownload en weergegeven in QGIS:

U kunt complexe query’s schrĳven met de taal voor Overpass Query. Bekĳk een aantal voorbeelden en probeer de
taal voor de query te verkennen.

9.2.3 ��� Volgen: De plug-in DataPlotly

De plug-inDataPlotly stelt u in staat omD3-plots te maken van gegevens van vectorattributen dankzĳ de bibliotheekl
plotly.

1. Begin een nieuw project.
2. Laad de laag sample_points uit de map exercise_data/plugins
3. Installeer de plug-in door de handleiding te volgen zoals beschreven in ��� Volgen: Nieuwe plug-ins installeren

en zoek naar Data Plotly

4. Open de plug-in door te klikken op het nieuwe pictogram in de werkbalk of in het menu Plug-ins►Data Plotly

In het volgende voorbeeld maken we een eenvoudig Spreidingsdiagram van twee velden uit de laag
sample_points. In het paneel DataPlotly:

1. Kies sample_points in het veld Laag, cl voor het X-veld en mg voor het Y-veld:
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2. Als u dat wilt kunt u de kleuren wĳzigen, het type markering, de transparantie en nog veel meer instellingen:
probeer enkele parameters te wĳzigen om het plot te krĳgen zoals hieronder.
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3. Klik, als alle parameters eenmaal zĳn ingesteld, op de knop Maak diagram om het plot te maken.
Het plot is interactief: dit betekent dat u alle bovenste knoppen kunt gebruiken om de grootte aan te passen, te
verplaatsen, of in/uit te zoomen op het kaartvenster van het plot. Meer nog, elk element van het plot is interactief:
door één of meer punten in het plot te selecteren of er op te klikken zullen de betreffende punten worden geselecteerd
in het kaartvenster van het plot.

U kunt het plot opslaan als een statische afbeelding in png of als een HTML-bestand door te klikken op de knop
of de knop in de rechter benedenhoek van het plot.
Er is meer. Soms kan het nuttig zĳn om twee (of meer) plots verschillende typen plots te laten zien met verschillende
variabelen op dezelfde pagina. Laten we dat eens doen!

1. Ga terug naar de tab voor de hoofdinstellingen voor het plot door te klikken op de knop in de
linkerbovenhoek van het paneel Plug-in

2. Wĳzig het Diagramtype naar Boxplot
3. Kies group als Grouping Field en ph as Y-veld
4. Wĳzig, in het onderste gedeelte van het paneel, hetDiagramtype van Enkelvoudig diagram naar Subdiagrammen

en laat de standaard optie Plot in rĳen geselecteerd.
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5. Als dat gedaan is, klik dan op de knop Maak diagram om het plot te tekenen

Nu worden zowel het spreidingsdiagram als het boxplot weergegeven op dezelfde plotpagina. U heeft nog steeds de
kans om op elk item van het plot te klikken en de corresponderen objecten in het kaartvenster te selecteren.
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Tip: Elk plot heeft zĳn eigen pagina voor de handleiding beschikbaar op de tab . probeer alle typen plots te
verkennen en bekĳk alle andere beschikbare instellingen.

9.2.4 Conclusie

Er zĳn vele handige plug-ins beschikbaar voor QGIS. U kunt naar nieuwe plug-ins zoeken en optimaal gebruik van
ze maken met behulp van de ingebouwde gereedschappen voor het installeren en beheren van deze plug-ins, .

9.2.5 Wat volgt?

Vervolgens zullen we kĳken naar hoe we lagen gebruiken die op dat moment worden gehost op servers op afstand.
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Module: Online bronnen

Bĳ het overwegen van gegevensbronnen voor een kaart is er geen reden om te zĳn beperkt tot gegevens die u heeft
opgeslagen op de computer waarop u werkt. Er zĳn gegevensbronnen online waaruit u gegevens kunt laden zolang u
bent verbonden met het internet.
In deze module zullen we twee soorten web-gebaseerde GIS-services behandelen: Web Mapping Services (WMS) en
Web Feature Services (WFS).

10.1 Les: Web kaartservices

Een Web Mapping Service (WMS) is een service die wordt gehost op een server op afstand. Net als met een website
kunt u er toegang tot verkrĳgen, zolang u een verbinding met de server heeft. Met behulp van QGIS kunt u eenWMS
direct in uw bestaande kaart laden.
Uit de les over plug-ins zult u hebben onthouden dat het mogelĳk is een nieuwe rasterafbeelding te laden vanaf,
bĳvoorbeeld, Google. Dat is echter een eenmalige transactie: als u de afbeelding eenmaal heeft gedownload, wĳzigt
die niet meer. Een WMS is anders in die zin dat het een live service is die automatisch zĳn weergave zal vernieuwen
als u op de kaart inzoomt of erover schuift.
Het doel voor deze les: Een WMS gebruiken en de beperkingen ervan begrĳpen.

10.1.1 ��� Volgen: Een WMS-laag laden

Voor deze oefening kunt ofwel de basiskaart gebruiken die u aan het begin van de cursus heeft gemaakt, of gewoon
een nieuwe kaart beginnen en er enkele bestaande lagen in laden. Voor dit voorbeeld gebruikten we een nieuwe kaart
en laden de originele lagen places, landuse en protected_areas en pasten de symbologie aan:
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1. Laad deze lagen nu in een nieuwe kaart, of gebruik uw originele kaart met alleen deze lagen zichtbaar.
2. Deactiveer eerst “Gelĳktĳdige CRS-transformatie gebruiken” vóórdat u begint met het toevoegen van deWMS-

laag (Project ► Eigenschappen… ► tab CRS, selecteer Geen CRS (of onbekende/niet aardse projectie). Dit kan
er voor zorgen dat de lagen elkaar niet langer juist overlappen, maar geen zorgen: dat repareren we later.

3. Klik, om WMS-lagen toe te voegen, op de knop om het dialoogvenster Databronnen beheren te openen
en schakel naar de tab WMS/WMTS.
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Weet u nog hoe u verbonden was met een database van SpatiaLite of GeoPackage aan het begin van de cursus?.
De lagen landuse, buildings en roads zĳn opgeslagen in een database. U moest eerst verbinden met de database
om die lagen te kunnen gebruiken. Een WMS gebruiken is soortgelĳk, met de uitzondering dat de lagen op een
server op afstand staan.

4. Klik op de knop Nieuw om een nieuwe verbinding naar een WMS te maken.
U heeft een adres voor een WMS nodig om door te gaan. Er zĳn verschillende gratis servers voor
WMS beschikbaar op het internet. Een daarvan is terrestris, die gebruik maakt van de gegevensset van
OpenStreetMap.

5. Stel, om gebruik te maken van deze WMS, het als volgt in in uw huidige dialoogvenster:
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• De waarde van het veld Naam zou terrestris moeten zĳn.
• De waarde van het veld URL zou ``https://ows.terrestris.de/osm/service` moeten zĳn.

6. Klik op OK. U zou de nieuwe server voor WMS moeten zien vermeld:
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7. Klik op Verbinden. In de lĳst hieronder zou u nu deze nieuwe items zien geladen:
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Dit zĳn alle lagen die worden gehost door de server van deze WMS.
8. Klik eenmaal op de laag OSM-WMS. Dit zal het in gebruik zĳnde CoördinatenReferentieSysteem weergeven en

het aantal CRS-en dat wordt ondersteund door de gegevensset:
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Laten we er een zoeken die aan onze behoeften voldoet, omdat we EPSG:4326 - WGS 84 niet gebruiken
voor onze kaart.

1. Klik op de knop CRS selecteren. U zult een standaard dialogvenster Coördinaten ReferentieSysteem
selecteren zien dat alle CRS-en weergeeft waarmee de gegevens zĳn gepubliceerd.

2. We willen een geprojecteerd CRS, dus laten weWGS 84 / Pseudo-Mercator met EPSG:3857 kiezen. U
kunt de bovenste widget Filter gebruiken.
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1. Klik op OK. Het Coördinaten ReferentieSysteem dat is geassocieerd met het item is gewĳzigd.
9. Klik op Toevoegen om de laag in uw project te laden met een Laagnaam` (standaard is OpenStreetMap WMS -

by terrestris).
10. Sluit het dialoogvenster Databronnen beheren, als het dat al niet automatisch doet.
11. Klik in het paneel Lagen en sleep het tot onderin de lĳst.
12. Zoom uit om een globaal overzicht van de lagen te krĳgen. Het zal u opvallen dat uw lagen niet juist zĳn geplaatst

(nabĳ het westen van Afrika). Dat komt omdat de projectie “Gelĳktĳdige CRS-transformatie gebruiken” is
uitgeschakeld.
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13. Laten we het opnieuw projecteren opnieuw inschakelen, maar laten we dezelfde projectie gebruiken als de laag
OpenStreetMap WMS, watWGS 84 / Pseudo Mercator is.
1. Open de tab Project ► Eigenschappen… ► CRS

2. Deselecteer Geen CRS (of onbekende/niet aardse projectie)

3. KiesWGS 84 / Pseudo Mercator uit de lĳst.
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4. Klik op OK.
14. Klik nu met rechts op een van uw eigen lagen in het paneel Lagen en klik op Zoomen naar la(a)g(en). U zou

het gebied van Swellendam moeten zien:
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Zie nu hoe de straten van de WMS-laag en uw eigen straten elkaar overlappen. Dat is een goed teken!

De natuur en beperkingen van WMS

Het zou u inmiddels opgevallen kunnen zĳn dat dezeWMS-laag in feite vele objecten in zich draagt. Het heeft straten,
rivieren, natuurreservaten, enzovoort. Maar verder, zelfs alsof het eruit ziet alsof het is gemaakt uit vectoren, het lĳkt
een raster te zĳn, maar u kunt de symbologie ervan niet veranderen. Waarom is dat?
Dit is hoe een WMS werkt: Het is een kaart, soortgelĳk aan een normale kaart op papier, die u ontvangt als een
afbeelding. Wat gewoonlĳk gebeurd is dat u vectorlagen heeft, die QGIS rendert als een kaart. Maar bĳ het gebruiken
van een WMS, bevinden die vectorlagen zich op de server van WMS, die het als een kaart rendert en die kaart naar
u verzendt als een afbeelding. QGIS kan deze afbeelding weergeven, maar kan de symbologie ervan niet wĳzigen,
omdat dat allemaal wordt afgehandeld op de server.
Dit heeft verschillende voordelen, omdat u zich geen zorgen hoeft te maken over de symbologie. Dat is allemaal al
verwerkt, en zal goed genoeg zĳn om te bekĳken op elk competent ontworpen WMS.
Aan de andere kant kunt u de symbologie niet wĳzigen als die u niet bevalt, en als er dingen wĳzigen op de server
van WMS, dan zullen zĳ ook op uw kaart wĳzigen. Dat is waarom soms in plaats daarvan een Web Feature Service
(WFS) wilt gebruiken, die u afzonderlĳke vectorlagen geeft en niet als deel van een kaart in WMS-stĳl.
Dit zal worden behandeld in de volgende les. Laten we eerst een andere WMS-laag toevoegen.

10.1.2 ��� Probeer zelf:

1. Voeg de WMS-server eAtlas op deze URL toe: https://maps.eatlas.org.au/maps/wms
2. Laad een laagWorld: Hillshading in de kaart.
3. U wilt misschien de Afbeeldingscodering instellen op JPEG en de optie Tile-grootte op 200 bĳ 200, zodat het

sneller laadt:
4. Uw kaart zou er zo uit moeten zien (u moet misschien de volgorde van de lagen veranderen en wat transparantie

toepassen):
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Antwoord
1. Ga naar Databronnen beheren, tab WMS / WMTS en maak een nieuw item voor een verbinding

2. Gebruik het tekstvak om de lĳst met lagen te filteren en de corresponderende laag te selecteren
3. Onthoud om te controleren/wĳzigen of EPSG:3857 - WGS 84 / Pseudo Mercator als CRS is ingesteld, net als

de rest van de kaart.

4. Nadat de laag is geladen, kunt u zĳn waarde Opaciteit aanpassen (op de tab voor de eigenschappen
Transparantie)

10.1.3 ��� Probeer zelf:

Een deel van de moeilĳkheid van het gebruiken van WMS is het vinden van een goede (gratis) server.
• Zoek een nieuwe WMS op directory.spatineo.com (of ergens anders online). Het moet geen geassocieerde
kosten of beperkingen hebben en moet dekking hebben voor het te onderzoeken gebied Swellendam.
Onthoud dat het enige wat u nodig heeft om een WMS te gebruiken is alleen de URL ervan (en bĳ voorkeur
een soort beschrĳving).

Antwoord
Spatineo is een van de vele plekken waar u kunt zoeken naar gegevens van OGC. Typ in het tekstgebied een naam,
sleutelwoord, locatie om te zien of u enkele werkbare resultaten krĳgt. Voor deze les, zou u de resultaten misschien
willen filteren om alleen WMS op te nemen.
Het zou kunnen zĳn opgevallen dat veel servers van WMS niet altĳd beschikbaar zĳn. Soms is dat tĳdelĳk, soms
permanent. Een voorbeeld van een WMS-server die werkte ten tĳde van het schrĳven hiervan is de MapServer
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Demonstration Server WMS op https://demo.mapserver.org/cgi-bin/wms?SERVICE=WMS&VERSION=1.3.0&
REQUEST=GetCapabilities. Het vereist geen kosten en heeft geen beperkingen voor toegang, en het is globaal.
Daarom voldoet het aan de vereisten. Onthoud echter dat dit slechts een voorbeeld is. Er zĳn nog veel meer servers
van WMS om uit te kiezen.

10.1.4 ��� Probeer zelf:

• Voeg de laag bluemarble toe vanaf de MapServer Demonstration Server. Is dat een geschikte gegevensset voor
ons te bestuderen gebied?

Antwoord
1. Verberg alle andere WMS-lagen om te voorkomen dat ze op de achtergrond onnodig zullen worden gerenderd.
2. Gebruik dezelfde benadering als hiervoor om de nieuwe server toe te voegen en de toepasselĳke laag zoals die

wordt gehost op die server:

3. Als u inzoomt op het gebied van Swellendam, zult u opmerken dat deze gegevensset een lage resolutie heeft:
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Daarom is het beter om deze gegevens niet voor de huidige kaart te gebruiken. De gegevens van Blue Marble
zĳn beter geschikt voor globale of nationale schalen

10.1.5 Conclusie

U kunt inactieve kaarten om op terug te vallen toevoegen aan uw bestaande gegevens voor uw kaarten door eenWMS
te gebruiken,.

10.1.6 Lees verder

• Spatineo Directory
• OpenStreetMap.org lĳst met servers voor WMS

10.1.7 Wat volgt?

Nu u een inactieve kaart om op terug te vallen heeft toegevoegd, zult u blĳ zĳn te weten dat het ook mogelĳk is om
objecten (zoals de andere vectorlagen die u eerder toevoegd) kunt toevoegen. Toevoegen van objecten vanaf servers
op afstand is mogelĳk door een Web Feature Service (WFS) te gebruiken. Dat is het onderwerp van de volgende les.
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10.2 Les: Web Feature Services

Een Web Feature Service (WFS) verschaft zĳn gebruikers GIS-gegevens in indelingen die direct in QGIS kunnen
worden geladen. Anders dan een WMS, die u alleen een kaart verschaft die u niet kunt bewerken, geeft een WFS u
toegang tot de objecten zelf.
Het doel voor deze les: Een WFS gebruiken en begrĳpen hoe die verschilt van een WMS.

10.2.1 ��� Volgen: Een WFS-laag laden

1. Begin een nieuwe kaart. Deze is alleen om te demonstreren en wordt niet opgeslagen.

2. Klik op de knop Databronnen beheren openen.

3. Schakel naar de tab WFS / OGC API - objecten.
4. Klik op de knop Nieuw.
5. Voer, in het dialoogvenster dat verschĳnt, de Naam in als nsidc.org en de URL als https://nsidc.org/cgi-

bin/atlas_south?version=1.1.0`.

6. Klik op OK en de nieuwe verbinding zal verschĳnen in uw Server-verbindingen.
7. Klik op de knop Verbinden. Een lĳst met beschikbare lagen zal verschĳnen:
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8. Deselecteer de optie Alleen objecten bevragen die het huidige zichtbare bereik overlappen onder de lĳst met
lagen, omdat uw huidige kaartvenster niet ons interessegebied zou kunnen bedekken: Antarctica.

9. Zoek naar de laag antarctica_country_border. U kunt het vak Filter bovenin gebruiken.
10. Klik op de laag om die te selecteren:
11. Zoek en selecteer ook de laag south_poles_wfs. U moet misschien Ctrl ingedrukt houden.
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12. Klik op Toevoegen.
Het kan even duren voordat de lagen zĳn geladen. Als zĳ zĳn geladen zullen zĳ verschĳnen op de kaart, de
omtrek van Antarctica en enkele punten daarop weergevend.
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Waarin verschilt dit van een WMS-laag?
13. Selecteer een willekeurige laag en u zult merken dat de gereedschappen voor het selecteren van objecten en

van de attributentabel zĳn ingeschakeld. Dit zĳn vectorlagen.
14. Selecteer de laag south_poles_wfs en open de attributentabel ervan. U zult dit zien:

Omdat de punten attributen hebben, kunnen we ze labelen, als ook hun symbologie wĳzigen. Hier is een
voorbeeld:
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Verschillen met WMS-lagen

EenWeb Feature Service geeft de laag zelf terug, niet slechts een daaruit gerenderde kaart. Dit geeft u directe toegang
tot de gegevens, wat betekent dat u hun symbologie kunt wĳzigen en analyse-functies erop kunt uitvoeren. Dat gaat
echter ten koste van heel veel gegevens die moeten worden verzonden. Dit zal speciaal duidelĳk zĳn als de lagen die
u laadt gecompliceerde vormen hebben, enorm veel attributen, of veel objecten; of zelfs als alleen maar veel lagen
laadt. WFS-lagen hebben hierom sowieso veel tĳd nodig om te laden.

10.2.2 ��� Volgen: Een WFS-laag bevragen

Hoewel het mogelĳk is een query uit te voeren op een WFS-laag nadat die is geladen, is het vaak efficiënter om de
query uit te voeren voordat hĳ is geladen. Op die manier vraagt u alleen de objecten op die u wilt, wat betekent dat u
veel minder bandbreedte gebruikt.
Op de server vanWFS die wemomenteel gebruiken is bĳvoorbeeld een laag genaamd countries (excluding Antarctica).
Laten we zeggen dat we willen weten waar Zuid-Afrika ligt, relatief ten opzichte van de laag south_poles_wfs (en
misschien ook de laag antarctica_country_border) die al is geladen.
Er zĳn twee manieren om dit te doen. U kunt de gehele laag countries … laden, en dan zoals gewoonlĳk een query
bouwen als hĳ is geladen. Echter, het verzenden van de gegevens voor alle landen in de wereld en dan alleen de
gegevens voor Zuid-Afrika gebruiken lĳkt een verspilling van bandbreedte. Afhankelĳk van uw verbinding kan het
enkele minuten duren om deze gegevensset te laden.
Het alternatief is om de query als een filter te bouwen vóór zelfs de laag te laden vanaf de server.

1. Schakel naar de tabWFS / OGC API Objecten in het dialoogvenster Databronnen beheren

2. Verbind met de server die we eerder hebben gebruikt en u zou de lĳst met beschikbare lagen moeten zien.
3. Zoek en dubbelklik op de laag countries (excluding Antarctica). De laagnaam is

country_borders_excluding_antarctica. U kunt ook de laag selecteren en drukken op
de knop Query maken aan de onderzĳde van het dialoogvenster:
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4. Typ, in het dialoogvenster dat verschĳnt, de volgende query SELECT * FROM
country_borders_excluding_antarctica WHERE "Countryeng" = 'South Africa'
in het vak SQL-argument.

5. Druk op OK.
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6. De gebruikte expressie zal verschĳnen als de waarde Sql van de doellaag:

7. Klik op Toevoegen met de laag geselecteerd zoals hierboven. Alleen het land met de waarde Countryeng
die South Africa is zal worden geladen vanuit die laag:
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Hebt u het pictogram opgemerkt naast de laag country_borders_excluding_antarctica ? Het geeft aan dat
de geladen laag is gefilterd en niet al zĳn objecten weergeeft in het project.

8. U hoeft het niet te doen, maar als u beide methoden heeft gebruikt, zult u merken dat dit een stuk sneller is dan
het laden van alle landen vóórdat u ze gefilterd heeft!

Opmerkingen over de beschikbaarheid van WFS

Het is zeldzaam een host voor WFS te vinden die de objecten host die u nodig heeft, als u hele specifieke behoeften
heeft. De reden waaromWeb Feature Services relatief zeldzaam zĳn is vanwege de grote hoeveelheden gegevens die
moeten worden verzonden om een geheel object te beschrĳven. Het is daarom niet erg kosteneffectief om een WFS
te hosten in plaats van een WMS, dat alleen afbeeldingen verzendt.
Het meest voorkomende type WFS dat u daarom zult tegenkomen zal daarom waarschĳnlĳk op een lokaal netwerk
staan of zelfs op uw eigen computer, in plaats van op het internet.

10.2.3 Conclusie

WFS-lagen hebben de voorkeur boven WMS-lagen als u directe toegang nodig heeft tot de attributen en geometrieën
van de lagen. Echter de hoeveelheid gegevens in aanmerking nemende die moet worden gedownload (wat leidt tot
problemen met de snelheid en ook een gebrek aan eenvoudig beschikbare publieke servers voorWFS) is het niet altĳd
mogelĳk een WFS te gebruiken in plaats van een WMS.
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10.2.4 Wat volgt?

Vervolgens zullen we u laten zien hoe u QGIS Server kunt gebruiken om services van OGC te verschaffen.
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Module: QGIS Server

Deze module is bĳgedragen door Tudor Bărăscu.
In deze module zullen we behandelen hoe QGIS Server te installeren en te gebruiken.
Lees de QGIS-Server-manual om meer te leren over QGIS Server.

11.1 Les: QGIS Server installeren

Het doel voor deze les: Leren hoe QGIS Server te installeren op Debian Stretch. Met verwaarloosbare variaties
kunt u dit ook volgen voor elke distributie die is gebaseerd op Debian, zoals Ubuntu en de afgeleiden daarvan.

Notitie: In Ubuntu kunt u uw gewone gebruiker gebruiken, sudo vooraf laten gaan aan opdrachten die rechten van
de admin vereisen. In Debian kunt u werken als admin (root), zonder sudo te gebruiken.

11.1.1 ��� Volgen: Installeren vanuit pakketten

In deze les doen we alleen het installeren vanuit pakketten zoals hier is weergegeven.
QGIS Server installeren met:

apt install qgis-server --no-install-recommends --no-install-suggests

# if you want to install server plugins, also:
apt install python3-qgis

QGIS Server zou in productie moeten worden gebruikt zonder geïnstalleerde QGIS Desktop (met de daarbĳ
behorende X Server) op dezelfde machine.

359

https://qgis.org/resources/installation-guide/#linux


QGIS Training Manual

11.1.2 ��� Volgen: Uitvoerbaar bestand QGIS Server

Het voor QGIS Server uitvoerbare ebstand is qgis_mapserv.fcgi. U kunt controleren waar het is geïnstalleerd
door find / -name 'qgis_mapserv.fcgi' uit te voeren wat iets uit zou moeten uitvoeren als /usr/
lib/cgi-bin/qgis_mapserv.fcgi.
Optioneel, als u op dit moment een test van de opdrachtregel wilt uitvoeren kunt u de opdracht /usr/lib/
cgi-bin/qgis_mapserv.fcgi --version uitvoeren die iets zou moeten uitvoeren zoals:

QGIS 3.21.0-Master 'Master' (1c70953f1e)
QGIS code revision 1c70953f1e
Qt version 5.15.2
Python version 3.9.5
GDAL/OGR version 3.2.2
PROJ version 7.2.1
EPSG Registry database version v10.008 (2020-12-16)
GEOS version 3.9.0-CAPI-1.16.2
SQLite version 3.34.1
OS Ubuntu 21.04

We zullen later zien hoe verzoeken voor WMS te maken.

11.1.3 ��� Configureren HTTP-server

We moeten een HTTP-server gebruiken om toegang te krĳgen tot de geïnstalleerde QGIS-server via een
internetbrowser. Het installatieproces voor Apache HTTP Server wordt in detail beschreven in het gedeelte httpserver.

Notitie: Indien u QGIS Server installeerde zonder een X Server uit te voeren (opgenomen in Linux Desktop) en
indien u ook de opdracht GetPrint wilt gebruiken dan zou u een namaak- X Server moeten installeren en QGIS
Server moeten vertellen om die te gebruiken. U kunt dat doen door het Xvfb installatieproces te volgen.

11.1.4 ��� Volgen: Een andere virtuele host maken

Laten we eens een andere Apache virtuele host maken die verwĳst naar QGIS Server. U kunt elke naam kiezen die u
wilt (coco.bango, super.duper.training, example.com, etc.) maar omwille van de eenvoud gaan wĳ
myhost gebruiken.

• Laten we de naam myhost instellen om te verwĳzen naar het IP van de localhost IP door 127.0.0.1 x
toe te voegen aan het bestand /etc/hosts met de volgende opdracht: sh -c "echo '127.0.0.1
myhost' >> /etc/hosts" of door handmatig te bewerken met gedit /etc/hosts.

• We kunnen controleren of myhost verwĳst naar de localhost door in de terminal de opdracht ping myhost
uit te voeren die terug zou moeten geven:

qgis@qgis:~$ ping myhost
PING myhost (127.0.0.1) 56(84) bytes of data.
64 bytes from localhost (127.0.0.1): icmp_seq=1 ttl=64 time=0.024 ms
64 bytes from localhost (127.0.0.1): icmp_seq=2 ttl=64 time=0.029 ms

• Laten we eens proberen of we toegang kunnen krĳgen tot QGIS Server vanaf de site van myhost door uit te
voeren: curl http://myhost/cgi-bin/qgis_mapserv.fcgi of door toegang te krĳgen tot de
URL via de browser van uw Debianbox. U zult waarschĳnlĳk terugkrĳgen:

<!DOCTYPE HTML PUBLIC "-//IETF//DTD HTML 2.0//EN">
<html><head>
<title>404 Not Found</title>
</head><body>
<h1>Not Found</h1>

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
<p>The requested URL /cgi-bin/qgis_mapserv.fcgi was not found on this server.</p>
<hr>
<address>Apache/2.4.25 (Debian) Server at myhost Port 80</address>
</body></html>

• Apache weet niet dat het geacht wordt verzoeken te beantwoorden die verwĳzen naar de server genaamd
myhost. De meest eenvoudige manier om de virtuele host in te stellen zou zĳn om een bestand myhost.
conf te maken in de map /etc/apache2/sites-available die dezelfde inhoud heeft als het bestand
qgis.demo.conf met uitzondering van de regel ServerName die zou moeten zĳn ServerName
myhost. U zou ook kunnen wĳzigen waar de logboeken naartoe moeten worden gestuurd, omdat anders
de logboeken voor de twee virtuele hosts zouden worden gedeeld maar dit is optioneel.

• Laten we nu de virtuele host inschakelen met apt-get a2ensite myhost.conf en dan de Apache-
service opnieuw laden met service apache2 reload.

• Als u probeert toegang te krĳgen tot de URL http://myhost/cgi-bin/qgis_mapserv.fcgi zult u merken dat nu
alles werkt!

11.1.5 Conclusie

U heeft geleerd verschillende versies van QGIS Server vanuit pakketten te installeren, hoe Apache te configureren
met QGIS Server, op distributies voor Linux die zĳn gebaseerd op Debian.

11.1.6 Wat volgt?

Nu u QGIS Server hebt geïnstalleerd en het toegankelĳk is via het protocol HTTP, moeten we leren hoe toegang
te krĳgen tot enkele services die het biedt. Het onderwerp van de volgende les is hoe te leren toegang te krĳgen tot
WMS-services van QGIS Server.

11.2 Les: Server voor WMS

De voor deze oefening gebruikte gegevens zĳn beschikbaar in de submap qgis-server-tutorial-data van
de training data die u hebt gedownload. Voor het gemak en om mogelĳke problemen met rechten te vermĳden, gaan
we er van uit dat deze bestanden zĳn opgeslagen in de map /home/qgis/projects. Pas daarom de volgende
instructies aan naar uw eigen pad.
De demogegevens bevatten een project voor QGIS project genaamd world.qgs dat al is voorbereid om te kunnen
werken met QGIS Server. Als u uw eigen project wilt gebruiken of wilt leren hoe een project wordt voorbereid, bekĳk
dan het gedeelte Creatingwmsfromproject.

Notitie: Deze module geeft de URL’s weer zodat het publiek gemakkelĳk onderscheid kan maken tussen de
parameters en de waarden van de parameters. Hoewel de normale indeling is:

...&field1=value1&field2=value2&field3=value3

gebruikt deze handleiding:

&field1=value1
&field2=value2
&field3=value3
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Plakken hiervan in Mozilla Firefox werkt correct, maar andere webbrowsers, zoals Chrome, zouden ongewenste
spaties kunnen toevoegen tussen de paren veld:parameter. Dus, als u dit probleem tegenkomt dient u ofwel
Firefox te gebruiken of de URL’s aan te passen zodat zĳn in de indeling voor op één regel staan.

Laten we een verzoek voor WMS GetCapabilities maken in de webbrowser of met curl:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetCapabilities
&map=/home/qgis/projects/world.qgs

In de configuratie voor Apache uit e vorige les stelt de variabele QGIS_PROJECT_FILE het standaard project in op
/home/qgis/projects/world.qgs. Echter, in het bovenstaande verzoek gebruikten we de parametermap
parameter om expliciet te zĳn en om aan te geven dat het kan worden gebruikt om naar een punt in elk project te
kunnen verwĳzen. Indien u de parameter map verwĳdert uit het bovenstaande verzoek zal QGIS Server hetzelfde
antwoord teruggeven.
Door een WMS-cliënt laten verwĳzen naar de URL GetCapabilities, krĳgt de cliënt als antwoord een XML-
document met metadata van de informatie van de Web Map Server, bĳv. welke lagen het bevat, de geografische
bedekking, in welke indeling, welke versie van WMS etc.
Omdat QGIS zelf ook een ogc-wms is kunt u een nieuwe serververbinding voor WMS maken met de hulp van de
bovenstaande URL GetCapabilities. Bekĳk de gedeelten Les: Web kaartservices of ogc-wms-servers over hoe dit te
doen.
Door het toevoegen van de WMS-laag countries aan uw project van QGIS zou u een afbeelding moeten krĳgen
zoals hieronder:
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Fig. 11.1: QGIS Desktop verwerkt de QGIS Server WMS-service laag countries

Notitie: QGIS Server verwerkt lagen die zĳn gedefinieerd in het project world.qgs. Door het project te openen
met QGIS kunt u zien dat er verschillende stĳlen zĳn voor de laag countries. QGIS Server is zich daar ook van
bewust en u kunt in uw verzoek de stĳl kiezen die u wilt. De stĳl classified_by_population werd voor
bovenstaande afbeelding gekozen.
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11.2.1 Loggen

Wanneer u een server instelt, zĳn de logboeken altĳd belangrĳk omdat zĳ weergeven wat er gebeurt. We hebben in
het bestand *.conf de volgende logboeken ingesteld:

• QGIS Server log op /logs/qgisserver.log
• qgisplatform.demo Apache access log op qgisplatform.demo.access.log
• qgisplatform.demo Apache error log op qgisplatform.demo.error.log

De bestanden voor de logboeken zĳn eenvoudigweg tekstbestanden, dus u kunt een tekstbewerker gebruiken om ze te
bekĳken. U kunt ook de opdracht tail in a terminal gebruiken: sudo tail -f /logs/qgisserver.log.
Dit zal doorlopend uitvoer geven in de terminal over wat er in dat logbestand staat geschreven. U kunt ook drie
terminals geopend hebben voor elk logbestand, als volgt:

Fig. 11.2: De opdracht tail gebruiken om de uitvoer van de logs van QGIS Server te visualiseren

Wanneer u de QGIS Desktop gebruikt om de WMS-services van QGIS Server WMS te verwerken zul;t u alle
verzoeken zien die QGIS verstuurt naar de Server in het access log, de fouten van QGIS Server in het QGIS Server
log etc.
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Notitie:
• Als u kĳkt naar de logs in de volgende gedeelten zult u beter begrĳpen wat er gebeurt.
• Door Apache opnieuw te starten terwĳl u kĳkt naar het log van QGIS Server, vindt u enkele extra aanwĳzingen
over hoe dingen werken.

11.2.2 Verzoeken GetMap

QGIS Desktop gebruikt, om de laag countries weer te geven,, net als elke andere WMS-cliënt, verzoeken
GetMap.
Een eenvoudig verzoek ziet er uit als:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries
&FORMAT=image/jpeg

Het bovenstaande verzoek zal de volgende afbeelding teruggeven:
Afbeelding: eenvoudig verzoek GetMap aan QGIS Server
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Fig. 11.3: Antwoord van Qgis Server na een eenvoudig verzoek GetMap

11.2.3 ��� Probeer zelf: De parameters voor afbeelding en lagen wijzigen

Laten we, gebaseerd op het bovenstaande verzoek, de laag countries vervangen door een andere.
U zou, om te kunnen zien welke andere lagen beschikbaar zĳn, het project world.qgs kunnen openen in QGIS
en kĳken naar de inhoud. Onthoud echter dat de WMS-cliënten geen toegang hebben tot het project van QGIS, zĳ
kĳken slechts naar de inhoud van het document capabilities.
Ook is er een optie in de configuratie die enkele bestaande lagen in het project van QGIS laat negeren door QGIS als
de WMS-service wordt bediend.
U zou dus kunnen kĳken naar de lagenlĳst als u QGIS Desktop verwĳst naar de URL GetCapabilities of u
zou zelf andere namen kunnen proberen te vinden in het XML-antwoord GetCapabilities.
Eén van de laagnamen die u zou kunnen vinden en die werktcountries_shapeburst. U zou ook andere kunnen
vinden maar onthoud dat sommige niet zichtbaar zouden kunnen zĳn op een dergelĳke kleine schaal, dus zou u een
blanco afbeelding als antwoord kunnen krĳgen.
U kunt ook nog met enkele andere parameters hierboven kunnen experimenteren, zoals het wĳzigen van het type
afbeelding naar image/png.
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11.2.4 ��� Volgen: Parameters voor filters, opaciteit en stijlen gebruiken

Laten we een ander verzoek uitvoeren dat een andere laag toevoegt, enkele basic parameters, FILTER en
OPACITIES, maar ook de standaard parameter STYLES gebruikt.

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&FORMAT=image/jpeg
&LAYERS=countries,countries_shapeburst
&STYLES=classified_by_name,blue
&OPACITIES=255,30
&FILTER=countries:"name" IN ( 'Germany' , 'Italy' )

Het bovenstaande verzoek zal de volgende afbeelding teruggeven:

Fig. 11.4: Antwoord voor een verzoek GetMap met parameters FILTER en OPACITIES

Zoals u kunt zien, naast andere dingen, in de bovenstaande afbeelding, vertelden weQGIS Server om alleenGermany
en Italy te renderen uit de laag countries.
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11.2.5 ��� Volgen: Redlining gebruiken

Laten we een ander verzoek GetMap maken dat gebruik maakt van de mogelĳkheid redlining en van de parameter
SELECTION die gedetailleerd wordt weregegeven in het gedeelte Basics:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?MAP=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0
&REQUEST=GetMap
&BBOX=-432786,4372992,3358959,7513746
&SRS=EPSG:3857
&WIDTH=665
&HEIGHT=551
&LAYERS=countries,countries_shapeburst
&FORMAT=image/jpeg
&HIGHLIGHT_GEOM=POLYGON((590000 6900000, 590000 7363000, 2500000 7363000, 2500000␣
↪→6900000, 590000 6900000))
&HIGHLIGHT_SYMBOL=<StyledLayerDescriptor><UserStyle><Name>Highlight</Name>
↪→<FeatureTypeStyle><Rule><Name>Symbol</Name><LineSymbolizer><Stroke><SvgParameter␣
↪→name="stroke">%233a093a</SvgParameter><SvgParameter name="stroke-opacity">1</
↪→SvgParameter><SvgParameter name="stroke-width">1.6</SvgParameter></Stroke></
↪→LineSymbolizer></Rule></FeatureTypeStyle></UserStyle></StyledLayerDescriptor>
&HIGHLIGHT_LABELSTRING=QGIS Tutorial
&HIGHLIGHT_LABELSIZE=30
&HIGHLIGHT_LABELCOLOR=%23000000
&HIGHLIGHT_LABELBUFFERCOLOR=%23FFFFFF
&HIGHLIGHT_LABELBUFFERSIZE=3
&SELECTION=countries:171,65

Plakken van het bovenstaande verzoek in uw webbrowser zou de volgende afbeelding terug moeten geven:
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Fig. 11.5: Antwoord op een verzoek met de mogelijkheid REDLINING en de parameter SELECTION

U kunt in de bovenstaande afbeelding zien dat de landen met de ID’s 171 en 65 in geel zĳn geaccentueerd (Roemenië
en Frankrĳk) met behulp van de parameter SELECTION en we gebruikten de mogelĳkheid REDLINING om er
een label met QGIS Tutorial overheen te leggen.

11.2.6 Verzoeken GetPrint

Een hele leuke mogelĳkheid van QGIS Server is dat het gebruik maakt van de afdruklay-outs van QGIS Desktop. U
kunt er meer over te weten komen in het gedeelte wms_getprint.
Als u het project world.qgs opent met QGIS Desktop zult u een afdruklay-out vinden, genaamd Population
distribution. Een vereenvoudigd verzoek GetPrint dat een voorbeeld is van deze fantastische mogelĳkheid
is:

http://qgisplatform.demo/cgi-bin/qgis_mapserv.fcgi
?map=/home/qgis/projects/world.qgs
&SERVICE=WMS
&VERSION=1.3.0&
REQUEST=GetPrint
&FORMAT=pdf
&TRANSPARENT=true
&SRS=EPSG:3857
&DPI=300
&TEMPLATE=Population distribution

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
&map0:extent=-432786,4372992,3358959,7513746
&LAYERS=countries

Fig. 11.6: Geeft de resulterende PDF weer van bovenstaand verzoek GetPrint

Natuurlĳk is het moeilĳk om uw verzoeken GetMap, GetPrint etc. te schrĳven.
QGISWebClient of QWC is eenWebcliëntproject dat naast QGIS Server kan werken zodat u uw projecten op het web
kunt publiceren of u kan helpen verzoeken voor QGIS Server te maken voor een beter begrip over de mogelĳkheden.
U kunt het als volgt installeren:

• Ga, als gebruiker qgis, naar de thuismap met cd /home/qgis.
• Download het QWCproject vanaf hier en pak het uit.
• Maak een symbolische koppeling naar de map /var/www/html omdat dat de DocumentRoot is die we
hebben ingesteld in de configuratie van de virtuele host. Als u het archief heeft uitgepakt onder /home/
qgis/Downloads/QGIS-Web-Client-master kunnen we dat doen met sudo ln -s /home/
qgis/Downloads/QGIS-Web-Client-master /var/www/html/.

• Ga naar http://qgisplatform.demo/QGIS-Web-Client-master/site/qgiswebclient.html?map=/home/qgis/
projects/world.qgs vanuit uw webbrowser.

Nu zou u de kaart moeten kunnen zien zoals die in de volgende afbeelding:
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Fig. 11.7: QGIS Web Client verwerkt het project world.qgs

Als u klikt op de knop Print in QWC kunt u interactief verzoeken GetPrint maken. U kunt ook klikken op het
pictogram ? in QWC om toegang te verkrĳgen tot de beschikbare Help zodat u de mogelĳkheden van QWC beter
kunt ontdekken.

11.2.7 Conclusie

U heeft geleerd QGIS Server WMS-services te laten verschaffen.
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11.2.8 Wat volgt?

Vervolgens zullen we u laten zien hoe u QGIS kunt gebruiken als startpunt voor het beroemde GRASS GIS.
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Module: GRASS

GRASS (Geographic Resources Analysis Support System) is een bekend open bron GIS met een brede variëteit
aan handige functies voor GIS. Het werd voor het eerst uitgegeven in 1984 en heeft sindsdien veel verbeteringen
ondergaan en aanvullende functionaliteit gekregen. QGIS stelt u in staat direct gebruik te maken van de krachtige
gereedschappen voor GIS in GRASS.

12.1 Les: GRASS instellen

GRASS gebruiken in QGIS vereist dat u op een enigszins andere manier naar de interface kĳkt. Onthoud dat u niet
direct werkt in QGIS, maar dat u werkt in GRASS via QGIS. Daarom dient u er voor te zorgen dat u QGIS Desktop
hebt geïnstalleerd met ondersteuning voor Grass.

Voor het openen van een sessie van QGIS met GRASS, beschikbaar op Windows, dient u te klikken op het
pictogram QGIS Desktop with GRASS.
Het doel voor deze les: Een project in GRASS beginnen in QGIS.

12.1.1 ��� Volgen: Een nieuwe sessie van GRASS starten

U moet, net als met elke andere plug-in, het activeren om GRASS te kunnen starten vanuit QGIS:
1. First, open a new QGIS project.
2. Schakel, in Plug-ins beheren en installeren…, GRASS in de lĳst in:
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De werkbalk voor GRASS en het paneel GRASS zullen verschĳnen:

Fig. 12.1: GRASS werkbalk en paneel

Het paneel GRASS is niet actief omdat u, vóórdat u GRASS kunt gebruiken, u een Mapset dient te maken. GRASS
werkt altĳd in een databaseomgeving, wat betekent dat u alle gegevens die u wilt gebruiken moet importeren in een
database van GRASS.
De database voor GRASS heeft een vrĳ eenvoudige structuur, zelfs als die er op het eerste oog zeer gecompliceerd
uitziet. Het meest belangrĳke ding dat u zou moeten weten is dat het bovenste niveau van de database de Location
is. Elke Location mag meerdere Mapset’s bevatten: in elke Mapset vindt u de Mapset PERMANENT omdat
die standaard wordt gemaakt door GRASS. Elke Mapset bevat de gegevens (raster, vector, etc) in een bepaalde
structuur, maar geen zorgen, GRASS zal, voor u, daarvoor zorgen.
Onthoud gewoon: Location bevat Mapset dat de gegevens bevat. Voor meer informatie, bezoek de website van
GRASS.
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Fig. 12.2: GRASS databasestructuur (uit documenten van GRASS)

12.1.2 ��� Volgen: Een nieuw project van GRASS starten

1. Klik op het menu Plug-ins ► GRASS ► Nieuwe mapset:

U zult worden gevraagd naar om de locatie van de database van GRASS te kiezen.
2. Stel het in als de map die door GRASS zal worden gebruikt om de database ervan in te stellen:

12.1. Les: GRASS instellen 375



QGIS Training Manual

3. Klik op Next.
GRASS moet een Location maken, die het maximale bereik beschrĳft van het geografische gebied waarin u zult
werken, ook wel bekend als Region in Grass.

Notitie: de Region is extreem belangrĳk voor GRASS omdat het het gebied beschrĳft waarin met alle lagen rekening
wordt gehouden voor GRASS. Alles wat er buiten ligt zal niet in overweging worden genomen. Geen zorgen, u kunt
altĳd het bereik van de Region van GRASS wĳzigen, nadat de Location is gemaakt

1. Noem de nieuwe locatie SouthAfrica:

2. Klik op Next.
3. We zullen werken met WGS 84, dus zoek naar en selecteer dit CRS:
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4. Klik op Next.
5. Selecteer nu de regio South Africa uit de keuzelĳst en klik op Toepassen:
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6. Klik op Next.
7. Maak een mapset, wat het bestand met kaarten is waarmee u zult werken.

Als u gereed bent, zult u een dialoogvenster zien dat u een samenvatting geeft van de ingevoerde informatie.
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8. Klik op Finish.
9. Klik op OK in het dialoogvenster.

U zult zien dat het paneel GRASS actief zal worden en u kunt beginnen met het gebruiken van alle gereedschappen
voor GRASS.

12.1.3 ��� Volgen: Vectorgegevens in GRASS laden

U heeft nu een blanco kaart en voordat u van start gaat met het gebruiken van alle gereedschappen van GRASS, dient
u gegevens te laden in de database van GRASS database, specifiek in de mapset. U kunt geen gereedschappen van
GRASS gebruiken met lagen die niet zĳn geladen in een mapset van GRASS.
Er zĳn vele manieren om gegevens in de database van GRASS te laden. Laten we beginnen meet de eerste.

��� Volgen: Gegevens laden met de QGIS Browser

In het gedeelte ��� Het paneel Browser zagen we dat de gemakkelĳkste en snelste manier de gegevens in QGIS te
laden het paneel Browser is.
Gegevens voor GRASS worden vanuit de QGIS Browser herkend als echte gegevens voor GRASS en u kunt dat zien

omdat u het pictogram van GRASS naast de mapset van GRASS zult zien. Meer nog, u zult het pictogram naast
de geopende mapset zien staan.
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Notitie: U zult een replicatie vand GRASS Location als een normale map zien: gegevens van GRASS mapset zĳn
die in de map

U kunt gemakkelĳk lagen slepen en laten vallen uit mappen naar de mapset van GRASS.
Laten we de laag roads proberen te importeren in de mapset grass_mapset van de Location SouthAfrica.
Ga naar de Browser en sleep eenvoudigweg de laag roads uit het bestand voor GeoPackage training_data.
gpkg in de mapset grass_mapset.
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Dat is alles! Als u de mapset vergroot zult u de geïmporteerde laag roads zien. U kunt nu de geïmporteerde laag in
QGIS laden, net als alle andere lagen.

Tip: U kunt ook lagen laden uit het paneel Legenda van de lagen in de mapset in het paneel Browser. Dit zal uw
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werkstroom enorm versnellen!

��� Volgen: Gegevens laden met het paneel van GRASS

We zullen nu de lange methode gebruiken om de laag rivers.shp in dezelfde mapset te laden.
1. Laad gegevens zoals gewoonlĳk in QGIS. Gebruik de gegevensset rivers.shp (te vinden in de map

exercise_data/shapefile/).
2. Klik, zodra die is geladen, op het vak Filter van het paneel GRASS en zoek naar het gereedschap voor het

importeren van vector door de term v.in.ogr.qgis in te voeren (beschikbaar onder File management ►
Import into GRASS ► Import vector into GRASS):

Waarschuwing: Er zĳn 2 soortgelĳke gereedschappen: v.in.ogr.qgis en v.in.ogr.qgis.loc.
We zoeken de eerste.

De v staat voor vector, in betekent een functie om gegevens te importeren in de database van GRASS,
ogr is de softwarebibliotheek die wordt gebruikt om de vectorgegevens te lezen, en qgis betekent dat het
gereedschap zal zoeken naar een vector naast de vectoren die al zĳn geladen in QGIS.

3. Als u dit gereedschap eenmaal hebt gevonden, klik er dan op om het gereedschap zelf te activeren. Kies de
laag rivers in het van Geladedn laag en typ en noem die g_rivers om verwarring te voorkomen:
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Notitie: ★★★ Merk de extra opties voor importeren op onder Advanced Options. Deze omvatten de
mogelĳkheid om een clausule WHERE toe te voegen voor de gebruikte query van SQL voor het importeren
van de gegevens.

4. Klik op Uitvoeren om het importeren te starten.
5. Klik, als het voltooid is, op de knop Uitvoer bekĳken om de nieuw geïmporteerde laag voor GRASS in de kaart

te bekĳken.
6. Sluit eerst het gereedschap voor het importeren (klik op de knop Close direct rechts naast Uitvoer bekĳken), en

sluit het venster GRASS-gereedschap.
7. Verwĳder de originele laag rivers.

Nu heeft u alleen nog de geïmporteerde laag van GRASS weergegeven in uw kaart van QGIS.

12.1.4 ��� Volgen: Rastergegevens laden in GRASS

U kunt een rasterlaag op dezelfde manier importeren als hoe we vectorlagen importeerden.
We gaan in de mapset van GRASS de laag srtm_41_19_4326.tif importeren.

Notitie: de rasterlaag staat al in het juiste CRS, WGS 84. Als u lagen in een ander CRS hebt, dient u die eerst
opnieuw te projecteren naar hetzelfde CRS als dat van de mapset van GRASS

1. Laad de laag srtm_41_19_4326.tif in QGIS
2. Open opnieuw het dialoogvenster GRASS-gereedschap.
3. Klik op de tab Modules.
4. Zoek naarr.in.gdal.qgis (beschikbaar onderFile management► Import into GRASS► Import raster into

GRASS ► Import raster into GRASS from QGIS view) en dubbelklik op het gereedschap om het dialoogvenster
ervan te openen.
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5. Stel het zo in dat de invoerlaag srtm_41_19_4326.tif is en de uitvoer g_dem is.

6. Klik op Uitvoeren.
7. Als het proces is voltooid, klik op Uitvoer bekĳken.
8. Close de huidige tab en Close dan het gehele dialoogvenster.

9. U kunt nu de originele laag srtm_41_19_4326.tif verwĳderen.
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12.1.5 ��� Probeer zelf: Lagen toevoegen aan Mapset

Probeer in de mapset van GRASS Mapset de vectorlagen water.shp en places.shp uit de map
exercise_data/shapefile/ te importeren. Hernoem, zoals we al deden voor rivers, de geïmporteerde
laag als g_water en g_places om verwarring te voorkomen

Antwoord
U kunt lagen toevoegen (zowel vector als raster) in een GRASS Mapset door ze te slepen en neer te zetten in de
Browser (bekĳk ��� Volgen: Gegevens laden met de QGIS Browser) of door v.in.gdal.qgis voor vector- en
r.in.gdal.qgis voor rasterlagen te gebruiken.

12.1.6 ��� Een bestaande GRASS Mapset openen

Als u al een bestaande mapset voor GRASS hebt, kunt u die gemakkelĳk heropenen in een andere sessie van QGIS.
U heeft verscheidene methoden om een mapset voor GRASS te openen, laten we enkele daarvan verkennen.
Laten we de mapset sluiten door te klikken op de knop Mapset sluiten van het venster van GRASS-gereedschap.

��� Volgen: De plug-in GRASS gebruiken

1. Klik op het menu Plug-ins ► GRASS ► Mapset openen:
2. Blader naar de map van de database van GRASS: wees voorzichtig! U moet de oudermap selecteren, niet die

van de mapset voor GRASS. GRASS zal inderdaad alle Locations van de database lezen en alle Mapsets
van elke Location:

3. Kies de Location SouthAfrica en de mapset grass_mapset die we eerder hebben gemaakt.
Dat is alles! Het paneel GRASS zal actief worden wat betekent dat de mapset correct is geopend.

��� Volgen: De QGIS Browser gebruiken

Nog sneller en gemakkelĳker is het openen van een mapset met de QGIS Browser:
1. Sluit de mapset (als die geopend is) door te klikken op de knop Mapset sluiten van het venster GRASS-

gereedschap.
2. Blader, in de QGIS Browser, naar de map van de database van GRASS.

3. Klik met rechts op de mapset (onthoud dat de mapset het pictogram GRASS naast zich heeft staan). U
zult enkele opties zien.

4. Klik op Mapset openen:
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De mapset is nu geopend en klaar om te gebruiken!

Tip: Klikken met rechts op een mapset van GRASS biedt u een groot aantal verschillende instellingen. Probeer ze
te verkennen en bekĳk alle nuttige opties.
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12.1.7 Conclusie

De werkstroom voor GRASS voor het binnenhalen van gegevens is enigszins anders dan de methode van QGIS omdat
GRASS zĳn gegevens in een ruimtelĳke databasestructuur laad. Door echter QGIS als startpunt te gebruiken, kunt
u het instellen van een mapset voor GRASS eenvoudiger maken door bestaande lagen in QGIS te gebruiken als
gegevensbronnen voor GRASS.

12.1.8 Wat volgt?

Nu de gegevens zĳn geïmporteerd in GRASS kunen we kĳken naar de geavanceerde analysebewerkingen die GRASS
bied.

12.2 Les: Gereedschappen van GRASS

In deze les zullen we een selectie van gereedschappen presenteren om u een idee van de mogelĳkheden van GRASS
te geven.

12.2.1 ��� Volgen: Een kaart van het aspect maken

1. Open de tab GRASS-gereedschap

2. Laad de rasterlaag g_dem uit de mapset grass_mapset

3. Zoek naar de module r.aspect door er naar te zoeken in het veld Filter van de tab Modules

4. Open het gereedschap en stel het in zoals hier en klik op de knop Uitvoeren:
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5. Als het proces is voltooid klik dan op Uitvoer bekĳken om de resulterende laag in het kaartvenster te laden:
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De laag g_aspect is opgeslagen in de mapset grass_mapset dus u kunt de laag uit het kaartvenster verwĳderen en
opnieuw laden wanneer u wilt.

12.2.2 ��� Volgen: Basisstatistieken voor rasterlaag ophalen

We willen enkele basisstatistieken van de rasterlaag g_dem weten.
1. Open de tab GRASS-gereedschap

2. Laad de rasterlaag g_dem uit de mapset grass_mapset

3. Zoek naar de module r.info door er naar te zoeken in het veld Filter van de tab Modules

4. Stel het gereedschap in zoals hier en klik op Uitvoeren:
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5. Op de tab Uitvoer zult u enige informatie over het raster zien afgedrukt, zoals het pad naar het bestand, het
aantal rĳen en kolommen en andere nuttige informatie:
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12.2.3 ��� Volgen: Het gereedschap Reclass

Opnieuw classificeren van een rasterlaag is een bĳzonder nuttige taak.We hebben zojuist de laagg_aspect gemaakt
uit de g_dem. Het bereik van de waarden gaat van 0 (Noord) langs 90 (Oost), 180 (Zuid), 270 (West) en tenslotte
naar 360 (Noord opnieuw).We kunnen de laag g_aspect opnieuw classificeren om slechts 4 categorieën te hebben
door specifieke regels te volgen (Noord = 1, Oost = 2, Zuid = 3 en West = 4).
Het gereedschap Reclassify van Grass accepteert een bestand txt met de gedefinieerde regels. Het schrĳven van de
regels is erg eenvoudig en de handleiding van GRASS bevat een hele goede beschrĳving.

Tip: Elk gereedschap van GRASS heeft zĳn eigen tab Handleiding. Neem de tĳd om de beschrĳving van het
gereedschap dat u gaat gebruiken door te lezen om nuttige parameters niet te missen

1. Laad het bestand g_aspect of, als u dat niet gemaakt hebt, ga terug naar het gedeelte ��� Volgen: Een kaart
van het aspect maken.
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2. Zoek naar de module r.reclass door er naar te zoeken in het veld Filter van de tab Modules

3. Open het gereedschap en stel het in zoals op de volgende afbeelding. Het bestand dat de regels bevat, in de
map exercise_data/grass/, is genaamd reclass_aspect.txt.

4. Klik op Uitvoeren en wacht tot het proces is voltooid:

5. Klik op Uitvoer bekĳken om het opnieuw geclassificeerde raster in het kaartvenster te laden
De nieuwe laag is opgemaakt met slechts 4 waarden (1, 2, 3, en 4) en het is gemakkelĳker te beheren en te
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verwerken.

Tip: Open het bestand reclass_aspect.txt met een tekstbewerker om de regels te bekĳken en er aan te
wennen. Meer nog, bekĳk de handleiding van GRASS wat nader: veel verschillende voorbeelden zĳn beschikbaar.

12.2.4 ��� Probeer zelf: Opnieuw classificeren met uw regels

Probeer de laag g_dem opnieuw te classificeren in 3 nieuwe categorieën:
• van 0 tot 1000, nieuwe waarde = 1
• van 1000 tot 1400, nieuwe waarde = 2
• vanaf 1400 tot de maximum rasterwaarde, nieuwe waarde = 3

Antwoord
Voer, om de maximale waarde van het raster te weten te komen, het gereedschap r.info uit: in de console zult u
zien dat de maximumwaarde 1699 is. U bent nu klaar om de regels te schrĳven.

1. Open een tekstbewerker en voeg de volgende regels toe:

0 thru 1000 = 1
1000 thru 1400 = 2
1400 thru 1699 = 3

2. Sla het bestand op als bestand my_rules.txt en sluit de tekstbewerker.
3. Voer het gereedschap r.reclass uit: kies de laag g_dem en laad het bestand dat de regels bevat die u zojuist

hebt opgeslagen.
4. Klik op Run en dan op View Output. U kunt de kleuren wĳzigen en het uiteindelĳke resultaat zou eruit moeten

zien als op de volgende afbeelding:
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12.2.5 ��� Volgen: Het gereedschap Mapcalc

Het gereedschap Mapcalc is soortgelĳk aan de Rasterberekeningen van QGIS. U kunt rekenkundige bewerkingen
uitvoeren op een of meer rasterlagen en het uiteindelĳke resultaat zal een nieuwe laag zĳn met de berekende waarden.
Het doel van de volgende oefening is om de waarden die groter zĳn dan 1000 uit de rasterlaag g_dem uit te nemen.

1. Zoek naar de module r.mapcalc door er naar te zoeken in het veld Filter van de tab Modules

2. Start het gereedschap.
Het dialoogvensterMapcalc stelt u in staat een reeks analyses te construeren die moeten worden uitgevoerd op
een raster, of collectie rasters. U zult deze gereedschappen gebruiken om dat te doen:

In volgorde zĳn dat:
• Kaart toevoegen: Voeg een rasterbestand uit uw huidige mapset van GRASS toe.
• Constante toevoegen: Een constante waarde toevoegen die moet worden gebruikt in functies, 1000 in dit
geval.

• Operator of functie toevoegen: Een operator of functie toevoegen die moet worden verbonden met de
invoer en uitvoer. We zullen de operator groter dan of is gelijk aan gebruiken.

• Verbinding toevoegen: Verbindt elementen. Klik en sleep, met dit gereedschap, van de ene rode punt op
het ene item naar de rode punt op een ander item. Punten die juist zĳn verbonden met een verbindingslĳn
zullen grĳs worden. Als de lĳn of punt rood is, is die niet juist verbonden!

• Item selecteren: Selecteert een item en geselecteerde items verplaatsen.
• Verwĳder geselecteerde item: Verwĳdert het geselecteerde item uit het huidige blad voor mapcalc, maar
niet uit de mapset (als het een bestaand raster is)
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• Openen: Een bestaand bestand openen met de gedefinieerde bewerking
• Opslaan: Alle bewerkingen opslaan in een bestand
• Opslaan als: Alle bewerkingen opslaan in een nieuw bestand op de schĳf.

3. Construeer het volgende algoritme met deze gereedschappen:

4. Klik op Uitvoeren en dan op Uitvoer bekĳken om de uitvoer te zien weergegeven in uw kaart:
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Dit geeft alle gebieden weer waar het terrein hoger is dan 1000 meter.

Tip: U kunt ook de formule die u hebt gemaakt opslaan en laden in een ander project van QGIS door te klikken op
de laatste knop van de werkbalk van GRASS Mapcalc.

12.2.6 Conclusie

In deze les hebben we slechts een paar van de vele gereedschappen behandeld die GRASS te bieden heeft. Open
het dialoogvenster GRASS-gereedschap en scroll door de Modules om de mogelĳkheden van GRASS voor uzelf te
verkennen. OF, voor een meer gestructureerde benadering, kĳk onder de tab Modules, waar de gereedschappen op
type zĳn vermeld.
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Module: Beoordeling

Gebruik uw eigen gegevens voor dit gedeelte. U zult nodig hebben:
• een punt-vectorgegevensset van interessante punten (POIi’s), met namen voor de punten en meerdere
categorieën

• een lĳn-vectorgegevensset van wegen
• een polygoon-vectorgegevensset van grondgebruik (met behulp van grenzen voor eigendommen)
• een afbeelding met visueel-spectrum (zoals een luchtfoto)
• een DEM (te downloaden vanaf de CGIAR-CSI als u er zelf geen heeft)

13.1 Een basiskaart maken

Vóórdat u een gegevensanalyse doet, heeft u een basiskaart nodig, die u de resultaten van de analyse met context
verschaft.

13.1.1 De puntlaag toevoegen

• Voeg de puntlaag toe. Gebaseerd op het niveau waarop u de cursus doet, doet u alleen wat vermeld is in het
toepasselĳke gedeelte hieronder:

���

• Label de punten overeenkomstig een uniek attribuut, zoals plaatsnamen. Gebruik een klein lettertype en houd
de labels nauwelĳks leesbaar. De informatie zou beschikbaar moeten zĳn, maar zou geen hoofdonderdeel van
de kaart uit moeten maken.

• Classificeer de punten zelf in verschillende kleuren, gebaseerd op een categorie. Categorieën zouden,
bĳvoorbeeld, kunnen omvatten “toeristische bestemming”, “politiebureau” en “stadscentrum”.
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���

• Doe hetzelfde als in het gedeelte ★☆☆.
• Classificeer de punten op belangrĳkheid: hoe meer belangrĳk een object is, hoe groter de punt ervan.
Overschrĳd echter niet de grootte 2.00 voor de punt.

• Voor objecten die niet zĳn geplaatst op één punt (bĳvoorbeeld provinciale/regionale namen, of namen van
steden op een grote schaal), wĳst u in het geheel geen punt toe.

���

• Gebruik helemaal geen puntsymbolen om de laag te symboliseren. Gebruik in plaats daarvan labels die zĳn
gecentreerd over de punten; de symbolen punt zelf zouden geen grootte moeten hebben.

• Gebruik Data-bepaalde eigenschappen om de labels op te maken in betekenisvolle categorieën.
• Voeg, indien nodig, toepasselĳke kolommen toe aan de attributengegevens. Maak, als u dat doet, geen fictionele
gegevens - maar, gebruik de Veldberekening om de nieuwe kolommen te vullen, gebaseerd op toepasselĳk
bestaande waarden in de gegevensset.

13.1.2 Voeg de lijnlaag toe

• Voeg de laag met wegen toe en wĳzig dan de symbologie daarvan. De wegen krĳgen geen label.

���

• Wĳzig de symbologie van de weg naar een lichte kleur met een brede lĳn. Maak het ook iets transparant.

���

• Maak een symbool met meerdere symboollagen. Het resulterende symbool zou er als een echte weg uit moeten
zien. U kunt hier een eenvoudig symbool voor gebruiken; bĳvoorbeeld een zwarte lĳn met een dunne witte lĳn
die door het midden ervan loopt. Het mag ook meer uitgewerkt zĳn, maar de resulterende kaart zou er niet te
druk uit moeten zien.

• Als uw gegevensset een hoge dichtheid aan wegen heeft op de schaal waarop u de kaart wilt weergeven, zou u
twee lagen met wegen moeten hebben: de uitgewerkte met het symbool dat op een weg lĳkt en een eenvoudiger
symbool voor kleinere schalen. (Gebruik schaalafhankelĳke zichtbaarheid om ze uit te laten schakelen op de
toepasselĳke schalen.)

• Alle symbolen zouden meerdere symboollagen moeten hebben. Gebruik symbolen om ze juist te laten
weergeven.

���

• Doe hetzelfde als in het gedeelte ★★☆.
• In aanvulling daarop zouden de wegenmoeten worden geclassificeerd. Bĳ het gebruiken van realistische wegen-
achtige symbolen, zou elk type weg een toepasselĳk symbool moeten hebben; een snelweg zou bĳvoorbeeld
twee rĳstroken in elke richting moeten hebben.
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13.1.3 Voeg de polygoonlaag toe

• Voeg de laag voor grondgebruik toe en wĳzig de symbologie daarvan.

���

• Classificeer de laag overeenkomstig het grondgebruik. Gebruik volle kleuren.

���

• Classificeer de laag overeenkomstig het grondgebruik. Waar van toepassing, verwerk symboollagen,
verschillende typen symbolen, etc. laat echter de resultaten er gematigd en uniform uitzien. Onthoud dat dit
een deel is van de achtergrond!

���

• Gebruik op regels gebaseerde classificatie om het grondgebruik in algemene categorieën te verdelen, zoals
“stedelĳk”, “landelĳk”, “natuarreservaat”, etc.

13.1.4 Maak de raster-achtergrond

• Maak een schaduw voor heuvels uit de DEM en gebruik die als een transparant op een geclassificeerde versie
van de DEM zelf. U zou ook de plug-in Reliëf kunnen gebruiken (zoals weergegeven in de les over plug-ins).

13.1.5 Voltooien van de basiskaart

• Maak met behulp van de genoemde bronnen een basiskaart door enkele of alle lagen te gebruiken. De kaart
dient alle basisinformatie te bevatten die nodig is ter orientatie en dient visueel eenduidig en attractief te zĳn.

13.2 De gegevens analyseren

• U zoekt naar een eigendom dat voldoet aan bepaalde criteria.
• U mag beslissen op basis van uw eigen criteria, die u wel moet documenteren.
• Er zĳn enkele richtlĳnen voor deze criteria:

– het doel-eigendom zou deel moeten zĳn van (een) bepaalde type(n) grondgebruik
– het zou binnen een bepaalde afstand van wegen moeten liggen, of worden gekruist door een weg
– het zou binnen een bepaalde afstand van enige categorie van punten moeten liggen, zoals bĳvoorbeeld
een ziekenhuis
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13.2.1 ��� / ���

• Neem rasteranalyse op in uw resultaten. Overweeg ten minste één afgeleide eigenschap van het raster,zoals het
aspect of de helling ervan.

13.3 Uiteindelijke kaart

• Gebruik de Afdruklay-out om een uiteindelĳke kaart te maken, waarin uw analyseresultaten zĳn verwerkt.
• Neem de kaart op in een document en vul aan met extra documentatie. Wanneer de kaart visueel te druk wordt
dan is het mogelĳk lagen te deselecteren.

• Uw kaart moet een titel en een legenda bevatten.
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Module: Toepassing Bosbouw

In demodules 1 tot enmet 13 heeft u al heel veel geleerd over QGIS en hoe ermee te werken. Als u bent geïnteresseerd
om iets meer te leren over enkele basistoepassingen voor bosbouw van GIS, zal het volgen van deze module u de
mogelĳkheid geven toe te passen wat u heeft geleerd en zal u enkele nieuwe handige gereedschappen tonen.

De ontwikkeling van deze module is gesponsord door de Europese Unie.

14.1 Les: Presentatie module Bosbouw

Het volgen van deze module over een toepassing voor bosbouw vereist de kennis die u heeft geleerd in de modules 1
tot en met 11 van deze trainingshandleiding. De oefeningen in de volgende lessen gaan er van uit dat u al in staat bent
veel van de basisbewerkingen in QGIS uit te voeren en alleen gereedschappen die nog niet eerder werden gebruikt
zullen meer in detail worden gepresenteerd.
Niettegenstaande dat volgt de module een basisniveau door de lessen zodat, als u eerdere ervaringen heeft met QGIS,
u de instructies waarschĳnlĳk zonder problemen kunt volgen.
Merk op dat u een aanvullend pakket met gegevens moet downloaden voor deze module.
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14.1.1 Voorbeeldgegevens Bosbouw

Notitie: De voorbeeldgegevens die in deze module worden gebruikt maken deel uit van de gegevensset voor de
Trainingshandleiding en is beschikbaar in de map exercise_data\forestry\.

De aan bosbouw gerelateerde voorbeeldgegevens (kaart over bosbouw, gegevens over bosbouw), zĳn verschaft door
de EVO-HAMK school voor bosbouw. De gegevenssets zĳn aangepast om aan de behoeften voor de lessen te voldoen.
De algemene voorbeeldgegevens (luchtfoto’s, gegevens van LiDAR, basiskaarten) zĳn verkregen van deNational Land
Survey of Finland open data service, en aangepast voor de doelen van deze lessen. Toegang tot de downloadservice
voor het open gegevensbestand kan, in het Engels, hier worden verkregen.

Waarschuwing: Net als voor de rest van de trainingshandleiding bevat deze module instructies over het
toevoegen, verwĳderen en wĳzigen van gegevenssets voor GIS. We hebben voor dit doel trainingssets verschaft.
Zorg er voor dat u altĳd goede back-ups heeft vóórdat u de hier beschreven technieken toepast op uw eigen
gegevens!

14.2 Les: Geoverwijzingen in een kaart

Een veelvoorkomende taak in de bosbouw zou het bĳwerken kunnen zĳn van de informatie over een gebied met
bosbouw. Het is mogelĳk dat de eerdere informatie voor dat gebied al van jaren geleden is en analoog ( dat is: op
papier) werd verkregen of dat het werd gedigitaliseerd maar dat alles wat u nog heeft de papieren versie van de
gegevens van de inventarisatie is.
Heel waarschĳnlĳk zou u die informatie in uw GIS willen gebruiken om, bĳvoorbeeld, later te vergelĳken met latere
inventarisaties. Dit betekent dat u de voor de hand liggende informatie moet digitaliseren met uw software voor GIS.
Maar voordat u kunt beginnen met digitaliseren, is er een belangrĳke eerste stap die moet worden uitgevoerd, scannen
en aanbrengen van geoverwĳzingen in uw papieren kaart.
Het doel voor deze les: Het gereedschap Georeferencer in QGIS leren gebruiken.

14.2.1 ��� De kaart scannen

De eerste taak die u zult moeten uitvoeren is het scannen van uw kaart. Als uw kaart te groot is, dan kunt u hem scannen
in verschillende delen maar onthoudt dat u de taken voor het voorverwerken en aanbrengen van geoverwĳzingen voor
elk deel moet herhalen. Dus, indien mogelĳk, scan de kaart in zo min mogelĳk delen.
Als u een andere kaart gaat gebruiken dan die welke is verschaft voor deze handleiding, gebruik dan uw eigen scanner
om de kaart als een afbeeldingsbestand te scannen, een resolutie van 300 DPI is voldoende. Als uw kaart kleuren
heeft,m scan hem dan in kleur zodat u later die kleuren kunt gebruiken om informatie uit de kaart te halen voor
verschillende lagen (bĳvoorbeeld, bosopstand, contourlĳnen, wegen…).
Voor deze oefening zult u een eerder gescande kaart gebruiken, u vindt die als rautjarvi_map.tif in de map
met gegevens exercise_data/forestry
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14.2.2 ��� Volgen: De gescande kaart voorzien van geoverwijzingen

1. Open QGIS en stel het CRS van het project in op EPSG:3067 - ETRS89 / TM35FIN(E,N) in Project
► Eigenschappen ► CRS, wat het momenteel gebruikte CRS in Finland is.

2. Sla het project van QGIS op als map_digitizing.qgs.
U zult het gereedschap voor geo-verwĳzingen uit QGIS, genaamd Georeferencer, gebruiken. Geo-verwĳzingen
toevoegen aan de kaart:

1. Open het gereedschap Georeferencer, Kaartlagen ► Georeferencer….
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2. Voer het afbeeldingsbestand van de kaart, rautjarvi_map.tif, in als de afbeelding die moet worden
voorzien van geo-verwĳzingen, File ► Open raster.

3. Klik op OK.
Vervolgens zou u de instellingen voor de transformatie moeten definiëren voor het aanbrengen van geoverwĳzingen
in de kaart:

1. Open Extra ► Instellingen voor transformatie.
2. Stel het type Transformatie type in op Lineair en de Hersampling methode op Dichtstbijzijnde

buur.

3. Druk op de knop CRS selecteren naast de optie Doel-SRS en selecteer het CRS EPSG:2392 - KKJ /
Finland zone 2; dat is het CRS dat in Finland werd gebruikt in 1994 toen deze kaart werd gemaakt.

4. Klik op het pictogram naast het vak Uitvoerbestand, ga naar de map en maak de map exercise_data\
forestry\digitizing en noem het bestand rautjarvi_georef.tif.

5. Selecteer Na afloop in QGIS laden

6. Laat de rest van de parameters op de standaard instellingen staan.
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7. Klik op OK.
De kaart bevat verschillende kruisdraden die de coördinaten op de kaart markeren, we zullen die gebruiken om
geoverwĳzingen aan te brengen in deze afbeelding. U kunt, zoals u gewoonlĳk ook doet in QGIS, de gereedschappen
zoomen en pannen gebruiken om de afbeelding in het venster van Georeferencer te inspecteren.

1. Zoom in op de linkerbenedenhoek van de kaart en merk op dat er een kruisdraad is met een coördinaten-paar,
X en Y, die, zoals eerder vermeld, staan in het CRS KKJ / Finland zone 2. U zult dit punt gebruiken
als het eerste grondcontrolepunt voor de geo-verwĳzingen in uw kaart.

2. Selecteer het gereedschap Punt toevoegen en klik op de kruising van de kruisdraad (pan en zoom zoals nodig
is).

3. Voer, in het dialoogvensterVoer kaartcoördinaten in, de coördinaten in die verschĳnen op de kaart (X: 2557000
en Y: 6786000) en hun CRS (EPSG:2392 - KKJ / Finland zone 2)

4. Klik op OK.
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Het eerste coördinaat voor het aanbrengen van geoverwĳzingen is nu klaar.
5. Zoek naar andere zwarte kruisdraden in de afbeelding, zĳ staan op een afstand van 1000 meter van elkaar in

zowel de richting Noord als Oost. U zou in staat moeten zĳn de coördinaten van deze punten te berekenen in
relatie met het eerste punt.

6. Zoom uit op de afbeelding en verplaats naar rechts of naar boven totdat u een andere kruisdraad vindt, en schat
hoeveel kilometers u bent verplaatst. Probeer grondcontrolepunten te krĳgen die zo ver mogelĳk van elkaar af
staan.

7. Digitaliseer in elk geval nog drie grondcontrolepunten op dezelfde manier als u de eerste deed. U zou moeten
eindigen met iets zoals dit:

Met al drie gedigitaliseerde grondcontrolepunten zult u in staat zĳn de fout voor geo-verwĳzingen als een rode lĳn
te zien die vanuit de punten komt. De fout in pixels is ook te zien in de GCP-tabel in de kolommen dX[pixels] en
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dY[pixels]. De fout in pixels zou niet hoger moeten zĳn dan 10 pixels. Als dat wel zo is zou u de punten die u hebt
gedigitaliseerd opnieuw moeten bekĳken en de coördinaten die u hebt ingevoerd om uit te zoeken wat het probleem
is. U kunt de afbeelding hierboven als een richtlĳn beschouwen.
Als uw grondcontrolepunten eenmaal naar wens zĳn, dan kunt u ze opslaan om ze later nog eens te gebruiken:

1. Ga naar Bestand ► GCP-punten opslaan als….
2. In de map exercise_data\forestry\digitizing, noem het bestand rautjarvi_map.tif.

points.
Voorzie tenslotte uw kaart van geo-verwĳzingen:

1. Ga naar Bestand ► Geoverwĳzingen starten.
2. Merk op dat u het bestand al rautjarvi_georef.tif hebt genoemd toen u de instellingen voor

Georeferencer bewerkte.
Nu kunt u de kaart zien in het project van QGIS als een raster met geoverwĳzingen. Merk op dat het raster
licht gedraaid lĳkt te zĳn, maar dat is eenvoudigweg omdat de gegevens in KKJ / Finland zone 2 staan
en uw project is in ETRS89 / TM35FIN(E,N).

3. U kunt, om te controleren of uw gegevens juist zĳn voorzien van geoverwĳzingen
1. De luchtfoto openen in de map exercise_data\forestry, genaamd rautjarvi_aerial.

tif.
2. Uw kaart en deze foto zouden goed overeen moeten komen: stel de transparantie van de kaart in op 50%

en vergelĳk die met de luchtfoto.
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4. Sla de wĳzigingen in uw project van QGIS op, u zult vanaf dit punt doorgaan naar de volgende les.
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14.2.3 Conclusie

U heeft nu een papieren kaart voorzien van geoverwĳzingen, wat het mogelĳk maakt die te gebruiken als kaartlaag
in QGIS.

14.2.4 Wat volgt?

In de volgende les zult u de bosopstanden in uw kaart digitaliseren als polygonen en de gegevens van de inventarisatie
er aan toevoegen.

14.3 Les: Bosopstanden digitaliseren

Tenzĳ u uw kaart met geoverwĳzingen gaat gebruiken als een eenvoudige afbeelding voor de achtergrond, is de
volgende logische stap om de elementen erin te digitaliseren. U heeft dat al gedaan in de oefeningen over het maken
van vectorgegevens in Les: Een nieuwe vector gegevensset maken, toen u de velden van de school digitaliseerde. In
deze les gaat u de grenzen van de bosopstanden digitaliseren die als groene lĳnen op de kaart staan, maar in plaats
van het te doen met behulp van een luchtfoto, zult u uw kaart met geoverwĳzingen gebruiken.
Het doel voor deze les: Een techniek leren om te helpen bĳ de taak van het digitaliseren, bosopstanden digitaliseren
en tenslotte de gegevens van de inventarisatie er aan toevoegen.

14.3.1 ��� Volgen: De grenzen van de bosopstanden uitnemen

Open uw project map_digitizing.qgs, dat u in de vorige les heeft opgeslagen, in QGIS.
Als u eenmaal uw kaart heeft gescand en voorzien van geoverwĳzingen zou u direct kunnen beginnenmet digitaliseren
door naar de kaart te kĳken als een hulpmiddel. Dat zou, zeer waarschĳnlĳk, de manier om te doen als de afbeelding
van waaruit u gaat digitaliseren, bĳvoorbeeld, een luchtfoto is.
Als wat u gaat gebruiken voor het digitaliseren een goede kaart is, zoals in ons geval, is het aannemelĳk dat de
informatie duidelĳk wordt weergegeven als lĳnen met verschillende kleuren voor elk type element. Deze kleuren
kunnen relatief eenvoudig worden uitgenomen als individuele afbeeldingen met behulp van een software voor het
bewerken van afbeeldingen, zoals GIMP. Dergelĳke afzonderlĳke afbeeldingen kunnen worden gebruikt om te
assisteren bĳ het digitaliseren, zoals u hieronder zult zien.
De eerste stap zal zĳn om GIMP te gebruiken om een afbeelding te verkrĳgen die alleen de bosopstanden bevat, dat
is, alle groene lĳnen die u zou kunnen zien in de originele gescande kaart:

1. Open GIMP (als u het nog niet geïnstalleerd heeft, download het vanaf het internet of vraag uw leraar).
2. Open de originele kaartafbeelding, Bestand ► Openen, rautjarvi_map.tif in de map

exercise_data/forestry. Onthoud dat de bosopstanden als groene lĳnen worden weergegeven
(met het nummer van de bosopstand ook in groen binnen elke polygoon).
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3. Nu kunt u de pixels in de afbeelding selecteren die de grenzen van de bosopstanden vormen (de groenachtige
pixels):
1. Open het gereedschap Selecteren ► Op kleur.
2. Zoom, met het gereedschap actief, in op de afbeelding (Ctrl + muiswiel) zodat een lĳn van een

bosopstand dicht bĳ genoeg is om de pixels die de lĳn vormen te onderscheiden. Zie de linker afbeelding
hieronder.

3. Klik en sleep de muiscursor in het midden van de lĳn zodat het gereedschap verscheidene kleurwaarden
van de pixels zal verzamelen.

4. Laat de muisknop los en wacht enkele seconden. De pixels die overeenkomen met de kleuren die zĳn
verzameld door het gereedschap zullen vanuit de gehele afbeelding worden geselecteerd.

5. Zoom uit om te zien hoe de groenachtige pixels zĳn geselecteerd in de gehele afbeelding.
6. Als u niet tevreden bent met het resultaat, herhaal dan de bewerking klikken en slepen.
7. Uw selectie van pixels zou er ongeveer uit moeten zien als op de rechter afbeelding hieronder.
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4. Als u eenmaal klaar bent met het selecteren moet u deze selectie als een nieuwe laag kopiëren en die dan
opslaan als een afzonderlĳk afbeeldingsbestand:
1. Kopieer (Ctrl+C of Bewerken ► Kopiëren) de geselecteerde pixels.
2. En plak de pixels direct als een nieuwe laag (Bewerken ► Plakken als ► Nieuwe laag). GIMP zal de

geplakte pixels weergeven als een nieuwe laag (Geplakte laag) in het paneel Lagen.
3. Klik op het pictogram “oog” naast de originele afbeeldingslaag om die uit te schakelen, zodat alleen de

Geplakte laag zichtbaar is:
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5. Selecteer tenslotte Bestand ► Exporteren als…, stel Selecteer bestandstype (Volgens extensie) in als een TIFF-
afbeelding, selecteer de map digitizing en noem het rautjarvi_map_green.tif. Selecteer Geen
compressie indien daarnaar gevraagd wordt.

U zou hetzelfde proces kunnen uitvoeren met andere elementen in de afbeelding, bĳvoorbeeld de zwarte lĳnen
uitnemen die wegen weergeven of de bruine die de contourlĳnen van het terrein weergeven. Maar voor ons zĳn
de bosopstanden voldoende.

14.3.2 ��� Probeer zelf: De afbeelding met groene pixels voorzien van
geoverwijzingen

Zoals u al in de vorige les deed dient u deze nieuwe afbeelding te voorzien van geoverwĳzingen om in staat te zĳn
om hem te kunnen gebruiken met de rest van uw gegevens.
Onthoud dat u de grondcontrolepunten niet meer hoeft te digitaliseren omdat deze afbeelding nagenoeg hetzelfde is
als de originele afbeelding, voor zover het het gereedschap Georeferencer betreft. Hier zĳn enkele dingen die u zou
moeten onthouden:

• Deze afbeelding is, natuurlĳk, ook in het CRS KKJ / Finland zone 2.
• U zou de grondcontrolepunten moeten gebruiken die u heeft opgeslagen, Bestand ► GCP-punten laden.
• Onthoud om de Transformatie instellingen opnieuw te bekĳken.
• Noem het uitvoerraster rautjarvi_green_georef.tif in de map digitizing.

Controleer of het nieuwe raster netjes past op de originele kaart.

14.3.3 ��� Volgen: Ondersteunende punten voor digitaliseren maken

Met de gereedschappen voor digitaliseren in QGIS in gedachten, zou u misschien al kunnen denken dat het handig
zou zĳn aan die groene pixels te ‘snappen’ tĳdens het digitaliseren. Dat is precies wat u als volgende gaat doen, punten
maken uit die pixels om ze later te kunnen gebruiken om de grenzen van de bosopstanden te volgen tĳdens het
digitaliseren, met behulp van de beschikbare gereedschappen voor snappen in QGIS.

1. Gebruik het gereedschap Raster ► Conversie ► Polygoniseren (Raster naar vector) om uw groene lĳnen naar
polygonen te vectoriseren. Als u niet meer weet hoe, kunt u het nog eens bekĳken in Les: Conversie van raster
naar vector.

2. Sla op als rautjarvi_green_polygon.shp in de map digitizing.
3. Zoom in en zie hoe de polygonen eruit zien. U zult iets hebben zoals dit:
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4. De volgende optie is om punten van deze polygonen te maken om hun zwaartepunten te vinden:
1. Open Vector ► Geometrie-gereedschappen ► Centroïdes….

2. Stel Invoerlaag in op rautjarvi_green_polygon (de polygonenlaag die u zojuist hebt gemaakt)
3. Stel de uitvoer Centroïdes in op het bestand green_centroids.shp in de map digitizing

4. Selecteer Uitvoerbestand openen na uitvoeren van algoritme

5. Druk op Uitvoeren. Dit zal de zwaartepunten berekenen voor de polygonen als een nieuwe laag en die
toevoegen aan het project.
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5. Nu kunt u de laag rautjarvi_green_polygon uit de lagenlĳst verwĳderen.
6. Wĳzig de symbologie van de laag met zwaartepunten als volgt:

1. Open de Laageigenschappen voor green_centroids.
2. Ga naar de tab Symbologie.
3. Stel Grootte in op 1.00 en kies Kaarteenheden

Het is niet nodig om de verschillende punten van elkaar te differentiëren, u heeft ze daar alleen maar nodig om ze
te laten gebruiken door de gereedschappen voor ‘snappen”. U kunt deze punten nu gebruiken om de originele lĳnen
veel makkelĳker te volgen dan zonder ze.
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14.3.4 ��� Volgen: De bosopstanden digitaliseren

Nu bent u klaar om met het eigenlĳke werk van digitaliseren te beginnen. U zou moeten beginnen met het maken van
een vectorbestand van het type polygoon, maar, voor deze oefening, is er een shapefile met daarin een gedeelte van
het interessegebied dat al is gedigitaliseerd. U zult het digitaliseren voltooien voor de helft van de bosopstanden die
zĳn overgelaten tussen de belangrĳke wegen (brede roze lĳnen) en het meer:
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1. Ga naar de map digitizing met behulp van uw browser voor bestandsbeheer.
2. Sleep en zet het vectorbestand forest_stands.shp op uw kaart neer.
3. Wĳzig de symbologie van de nieuwe laag, zodat de polygonen die al gedigitaliseerd zĳn, gemakkelĳker te zien

zĳn:
1. Stel Vulkleur in op groen - en wĳzig de Opaciteit naar 50%.
2. Selecteer Standaard vulling en stel Lĳndikte in op 1.00 mm.

Nu, als u de voorgaande modules heeft onthouden, moeten we de opties voor “snappen” instellen en activeren:
1. Ga naar Project ► ‘Opties voor snappen…’

2. Druk op Snappen inschakelen en selecteer Gevorderde configuratie

3. Selecteer de lagen green_centroids en forest_stands

4. Stel het Type voor elke laag in op Hoekpunt

5. Stel Tolerantie voor elke laag in op 10
6. Stel Eenheden voor elke laag in op pixels

7. Selecteer Kruisingen vermĳden voor de laag forest_stands.

8. Druk op Topologisch bewerken aan-/uitzetten

9. Kies Gevorderde configuratie volgen

10. Sluit de pop-up

Met deze instellingen voor snappen, altĳd wanneer u aan het digitaliseren bent en dicht genoeg bĳ een van de
punten in de laag met zwaartepunten of een punt van uw gedigitaliseerde polygonen komt, zal een roze vierkant
verschĳnen op het punt waaraan zal worden gesnapt.

11. Schakel tenslotte de zichtbaarheid van alle lagen, met uitzondering van forest_stands en rautjarvi_georef uit.
Zorg er voor dat de kaartafbeelding geen transparantie meer heeft.

Een paar belangrĳke dingen om te onthouden vóórdat u begint met digitaliseren:
• Probeer niet te nauwkeurig te zĳn bĳ het digitaliseren van de randen.
• Als een rand een rechte lĳn is, digitaliseer die dan met slechts twee knopen. In het algemeen: gebruik bĳ het
digitaliseren zo min mogelĳk knopen.

• Zoom alleen in om gebieden te sluiten als u denkt dat u nauwkeurig moet zĳn, bĳvoorbeeld, op sommige hoeken
of wanneer u een polygoon wilt verbinden met een andere polygoon op een bepaalde knoop.

• Gebruik de middelste knop van de muis om in of uit te zoomen en te verschuiven als u digitaliseert.
• Digitaliseer slechts één polygoon per keer.
• Na het digitaliseren van een polygoon, schrĳf dan het ID van de bosopstand die u kunt zien in de kaart.
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Nu kunt u beginnen met digitaliseren:
1. Lokaliseer de bosopstand 357 in het kaartvenster.
2. Selecteer de laag forest_stands.

3. Klik op de knop Bewerken aan/uitzetten om bewerken in te schakelen.

4. Selecteer het gereedschap Object Polygoon toevoegen

5. Beginmet het digitaliseren van de bosopstand 357 door enkele van de puntenmet elkaar te verbinden. Onthoud
dat de roze vierkanten het snappen aangeven.

Als u gereed bent:
1. Klik met rechts om het digitaliseren voor die polygoon te beëindigen.
2. Voer de ID voor de bosopstand in het formulier in (in dit geval 357).
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3. Klik op OK.
Als u er geen formulier verscheen toen u het digitaliseren van de polygoon voltooide, ga naar Extra ► Opties ►
Digitaliseren en zorg er voor dat Voorkom tonen van attributenformulier na intekenen object niet is geselecteerd.
Uw gedigitaliseerde polygoon zal er ongeveer zo uitzien:

Voor de tweede polygoon gebruiken we bosopstand 358. Zorg er voor dat Kruisingen vermĳden. is geselecteerd
voor de laag forest_stands (zoals hierboven weergegeven). Deze optie zorgt er voor dat polygonen elkaar niet
overlappen. Als u dus digitaliseert over een bestaande polygoon, zal de nieuwe polygoon worden afgebroken op de
rand van de al bestaande polygonen. U kunt deze optie gebruiken om automatisch een gezamenlĳke rand te krĳgen.

1. Begin het digitaliseren van bosopstand 358 op één van de gemeenschappelĳke knopen met de bosopstand 357.
2. Ga normaal door totdat u bĳ de volgende gemeenschappelĳke knoop voor beide bosopstanden komt.
3. Digitaliseer tenslotte een aantal punten binnen polygoon 357 er zorg voor dragend dat de gemeenschappelĳk

rand niet wordt gekruist. Zie de linker afbeelding hieronder.
4. Klik met rechts om het bewerken van bosopstand 358 te voltooien.
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5. Stel de ID in als 358.
6. Klik op OK. Uw nieuwe polygoon zou nu een gemeenschappelĳke rand moeten hebben met de bosopstand 357,

zoals u kunt zien in de afbeelding aan de rechterkant.

Het gedeelte van de polygoon dat de bestaande polygoon overlapte is automatisch afgebroken en u blĳft achter met
een gemeenschappelĳke rand - wat uw bedoeling was.

14.3.5 ��� Volgen: Voltooien van digitaliseren van de bosopstanden

Nu heeft u twee bosopstanden voltooid. En een goed idee over hoe u verder moet gaan. Ga in uw eigen tempo door met
digitaliseren totdat u alle bosopstanden, die worden begrensd door de hoofdweg en het meer, heeft gedigitaliseerd.
Het lĳkt heel veel werk te zĳn, maar u zult er snel aan gewend raken om de bosopstanden te digitaliseren. Het zou u
ongeveer 15 minuten moeten kosten.
Gedurende het digitaliseren moet u misschien knopen bewerken of verwĳderen, polygonen splitsen of samenvoegen.
U heeft over de benodigde gereedschappen geleerd in Les: Topologie voor objecten, nu is het waarschĳnlĳk een goed
moment om het nog eens na te lezen.
Onthoud dat met Topologie bewerken activeren geactiveerd, u in staat bent knopen te verplaatsen die
gemeenschappelĳk zĳn voor twee polygonen zodat de gezamenlĳke rand tegelĳkertĳd wordt bewerkt voor beide
polygonen.
Uw resultaat zal er uitzien zoals dit:
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14.3.6 ��� Volgen: De gegevens voor de bosopstanden samenvoegen

Het is mogelĳk dat de gegevens van de inventarisatie van het bos die u voor uw kaart heeft ook op papier zĳn
geschreven. In dat geval zou u eerst de gegevens naar een tekstbestand of werkblad moeten wegschrĳven. Voor deze
oefening is de informatie van de inventarisatie voor 1994 (dezelfde inventarisatie als de kaart) al aanwezig als een
komma-gescheiden tekstbestand (csv).

1. Open het bestand rautjarvi_1994.csv uit de map exercise_data\forestry in een
tekstbewerker en merk op dat het gegevensbestand van de inventarisatie een attribuut heeft, genaamd ID
dat de nummers van de bosopstanden bevat. Deze nummers zĳn hetzelfde als de ID’s voor de bosopstanden
die u voor uw polygonen heeft ingevoerd en kunnen worden gebruikt om de gegevens uit het tekstbestand te
koppelen aan uw vectorbestand. U kunt de metadata voor deze gegevens van inventarisatie bekĳken in het
bestand rautjarvi_1994_legend.txt in dezelfde map.
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2. Voeg nu dit bestand toe aan het project:

1. Gebruik het gereedschap Tekstgescheiden laag toevoegen. Die is te bereiken via Kaartlagen► Laag toevoegen
► Tekstgescheiden laag toevoegen….

2. Stel de details in het dialoogvenster als volgt in:

3. Druk op Toevoegen om het opgemaakte bestand csv te laden in het project.
3. Maak een samenvoeging tussen de twee lagen om de gegevens uit het bestand .csv te koppelen aan de

gedigitaliseerde polygonen:
1. Open de Laageigenschappen voor de laag forest_stands.
2. Ga naar de tab Koppelingen.

3. Klik op de knop Nieuwe verbinding toevoegen aan de onderzĳde van het dialoogvenster.
4. Selecteer rautjarvi_1994.csv als de Koppellaag.
5. Stel Koppelveld in op ID.
6. Stel het veld Doelveld in op ID.
7. Klik tweemaal op OK.

De gegevens uit het tekstbestand zouden nu moeten zĳn gekoppeld aan uw vectorbestand. Selecteer de laag
forest_stands en gebruik Attributentabel openen, om te zien wat er is gebeurd. U kunt zien dat alle attributen van
het gegevensbestand voor de inventarisatie nu zĳn gekoppeld aan uw gedigitaliseerde vectorlaag.
U zult zien dat de veldnamen worden voorafgegaan door rautjarvi_1994_. Om dit te wĳzigen:

1. Open de Laageigenschappen voor de laag forest_stands.
2. Ga naar de tab Koppelingen.
3. Selecteer Koppellaag rautjarvi_1994

4. Klik op de knop Geselecteerde verbinding bewerken om bewerken in te schakelen.
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5. Onder Voorvoegsel voor naam aangepast veld, verwĳder de naam van het voorvoegsel

De gegevens uit het .csv-bestand zĳn slechts gekoppeld aan uw vectorbestand. U moet de laag forest_stands
als een nieuw vectorbestand opslaan om deze koppeling permanent te maken, zodat de gegevens feitelĳk worden
opgenomen in het vectorbestand. Om dit te doen:

1. Klik met rechts op de laag forest_stands
2. Kies Exporteren –> Objecten opslaan als…

3. Stel Indeling to ESRI Shapefile

4. Stel de bestandsnaam in op forest_stands_1994.shp in de map forestry

5. Selecteer Voeg opgeslagen kaart toe aan project om het nieuwe bestand als een laag op te nemen in het
project
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14.3.7 ��� Probeer zelf: Gebied en omtrek toevoegen

Uwilt misschien het gebied en de begrenzingen van de bosopstanden berekenen om het verzamelen van de informatie
gerelateerd aan deze bosopstanden. U heeft gebieden voor polygonen al berekend in Les: Extra oefening. Ga terug
naar die les als dat nodig is en bereken de gebieden voor de bosopstanden. Noem het nieuwe attribuut Gebied en
zorg er voor dat de waarden worden berekend in hectares. U zou hetzelfde kunnen doen voor de begrenzingen.
Nu is uw laag forest_stands_1994 gereed en verpakt met alle beschikbare informatie.
Sla uw project op om de huidige lagen van de kaart te behouden voor het geval u daar later terug moet komen.
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14.3.8 Conclusie

Het heeft een aantal muisklikken gekost maar u heeft nu uw oude gegevens van de inventarisatie in digitale indeling
en gereed voor gebruik in QGIS.

14.3.9 Wat volgt?

U zou nu kunnen beginnen met het uitvoeren van verschillende analyses met uw brandnieuwe gegevensset, maar u
bent misschien meer geïnteresseerd in het uitvoeren van analyses op een meer up to date gegevensset. Het onderwerp
van de volgende les zal het maken van bosopstanden zĳn, met behulp van recente luchtfoto’s en het toevoegen van
enige relevante informatie aan uw gegevensset.

14.4 Les: Bosopstanden bijwerken

Nu u de informatie uit de oude inventariskaarten hebt gedigitaliseerd en de overeenkomende informatie aan de
bosopstanden hebt toegevoegd, zou de volgende stap zĳn de inventaris van de huidige status van het bos te maken.
U zult nieuwe bosopstanden vanaf nul digitaliseren met een luchtfoto. Net als in de vorige les zult u een infrarood
gekleurde luchtfoto (CIR) gebruiken. Dit type afbeeldingen, waarbĳ het infrarode licht wordt opgenomen in plaats
van het blauwe licht, worden breed gebruikt om begroeide gebieden te bestuderen.
Na het digitaliseren van de bosopstanden, zult u informatie toevoegen, zoals nieuwe beperkingen, opgelegd door
regelgeving met betrekking tot het behouden ervan.
Het doel voor deze les: Een nieuwe set bosopstanden digitaliseren vanuit CIR-luchtfoto’s en informatie toevoegen
vanuit andere gegevenssets.

14.4.1 ��� Oude bosopstanden met huidige luchtfoto’s vergelijken

De National Land Survey van Finland heeft een beleid voor open gegevens die u in staat stellen een groot
scala aan geografische gegevens, zoals luchtfoto’s, traditionele topografische kaarten, DEM, LiDAR-gegevens,
etc, te downloaden. Toegang tot de service kan hier ook in het Engels worden verkregen. De in deze oefening
gebruikte luchtfoto is gemaakt uit twee orthogerectificeerde CIR-afbeeldingen, gedownload vanaf die service
(M4134F_21062012 en M4143E_21062012).

1. Open QGIS en stel het CRS van het project in op ETRS89 / ETRS-TM35FIN in Project ► Eigenschappen… ►
CRS

2. Voeg de CIR-afbeelding rautjarvi_aerial.tif toe aan het project:
1. Ga naar de map exercise_data\forestry\ met behulp van uw browser voor bestandsbeheer
2. Sleep het bestand rautjarvi_aerial.tif op uw project en zet het neer

3. Sla het project van QGIS op als digitizing_2012.qgs
De CIR-afbeeldingen zĳn van 2012. U kunt de bosopstanden die werden gemaakt in 1994 vergelĳken met de situatie
bĳna 20 jaar later.

1. Voeg de laag forest_stands_1994.shp toe die werd gemaakt in de vorige les:
1. Ga naar de map exercise_data\forestry\ met behulp van uw browser voor bestandsbeheer
2. Sleep het bestand forest_stands_1994.shp op uw project en zet het neer

2. Stel de symbologie zo in dat u door uw polygonen heen kunt kĳken:
1. Klik met rechts op forest_stands_1994

2. Selecteer Eigenschappen
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3. Ga naar de tab Symbologie

4. Stel Vulkleur in op transparante vulling
5. Stel Lĳnkleur in op paars
6. Stel Lĳndikte in op 0.50 mm

3. Bekĳk hoe de oude bosopstanden volgen (of niet) wat u visueel als een homogeen bos zou interpreteren.
4. Zoom en pan over het gebied. U zult waarschĳnlĳk opmerken dat sommige van de oude bosopstanden nog

steeds zullen corresponderen met de afbeeldingen maar dat andere dat niet doen.
Dit is een normale situatie, omdat 20 jaar is verstreken en verschillende bewerkingen in de bossen zĳn
uitgevoerd (oogsten, uitdunnen…). Het is ookmogelĳk dat de bosopstanden er in 1992 homogeen uitzagen voor
de persoon die ze digitaliseerde maar dat sommige bossen zich, bĳ het verstrĳken van de tĳd, op verschillende
manieren hebben ontwikkeld. Het is ook mogelĳk dat de prioriteiten voor het inventariseren van de bossen
toen anders waren dan dat zĳ vandaag de dag zĳn.

Vervolgens zult u nieuwe bosopstanden maken voor deze afbeelding, zonder de oude te gebruiken. Later kunt u ze
vergelĳken om de verschillen te bekĳken.

14.4.2 ��� De CIR-afbeelding interpreteren

Laten we hetzelfde gebied digitaliseren als dat wat werd bedekt door de oude inventarisatie, begrensd door de wegen
en het meer. U hoeft niet het gehele gebied te digitaliseren, net zoals in de vorige oefening kunt u beginnen met een
vectorbestand dat al de meeste bosopstanden bevat.

1. Verwĳder de laag forest_stands_1994.
2. Voeg het bestand exercise_data\forestry\forest_stands_2012.shp toe aan het project
3. Stel de opmaak van deze laag zo in dat de polygonen geen vulling hebben en de randen zichtbaar zĳn

1. Open het dialoogvenster Laageigenschappen voor de laag forest_stands_2012

2. Ga naar de tab Symbologie

3. Stel Vulkleur in op transparante vulling
4. Stel Lĳnkleur in op groen
5. Stel Lĳndikte in op 0.50 mm
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U kunt zien dat het noordelĳke gedeelte van het gebied van de inventarisatie nog ontbreekt. Uw taak is om de
ontbrekende bosopstanden te digitaliseren.
Besteed, voordat u begint, enige tĳd aan het bekĳken van de reeds gedigitaliseerde bosopstanden en de
overeenkomende bossen in de afbeelding. Probeer een idee te vormen over hoe de grenzen van de bosopstanden
worden bepaald, het helpt als u enige kennis over bosbouw heeft.
Enkele punten om aan te denken:

• Welke bossen zĳn loofbomen (in Finland meestal berkenbossen) en welke zĳn coniferen (in deze regio den
of spar). In CIR-afbeeldingen zullen loofbomen veelal een heldere rode kleur hebben, waar coniferen als een
donkergroene kleur worden weergegeven.
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• Hoe oud is het bos? De grootte van de boomkruinen kan worden geïdentificeerd in de afbeelding.
• Hoe dicht zĳn de verschillende bosopstanden? Een bosopstand waar recent werd uitgedund zal bĳvoorbeeld
duidelĳk ruimte weergeven tussen de boomkruinen en zou eenvoudig te herkennen moeten zĳn van de andere
bosopstanden er omheen.

• Blauwachtige gebieden geven onvruchtbaar terrein, wegen en stedelĳke gebieden , gewassen die nog niet zĳn
gaan groeien etc. aan.

• Gebruik geen zoom die te dicht op de afbeelding komt bĳ het proberen te identificeren van bosopstanden.
Een schaal tussen 1 : 3.000 en 1 : 5.000 zou voor deze afbeeldingen voldoende moeten zĳn. Zie de afbeelding
hieronder (schaal 1:4000):

14.4.3 ��� Probeer zelf: Bosopstanden digitaliseren vanuit CIR-afbeelding

Bĳ het digitaliseren van bosopstanden zou u moeten proberen bosgebieden te krĳgen die zo homogeen mogelĳk zĳn
in termen van boomsoorten, leeftĳd van het bos, dichtheid van de bosopstand…Wees echter niet te gedetailleerd, of
u eindigt met het maken van honderden kleine bosopstanden - en die in het geheel niet bruikbaar zĳn. U zou moeten
proberen opstanden te krĳgen die betekenisvol zĳn in de context van bosbouw, niet te klein (ten minste 0,5 ha) maar
ook niet te groot (niet meer dan 3 ha).
Met deze punten in gedachten kunt u nu de ontbrekende bosopstanden digitaliseren.

1. Stel de opties voor snappen en topologie in:
1. Ga naar Project ► ‘Opties voor snappen…’

2. Druk op Snappen inschakelen en selecteer Gevorderde configuratie
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3. Selecteer de laag forest_stands_2012

1. Stel Type in op Hoekpunt

2. Stel Tolerantie in op 10
3. Stel Eenheden in op pixels

4. Selecteer het vak onder Kruising voorkomen

5. Druk op Topologisch bewerken aan-/uitzetten

6. Kies Gevorderde configuratie volgen

7. Sluit de pop-up

2. Selecteer de laag forest_stands_2012 in de lĳst Lagen

3. Klik op de knop Bewerken aan/uitzetten om bewerken in te schakelen.
4. Begin met het digitaliseren met dezelfde technieken als in de vorige les. Het enige verschil is dat u nu geen

puntenlaag heeft waaraan u kunt snappen. Voor dit gebied zou u ongeveer 14 nieuwe bosopstanden moeten
krĳgen. Vul het veld StandID met nummers, beginnend met 901, tĳdens het digitaliseren.

5. Wanneer u gered bent zou uw laag er ongeveer als volgt uit moeten zien:
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Nu heeft u een nieuwe set polygonen die de verschillende bosopstanden weergeven voor de situatie van 2012 zoals
die kan worden geïnterpreteerd vanuit de CIR-afbeeldingen. Echter, u mist de gegevens van de inventarisatie van de
bossen. Daarvoor dient u naar het bos te gaan en monstergegevens te verzamelen die u zult gebruiken om de attributen
voor de bossen in te schatten voor elk van de bosopstanden. U zult in de volgende les zien hoe u dat doet.
U kunt enkele extra informatie over regels voor natuurbehoud toevoegen waarmee in dit gebied rekening moet worden
gehouden.

14.4.4 ��� Bosopstanden bijwerken met informatie over natuurbehoud

Voor het gebied waarin u werkt is zĳn er enkele regels met betrekking tot natuurbehoud waarmee rekening moet
worden gehouden bĳ het maken van de planning voor de bossen:

• Twee locaties van een beschermde soort gewone vliegende eekhoorn (Pteromys volans) zĳn geïdentificeerd.
Overeenkomstig de regelgeving dient een gebied van 15 meters rondom die plaatsen onaangetast te blĳven.

• Een aan de oever gelegen bos met speciale betekenis dat groeit langs een stroom in het gebied moet worden
beschermd. Tĳdens veldonderzoek is vastgesteld dat 20 meter aan beide zĳden van de stroom beschermd moet
worden.

U heeft een vectorbestand dat de informatie over de locaties van de eekhoorns bevat en een ander met de
gedigitaliseerde stroom die stroomt van het noordelĳke gebied naar het meer.

1. Voeg, uit de map exercise_data\forestry\, de bestanden squirrel.shp en stream.shp toe
aan het project.
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2. Gebruik het gereedschap Attributentabel openen om de laag squirrel te bekĳken
U kunt zien dat er twee locaties zĳn gedefinieerd voor de gewone vliegende eekhoorn, en dat het gebied dat
moet worden beschermd is aangegeven door een afstand van 15 meter vanaf die locaties.

Laten we het te beschermen gebied wat meer nauwkeurig afbakenen. We zullen een buffer maken rondom de locaties
van de punten, met de afstand voor bescherming.

1. Open Vector ► Geoprocessing-gereedschap ► Buffer.

2. Stel Invoerlaag in op squirrel

3. Stel Afstand in op 15 meter

4. Stel Gebufferd in op exercise_data\forestry\squirrel_15m.shp

5. Selecteer Uitvoerbestand openen na uitvoeren van algoritme

6. Klik op Uitvoeren

7. Als het proces is voltooid, klik op Sluiten
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U zult opmerken dat, als u inzoomt op de locatie in het noordelĳke gedeelte van het gebied, het gebied van de buffer
zich ook uitstrekt over twee aanliggende bosopstand. Dit betekent dat wanneer er een bewerking plaats zou vinden in
die bosopstand, ook rekening gehouden zou moeten worden met de beschermde locatie.

Voor het beschermen van de locaties van de eekhoorns gaat u een nieuw attribuut (kolom) toevoegen aan uw nieuwe
bosopstanden, die informatie zal bevatten over de locaties die moeten worden beschermd. Die informatie zal dan
beschikbaar zĳn als er een bewerking in het bos moet worden gepland, en het team in het veld, vóór het werk begint,
in staat stellen het gebied te markeren dat onaangetast moet blĳven.
Voor het samenvoegen van de informatie over de eekhoorns met die van de bosopstanden kunt u het algoritme Koppel
attributen op basis van plaats gebruiken:

1. Open Vector ► Datamanagement-gereedschap ► Attributen op basis van plaats bĳeenbrengen.

2. Stel Samenvoegen met objecten in in op forest_stands_2012

3. In Objecten die ze (geometrisch voorvoegsel), selecteer kruisen

4. Stel In vergelĳking met in op squirrel_15m

5. Stel Verbindingsstĳl in als Alleen attributen gebruiken van eerste overeenkomende object (één-tot-één)

6. Laat unchecked Records negeren die niet konden worden verbonden als niet geselecteerd
7. Stel Samengevoegde laag in op exercise_data\forestry\stands_squirrel.shp

8. Selecteer Uitvoerbestand openen na uitvoeren van algoritme

9. Klik op Uitvoeren

10. Als het proces is voltooid, kunt u het dialoogvenster Sluiten
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Nu heeft u een nieuwe laag met bosopstanden, stands_squirrel.shp die de informatie voor natuurbehoud
voor de gewone vliegende eekhoorn weergeeft.

1. Open de attributentabel van de laag stands_squirrel
2. Sorteer de tabel door te klikken op het veld point_pr in de koprĳ van de tabel.
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U kunt nu zien dat er enkele bosopstanden zĳn die informatie hebben over de beschermde locaties. De
informatie in de gegevens voor de bosopstanden zullen aan de beheerder van het bos duidelĳk maken dat
er rekening moet worden gehouden met regels over natuurbehoud. Dan kan hĳ of zĳ de locatie ophalen uit de
gegevensset squirrel, en het gebied bezoeken om de overeenkomende buffer rondom de locatie te markeren,
zodat de veldwerkers kunnen voorkomen dat zĳ de woonomgeving van de eekhoorns verstoren.

14.4.5 ��� Probeer zelf: Bosopstanden bijwerken met afstand tot de stroom

Door dezelfde benadering, zoals aangegeven voor de beschermde locaties voor de eekhoorns, te volgen kunt u nu uw
bosopstanden bĳwerken met de informatie voor de bescherming die is gerelateerd aan de stroom. Enkele punten:

• Onthoud dat de buffer 20 meter rondom de stroom is
• U wilt alle informatie over de bescherming in hetzelfde vectorbestand, gebruik dus de laag
stands_squirrel als de basislaag.

• Noem uw uitvoerbestand forest_stands_2012_protect.shp.
Open, als het proces is voltooid, de attributentabel van de uitvoerlaag en bevestig dat u alle informatie voor
natuurbehoud voor de bosopstanden langs de aan de oever gelegen stroom die zĳn geassocieerd met de stroom heeft.
Sla uw project van QGIS op als u tevreden bent met de resultaten

14.4.6 Conclusie

U heeft gezien hoe u CIR-afbeeldingen kunt interpreteren om bosopstanden te digitaliseren. Natuurlĳk zou het enige
praktĳkervaring vergen om meer nauwkeurige bosopstanden te maken en gewoonlĳk zou het gebruiken van andere
informatie,zoals kaarten van de bodem, betere resultaten geven, maar u kent nu de basis voor dit type taak. Toevoegen
van informatie uit andere gegevenssets bleek een onbeduidende taak te zĳn.
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14.4.7 Wat volgt?

De bosopstanden die u heeft gedigitaliseerd zullen worden gebruikt voor het plannen van bewerkingen in de bossen
in de toekomst, maar u moet nog steeds meer informatie over het bos krĳgen. In de volgende les zult u zien hoe u een
aantal monsterplaatsen plant om het bosgebied dat u zojuist heeft gedigitaliseerd te inventariseren, en een algehele
indruk te krĳgen over de parameters van het bos.

14.5 Les: Ontwerpen van systematisch monsters nemen

U heeft al een set polygonen gedigitaliseerd die de bosopstanden weergeven, maar u heeft op dit moment nog geen
informatie over het bos. Voor dat doel kunt u een enquête ontwerpen om het gehele bosgebied te inventariseren en
dan de parameters daarvan in te schatten. In deze les zult u een systematische set van monsterplaatsen maken.
Wanneer u begint met het plannen van de inventarisatie van het bos, is het belangrĳk om de doelen helder te
definiëren, de typen monsterplaatsen die zullen worden gebruikt, en de gegevens die zullen worden verzameld om de
doelen te bereiken. Voor elk individueel geval zullen deze afhangen van het type bos en de beheersdoeleinden; en
zouden zorgvuldig moeten worden gepland door iemand met kennis van bosbouw. In deze les zult u een theoretische
inventarisatie implementeren, gebaseerd op een systematisch ontwerp van monsterplaatsen.
Het doel voor deze les: Een systematisch ontwerp van monsterplaatsen maken om het bosgebied te onderzoeken.

14.5.1 Inventariseren van het bos

Er bestaan verscheidene methoden om bossen te inventariseren, elk daarvan voor verschillende doeleinden en met
andere voorwaarden. Een zeer nauwkeurige manier om bĳvoorbeeld een bos te inventariseren (als u alleen kĳkt naar
soorten bomen) zou zĳn om het bos te bezoeken en een lĳst te maken van elke boom en de karakteristieken daarvan.
Zoals u zich kunt voorstellen is dat, met uitzondering van enkele kleine gebieden of in speciale situaties, niet algemeen
toe te passen.
De meest voorkomende manier om een bos te onderzoeken is door er monsters van te nemen, dat is, metingen
verrichten op verschillende locaties in het bos en die informatie te veralgemeniseren voor het gehele bos. Deze
metingen worden vaak verricht op monsterplaatsen wat kleinere bosgebieden zĳn die gemakkelĳk bemeten kunnen
worden. De monsterplaatsen kunnen elke grootte zĳn (bĳv. 50 m2, 0,5 ha) en vorm (bĳv. cirkelvormig, rechthoekig,
variabele grootte), en kunnen op verschillende manieren in het bos liggen (bĳv. willekeurig, systematisch, langs
lĳnen). De grootte, vorm en locatie van de monsterplaatsen worden gewoonlĳk bepaald aan de hand van statistische,
economische en praktische overwegingen. Als u geen kennis heeft over bosbouw, bent u misschien geïnteresseerd in
het lezen van dit artikel op Wikipedia.

14.5.2 ��� Volgen: Implementeren van een ontwerp van het gebied voor
systematisch monsters nemen

Voor het bos waarmee u werkt heeft de beheerder besloten dat een systematisch ontwerp van monsterplaatsen het
meest toepasselĳk is voor dit bos en heeft besloten dat een vaste afstand van 80 meter tussen de monsterplaatsen
en monsterlĳnen betrouwbare resultaten zal opleveren (voor dit geval een gemiddelde foutmarge van +- 5% bĳ een
waarschĳnlĳkheid van 68%). Besloten is dat monsterplaatsen met een variabele grootte de meest effectieve methode
voor deze inventarisatie zĳn, voor groeiende en volwassen bosopstanden, maar monsterplaatsen met een vaste straal
van 4 meter zal worden gebruikt voor bosopstanden met zaailingen.
In de praktĳk dient u eenvoudigweg de monsterplaatsen weer te geven als punten, die later zullen worden gebruikt
door de teams in het veld:

1. Open uw project digitizing_2012.qgs uit de vorige les.
2. Verwĳder alle lagen, behalve forest_stands_2012.
3. Sla uw project nu op als forest_inventory.qgs.
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Nu moet u een rechthoekig raster van punten maken die 80 meter van elkaar liggen:

1. Open Vector ► Onderzoeks-gereedschap Regelmatige punten.
2. Druk op de keuzeknop naast het veld Bereik invoer en selecteer, uit het menu Uit laag berekenen,

forest_stands_2012.
3. In de instelling Punt afstand/aantal, voer 80 meters in.
4. Selecteer het vak Punt afstand gebruiken om aan te geven dat de waarde de afstand tussen de punten aangeeft.
5. Onder Regelmatige punten, sla de uitvoer op als systematic_plots.shp in de map forestry\

sampling\.
6. Selecteer Uitvoerbestand openen na uitvoeren van algoritme.
7. Druk op Uitvoeren.

Notitie: De voorgestelde Regelmatige punten maakt de systematische punten, beginnend in de linkerbovenhoek van
het bereik van de geselecteerde polygoonlaag. Als u wat meer willekeurigheid aan deze regelmatige punten wilt
toevoegen, zou u eenwillekeurig berekend getal tussen 0 en 80 (80 is de afstand tussen onze punten) kunnen gebruiken,
en dat dan schrĳven als de parameter Beginwaarde voor hoek (LH kant) in het dialoogvenster van het gereedschap.

U zult gemerkt hebben dat het gereedschap het gehele bereik van uw laag met bosopstanden heeft gebruikt om een
rechthoekig raster van punten te genereren. Maar u bent alleen geïnteresseerd in de punten die feitelĳk binnen uw
bosgebied liggen (bekĳk de afbeeldingen hieronder):

1. Vanuit de Toolbox van Processing, open GDAL ► Vector geoprocessing ► Vector op maskerlaag clippen.
2. Selecteer systematic_plots als de Invoerlaag.
3. Stel forest_stands_2012 in als de Maskeerlaag.
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4. Sla het resultaat Geclipt (masker) op als systematic_plots_clip.shp in de map forestry\
sampling\.

5. Selecteer Uitvoerbestand openen na uitvoeren van algoritme.
6. Druk op Uitvoeren.

U heeft nu de punten die de teams in het veld zullen gebruiken om naar de locaties van de ontworpen monsterplaatsen
te navigeren. U kunt deze punten nog steeds voorbereiden zodat ze meer bruikbaar zĳn voor het veldwerk. U zult
tenminste betekenisvolle namen moeten toevoegen aan de punten en ze exporteren naar een indeling die kan worden
gebruikt in hun GPS-apparaten.
Laten we beginnen met het benoemen van de monsterplaatsen. Als u de Attributentabel van de plots binnen het
bosgebied bekĳkt, kunt u zien dat u het standaard veld id automatisch werd gemaakt door het gereedschapRegelmatige
punten. Label de punten om ze op de kaart te zien en overweeg of u deze nummers als deel van de naamgeving voor
uw monsterplaatsen kunt gebruiken:

1. Open de Laageigenschappen ► Labels voor de laag systematic_plots_clip.
2. Schakel het bovenste menu naar Enkele labels.
3. Voor het itemWaarde, selecteer het veld id.
4. Ga naar de tab Buffer, selecteer Teken tekstbuffer en stel de Grootte van de buffer in op 1.
5. Klik op OK.

Bekĳk nu de labels op uw kaart. U kunt zien dat de punten zĳn gemaakt en genummerd van Oost naar West en
vervolgens van Noord naar Zuid. Als u opnieuw naar de attributentabel kĳkt, zult u zien dat de volgorde in de tabel
ook dat patroon volgt. Tenzĳ u een reden hebt om de monsterplaatsen een andere naam te geven, is het benoemen
ervan op de wĳze van West-Oost/Noord-Zuid een logische volgorde en is een goede optie.
Niettegenstaande dat, de getalwaarden in het veld id zĳn niet zo goed. Het zou beter zĳn als de naamgeving iets zou
zĳn van p_1, p_2…. U kunt een nieuwe kolom maken voor de laag systematic_plots_clip:

1. Ga naar de Attributentabel van systematic_plots_clip.

2. Schakel naar de modus Bewerken.

3. Open de Veldberekening:
1. Selecteer Nieuw veld aanmaken

2. Voer Plot_id in als Naam voor veld

3. Stel het Veldtype in op Tekst (string).
4. Schrĳf, kopieer of construeer in het veld Expressie, deze formule concat('P_', @row_number).

Onthoud dat u ook kunt dubbelklikken op de elementen binnen de Functielĳst. De functie concat is te
vinden onder Tekenreeks en @row_number staat in de groep Velden en waarden.

4. Klik op OK.
5. Schakel de modus Bewerken uit en sla uw wĳzigingen op.

Nu heeft u een nieuwe kolom met namen voor monsterplaatsen die voor u een betekenis hebben. Wĳzig, voor de laag
systematic_plots_clip, het veld dat wordt gebruikt voor het labelen naar uw nieuwe veld Plot_id.
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14.5.3 ��� Volgen: Exporteren van gebieden voor monsters in indeling GPX

De veldteams zullen waarschĳnlĳk een GPS-apparaat gebruiken om de door u geplande monsterplaatsen te
lokaliseren. De volgende stap is om de punten die u hebt gemaakt te exporteren naar een indeling die uw GPS
kan lezen. QGIS stelt u in staat uw punt- en lĳn-vectorgegevens op te slaan in GPS eXchange Format (GPX), dat
een standaard GPS-gegevensindeling is die kan worden gelezen door de meeste gespecialiseerde software. U moet
voorzichtig zĳn met het selecteren van het CRS als u uw gegevens opslaat:

1. Klik met rechts op de laag systematic_plots_clip en selecteer Exporteren ► Objecten opslaan als….

2. Selecteer GPS eXchange Format [GPX] in Formaat.
3. Sla de Bestandsnaam voor de uitvoer op als plots_wgs84.gpx in de map forestry\sampling\.
4. Selecteer Geselecteerd CRS in CRS.
5. Blader naar EPSG:4326 - WGS 84.

Notitie: De indeling GPX accepteert alleen dit CRS, wanneer u een ander selecteert zal QGIS geen
foutmelding geven, maar u krĳgt een leeg bestand.

6. Klik op OK.
7. In het dialoogvenster dat opent, selecteer alleen de laag waypoints (de rest van de lagen is leeg).

De monsterplaatsen voor de inventarisatie staan nu in een standaard indeling die kan worden beheerd door de meeste
software voor GPS. De veldteams kunnen nu de locaties van demonsterplaatsen uploaden naar hun apparaten. Dat zou
worden gedaan met de eigen software van de specifieke apparaten en het bestand plots_wgs84.gpx dat u zojuist
hebt opgeslagen. Een andere optie zou zĳn om de plug-in GPS Tools te gebruiken, maar dat zou zeer waarschĳnlĳk
inhouden om dat gereedschap in te stellen om te kunnen werken met uw specifieke GPS-apparaat. Als u alleen met
uw eigen gegevens werkt en wilt zien hoe het gereedschap werkt, kunt u informatie erover vinden in het gedeelte
working_gps in de QGIS Gebruikershandleiding.
Sla nu uw project van QGIS op.
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14.5.4 Conclusie

U zag zojuist hoe eenvoudig u een systematisch ontwerp voor monstername kunt maken dat gebruikt kan worden
worden voor de inventarisatie van een bos. Het maken van andere typen ontwerpen voor het nemen van monsters zal
het gebruiken van andere gereedschappen binnen QGIS behelzen, werkbladen of scripten om de coördinaten van de
monsterplaatsen te berekenen, maar het algemene idee blĳft hetzelfde.

14.5.5 Wat volgt?

In de volgende les zult u zien hoe u de mogelĳkheden voor Atlas in QGIS kunt gebruiken om automatisch
gedetailleerde kaarten te genereren die teams in het veld zullen gebrukken om naar de monsterplaatsen te navigeren
die aan hen zĳn toegewezen.

14.6 Les: Gedetailleerde kaarten maken met het gereedschap
Atlas

Het systematisch ontwerp voor het nemen van monsters is gereed en de teams in het veld hebben de GPS-coördinaten
in hun navigatieapparaten geladen. Zĳ hebben ook een formulier met veldgegevens waarop zĳ de informatie zullen
verzamelen die zĳ hebben gemeten op elke monsterplaats. Zĳ hebben een aantal gedetailleerde kaarten gevraagd
waarop enige informatie over het terrein duidelĳk zichtbaar is, tezamen met een kleinere subset van monsterplaatsen
en enige informatie over het gebied van de kaart om eenvoudiger hun weg naar elke monsterplaats te vinden. U kunt
het gereedschap Atlas gebruiken om automatisch een aantal kaarten in een gelĳke indeling te generen.
Het doel voor deze les: Het gereedschap Atlas in QGIS leren gebruiken om gedetailleerde af te drukken kaarten te
genereren om te helpen bĳ de inventarisatie in het veld.

14.6.1 ��� Volgen: Afdruklay-out voorbereiden

Vóór we de gedetailleerde kaarten van het bosgebied en onze monsterplaatsen kunnen automatiseren, moeten we
een kaartsjabloon maken met alle elementen die we nuttig achten voor het werk in het veld. Natuurlĳk is het meest
belangrĳke dat het goed opgemaakt is, maar, zoals u al eerder heeft gezien, u zult ook heel veel andere elementen
moeten toevoegen die de afgedrukte kaart completeren.

1. Open het project forest_inventory.qgs van QGIS vanuit de vorige les. U zou ten minste de volgende
lagen moeten hebben:

• forest_stands_2012 (met een transparantie van 50%, groene vulling en donkergroene lĳnen als rand).
• systematic_plots_clip

• rautjarvi_aerial

2. Sla het project op onder de nieuwe naam map_creation.qgs.
Onthoud dat u Lay-out beheren: gebruikt om een kaart te maken die kan worden afgedrukt,

1. Project ► Lay-out beheren… te openen.
2. In het dialoogvenster Lay-out beheren:

1. Onder Nieuw uit sjabloon, klik op de knop Maken… het item Lege lay-out.
2. Noem uw afdruklay-out forest_map.
3. Druk op OK. Een nieuwe afdruklay-out is gemaakt en geopend, geeft een blanco papier weer.

3. In het venster Afdruklay-out, zorg er voor dat de eigenschappen zĳn ingesteld voor A4-papier:
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1. Klik met rechts op het papier en selecteer Item-eigenschappen. Het paneel Item-eigenschappen voor
pagina’s is nu geopend aan de rechterkant van de lay-out.

2. Controleer of Grootte A4 is.
3. Controleer of Oriëntatie Liggend is.

4. Schakel de tab Lay-out naast het paneel:Item-eigenschappen en stel Export resolutie in op 300 dpi.
Het maken van een kaart gaat eenvoudiger als u gebruikt maakt van het kaartraster om de verschillende elementen te
plaatsen. Bekĳk de instellingen voor het raster van afdruklay-out:

1. Vergroot, op de tab Lay-out, het gebied Hulplĳnen en raster.
2. Controleer of de Rasterafstand is ingesteld op 10 mm en dat de Tolerantie voor ‘snappen’ is ingesteld op 5

px.
U dient het gebruiken van het raster te activeren:

1. Open het menu Beeld.
2. Klik op Grid tonen.
3. Selecteer Aan grid snappen.
4. Merk op dat de opties voor het gebruiken van Hulplĳnen standaard zĳn geselecteerd, wat u in staat stelt rode

hulplĳnen te zien wanneer u elementen in de lay-out verplaatst.
5. Nu kunt u beginnen met het toevoegen van elementen aan uw lay-out. Voeg eerst een kaartelement toe zodat

u kunt bekĳken hoe het kaartvenster er uitziet als u wĳzigingen in de symbologie van de kaart maakt:

1. Klik op de knop Kaart toevoegen.
2. Klik en sleep een rechthoek op het kaartvenster zodat de kaart het grootste deel daarvan bedekt.

Merk op hoe de muiscursor snapt aan het kaartraster. Gebruik deze functie als u andere elementen toevoegt. Als u
nauwkeuriger wilt werken, wĳzig dan de instelling Rasterafstand voor het raster. Als u om enige reden niet op een
bepaald punt niet zou willen snappen aan het raster, kunt u het altĳd in- of uitschakelen in het menu Beeld.
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14.6.2 ��� Volgen: Een kaart voor de achtergrond toevoegen

Laat de lay-out open maar ga terug naar de kaart. Laten we enige achtergrondgegevens toevoegen en enige opmaak
maken zodat de inhoud van de kaart zo duidelĳk als maar mogelĳk is.

1. Voeg het raster voor de achtergrond basic_map.tif toe dat u kunt vinden in de map exercise_data\
forestry\.

2. Indien daarnaar gevraagd, selecteer het CRS ETRS89 / ETRS-TM35FIN voor het raster.
Zoals u kunt zien is de kaart voor de achtergrond al opgemaakt. Dit type direct te gebruiken cartografie-raster
is vrĳ algemeen. Het wordt gemaakt vanuit vectorgegevens, opgemaakt in een standaard indeling en opgeslagen
als een raster zodat u zich niet bezig hoeft te houden met het opmaken van verscheidene vectorlagen en u geen
zorgen hoeft te maken of u wel een goed resultaat krĳgt.

3. Zoom nu in op uw monsterplaatsen, zodat u alleen nog vier of vĳf lĳnen met monsterplaatsen ziet.
De huidige opmaak van de monsterplaatsen is niet de beste:

Gedurende de laatste oefeningen was de witte buffer boven op de luchtfoto OK, maar nu dat de achtergrondafbeelding
meest wit is kunt u de labels nog nauwelĳks zien.Maar hoe ziet het eruit in de afdruklay-out? Laten we het controleren:

1. Ga naar het venster Afdruklay-out.

2. Gebruik de knop Item selecteren/Verplaatsen om het kaartelement in de lay-out te selecteren.
3. Ga naar de tab Item-eigenschappen.

4. Klik op Kaartbereik instellen op bereik van kaartvenster.

5. Klik op Voorvertoning bĳwerken als u het element moet vernieuwen.
Dit is duidelĳk niet voldoende; u wilt de nummers van de monsterplaatsen zo zichtbaar mogelĳk maken voor de teams
in het veld.

14.6.3 ��� Probeer zelf: De symbologie van lagen wijzigen

InModule: Een basiskaart maken en verkennen is gewerkt met symbologie en inModule: Vectorgegevens classificeren
met labels. Het is aan te raden deze delen van de handleiding nog even door te lezen. Doel is om locaties en namen
van monsterplaatsen zichtbaar te maken op een manier waarbĳ de ondergrond ook zichtbaar blĳft. Onderstaande
afbeelding geeft een mogelĳk resultaat:
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U zult later de groene opmaak van de laag forest_stands_2012 gebruiken. Om die te behouden en een
visualisatie er van te hebben die alleen de randen van de bosopstanden weergeeft:

1. Klik met rechts op forest_stands_2012 en selecteer Dupliceren

2. U krĳgt een nieuwe laag, genaamd forest_stands_2012 kopiëren, die u kunt gebruiken om een
andere stĳl te definiëren, bĳvoorbeeld zonder vulling en met rode randen.
Nu heeft u twee verschillende visualisaties van de bosopstanden en kunt u beslissen welke weer te geven voor
uw detailkaart.

3. Ga vaak terug naar het venster Afdruklay-out om te zien hoe de kaart er uit zou komen te zien. Voor het doel
gedetailleerde kaarten te maken, zoekt u naar een symbologie die er niet goed uitziet op de schaal van het gehele
bosgebied (linker afbeelding hieronder) maar op een kleinere schaal (rechter afbeelding hieronder). Vergeet
niet Voorvertoning bĳwerken en Aanpassen aan kaartformaat te gebruiken wanneer u de zoomfactor
wĳzigt in uw kaart of de lay-out.
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14.6.4 ��� Probeer zelf: Een sjabloon voor een basiskaart maken

1. Als u eenmaal een symbologie heeft die u bevalt, bent u klaar om meer informatie aan uw af te drukken kaart
toe te voegen. Voeg ten minste de volgende elementen toe:

• Titel.
• Een schaalbalk.
• Een raster voor uw kaart.
• Coördinaten aan de zĳkanten van het raster.

2. U heeft al een soortgelĳke lay-out gemaakt in Module: De kaarten opmaken. Ga terug naar die module als dat
nodig is. U kunt deze voorbeeldafbeelding als verwĳzing gebruiken:

3. Exporteer uw kaart als een afbeelding en bekĳk hem.
1. Lay-out ► Als afbeelding exporteren.
2. Gebruik de JPG format voor het voorbeeld.

Dat is hoe het er uit zal zien na het afdrukken.

14.6.5 ��� Volgen: Meer elementen aan de Afdruklay-out toevoegen

Zoals u waarschĳnlĳk al is opgevallen in de voorgestelde voorbeelden voor afbeeldingen van sjablonen, is er ruim
voldoende ruimte aan de rechterzĳde van het kaartvenster. Laten we eens zien wat daar nog meer zou kunnen worden
geplaatst. Voor het doel van onze kaart is een legenda niet echt nodig, maar een overzichtskaart en enkele tekstvakken
zouden waarde aan de kaart kunnen toevoegen.
Een overzichtskaart zou de teams in het veld helpen de gedetailleerde kaart binnen het algehele bosgebied te plaatsen:

1. Voeg een ander kaartelement toe aan het kaartvenster, rechts onder de tekst voor de titel.
2. Open, op de tab Item-eigenschappen, de keuzelĳst Overzichtskaarten.
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3. Stel het Kaartframe in op Kaart 0. Dit maakt een geschaduwde rechthoek over de kleinere kaart die het bereik
weergeeft dat zichtbaar is in de grotere kaart.

4. Selecteer ook de optie Frame met een zwarte kleur en een Dikte van 0.30.

Merk op dat uw overzichtskaart niet echt een overzicht geeft van het gehele bosgebied, wat is wat u wilt. U
wilt dat deze kaart het gehele bosgebied weergeeft en u wilt dat het alleen de achtergrondkaart en de laag
forest_stands_2012 weergeeft, en niet de monsterplaatsen. Ook wilt u dat zĳn weergave wordt vergrendeld
zodat die niet meer wĳzigt wanneer u de zichtbaarheid of volgorde van de lagen wĳzigt.

1. Ga terug naar de kaart, maar sluit de Lay-out niet.
2. Klik met rechts op de laag forest_stands_2012 en klik op Op kaartlaag inzoomen.
3. Deactiveer alle lagen met uitzondering van basic_map en forest_stands_2012.
4. Vergroot het gereedschap Kaartthema’s beheren in het paneel Layers en selecteer Thema toevoegen.
5. Noem het basic_overview.
6. Ga terug naar de afdruklay-out.
7. Klik, met de kleine kaart geselecteerd, opAanpassen aan kaartformaat hoofdvenster om zĳn bereik in te stellen

op wat u ziet in het kaartvenster.
8. Vergrendel deweergave voor de overzichtskaart door te selecterenLagen vastzetten voor kaartthema en selecteer

basic_overview onder Algemene eigenschappen.
Nu is uw overzichtskaart meer zoals u verwachtte en de weergave ervan zal niet meer wĳzigen. Maar, natuurlĳk, nu
geeft uw gedetailleerde kaart de randen van de bosopstanden niet meer weer, noch de monsterplaatsen. Laten we dat
repareren:

1. Ga opnieuw naar het kaartvenster en selecteer de lagen die zichtbaar moeten zĳn
(systematic_plots_clip, forest_stands_2012 kopiëren en Basic_map).

2. Zoom opnieuw in zodat slechts een paar lĳnen met monsterplaatsen zichtbaar zĳn.
3. Ga terug naar het venster Lay-out.
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4. Selecteer de grotere kaart in uw lay-out.
5. Klik, in Item-eigenschappen op Voorvertoning bĳwerken en Aanpassen aan kaartformaat hoofdvenster.

Merk op dat alleen de grotere kaart de huidige kaartweergave toont, en dat de kleinere overzichtskaart dezelfde
weergave heeft als toen u die vergrendelde.
Merk ook op dat de overzichtskaart een geschaduwd frame weergeeft voor het bereik dat wordt weergegeven in de
detailkaart.

Uw sjabloon voor de kaart is bĳna voltooid. Voeg nu twee tekstvakken onder de kaart toe, één met de tekst
‘Gedetailleerde kaart zone: ‘ en de andere met ‘Opmerking: ‘. Plaats ze zoals u kunt zien in bovenstaande afbeelding.
U kunt ook een Noordpĳl toevoegen aan de overzichtskaart:

1. Selecteer het gereedschap Noordpĳl toevoegen.
2. Klik en sleep een rechthoek in de rechterbovenhoek van de overzichtskaart.
3. In Item-eigenschappen Selecteer SVG-afbeelding

4. Blader naar SVG Browser ► SVG-groepen voor de afbeelding van een pĳl.
5. Selecteer, onder Rotatie afbeelding, Met kaart synchroniseren en selecteer Kaart 1 (de overzichtskaart).
6. Wĳzig de grootte van de afbeelding van de pĳl zodat die er goed uitziet op een kleine kaart.

De lay-out voor de basiskaart is nu gereed, nu wilt u gebruikmaken van het gereedschapAtlas om zoveel gedetailleerde
kaarten in deze indeling te generen als u nodig vindt.
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14.6.6 ��� Volgen: Een Atlas-bedekking maken

De Atlas dekking is slechts een vectorlaag die zal worden gebruikt om de gedetailleerde kaarten te genereren, één
kaart voor elk object in de dekking. Hier is een volledige set van gedetailleerde kaarten voor het bosgebied om een
idee te krĳgen van wat vervolgens zal worden gedaan.

De bedekking zou elke bestaande laag kunnen zĳn, maar gewoonlĳk is het verstandiger er een te maken voor dit
specifieke doel. Laten we een raster van polygonen maken die het bosgebied bedekken:

1. Open, in de kaartweergave van QGIS, Vector ► Onderzoeks-gereedschap ► Grid maken.
2. Stel het gereedschap in zoals in deze afbeelding:
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3. Sla de uitvoer op als atlas_coverage.shp.
4. Maak de nieuwe laag atlas_coverage zo op dat de polygonen geen vulling hebben.

De nieuwe vlakken bedekken het hele gebied van het bos en geven een indruk van wat elke kaart (gemaakt van
individuele vlakken) bevat.
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14.6.7 ��� Volgen: Het gereedschap Atlas instellen

De laatste stap is om het gereedschap Atlas in te stellen:
1. Ga terug naar de afdruklay-out.
2. Ga, in het paneel rechts, naar de tab Atlas-generatie.
3. Stel de opties als volgt in:
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Dat vertelt het gereedschap Atlas om de objecten (polygonen) binnen atlas_coverage te gebruiken als
de focus voor elke gedetailleerde kaart. Het zal één kaart uitvoeren voor elk object in de laag. De Verborgen
bedekkingslaag vertelt de Atlas om de polygonen niet weer te geven op de uitgevoerde kaarten.

Er moet nog één ding worden gedaan. U moet het gereedschap Atlas vertellen welk kaartelement moet worden
bĳgewerkt voor elke uitgevoerde kaart. U kunt nu waarschĳnlĳk wel raden dat het kaartonderdeel dat voor elke
kaart moet worden bĳgewerkt dat is welk u heeft voorbereid om detailweergaven te bevatten van de monsterplaatsen,
dat is het grotere kaartelement in uw kaartvenster:

1. Selecteer het grotere kaartelement (Kaart 0).
2. Ga naar de tab Item-eigenschappen.
3. Selecteer in de lĳst Beheerd door Atlas.
4. En stel Marge rond object in op 10%. Het bereik voor de weergave zal 10% groter zĳn dan de polygonen, wat

betekent dat uw gedetailleerde kaarten elkaar 10% overlappen.
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Nu kunt u het gereedschap Voorvertoning voor Atlas-kaarten gebruiken om te zien hoe uw kaarten eruit zullen komen
te zien:

1. Activeer de voorbeelden van Atlas met behulp van de knop of, als uw werkbalk Atlas niet zichtbaar is, via
Atlas ► Voorbeeld Atlas.

2. U kunt de pĳlen in de werkbalk Atlas gebruiken of die in het menu Atlas om door de te maken kaarten te
verplaatsen.

Merk op dat sommige ervan niet interessant zĳn. Laten we daar iets aan doen en enkele bomen sparen door die
onbruikbare kaarten niet af te drukken.

14.6.8 ��� Volgen: De bedekkingslaag bewerken

Naast het verwĳderen van de polygonen voor die gebieden die niet interessant zĳn, kunt u ook de tekstlabels in uw te
generen kaart aanpassen met inhoud uit de Attributentabel van uw bedekkingslaag:

1. Ga terug naar de kaartweergave.
2. Schakel Bewerken in voor de laag atlas_coverage.
3. Selecteer de polygonen die zĳn geselecteerd (in geel) in onderstaande afbeelding.
4. Verwĳder de geselecteerde polygonen.
5. Schakel Bewerken uit en sla de wĳzigingen op.
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U kunt nu terug gaan naar de afdruklay-out en controleren of de voorbeelden van Atlas alleen de polygonen gebruiken
die zĳn overgebleven op de laag.
De bedekkingslaag die u gebruikt heeft nog geen bruikbare informatie die u zou kunnen gebruiken om de inhoud van
de labels op uw kaart aan te passen. De eerste stap is om ze te maken, u kunt bĳvoorbeeld een code voor de zone
toevoegen voor de gebieden van de polygonen en een veld met enkele opmerkingen voor de teams in het veld om
rekening mee te houden:

1. Open de Attributentabel voor de laag atlas_coverage.
2. Schakel Bewerken in.

3. Gebruik de veldberekening om de volgende twee velden te maken en in te vullen.
4. Maak een veld genaamd Zone en typ Geheel getal (integer).
5. In het vak Expressie schrĳf/kopieer/construeer @row_number.
6. Maak een ander veld, genaamd Opmerking,van het type Tekst (string) en een breedte van 255.
7. Schrĳf, in het vak Expressie ``’Geen opmerkingen.’``Dat zal de standaardwaarde instellen voor alle polygonen.

De beheerder van het bos zal enige informatie hebben over het gebied die bruikbaar is bĳ het bezoeken van het
gebied. Bĳvoorbeeld de aanwezigheid van een brug, een moeras of de locatie van een beschermde soort. De laag
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atlas_coverage staat waarschĳnlĳk nog steeds in demodus Bewerken, voeg de volgende tekst toe in het veldOpmerking
voor de overeenkomende polygonen (dubbelklik op de cel om die te bewerken):

• Voor de Zone 2:Brug ten noorden van monsterplaats 19. Siberische grondeekhoorn
tussen p_13 en p_14.

• Voor de Zone 6: Moeilijk te verplaatsen in het moeras ten noorden van het
meer.

• Voor de Zone 7: Siberische grondeekhoorn ten zuiden van p_94.

• Schakel Bewerken uit en sla uw wĳzigingen op.
Bĳna klaar. Nu moet u het gereedschap Atlas vertellen dat u wilt dat enkele tekstlabels de informatie uit de
attributentabel van de laag atlas_coverage gebruiken.

1. Ga terug naar de Lay-out.
2. Selecteer het tekstlabel dat Gedetailleerde kaart... bevat.
3. Stel de grootte van Lettertype in op 12.
4. Zet de cursor aan het einde van de tekst in het label.
5. Klik, in de Algemene eigenschappen op de tab Item-eigenschappen, op Een expressie invoeren of bewerken….
6. Dubbelklik, in de Functielĳst, op het veld Zone onder Velden en waarden.
7. Klik op OK.
8. De tekst in het vak in de Item-eigenschappen zou nu Gedetailleerde kaart zone [% "Zone" %]

moeten weergeven. Onthoud dat [% "Zone" %] zal worden vervangen door de waarde van het veld Zone
voor het overeenkomende object uit de laag atlas_coverage.

9. Test de inhoud van het label door te kĳken naar de verschillende voorbeelden van de kaarten in Atlas.
10. Doe hetzelfde voor de labels met de tekstOpmerking: door het veldmet de informatie voor de zone te gebruiken.

U kunt een regeleinde invoegen vóór u de expressie invoert. U kunt het resultaat voor het voorbeeld van zone
2 zien in de afbeelding hieronder:
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11. Gebruik de voorbeelden van Atlas om door alle kaarten te bladeren die u nu snel zult maken en geniet ervan!

14.6.9 ��� Volgen: De kaarten afdrukken

Als laatste maar niet het minste, afdrukken of exporteren van uw kaarten als afbeeldingen of PDF-bestanden. U kunt
Atlas ► Atlas als afbeeldingen exporteren… of Atlas ► Atlas als PDF exporteren… gebruiken. Momenteel werkt het
exporteren naar de indeling SVG nog niet goed en zal een slecht resultaat geven.
Laten we de kaarten als één enkele PDF exporteren die u naar het veldbureau kunt sturen om af te drukken:

1. Ga naar de tab Atlas-generatie in het paneel rechts.
2. Selecteer, onder Uitvoer, Exporteren naar enkel bestand indien mogelĳk. Dit zal alle kaarten bĳ elkaar in één

PDF stoppen, als deze optie niet wordt geselecteerd krĳgt u één bestand voor elke kaart.
3. Open Lay-out ► Als PDF exporteren….
4. Sla het PDF-bestand op als inventory_2012_maps.pdf in uw map exercise_data\forestry\

samplig\map_creation\.
5. Open het PDF-bestand om te controleren of alles is gegaan zoals verwacht.
6. U zou net zo makkelĳk afzonderlĳke afbeeldingen kunnen maken voor elke kaart (onthoud om het maken van

één enkel bestand uit te schakelen), hier kunt u de miniaturen zien voor de afbeeldingen die gemaakt zullen
worden:
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7. In de Afdruklay-out, druk op Opslaan om uw wĳzigingen van de afdruklay-out in het project op te slaan. Dit
slaat ook het projectbestand op. U kunt het project op elk moment heropenen of de Atlas bewerken.
Het is ook mogelĳk uw kaart op te slaan als een sjabloon voor lay-out als forestry_atlas.qpt in uw
map exercise_data\forestry\map_creation\. Gebruik Lay-out ► Als sjabloon opslaan. U zult
in staat zĳn dit sjabloon steeds opnieuw te gebruiken.

8. Sluit de Afdruklay-out en het project.

14.6.10 Conclusie

U bent erin geslaagd een sjabloonkaart te maken die kan worden gebruikt om automatisch gedetailleerde kaarten te
genereren die in het veld kunnen worden gebruikt om naar de verschillende monsterplaatsen te navigeren. Zoals u
heeft gemerkt was dit geen eenvoudige taak maar de voordelen worden duidelĳk wanneer u soortgelĳke kaarten moet
maken voor andere regio’s en u het sjabloon kunt gebruiken dat u zojuist heeft gemaakt.

14.6.11 Wat volgt?

In de volgende les zult u zien hoe u gegevens van LiDAR kunt gebruiken om een DEM te maken en die dan te
gebruiken om de zichtbaarheid van uw gegevens en kaarten te vergroten.

14.7 Les: De parameters voor het bos berekenen

Het bepalen van de parameters van het bos is het doel van de inventarisatie van het bos. In aansluiting op het voorbeeld
uit de vorige les, zult u de in het veld verzamelde informatie van de inventarisatie gaan gebruiken om de parameters
voor het bos te berekenen, eerst voor het gehele bos, en dan voor de bosopstanden die u eerder digitaliseerde.
Het doel voor deze les: Parameters voor het bos berekenen, voor het geheel en op niveau van bosopstand.
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14.7.1 ��� Volgen: De resultaten van de inventarisatie toevoegen

De teams in het veld hebben het bos bezocht en, met behulp van de informatie die u heeft verschaft, informatie over
het bos verzameld op elke monsterplaats.
Heel vaak zal de informatie worden verzameld op papieren formulieren in het veld, daarna getypt in een werkblad. De
informatie van de monsterplaatsen is opgenomen in een .csv-bestand dat eenvoudig kan worden geopend in QGIS.
Ga door met het project van QGIS uit de les over het ontwerpen van de inventarisatie. U heeft het waarschĳnlĳk
forest_inventory.qgs genoemd.
Voeg als eerste de metingen van de monsterplaatsen toe aan uw project van QGIS:

1. Ga naar Laag ► Laag toevoegen ► Tekstgescheiden kaartlaag toevoegen….
2. Blader naar het bestand systematic_inventory_results.csv geplaatst in de map

exercise_data/forestry/results/.
3. Zorg er voor dat de optie Puntcoördinaten is geselecteerd.
4. Stel de velden voor de coördinaten in op de velden X en Y.
5. Klik op OK.
6. Selecteer het CRS ETRS89 / ETRS-TM35FIN CRS als daarnaar gevraagd wordt.
7. Open de Attributentabel voor de nieuwe laag en bekĳk de gegevens.

U kunt het type gegevens dat is opgenomen in de metingen op de monsterplaatsen lezen in het tekstbestand
legend_2012_inventorydata.txt dat is geplaatst in de map exercise_data/forestry/
results/.
De laag systematic_inventory_results die u zojuist heeft toegevoegd is in feite slechts een virtuele
weergave van de tekstinformatie in het .csv-bestand. Converteer, vóórdat u doorgaat, de resultaten van de
inventarisatie naar een echte ruimtelĳke gegevensset:

1. Klik met rechts op de laag systematic_inventory_results.
2. Blader naar de map exercise_data/forestry/results/.
3. Noem het bestand sample_plots_results.shp.
4. Selecteer Voeg opgeslagen bestand toe aan kaart.
5. Verwĳder de laag systematic_inventory_results uit uw project.

14.7.2 ��� Volgen: Schatting parameters voor gehele bos

U kunt de gemiddelden berekenen voor het gehele bosgebied vanuit de resultaten voor de inventarisatie voor enkele
interessante parameters, zoals het volume en het aantal stammen per hectare. Omdat de systematischemonsterplaatsen
gelĳke gebieden vertegenwoordigen, kunt u direct de gemiddelden van de volumes en het aantal stammen per hectare
berekenen vanuit de laag sample_plots_results.
U kunt het gemiddelde van een veld in een vectorlaag berekenen met behulp van het gereedschap Basisstatistieken:

1. Open Vector ► Analyse-gereedschap ► Basisstatistieken voor velden.
2. Selecteer sample_plots_results als de Invoer vectorlaag.
3. Selecteer Vol als Doelveld.
4. Klik op OK.

Het gemiddelde volume in het bos is 135.2 m3/ha.
U kunt op dezelfde manier het gemiddelde aantal stammen berekenen, 2745 stammen/ha.
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14.7.3 ��� Volgen: Schatten parameters bosopstand

U kunt gebruikmaken van deze zelfde systematische monsterplaatsen schattingen te berekenen voor de verschillende
bosopstanden die u eerder digitaliseerde. Enkele van deze bosopstanden kregen geen monsterplaats en voor hen zult u
dus geen informatie ontvangen. U zou enkele extra monsterplaatsen hebben kunnen plannen toen u de systematische
inventarisatie plande, zodat de teams in het veld voor dit doel een paar extra monsterplaatsen zouden hebben bemeten.
Of u zou later een team het veld ingestuurd kunnen hebben om schattingen voor de ontbrekende bosopstanden te
verkrĳgen omde inventarisatie van de bosopstanden te completeren. Niettegenstaande dat, u zult informatie verkrĳgen
voor een groot aantal bosopstanden door slechts gebruik te maken van de geplande monsterplaatsen.
Wat u nodig heeft zĳn de gemiddelden van de monsterplaatsen die binnen elk van de bosopstanden vallen. Wanneer
u informatie wilt combineren, gebaseerd op hun relatieve locaties, moet u een ruimtelĳke join uitvoeren:

1. Open het gereedschap Vector► Datamanagement-gereedschap► Attributen op basis van plaats bĳeenbrengen.
2. Stel forest_stands_2012 in als de Doel vectorlaag. De laag waarvan u de resultaten wilt.
3. Stel sample_plots_results in als de Join vectorlaag. De laag waaruit u de schattingen wilt berekenen.
4. Selecteer Samenvatting gebruiken van snĳdende objecten.
5. Selecteer om alleen het Gemiddelde te berekenen.
6. Noem het resultaatforest_stands_2012_results.shp en sla het op in demapexercise_data/

forestry/results/.
7. Selecteer tenslotte Alle rĳen behouden…, zodat u later kunt controleren welke bosopstanden geen informatie

kregen.
8. Klik op OK.
9. Accepteer, indien daarnaar gevraagd, het toevoegen van de nieuwe laag aan uw project.
10. Sluit het gereedschap Attributen op basis van plaats bĳeenbrengen.

Open de Attributentabel voor forest_stands_2012_results en bekĳk de resultaten die u heeft. Merk op dat een aantal
bosopstanden NULL hebben als de waarde voor de berekeningen, dat zĳn die welke geen monsterplaatsen hebben.
Selecteer ze allemaal en bekĳk ze op de kaart, het zĳn enkele van de kleinere bosopstanden:
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Laten we nu dezelfde gemiddelden berekenen zoals u eerder voor het gehele bos heeft gedaan, alleen zullen we
deze keer de gemiddelden die u kreeg voor de bosopstanden gebruiken als basis voor de berekening. Onthoud dat
in de eerdere situatie elke monsterplaats een theoretisch bosopstand weergaf van 80x80 m. Nu moet u in plaats
daarvan het gebied van elke bosopstand individueel in ogenschouw nemen. Op die manier worden, opnieuw, de
gemiddelde waarden van de parameters die in, bĳvoorbeeld, m³/ha voor de volumes zĳn, worden geconverteerd naar
totale volumes voor de bosopstanden.
U moet eerst de gebieden voor de bosopstanden berekenen en dan totale volumes en aantal stammen voor elk ervan
berekenen:

1. Schakel, in de Atributentabel, Bewerken in.
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2. Open de Veldberekening.
3. Maak een nieuw veld, genaamd area.
4. Laat het Type voor veld staan op Decimaal getal (real).
5. Stel Precisie in op 2.
6. Schrĳf, in het vak Expressie, $area / 10000. Dit zal het gebied van de bosopstanden berekenen in ha.
7. Klik op OK.

Bereken nu een veld met de total volumes en geschatte anatal stammen voor elke bosopstand:
1. Noem de velden s_vol en s_stem.
2. De velden mogen gehele getallen zĳn of u kunt ook real-getallen gebruiken.
3. Gebruik respectievelĳk de expressies "area" * "MEANVol" en "area" * "MEANStems" voor totale

volumes en totaal aantal stammen.
4. Sla de wĳzigingen op als u gereed bent.
5. Schakel Bewerken uit.

In de eerdere situatie waren de gebieden die door elke monsterplaats werden weergegeven hetzelfde, dus was het
voldoende om het gemiddelde van de monsterplaatsen te berekenen. Voor het berekenen van de schattingen, moet
u nu de som van het volume of het aantal stammen voor de bosopstand delen door de som van de gebieden van de
bosopstanden die informatie bevatten.

1. Selecteer, in de Attributentabel voor de laag forest_stands_2012_results, alle bosopstanden die
informatie bevatten.

2. Open Vector ► Analyse-gereedschap ► Basisstatistieken voor velden.
3. Selecteer forest_stands_2012_results als de Invoer vectorlaag.
4. Selecteer area als Veld waarop statistieken moeten worden berekend.
5. Selecteer Alleen geselecteerde objecten

6. Klik op OK.
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Zoals u kunt zien is de totale som van de gebieden van de bosopstanden 66.04 ha. Merk op dat het gebied van de
ontbrekende bosopstanden slechts ongeveer 7 ha is.
Op dezelfde wĳze kunt u berekenen dat het totale volume voor deze bosopstanden 8908 m3/ha is en het totale
aantal stammen is 179594 stammen.
Het gebruiken van de informatie voor de bosopstanden, in plaats van die direct vanuit demonsterplaatsen te gebruiken,
geeft de volgende schattingen voor de gemiddelden:

• 184.9 m3/ha en
• 2719 stammen/ha.

Sla uw project voor QGIS op, forest_inventory.qgs.

14.7.4 Conclusie

U bent er in geslaagd schattingen voor het gehele bos te berekenen met behulp van de informatie uit uw systematische
monsterplaatsen, eerst zonder de karakteristieken van het bos in overweging te nemen en ook met behulp van de
interpretatie van de luchtfoto naar bosopstanden. En u heeft ook enige waardevolle informatie verkregen over de
afzonderlĳke bosopstanden, wat zou kunnen worden gebruikt om het beheer van het bos te plannen voor de komende
jaren.
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14.7.5 Wat volgt?

In de volgende les zult u eerst een achtergrond met schaduw voor een heuvel maken vanuit een gegevensset van
LiDAR die u zult gebruiken om een kaartweergave voor te bereiden met de resultaten voor het bos die u zojuist heeft
berekend.

14.8 Les: DEM vanuit gegevens van LiDAR

U kunt het uiterlĳk van uw kaarten verbeteren door gebruik te maken van verschillende achtergrondafbeeldingen. U
zou de basiskaart of de luchtfoto kunnen gebruiken die u eerder heeft gebruikt, maar een raster met schaduw voor
heuvels van het terrein zal er in sommige situaties beter uitzien.
U zult LAStools gebruiken om een DEM uit een gegevensset van LiDAR te nemen en dan een raster met een schaduw
voor heuvels maken om later in uw kaartweergave te gebruiken.
Het doel voor deze les: LAStools installeren en een DEM berekenen vanuit gegevens van LiDAR en een raster met
schaduw voor heuvels.

14.8.1 ��� Volgen: LAStools installeren

Managing LiDAR data within QGIS is possible using the Processing framework and the algorithms provided by
LAStools.
Een digitaal hoogtemodel (DEM) kan worden gemaakt op basis van een LiDAR puntenwolk. Vervolgens kunnen
eventueel schaduwen worden gegenereerd voor presentatiedoeleinden. De instellingen van het framework Processing
dienen als volgt te worden ingesteld om met LAStools aan de slag te gaan:

• Sluit QGIS, als u dat al heeft gestart.
• Een oudere plug-in voor LiDAR zou al standaard geïnstalleerd kunnen zĳn op uw systeem in de map C:/
Program Files/QGIS Valmiera/apps/qgis/python/plugins/processing/.

• Als u een map heeft die is genaamd lidar, verwĳder die. Dit geldt voor sommige installaties van QGIS 2.2
en 2.4.
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• Ga naar de map exercise_data\forestry\lidar\, daar vindt u het bestand
QGIS_2_2_toolbox.zip. Open het en pak de map lidar uit om die, welke u zojuist heeft verwĳderd,
te vervangen.

• Als u een andere versie van QGIS gebruikt, kunt u meer instructies voor de installatie vinden in deze
handleiding.

Nu moet u de LAStools op uw computer installeren. Haal de nieuwste versie van LAStools hier op en pak de inhoud
van het bestand lastools.zip uit in een map op uw systeem, bĳvoorbeeld, c:\lastools\. Het pad naar de
map lastools mag geen spaties of speciale tekens bevatten.

Notitie: Lees het bestand LICENSE.txt in de map LAStools. Sommige van de LAStools zĳn open bron en
andere zĳn gesloten en vereisen een licentie voor meestal commercieel en gebruik door de overheid. Voor educatieve
en evaluatie-doeleinden mag u LAStools gebruiken en testen zoveel u wilt.

De plug-in en de actuele algoritmes zĳn nu geïnstalleerd op uw computer en bĳna klaar om te gebruiken, u dient
alleen nog het framework Processing in te stellen om ze te kunnen gebruiken:

• Open een nieuw project in QGIS.
• Stel het CRS van het project in op ETRS89 / ETRS-TM35FIN.
• Sla het project op als forest_lidar.qgs.

De LAStools instellen in QGIS:
• Ga naar Processing ► Opties en configuratie.
• Ga, in het dialoogvenster Processing opties, naar Providers en dan naar Tools for LiDAR data

• Selecteer Activate.
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• Stel voor LAStools folder in c:\lastools\ (of de map waarin u LAStools uitpakte).

14.8.2 ��� Volgen: Een DEM berekenen met LAStools

U heeft de toolbox Processing al gebruikt in Les: Ruimtelĳke statistieken om enkele algoritmes van SAGA uit te voeren.
Nu gaat u het gebruiken om programma’s van LAStools uit te voeren:

• Open Processing ► Toolbox.
• Selecteer, in het keuzemenu onderaan, Advanced interface.
• U zou de categorie Tools for LiDAR data moeten zien.
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• Vergroot het om de beschikbare gereedschappen te zien, en vergroot ook de categorie LAStools (het aantal
algoritmes kan variëren).

• Scroll naar beneden totdat u het algoritme lasview vindt, dubbelklik er op om hte te openen.
• Voor Input LAS/LAZ file, blader naar exercise_data\forestry\lidar\ en selecteer het bestand
rautjarvi_lidar.laz.

• Klik op Uitvoeren.
Nu kunt u de gegevens van LiDAR zien in het dialoogvenster just a little LAS and LAZ viewer:
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Er zĳn vele dingen die u kunt doen binnen deze viewer, maar voor nu kunt u in de viewer klikken en daarin slepen n
de puntenwolk van LiDAR om te zien hoe die er uit ziet.

Notitie: Als u meer details wilt weten over hoe de LAStools werken, kunt u de README tekstbestanden lezen over
elk van de gereedschappen, in de map C:\LAStools\bin\. Handleidingen en andere materialen zĳn beschikbaar
op de webpagina van Rapidlasso.

• Sluit de viewer als u klaar bent.
Het maken van een DEM met LAStools kan worden gedaan in twee stappen, de eerste om de puntenwolk te
classificeren in punten ground en no ground en dan een DEM berekenen met behulp van slechts de punten
ground.

• Ga terug naar de Processing Toolbox.
• In het vak Zoek…, schrĳf lasground.
• Dubbelklik om het gereedschap lasground te openen en stel het in zoals in deze afbeelding:
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• Het uitvoerbestand wordt opgeslagen in dezelfde map als waar rautjarvi_lidar.laz is geplaatst en
wordt genoemd rautjarvi_lidar_1.las.

U kunt het openen met lasview als u het wilt controleren.
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The brown points are the points classified as ground and the gray ones are the rest, you can click the letter g to
visualize only the ground points or the letter u to see only the unclassified points. Click the letter a to see all the
points again. Check the lasview_README.txt file for more commands. If you are interested, also this tutorial
about editing LiDAR points manually will show you different operations within the viewer.

• Sluit de viewer opnieuw.
• Zoek, in de Processing Toolbox, naar las2dem.
• Open het gereedschap las2dem en stel het in zoals weergegeven in deze afbeelding:
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De resulterende DEM wordt toegevoegd aan uw kaart met de algemene naam Output raster file.

Notitie: De gereedschappen lasground en las2dem vereisen een licentie. U kunt de niet gelicenseerde gereedschappen
gebruiken zoals aangegeven in het bestand over de licentie, maar u krĳgt de diagonalen die u kunt bewonderen in de
afbeelding met de resultaten.

14.8.3 ��� Volgen: Een terrein met schaduw voor heuvels maken

Voor visualisatie geeft een schaduw voor heuvels, gegenereerd uit een DEM, een betere
visualisatie van het terrein:

• Open Raster ► Terreinanalyse ► Schaduw heuvels.
• Blader, voor de Resultaatlaag, naar exercise_data\forestry\lidar\ en noem het bestand
hillshade.tif.

• Laat de rest van de parameters op de standaard instellingen staan.
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• Selecteer ETRS89 / ETRS-TM35FIN als het CRS als daarnaar gevraagd wordt.
Ondanks de diagonale lĳnen die zich in het raster met schaduw voor heuvels bevinden, kunt u duidelĳk een nauwkeurig
reliëf van het gebied zien. U kunt zelfs de de verschillende drainages zien die zĳn ingegraven in de bossen.
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14.8.4 Conclusie

Gebruiken van gegevens in LiDAR om een DEM te krĳgen, speciaal in beboste gebieden, geeft goede resultaten
zonder veel inspanning. U zou ook uit reeds voltooide DEM’s, afgeleid vanuit LiDAR, kunnen gebruiken of andere
bronnen zoals de SRTM 9m resolution DEMs. Voor beide geldt dat u ze kunt gebruiken om een raster met schaduw
voor heuvels te maken om in presentaties van uw kaarten te gebruiken.
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14.8.5 Wat volgt?

In de volgende, en laatste stap in deze module, les zult u het raster met schaduw voor heuvels en de resultaten van de
inventarisatie van het bos gebruiken om een kaartweergave van de resultaten te maken.

14.9 Les: Kaartweergave

In de vorige lessen heeft u een oude inventarisatie van een bos geïmporteerd als een project voor GIS, het bĳgewerkt
naar de huidige situatie, een inventarisatie voor het bos ontworpen, kaarten gemaakt voor het veldwerk en parameters
voor het bos berekend vanuit de metingen in het veld.
Het is vaak belangrĳk om kaarten te maken met de resultaten van een project van GIS. Een kaart die de resultaten
van de inventarisatie van het bos weergeeft zal het voor iedereen eenvoudiger maken om met een snelle blik een goed
idee te krĳgen van de resultaten, zonder naar de specifieke getallen te kĳken.
Het doel voor deze les: Een kaart maken om de resultaten van de inventarisatie weer te geven met behulp van een
raster met schaduw voor heuvels als achtergrond.

14.9.1 ��� Volgen: De kaartgegevens voorbereiden

Open het project vanQGIS uit de les over de berekeningen van de parameters,forest_inventory.qgs. Behoud
ten minste de volgende lagen:

• forest_stands_2012_results.
• basic_map.
• rautjarvi_aerial.
• lakes (als u die niet heeft, voeg die dan toe vanuit de map exercise_data\forestry\).

U gaat de gemiddelde volumes van uw bosopstanden in een kaart weergeven. Als u de Attributentabel opent voor de
laag forest_stands_2012_results, lunt u de waarden NULL zien voor de bosopstanden zonder informatie.
Om in staat te zĳn ook die bosopstanden in uw symbologie te zien zou u de waarden NULL moeten wĳzigen naar,
bĳvoorbeeld, -999, wetende dat deze negatieve getallen betekenen dat er geen gegevens zĳn voor deze polygonen.
Voor de laag forest_stands_2012_results:

• Open de Attributentabel en schakel Bewerken in.
• Selecteer de polygonen met de waarde NULL.
• Gebruik de veldberekening om de waarden van het veld MEANVol bĳ te werken naar -999, alleen voor de
geselecteerde objecten.

• Schakel Bewerken uit en sla de wĳzigingen op.
Nu kunt u een opgeslagen opmaak voor deze laag gebruiken:

• Ga naar de tab Symbologie.
• Klik op Stĳl -► Stĳl laden….
• Selecteer forest_stands_2012_results.qml uit de map exercise_data\forestry\
results\.

• Klik op OK.
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Uw kaart zal er ongeveer zo uitzien:
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14.9.2 ��� Probeer zelf: Probeer verschillende mengmodi

De stĳl die u heeft geladen:
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gebruikt de modus Hard licht voor de Laag blending modus. Merk op dat de verschillende modi verschillende
filters toepassen die de onder- en bovenliggende lagen combineren, in dit geval worden het raster met schaduw voor
heuvels en uw bosopstanden gebruikt. U kunt over deze modi lezen in de Gebruikersgids.
Probeer de verschillende modi en bekĳk de verschillen in uw in uw kaart. Kies dan die welke u beter vindt voor uw
uiteindelĳke kaart.

14.9.3 ��� Probeer zelf: Een sjabloon gebruiken om het resultaat van de kaart
te maken

Gebruik een eerder voorbereid sjabloon om de resultaten weer te geven. Het sjabloonforest_map.qpt is geplaatst
in de map exercise_data\forestry\results\. Laad dat met behulp van het dialoogvenster Project ►
Lay-out beheren….
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Open de afdruklay-out en bewerk de uiteindelĳke kaart om een resultaat te krĳgen waarmee u tevreden bent.
Het kaartsjabloon dat u gebruikt zal een kaart geven soortgelĳk aan deze:
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Sla uw project voor QGIS op voor toekomstige verwĳzingen.
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14.9.4 Conclusie

Door middel van deze module heeft u gezien hoe een basisinventarisatie van een bos kan worden gepland en
weergegeven met QGIS. Veel meer analyses voor bossen zĳn mogelĳk met de variëteit aan gereedschappen waar
u toegang toe heeft, maar hopelĳk heeft deze handleiding u een goed startpunt gegeven om te ontdekken hoe u de
specifieke resultaten kunt bereiken die u nodig heeft.
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Module: Concepten van databases met PostgreSQL

Relationele databases zĳn een belangrĳk onderdeel van elk GIS-systeem. In deze module zult u over concepten van
Relational Database Management System (RDBMS) leren en zult u PostgreSQL gebruiken om een nieuwe database
te maken om gegevens op te slaan, als ook leren over andere typische functies voor RDBMS.

15.1 Les: Introductie voor databases

Laten we, voordat we PostgreSQL gebruiken, onze basis vaststellen door algemene theorie over databases te
behandelen. U hoeft geen voorbeeldcode in te voeren; het is er alleen ter illustratie.
Het doel voor deze les: Fundamentele concepten voor databases begrĳpen.

15.1.1 Wat is een database?

Een database bestaat uit een georganiseerde verzameling gegevens voor één of meer doeleinden, gewoonlĳk in digitale
vorm. - Wikipedia

Een database management system (DBMS) bestaat uit software die werkt op databases, opslag, toegang, beveiliging,
back-up en andere faciliteiten verschaft. - Wikipedia

15.1.2 Tabellen

In relationele databases en platte databases, is een tabel een verzameling gegevenselementen (waarden) die is
georganiseerd met behulp van een model van verticale kolommen (die worden geïdentificeerd door hun naam) en
horizontale rĳen. Een tabel heeft een gespecificeerd aantal kolommen, maar kunnen elk willekeurig aantal rĳen
hebben. Elke rĳ wordt geïdentificeerd door de waarden die verschĳnen in een bepaalde subset van kolommen die
wordt geïdentificeerd als een kandidaat-sleutel. - Wikipedia

id | name | age
----+-------+-----

1 | Tim | 20
2 | Horst | 88

(2 rows)
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In databases van SQL staat een tabel ook bekend als een relatie.

15.1.3 Kolommen / Velden

Een kolom is een verzameling gegevenswaarden van een bepaald eenvoudig type, één voor elke rĳ van de tabel. De
kolommen verschaffen de structuur waarin de rĳen overeenkomstig worden samengesteld. De term veld wordt vaak
uitwisselbaar gebruik met kolom, hoewel velen het meer correct vinden om veld (of veldwaarde) te gebruiken om
specifiek te verwĳzen naar het enkele item dat bestaat op de kruising van één rĳ en één kolom. - Wikipedia

Een kolom:

| name |
+-------+
| Tim |
| Horst |

Een veld:

| Horst |

15.1.4 Records

Een record is de informatie die is opgeslagen in een rĳ van een tabel. Elk record zal een veld hebben voor elk van de
kolommen in de tabel.

2 | Horst | 88 <-- one record

15.1.5 Datatypen

Datatypen beperken het soort informatie dat kan worden opgeslagen in een kolom. - Tim en Horst

er bestaan vele soorten datatypen. Laten we focussen op de meest voorkomende:
• String - om tekstgegevens in de vorm van vrĳe tekst op te slaan
• Integer - om gehele getallen op te slaan
• Real - om decimale getallen op te slaan
• Date - om de verjaardag van Horst op te slaan zodat niemand die vergeet
• Boolean - om eenvoudige waarden ja/nee op te slaan

U kunt de database vertellen om u ook toe te staan niets in een veld op te slaan. Als er niets in een veld staat, dan
wordt naar de veldinhoud verwezen als een ‘null’-waarde:

insert into person (age) values (40);

select * from person;

Resultaat:

id | name | age
---+-------+-----
1 | Tim | 20
2 | Horst | 88
4 | | 40 <-- null for name

(3 rows)

Er zĳn nog veel meer datatypen die u kunt gebruiken - bekĳk de handleiding van PostgreSQL!
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15.1.6 Een adresdatabase modelleren

Laten we een eenvoudig geval bekĳken om te zien hoe een database is opgebouwd. We willen een adresdatabase
maken.

��� Probeer zelf:

Schrĳf de eigenschappen op waaruit een eenvoudig adres bestaat en die we zouden willen opslaan in onze database.

Antwoord
Voor onze theoretische tabel met adressen willen we misschien de volgende eigenschappen opslaan:

House Number
Street Name
Suburb Name
City Name
Postcode
Country

Bĳ het maken van de tabel om een object adres weer te geven, zouden we kolommen maken om elk van deze
eigenschappen weer te geven en we zouden ze benoemen met voor SQL begrĳpelĳke en mogelĳk afgekorte namen:

house_number
street_name
suburb
city
postcode
country

Structuur van een adres

De eigenschappen die een adres beschrĳven zĳn de kolommen. Het type informatie dat wordt opgeslagen in elke
kolom is het datatype. In het volgende gedeelte zullen we onze conceptuele adrestabel analyseren om te zien hoe we
het beter kunnen maken!

15.1.7 Database theorie

Het proces van het maken van een database omvat het maken van een model van de echte wereld; concepten uit de
echte wereld nemen en die in de database weer te geven als entiteiten.

15.1.8 Normalisatie

Eén van de belangrĳkste ideeën in een database is om duplicatie / herhaling van gegevens te vermĳden. Het proces
van het verwĳderen van herhaling uit een database wordt Normalisatie genoemd.
Normalisatie is een systematische manier om er voor te zorgen dat een structuur van een database geschikt is voor
bevragingen van algemene aard en vrĳ van bepaalde ongewenste karakteristieken - afwĳkingen bĳ invoegen, bĳwerken
en verwĳderen - die zouden kunnen leiden tot verlies van de integriteit van gegevens. - Wikipedia

Er bestaan verschillende ‘vormen’ van normalisatie.
Laten we eens naar een eenvoudig voorbeeld kĳken:
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Table "public.people"

Column | Type | Modifiers
----------+------------------------+------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

select * from people;

id | name | address | phone_no
---+---------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duester | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Veronderstel dat u veel vrienden heeft met dezelfde straatnaam of stad. Elke keer dat deze gegevens worden
gedupliceerd, nemen zĳ ruimte in. Erger nog, als een naam van een stad wĳzigt, moet u veel werk uitvoeren om
uw database bĳ te werken.

15.1.9 ��� Probeer zelf:

Ontwerp de bovenstaande theoretische tabel people opnieuw om duplicatie te verminderen en de structuur van de
gegevens te normaliseren.
U kunt hier meer lezen over normalisatie van databases

Antwoord
Het belangrĳkste probleem met de tabel people is dat er één enkel adresveld is dat het gehele adres van een persoon
bevat. Denkend aan onze theoretische tabel address eerder in deze les, weten we dat een adres bestaat uit veel
verschillende eigenschappen. Door deze eigenschappen op te slaan in één enkel veld, maken we het veel moeilĳker
om onze gegevens bĳ te werken en te bevragen. We moeten daarom het adresveld splitsen in de verscheidene
eigenschappen. Dat zou ons een tabel geven die de volgende structuur heeft:

id | name | house_no | street_name | city | phone_no
--+---------------+----------+----------------+------------+-----------------
1 | Tim Sutton | 3 | Buirski Plein | Swellendam | 071 123 123
2 | Horst Duester | 4 | Avenue du Roix | Geneva | 072 121 122

In het volgende gedeelte zult u leren over de relatie Foreign Key die in dit voorbeeld kan worden gebruikt om de
structuur van onze database verder te verbeteren.
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15.1.10 Indexen

Een index voor een database is een gegevensstructuur die de snelheid van bewerkingen voor het ophalen van gegevens
uit een databasetabel verhoogt. - Wikipedia

Veronderstel dat u een tekstboek aan het lezen bent en zoekt naar de uitleg over een concept - en dat het tekstboek
geen index heeft! U zult met lezen moeten beginnen bĳ het voorblad en u geheel door het boek moeten werken totdat
u de informatie vindt die u nodig heeft. De index aan het einde van het boek helpt u om snel naar de pagina met de
relevante informatie te springen:

create index person_name_idx on people (name);

Zoekacties op namen zullen nu sneller zĳn:

Table "public.people"

Column | Type | Modifiers
----------+------------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
| |

name | character varying(50) |
address | character varying(200) | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"person_name_idx" btree (name)

15.1.11 Reeksen

Een reeks is een generator voor unieke nummers. Het wordt normaal gesproken gebruikt om een unieke identificatie
te maken voor een kolom in een tabel.
In dit voorbeeld is id een reeks - het nummer wordt opgehoogd, elke keer als een record aan de tabel wordt toegevoegd:

id | name | address | phone_no
---+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

15.1.12 Entiteit Relaties Diagrammen

In een genormaliseerde database heeft u gewoonlĳk vele relaties (tabellen). Het entiteit-relatie diagram (ERDiagram)
wordt gebruikt om de logische afhankelĳkheden tussen de relaties te ontwerpen. Denk aan onze niet-genormaliseerde
tabel people eerder in deze les:

select * from people;

id | name | address | phone_no
----+--------------+-----------------------------+-------------
1 | Tim Sutton | 3 Buirski Plein, Swellendam | 071 123 123
2 | Horst Duster | 4 Avenue du Roix, Geneva | 072 121 122

(2 rows)

Met weinig werk kunnen we die splitsen in twee tabellen, waarbĳ we de noodzaak om de straatnaam te herhalen voor
mensen die in dezelfde straat wonen verwĳderen:
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select * from streets;

id | name
----+--------------
1 | Plein Street

(1 row)

en:

select * from people;

id | name | house_no | street_id | phone_no
----+--------------+----------+-----------+-------------

1 | Horst Duster | 4 | 1 | 072 121 122
(1 row)

We kunnen dan de twee tabellen koppelen met behulp van de ‘sleutels’ streets.id en people.streets_id.
Als we een ER Diagram tekenen voor deze twee tabellen zou het er ongeveer zo uitzien:

Het ER Diagram helpt ons om ‘één tot veel’-relaties uit te drukken. In dit geval geeft het pĳlsymbool aan dat in één
straat veel mensen zouden kunnen leven.

��� Probeer zelf:

Ons model people heeft nog steeds enige problemen met normalisatie - probeer eens of u het verder kunt normaliseren
en geef uw gedachten weer door middel van een ER Diagram.

Antwoord
Onze tabel people ziet er momenteel zo uit:

id | name | house_no | street_id | phone_no
---+--------------+----------+-----------+-------------
1 | Horst Duster | 4 | 1 | 072 121 122

De kolom street_id geeft een ‘een-tot-veel’-relatie weer tussen het object people en het daaraan gerelateerde object
straat, die in de tabel streets staat.
Een manier om de tabel verder te normaliseren is om het veld met de naam te splitsen in first_name en last_name:

id | first_name | last_name | house_no | street_id | phone_no
---+------------+------------+----------+-----------+------------
1 | Horst | Duster | 4 | 1 | 072 121 122

We kunnen ook afzonderlĳke tabellen maken voor de stads- of dorpsnaam en het land, en ze te koppelen aan onze
tabel people via ‘een-tot-veel’-relaties:

id | first_name | last_name | house_no | street_id | town_id | country_id
---+------------+-----------+----------+-----------+---------+------------
1 | Horst | Duster | 4 | 1 | 2 | 1

Een ER-diagram om dit weer te geven zou er zo uitzien:
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15.1.13 Beperkingen, Primaire sleutels en Vreemde sleutels

Een beperking voor een database wordt gebruikt om er voor te zorgen dat de gegevens in een relatie overeenkomt met
de weergave van het model over hoe die gegevens zouden moeten worden opgeslagen. Een beperking op uw postcode
zou er, bĳvoorbeeld, voor kunnen zorgen dat de getallen vallen tussen 1000 en 9999.
Een Primaire sleutel zĳn één of meer veldwaarden die een record uniek maken. Gewoonlĳk wordt de primaire sleutel
id genoemd en is een reeks.
Een vreemde sleutel wordt gebruikt om te verwĳzen naar een uniek record in een andere tabel (met behulp van de
primaire sleutel van de andere tabel).
In ER Diagrammen wordt de koppeling tussen tabellen gewoonlĳk gebaseerd op het koppelen van Vreemde sleutels
aan Primaire sleutels.
Als we naar ons voorbeeld people kĳken geeft de definitie van de tabel weer dat de kolom street een vreemde sleutel
is die verwĳst naar de primaire sleutel van de tabel streets:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)
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15.1.14 Transacties

Bĳ het toevoegen, wĳzigen of verwĳderen van gegevens in een database, is het altĳd belangrĳk dat de database in een
goede status wordt achtergelaten als er iets fout gaat. De meeste databases verschaffen een mogelĳkheid, genaamd
ondersteuning voor transacties. Transacties stellen u in staat om een positie vast te stellen voor het terugdraaien
waarnaar u kunt terugkeren als de aanpassingen aan de database niet gingen zoals was gepland.
Neem een scenario waar u een boekhoudsysteem heeft. Umoet fondsen van de ene rekening transfereren en toevoegen
aan de andere rekening. De reeks stappen zou als volgt zĳn:

• verwĳder R20 van Joe
• voeg R20 toe aan Anne

Als er iets misgaat gedurende het proces (bĳv. stroomuitval), zal de transactie worden teruggedraaid.

15.1.15 Conclusie

Databases stellen u in staat gegevens op een gestructureerde manier te beheren met behulp van eenvoudige
codestructuren.

15.1.16 Wat volgt?

Laten we, nu we hebben gekeken naar hoe databases in theorie werken, een nieuwe database maken om de theorie
die we hebben behandeld te implementeren.

15.2 Les: Het gegevensmodel implementeren

Nu we alle theorie hebben behandeld, laten we eens een nieuwe database maken. Deze database zal worden gebruikt
voor onze oefeningen voor de lessen die hierna volgen.
Het doel voor deze les: De vereiste software installeren en die gebruiken om onze voorbeelddatabase te
implementeren.

15.2.1 PostgreSQL installeren

Notitie: U vindt pakketten voor PostgreSQL en instructies voor het installeren voor uw besturingssysteem op https:
//www.postgresql.org/download/. Onthoud dat de documentatie er van uitgaat dat gebruikers QGIS uitvoeren onder
Ubuntu.

Onder Ubuntu:

sudo apt install postgresql-9.1

U zou een bericht als dit moeten krĳgen:

[sudo] password for qgis:
Reading package lists... Done
Building dependency tree
Reading state information... Done
The following extra packages will be installed:
postgresql-client-9.1 postgresql-client-common postgresql-common
Suggested packages:

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
oidentd ident-server postgresql-doc-9.1
The following NEW packages will be installed:
postgresql-9.1 postgresql-client-9.1 postgresql-client-common postgresql-common
0 upgraded, 4 newly installed, 0 to remove and 5 not upgraded.
Need to get 5,012kB of archives.
After this operation, 19.0MB of additional disk space will be used.
Do you want to continue [Y/n]?

Druk op Y en Enter en wacht tot het downloaden en installeren is voltooid.

15.2.2 Help

PostgreSQL heeft hele goede online documentatie.

15.2.3 Een gebruiker voor de database aanmaken

Onder Ubuntu:
Als de installatie is voltooid, voer deze opdracht uit om de gebruiker postgres te worden en dan een nieuwe gebruiker
voor de database te maken:

sudo su - postgres

Type uw normale wachtwoord voor inloggen in als daar naar gevraagd wordt (u moet rechten hebben voor sudo).
Nu, bĳ de bash prompt van de gebruiker postgres, maak de gebruiker voor de database aan. Zorg er voor dat de
naam van de gebruiker overeenkomt met uw inlognaam voor unix : het zal uw leven veel eenvoudiger maken, omdat
Postgres u automatisch zal authenticeren wanneer u ingelogd bent als die gebruiker:

createuser -d -E -i -l -P -r -s qgis

Voer een wachtwoord in als daar naar gevraagd wordt. U zou een ander wachtwoord moeten gebruiken dan uw
wachtwoord om in te loggen.
Wat betekenen deze opties?

-d, --createdb role can create new databases
-E, --encrypted encrypt stored password
-i, --inherit role inherits privileges of roles it is a member of (default)
-l, --login role can login (default)
-P, --pwprompt assign a password to new role
-r, --createrole role can create new roles
-s, --superuser role will be superuser

Nu zou u de omgeving van de bash shell van de gebruiker Postgres moeten verlaten door te typen:

exit
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15.2.4 Het nieuwe account verifiëren

psql -l

Zou iets terug moeten geven als dit:

Name | Owner | Encoding | Collation | Ctype |
----------+----------+----------+------------+------------+
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
(3 rows)

Typ Q om af te sluiten.

15.2.5 Een database maken

De opdracht createdb wordt gebrukt om een nieuwe database te maken. Het zou moeten worden uitgevoerd vanaf
de bash shell prompt:

createdb address -O qgis

U kunt het bestaan van uw nieuwe database verifiëren met behulp van deze opdracht:

psql -l

Wat iets zoals dit zou moeten teruggeven:

Name | Owner | Encoding | Collation | Ctype | Access privileges
----------+----------+----------+------------+------------+-----------------------
address | qgis | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
postgres | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 |
template0 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
template1 | postgres | UTF8 | en_ZA.utf8 | en_ZA.utf8 | =c/postgres:␣
↪→postgres=CTc/postgres
(4 rows)

Typ Q om af te sluiten.

15.2.6 Een database shell-sessie beginnen

U kunt uw database eenvoudig verbinden door dit:

psql address

Verlaten van de psql database shell, typ:

\q

Voor hulp in het gebruiken van de shell, type:

\?

Voor hulp bĳ het gebruiken van SQL-opdrachten, typ:

\help

Hulp krĳgen over een specifieke opdracht, typ (bĳvoorbeeld):
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\help create table

Bekĳk ook het Psql cheat sheet.

15.2.7 Tabellen in SQL maken

Laten we beginnen met het maken van enkele tabellen! We zullen ons ER Diagram als gids gebruiken. Verbind eerst
met de db address:

psql address

Maak dan een tabel streets:

create table streets (id serial not null primary key, name varchar(50));

serial en varchar zĳn datatypen. serial vertelt PostgreSQL om een reeks van een geheel getal te starten
(automatisch nummeren) om id automatisch te vullen voor elk nieuw record. varchar(50) vertelt PostgreSQL
om een veld van 50 tekens in lengte te maken.
Het zal u opvallen dat elke opdracht eindigt met een ; - alle opdrachten voor SQL zouden op deze manier moeten
worden beëindigd. Wanneer u op Enter drukt, zal psql iets rapporteren als dit:

NOTICE: CREATE TABLE will create implicit sequence "streets_id_seq"
for serial column "streets.id"

NOTICE: CREATE TABLE / PRIMARY KEY will create implicit index
"streets_pkey" for table "streets"

CREATE TABLE

Dat betekent dat uw tabel met succes werd gemaakt, met een primaire sleutel streets_pkey met behulp van
streets.id.
Opmerking: Als u op Return drukte zonder een; in te voeren, dan zult u een prompt zoals deze krĳgen:address-#.
Dit omdat PG van u meer invoer verwacht. Voer ; in om uw opdracht uit te voeren.
U kunt dit doen om uw schema van de tabel te bekĳken:

\d streets

Wat er ongeveer uit zou moeten zien zoals dit:

Table "public.streets"
Column | Type | Modifiers
--------+-----------------------+--------------------------------------
id | integer | not null default

| | nextval('streets_id_seq'::regclass)
name | character varying(50) |

Indexes:
"streets_pkey" PRIMARY KEY, btree (id)

U kunt dit doen om de inhoud van uw tabel te bekĳken:

select * from streets;

Wat er ongeveer uit zou moeten zien zoals dit:

id | name
---+------
(0 rows)

Zoals u kunt zien is onze tabel momenteel leeg.
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Probeer zelf: ���

Gebruik de hierboven weergegeven benadering om een tabel, genaamd people, te maken:
Voeg velden toe zoals telefoonnummer, adres, naam, etc. Zorg dat de velden een geldige veldnaam krĳgen (geen
spaties). Geef de tabel een kolom ID met hetzelfde datatype als hierboven.

Antwoord
De vereiste SQL om de juiste tabel people te maken is:

create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int not null,
phone_no varchar null );

Het schema voor de tabel (voer in \\d people) ziet er zo uit:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
Indexes:

"people_pkey" PRIMARY KEY, btree (id)

Ter illustratie hebben we met opzet de beperking fkey weggelaten.

15.2.8 Sleutels maken in SQL

Het probleem met onze oplossing hierboven is dat de database niet weet dat er een logische relatie bestaat tussen
people en streets. We moeten, om deze relatie aan te geven, een vreemde sleutel definiëren die verwĳst naar de
primaire sleutel van de tabel streets.

Er zĳn twee manieren om dat te doen:
• De sleutel toevoegen nadat de tabel is gemaakt
• De sleutel definiëren bĳ het maken van de tabel

Onze tabel is al gemaakt, dus doen we het op de eerste manier:

alter table people
add constraint people_streets_fk foreign key (street_id) references streets(id);

Dat vertelt de tabel people dat zĳn velden street_id moeten overeenkomen met een geldige id voor street uit
de tabel streets.
De meest gebruikte manier om een beperking toe te voegen is om dat te doen wanneer u de tabel maakt:
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create table people (id serial not null primary key,
name varchar(50),
house_no int not null,
street_id int references streets(id) not null,
phone_no varchar null);

\d people

Na het toevoegen van de beperking ziet ons schema voor de tabel er nu als volgt uit:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+---------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)

15.2.9 Indexen in SQL maken

We willen zoekacties met de snelheid van het licht op namen van mensen. We kunnen een index op de kolom name
van onze tabel people maken om dat mogelĳk te maken:

create index people_name_idx on people(name);

\d people

Wat resulteert in:

Table "public.people"

Column | Type | Modifiers
-----------+-----------------------+-----------------------------------
id | integer | not null default nextval

| | ('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name) <-- new index added!

Foreign-key constraints:
"people_streets_fk" FOREIGN KEY (id) REFERENCES streets(id)
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15.2.10 Tabellen in SQL verwijderen

Als u een tabel wilt verwĳderen kunt u gebruk maken van de opdracht drop:

drop table streets;

In ons huidige voorbeeld zou de bovenstaande opdracht niet werken. Waarom niet?

Antwoord
De reden dat de opdracht DROP in dit geval niet zou werken is omdat de tabel people een beperking Foreign Key heeft
voor de tabel streets. Dit betekent dat het verwĳderen (of deleten) van de tabel streets de tabel people zou achterlaten
met verwĳzingen naar niet bestaande gegevens van streets.
Het is mogelĳk om te ‘forceren’ dat de tabel streets wordt verwĳderd door de opdracht CASCADE te gebruiken, maar
dat zou ook de tabel people en elke andere tabel die een relatie heeft met de tabel streets verwĳderen. Gebruik het
met voorzichtigheid!

Als u dezelfde opdracht drop table zou gebruiken op de tabel people, zou die met succes worden uitgevoerd:

drop table people;

Notitie: Als u echt die opdracht invoerde en de tabel people verwĳderde, zou nu een goed moment zĳn om hem
opnieuw te bouwen, omdat u het in de volgende oefeningen nodig heeft.

15.2.11 Een woord over pgAdmin III

SQL opdrachten van psql worden gebruikt omdat dit een goede manier is om te leren werken met databases. Er zĳn
echter eenvoudigere enmogelĳk snellere manieren om deze SQL opdrachten uit te voeren, bĳvoorbeeld met pgAdmin
III. Dit is een grafische tool waarmee tabellen kunnen worden gemaakt, verwĳderd en gewĳzigdmet behulp van slepen
en klikken.
Onder Ubuntu kunt u het op deze manier installeren:

sudo apt install pgadmin3

pgAdmin III zal meer detail worden behandeld in een andere module.

15.2.12 Conclusie

U heeft nu gezien hoe u een nagelnieuwe database maakt, geheel vanaf niets beginnend.

15.2.13 Wat volgt?

Vervolgens zult u leren de DBMS te gebruiken om nieuwe gegevens toe te voegen.
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15.3 Les: Gegevens aan het model toevoegen

De modellen die we hebben gemaakt moeten nu worden gevuld met de gegevens die zĳ geacht worden te bevatten.
Het doel voor deze les: Leren hoe nieuwe gegevens in de modellen van de database in te voeren.

15.3.1 Argument Insert

Hoe voegt u gegevens toe aan een tabel? Het argument voor SQL INSERT verschaft daar de functionaliteit voor:

insert into streets (name) values ('High street');

Een anatal dingen om te onthouden:
• Na de naam van de tabel (streets), vermeldt u de kolomnamen die u wilt vullen (in dit geval alleen de kolom
name).

• Na het sleutelwoord values, plaats de lĳst met veldwaarden.
• Strings zouden moeten worden omsloten door enkele aanhalingstekens.
• Onthoud dat we geen waarde hebben ingevuld voor de kolom id; dat is omdat het een reeks is en automatisch
wordt gegenereerd.

• Indien u de id handmatig instelt, kunt u ernstige problemen veroorzaken voor de integriteit van uw database.
U zou INSERT 0 1 moeten zien als het met succes is voltooid.
U kunt het resultaat van uw invoeractie zien door alle gegevens in de tabel te selecteren:

select * from streets;

Resultaat:

select * from streets;
id | name

----+-------------
1 | High street

(1 row)

Probeer zelf: ���

Gebruik de opdracht INSERT om een nieuwe straat in te voeren in de tabel streets.

Antwoord
De opdracht voor SQL die u zou moeten gebruiken ziet er ongeveer zo uit (u mag de straatnaam vervangen door een
naam van uw keuze):

insert into streets (name) values ('Low Road');
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15.3.2 Toevoegen van gegevens in overeenstemming met beperkingen

15.3.3 Probeer zelf: ���

probeer een object persoon toe te voegen aan de tabel people met de volgende details:

Name: Joe Smith
House Number: 55
Street: Main Street
Phone: 072 882 33 21

Notitie: Onthoud dat we in dit voorbeeld telefoonnummers hebben gedefinieerd als strings, niet als integers.

Op dit punt zou u een foutbericht moeten krĳgen als u dit probeert te doen zonder eerst een record voor Main Street
te hebben gemaakt in de tabel streets.
U zou ook moeten hebben opgemerkt dat:

• U kunt de straat niet toevoegen met behulp van zĳn naam
• U kunt geen straat toevoegen met behulp van een id voor de straat zonder eerst het record voor de straat te
hebben gemaakt in de tabel streets

Onthoud dat onze twee tabellen zĳn gekoppeld via een paar Primaire/Vreemde sleutel. Dit betekent dat geen geldige
persoon kan worden gemaakt zonder dat er ook een geldig overeenkomend record is voor de straat.
Voeg, met behulp van bovenstaande kennis, de nieuwe persoon toe aan de database.

Antwoord
Hier is het juiste argument voor SQL:

insert into streets (name) values('Main Road');
insert into people (name,house_no, street_id, phone_no)

values ('Joe Smith',55,2,'072 882 33 21');

Als u opnieuw naar de tabel met straten kĳkt (met een argument Select zoals eerder), zult u zien dat de id voor het
item Main Road 2 is.
Dat is waarom we hierboven alleen het nummer 2 hoefden in te voeren. Zelfs hoewel we Main Road niet volledig
uitgeschreven zagen staan in het item hierboven, zal de database in staat zĳn dat te associëren met de waarde 2 voor
street_id.
Als u al een nieuw object street had toegevoegd, zou u kunnen merken dat de nieuwe Main Road eean id van 3
heeft, niet 2.

15.3.4 Gegevens selecteren

We hebben u de syntaxis voor het selecteren van records al laten zien. Laten we eens naar nog een aantal voorbeelden
kĳken:

select name from streets;

select * from streets;

select * from streets where name='Main Road';

In latere gedeelten zullen we meer in detail ingaan op hoe gegevens te selecteren en te filteren.
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15.3.5 Gegevens bijwerken

Wat als u een wĳziging wilt maken in enkele bestaande gegevens? Bĳvoorbeeld: een straatnaam is gewĳzigd:

update streets set name='New Main Road' where name='Main Road';

Wees zeer voorzichtig met het gebruiken van dergelĳke argumenten voor bĳwerken - als meer dan één record
overeenkomt met uw clausule WHERE, zullen zĳ allemaal worden bĳgewerkt!
Een betere oplossing is om de primaire sleutel van de tabel te gebruiken om te verwĳzen naar het record dat moet
worden gewĳzigd:

update streets set name='New Main Road' where id=2;

Het zou terug moeten geven UPDATE 1.

Notitie: de criteria voor het argument WHERE zĳn hoofdlettergevoelig Main Road is niet hetzelfde als Main
road

15.3.6 Gegevens verwijderen

Gebruik de opdracht DELETE om een object uit een tabel te verwĳderen:

delete from people where name = 'Joe Smith';

Laten we nu eens naar onze tabel people kĳken:

address=# select * from people;

id | name | house_no | street_id | phone_no
----+------+----------+-----------+----------

(0 rows)

15.3.7 Probeer zelf: ���

Gebruik de vaardigheden die u heeft geleerd om enkele nieuwe vrienden aan uw database toe te voegen:

name | house_no | street_id | phone_no
-----------------+----------+-----------+--------------
Joe Bloggs | 3 | 2 | 072 887 23 45
Jane Smith | 55 | 3 | 072 837 33 35
Roger Jones | 33 | 1 | 072 832 31 38
Sally Norman | 83 | 1 | 072 932 31 32

15.3.8 Conclusie

Nu weet u hoe u nieuwe gegevens moet toevoegen aan de bestaande modellen die u eerder heeft gemaakt. Onthoud
dat als u nieuwe soorten gegevens wilt toevoegen, u misschien moet aanpassen en/of nieuwe modellen moet maken
om die gegevens te kunnen bevatten.
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15.3.9 Wat volgt?

Nu dat u enkele gegevens heeft toegevoegd, zult u leren hoe u query’s gebruikt om op verschillende manieren toegang
te krĳgen tot deze gegevens.

15.4 Les: Query’s

Wanneer u een opdracht SELECT ... schrĳft staat die algemeen bekend als een query - u bevraagt de database op
informatie.
Het doel voor deze les: Query’s die bruikbare informatie teruggeven leren maken.

Notitie: Als u dat al niet deed in de vorige les, voeg de volgende objecten persoon toe aan uw tabel people. Als
u foutberichten krĳgt gerelateerd aan beperkingen voor vreemde sleutels, zult u eerst het object ‘Main Road’ moeten
toevoegen aan uw tabel streets

insert into people (name,house_no, street_id, phone_no)
values ('Joe Bloggs',3,2,'072 887 23 45');

insert into people (name,house_no, street_id, phone_no)
values ('Jane Smith',55,3,'072 837 33 35');

insert into people (name,house_no, street_id, phone_no)
values ('Roger Jones',33,1,'072 832 31 38');

insert into people (name,house_no, street_id, phone_no)
values ('Sally Norman',83,1,'072 932 31 32');

15.4.1 Resultaten ordenen

Laten we een lĳst van mensen ophalen, gesorteerd op hun huisnummers:

select name, house_no from people order by house_no;

Resultaat:

name | house_no
--------------+----------
Joe Bloggs | 3
Roger Jones | 33
Jane Smith | 55
Sally Norman | 83

(4 rows)

U kunt de resultaten sorteren op de waarden van meer dan één kolom:

select name, house_no from people order by name, house_no;

Resultaat:

name | house_no
--------------+----------
Jane Smith | 55
Joe Bloggs | 3
Roger Jones | 33
Sally Norman | 83

(4 rows)
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15.4.2 Filteren

Vaak zult u niet elk afzonderlĳk record in de database willen zien - in het bĳzonder als er duizenden records zĳn en
u alleen geïnteresseerd bent in het bekĳken van één of twee.
Hier is een voorbeeld van een numeriek filter wat alleen objecten teruggeeft waarvan het house_no kleiner is dan 50:

select name, house_no from people where house_no < 50;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

U kunt filters combineren (gedefinieerd met behulp van de clausuleWHERE) met sorteren (gedefinieerd met behulp
van de clausule ORDER BY):

select name, house_no from people where house_no < 50 order by house_no;

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

U kunt ook filteren gebaseerd op tekstgegevens:

select name, house_no from people where name like '%s%';

name | house_no
-------------+----------
Joe Bloggs | 3
Roger Jones | 33
(2 rows)

Hier hebben we de clausule LIKE gebruikt om alle namen met een s erin te vinden. Het zal u zĳn opgevallen dat
deze query hoofdlettergevoelig is, dus is het item Sally Norman niet vermeld.
Als u wilt zoeken naar een tekenreeks van letters, ongeacht hoofd- of kleine letters, kunt u een zoekactie uitvoeren
die niet hoofdlettergevoelig is met behulp van de clausule ILIKE:

select name, house_no from people where name ilike '%r%';

name | house_no
--------------+----------
Roger Jones | 33
Sally Norman | 83
(2 rows)

Die query gaf elk object uit people terug met een r of R in hun naam.
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15.4.3 Samenvoegingen (joins)

Wat als u de details van personen en hun straatnaam wilt zien in plaats van de ID? U dient de twee tabellen samen te
voegen in één enkele query om dat te kunnen doen. Laten we eens naar een voorbeeld kĳken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Notitie: Met samenvoegingen (joins) worden twee of meer tabellen of views samengevoegd, in dit geval de tabellen
people en streets. Er dient te worden gespecificeerd welke velden overeen moeten komen (vreemde sleutel & primaire
sleutel). Indien deze velden niet worden gespecificeerd worden alle velden van de tabellen onderling gecombineerd.
Dit resulteert in alle mogelĳke combinaties van mensen en straten, maar geeft geen antwoord op de vraag wie in welke
straat woont.

Hier is hoe de juiste uitvoer eruit zal zien:

name | house_no | name
--------------+----------+-------------
Joe Bloggs | 3 | Low Street
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road

(4 rows)

We zullen samenvoegingen (joins) opnieuw tegenkomen als we later meer complexe query’s maken. Onthoud alleen
dat zĳ een eenvoudige manier bieden om de informatie uit twee of meer tabellen te combineren.

15.4.4 Sub-Select

Sub-selecties stellen u in staat objecten te selecteren uit één tabel, gebaseerd op de gegevens uit een andere tabel die is
gekoppeld met een relatie vreemde sleutel. In ons geval willen we mensen vinden die in een specifieke straat wonen.
Laten we eerst onze gegevens iets aanpassen:

insert into streets (name) values('QGIS Road');
insert into streets (name) values('OGR Corner');
insert into streets (name) values('Goodle Square');
update people set street_id = 2 where id=2;
update people set street_id = 3 where id=3;

Laten we even snel kĳken naar onze gegevens na deze wĳzigingen: we kunnen onze query uit het eerdere gedeelte
opnieuw gebruiken:

select people.name, house_no, streets.name
from people,streets
where people.street_id=streets.id;

Resultaat:

name | house_no | name
--------------+----------+-------------
Roger Jones | 33 | High street
Sally Norman | 83 | High street
Jane Smith | 55 | Main Road
Joe Bloggs | 3 | Low Street

(4 rows)
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Nu willen we u een sub-selectie van deze gegevens laten zien. We willen alleen de mensen laten zien die wonen in
street_id nummer 1:

select people.name
from people, (

select *
from streets
where id=1

) as streets_subset
where people.street_id = streets_subset.id;

Resultaat:

name
--------------
Roger Jones
Sally Norman

(2 rows)

Hoewel dit een zeer eenvoudig voorbeeld is en onnodigmet onze kleine sets met gegevens, illustreert het hoe bruikbaar
en belangrĳk sub-selecties kunnen zĳn bĳ het bevragen van grote en complexe sets met gegevens.

15.4.5 Samenvattende query’s

Eén van de krachtige mogelĳkheden van een database is zĳn mogelĳkheid om de gegevens in zĳn tabellen samen
te vatten. Deze samenvattingen worden aggregate query’s genoemd. Hier is a typisch voorbeeld dat u vertelt hoeveel
objecten people er in uw tabel people staan:

select count(*) from people;

Resultaat:

count
-------

4
(1 row)

Als we de tellingen willen samenvatten op straatnaam kunnen we dit doen:

select count(name), street_id
from people
group by street_id;

Resultaat:

count | street_id
-------+-----------

2 | 1
1 | 3
1 | 2

(3 rows)

Notitie: Omdat we geen clausule ORDER BY hebben gebruikt, zou de volgorde van uw resultaten niet overeen
hoeven komen met wat hier is weergegeven.
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Probeer zelf: ���

Samenvatten van de personen op straatnaam en de feitelĳke straatnamen laten zien in plaats van de street_id’s.

Antwoord
Hier is het juiste argument voor SQL dat u zou moeten gebruiken:

select count(people.name), streets.name
from people, streets
where people.street_id=streets.id
group by streets.name;

Resultaat:

count | name
------+-------------

1 | Low Street
2 | High street
1 | Main Road

(3 rows)

U zult zien dat we vooraf gedefinieerde veldnamen met tabelnamen hebben (bĳv. people.name en streets.name). Dit
moet elke keer worden gedaan wanneer de veldnaam dubbelzinnig is (d.i. niet uniek voor alle tabellen in de database).

15.4.6 Conclusie

U heeft gezien hoe u query’s kunt gebruiken om de gegevens in uw database terug te geven op een manier die u in
staat stelt daaruit bruikbare informatie te halen.

15.4.7 Wat volgt?

Vervolgens zult u zien hoe u weergaven kunt maken uit de query’s die u heeft geschreven.

15.5 Les: Weergaven

Wanneer u een query schrĳft, spendeert u veel tĳd en moeite om die te formuleren. Met weergaven kunt u de definitie
van een query in SQL opslaan in een opnieuw te gebruiken ‘virtuele tabel’.
Het doel voor deze les: Een query al een weergave op te slaan.

15.5.1 Een weergave maken

U kunt een weergave net zo behandelen als een tabel, maar de gegevens ervan vinden hun oorsprong in een query.
Laten we, gebaseerd op bovenstaande, een eenvoudige weergave maken:

create view roads_count_v as
select count(people.name), streets.name
from people, streets where people.street_id=streets.id
group by people.street_id, streets.name;

Zoals u kunt zien is het enige dat veranderd is het gedeelte create view roads_count_v as aan het begin.
We kunnen nu gegevens uit die weergave selecteren:
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select * from roads_count_v;

Resultaat:

count | name
-------+-------------

1 | Main Road
2 | High street
1 | Low Street

(3 rows)

15.5.2 Een weergave aanpassen

Een weergave staat niet vast en bevat geen ‘echte gegevens’. Dit betekent dat u hem eenvoudig kunt wĳzigen zonder
dat dat enige impact heeft op de gegevens in uw database:

CREATE OR REPLACE VIEW roads_count_v AS
SELECT count(people.name), streets.name
FROM people, streets WHERE people.street_id=streets.id
GROUP BY people.street_id, streets.name
ORDER BY streets.name;

(Dit voorbeeld toont ook de best practice conventie voor het gebruiken van UPPER CASE voor alle sleutelwoorden
van SQL.)
U zult zien dat we een clausuleORDER BY hebben toegevoegd zodat de rĳen van onze weergave netjes zĳn gesorteerd:

select * from roads_count_v;

count | name
-------+-------------

2 | High street
1 | Low Street
1 | Main Road

(3 rows)

15.5.3 Een weergave verwijderen

Als u een weergave niet langer nodig heeft, kunt u die op deze manier verwĳderen:

drop view roads_count_v;

15.5.4 Conclusie

Met behulp van weergave kunt u een query opslaan en toegang krĳgen tot de resultaten daravan, als was het een tabel.
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15.5.5 Wat volgt?

Soms, bĳ het wĳzigen van gegevens, wilt u dat uw wĳzigingen ook ergens anders in de database effect hebben. De
volgende les zal u tonen doe dat te doen.

15.6 Les: Regels

Regels maken het mogelĳk de “queryboom” van een inkomende query te herschrĳven. Een veel voorkomend gebruik
is om weergaven te implementeren, inclusief een bĳ te werken weergave. - Wikipedia

Het doel voor deze les:: Leren nieuwe regels voor de database te maken.

15.6.1 Een regel voor loggen maken

Stel dat u elke wĳziging van phone_no in uw tabel people wilt loggen in een tabel people_log. Dus maakt u een nieuwe
tabel:

create table people_log (name text, time timestamp default NOW());

Maak, in de volgende stap, een regel die elke wĳziging van een telefoonnummer in de tabel people in de tabel
people_log logt:

create rule people_log as on update to people
where NEW.phone_no <> OLD.phone_no
do insert into people_log values (OLD.name);

Laten we een telefoonnummer aanpassen om te testen of de regel werkt:

update people set phone_no = '082 555 1234' where id = 2;

Controleer of de tabel people juist werd bĳgewerkt:

select * from people where id=2;

id | name | house_no | street_id | phone_no
----+------------+----------+-----------+--------------

2 | Joe Bloggs | 3 | 2 | 082 555 1234
(1 row)

Dankzĳ de regel die we hebben gemaakt, zal de tabel people_log er nu zo uitzien:

select * from people_log;

name | time
------------+----------------------------
Joe Bloggs | 2014-01-11 14:15:11.953141

(1 row)

Notitie: De waarde van het veld time is afhankelĳk van de huidige datum en tĳd.
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15.6.2 Conclusie

Regels stellen u in staat automatisch gegevens toe te voegen of te wĳzigen in uw database om wĳzigingen in andere
delen van de database weer te geven.

15.6.3 Wat volgt?

De volgende module brengt u naar het gebruiken van de Ruimtelĳke database met behulp van PostGIS, wat deze
concepten overneemt en die toepast op gegevens voor GIS.
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Module: Concepten van een ruimtelijke database met PostGIS

Ruimtelĳke databases maken het opslaan van de geometrieën van records in een database mogelĳk, als ook het
verschaffen van functionaliteit voor het bevragen en ophalen van de records met behulp van die geometrieën. In deze
module zullen we PostGIS gebruiken, een uitbreiding voor PostgreSQL, om te leren hoe een ruimtelĳke database in
te stellen, gegevens importeren in de database en gebruikmaken van de geografische functies die PostGIS biedt.
Gedurende het werken door dit gedeelte wilt u misschien een kopie hebben van het PostGIS spiekblad, beschikbaar
vanaf de Boston GIS gebruikersgroep. Een andere bruikbare bron is de online documentatie van PostGIS.
Er zĳn ook enkele meer uitgebreide handleidingen over PostGIS en ruimtelĳke databases beschikbaar, die zĳn
gemaakt door Boundless, en worden gehost op de website van PostGIS:

• Introduction to PostGIS
• PostGIS Database Tips and Tricks

Bekĳk ook PostGIS In Action.

16.1 Les: PostGIS instellen

Instellen van functies voor PostGIS zal u in staat stellen toegang te verkrĳgen tot ruimtelĳke functies binnen
PostgreSQL.
Het doel voor deze les: Ruimtelĳke functies installeren en in het kort hun effecten demonstreren.

Notitie: We gaan er van uit dat we voor deze oefening PostGIS versie 2.1 of nieuwer gebruiken. De installatie en
configuratie van de database zĳn anders voor oudere versies, maar de rest van dit materiaal in deze module zal nog
steeds werken. Consulteer de documentatie voor uw platform voor hulp bĳ de installatie en de configuratie van de
database.
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16.1.1 Installeren onder Ubuntu

Postgis wordt eenvoudig geïnstalleerd vanuit apt.

$ sudo apt install postgresql
$ sudo apt install postgis

Echt, zo eenvoudig is dat…

Notitie: De exacte versies die zullen worden geïnstalleerd zĳn afhankelĳk van de versie van Ubuntu die u gebruikt en
welke afhankelĳkheden u heeft geconfigureerd. U kunt de geïnstalleerde versie controleren door een query select
PostGIS_full_version(); uit te voeren met psql of een ander gereedschap.

U kunt de volgende opdrachten gebruiken om een specifieke versie (bĳv, PostgreSQL versie 13 en PostGIS 3) te
installeren.

$ sudo apt install wget ca-certificates
$ sudo lsb_release -a
$ wget --quiet -O - https://www.postgresql.org/media/keys/ACCC4CF8.asc | sudo apt-
↪→key add -
$ sudo sh -c 'echo "deb http://apt.postgresql.org/pub/repos/apt/ `lsb_release -cs`-
↪→pgdg main" >> /etc/apt/sources.list.d/pgdg.list'
$ sudo apt-get update
$ sudo apt install postgis postgresql-13-postgis-3

16.1.2 Installeren onder Windows

Installeren op Windows kan worden gedaan vanuit binaire pakketten met behulp van normale Windows
dialoogvensters voor installeren.
Bezoek eerst de downloadpagina. Volg daarna deze gids.
Meer informatie over het installeren op Windows kan worden gevonden op de website van PostGIS.

16.1.3 Installeren op andere platformen

De downloadwebsite van PostGIS bevat informatie over het installeren op andere besturingssystemen en platformen,
inclusief macOS en andere distributies van Linux.

16.1.4 Databases configureren om PostGIS te gebruiken

Als PostGIS eenmaal is geïnstalleerd, zult u uw database moeten configureren om de extensies te gebruiken. Als u
PostGIS versie > 2.0 heeft geïnstalleerd, is dit zo simpel als de volgende opdracht met psql uit te voeren met behulp
van de adresdatabase uit onze vorige oefening.

$ psql -d address -c "CREATE EXTENSION postgis;"

Notitie: Afhankelĳk van uw versie zou u meer instructies over hoe een database ruimtelĳk in te schakelen kunnen
vinden op https://postgis.net/docs/postgis_administration.html#create_spatial_db.
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16.1.5 Kijken naar de geïnstalleerde functies van PostGIS

Aan PostGIS kan worden gedacht als aan een collectie van functies binnen de database die de bronmogelĳkheden
van PostgreSQL uitbreiden zodat het ruimtelĳke gegevens kan afhandelen. Met ‘afhandelen’ bedoelen we opslaan,
ophalen, bevragen en bewerken. Een aantal functies worden in de database geïnstalleerd om dit te kunnen doen.
Onze PostgreSQL database address is nu geo-ruimtelĳk ingeschakeld, dankzĳ PostGIS. We gaan hier in de
komende gedeelten een stuk dieper op in, maar laten we u een klein voorproefje geven. Laten we zeggen dat we
een punt uit tekst willen maken. Eerst gebruiken we de opdracht voor psql om functies te zoeken in relatie tot punten.
Als u nog niet verbonden bent met de database address, doe dat dan nu. Voer dan uit:

\df *point*

Dit is de opdracht waar we naar zoeken: st_pointfromtext. Gebruik de pĳl naar beneden om door de lĳst te
gaan en druk op Q om terug te gaan naar de shell van psql.
Probeer deze opdracht uit te voeren:

select st_pointfromtext('POINT(1 1)');

Resultaat:

st_pointfromtext
--------------------------------------------
0101000000000000000000F03F000000000000F03F
(1 row)

Drie dingen om te onthouden:
• We definieerden een punt op de positie 1,1 (we gaan uit van EPSG:4326) met behulp van POINT(1 1),
• We voerden een argument van sql uit, maar niet op een tabel, alleen maar op gegevens ingevoerd vanuit de
SQL-prompt,

• De resulterende rĳ heeft weinig betekenis.
De resulterende rĳ is in de indeling OGC, genaamd ‘Well Known Binary’ (WKB). We zullen in het volgende gedeelte
in detail naar deze indeling kĳken.
We kunnen een snelle scan doen door de functielĳst naar iets dat tekst teruggeeft om de resultaten als tekst terug te
krĳgen:

\df *text

De query waar we nu naar zoeken is st_astext. Laten we die combineren met de vorige query:

select st_astext(st_pointfromtext('POINT(1 1)'));

Resultaat:

st_astext
------------

POINT(1 1)
(1 row)

Hier voerden we de tekenreeks POINT(1,1) in, maakten daar een punt van met behulp van
st_pointfromtext(), en maakten er weer een door mensen te lezen vorm van met st_astext(),
wat ons onze originele tekenreeks teruggaf.
Een laatste voorbeeld voor we echt naar de details gaan van het gebruiken van PostGIS:

select st_astext(st_buffer(st_pointfromtext('POINT(1 1)'),1.0));

Wat deed dat? Het maakte een buffer van 1 graad rondom ons punt, en gaf het resultaat als tekst terug.
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16.1.6 Ruimtelijke referentiesystemen

In aanvulling op de functies van PostGIS, bevat de extensie een verzameling definities voor ruimtelĳke
referentiesystemen (SRS) zoals gedefinieerd door de European Petroleum Survey Group (EPSG). Deze worden
gebruikt tĳdens bewerkingen zoals conversies van coördinaten referentiesystemen (CRS).
We kunnen deze definities voor SRS inspecteren in onze database omdat zĳ zĳn opgeslagen in normale
databasetabellen.
Laten we eerst eens kĳken naar het schema van de tabel door de volgende opdracht in te voeren bĳ de psql prompt:

\d spatial_ref_sys

Het resultaat zou dit moeten zĳn:

Table "public.spatial_ref_sys"
Column | Type | Modifiers

-----------+-------------------------+-----------
srid | integer | not null
auth_name | character varying(256) |
auth_srid | integer |
srtext | character varying(2048) |
proj4text | character varying(2048) |
Indexes:

"spatial_ref_sys_pkey" PRIMARY KEY, btree (srid)

U kunt standaard SQL-query’s gebruiken (zoals we hebben geleerd uit onze gedeelten ter introductie), om deze tabel
te bekĳken en te bewerken - hoewel het geen goed idee is om records te bewerken of te verwĳderen, tenzĳ u weet
waar u mee bezig bent.
Eén SRID waarin u misschien geïnteresseerd bent is EPSG:4326 - het geografische / lat lon referentiesysteem dat de
ellipsoïde WGS 84 gebruikt. Laten we er eens naar kĳken:

select * from spatial_ref_sys where srid=4326;

Resultaat:

srid | 4326
auth_name | EPSG
auth_srid | 4326
srtext | GEOGCS["WGS 84",DATUM["WGS_1984",SPHEROID["WGS
84",6378137,298.257223563,AUTHORITY["EPSG","7030"]],TOWGS84[0,
0,0,0,0,0,0],AUTHORITY["EPSG","6326"]],PRIMEM["Greenwich",0,
AUTHORITY["EPSG","8901"]],UNIT["degree",0.01745329251994328,
AUTHORITY["EPSG","9122"]],AUTHORITY["EPSG","4326"]]
proj4text | +proj=longlat +ellps=WGS84 +datum=WGS84 +no_defs

De srtext is de definitie van de projectie in well known text (u zou dit kunnen herkennen van de bestanden .prj in
uw verzameling shapefiles).

16.1.7 Conclusie

U heeft nu functies van PostGIS geïnstalleerd in uw kopie van PostgreSQL. Hiermee bent u in staat gebruik te maken
van de uitgebreide ruimtelĳke functies van PostGIS.
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16.1.8 Wat volgt?

Vervolgens zult u leren hoe ruimtelĳke objecten worden weergegeven in een database.

16.2 Les: Eenvoudig object model

Hoe kunnen we geografische objecten in een database opslaan en weergeven? In deze les zullen we één benadering
behandelen, het Eenvoudige object model zoals dat is gedefinieerd door de OGC.
Het doel voor deze les: Leren wat het Eenvoudig object model is en hoe het te gebruiken.

16.2.1 Wat is OGC?

Het Open Geospatial Consortium (OGC), een internationale organisatie voor standaarden onder vrĳwillige
consensus, werd opgericht in 1994. In de OGC werken meer dan 370+ commerciële, overheids-, non-profit-
en onderzoeksorganisaties wereldwĳd samen in een proces voor open consensus voor het aanmoedigen van de
ontwikkeling en implementatie van standaarden voor georuimtelĳke inhoud en services, het verwerken van gegevens
voor GIS en het delen van gegevens. - Wikipedia

16.2.2 Wat is het SFS-model (Eenvoudig object model)

Het Simple Feature voor SQL (SFS) Model is een niet-topologische manier om georuimtelĳke gegevens op te slaan
in een database en definieert functies vooe toegang tot, het bewerken van en het construeren van deze gegevens.

Het model definieert georuimtelĳke gegevens vanuit typen Punt, Lĳn en Polygoon (en samenvoegingen daarvan naar
Multi-objecten).
Kĳk, voor meer informatie, eens naar de standaard OGC Simple Feature for SQL.
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16.2.3 Een veld voor geometrie aan een tabel toevoegen

Laten we een veld point aan onze tabel people toevoegen:

alter table people add column geom geometry;

16.2.4 Een beperking, gebaseerd op een type geometrie, toevoegen

U zult opmerken dat het veldtype geometrie niet impliciet het type geometrie voor het veld specificeert - daarvoor
hebben we een beperking (constraint) nodig:

alter table people
add constraint people_geom_point_chk

check(st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL);

Dit voegt een beperking aan de tabel toe zodat die alleen een geometrie punt of een waarde null accepteert.

16.2.5 ��� Probeer zelf:

Maak een nieuwe tabel, genaamd cities, en geef die enkele toepasselĳke kolommen, inclusief een veld voor geometrie
voor het opslaan van polygonen (de stadsgrenzen). Zorg er voor dat het een beperking heeft die maakt dat de
geometrieën polygonen zĳn.

Antwoord

16.2.6 Tabel geometry_columns vullen

Op dit punt zou u ook een item aan de tabel geometry_columns moeten toevoegen:

insert into geometry_columns values
('','public','people','geom',2,4326,'POINT');

Waarom? geometry_columns wordt door bepaalde toepassingen gebruikt om bĳ te houden welke tabellen in de
database gegevens met geometrie bevatten.

Notitie: Als het bovenstaande argument INSERT een fout veroorzaakt, voer dan eerst deze query uit:

select * from geometry_columns;

Als de kolom f_table_name al de waarde people bevat, dan is deze tabel al geregistreerd en hoeft u niets meer
te doen.

De waarde 2 verwĳst naar het aantal dimensies; in dit geval twee: X en Y.
De waarde 4326 verwĳst naar de projectie die we gebruiken; in dit geval WGS 84, waarnaar wordt verwezen door
het getal 4326 (bekĳk de eerdere bespreking van EPSG).
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��� Probeer zelf:

Voeg een toepasselĳk item voor geometry_columns in voor uw nieuwe laag cities

Antwoord

insert into geometry_columns values
('','public','cities','geom',2,4326,'POLYGON');

16.2.7 Record met geometrie toevoegen aan tabel met behulp van SQL

Nu onze tabellen ingeschakeld zĳn voor geometrie, kunnen we er geometrieën in opslaan:

insert into people (name,house_no, street_id, phone_no, geom)
values ('Fault Towers',

34,
3,
'072 812 31 28',
'SRID=4326;POINT(33 -33)');

Notitie: In het nieuwe item hierboven zult u moeten specificeren welke projectie (SRID) u wilt gebruiken. Dit omdat
u de geometrie van het nieuwe punt invoert met behulp van een gewone tekenreeks van tekst, wat niet automatisch
de juiste informatie over de projectie toevoegt. Uiteraard dient het nieuwe punt hetzelfde SRID te gebruiken als de
gegevensset waaraan het wordt toegevoegd, dus u moet het specificeren.
Als u op dit punt een grafische interface zou gebruiken, zou, bĳvoorbeeld, het specificeren van de projectie voor elk
punt automatisch gebeuren. Met andere woorden: u hoeft zich gewoonlĳk geen zorgen te maken over het gebruiken
van de juiste projectie voor elk punt dat u wilt toevoegen als u het al voor die gegevensset heeft gespecificeerd, zoals
wĳ eerder al deden.

Nu is het waarschĳnlĳk een goed moment om QGIS te openen en te proberen uw tabel people te bekĳken. Ook
zouden we moeten proberen records te bewerken / toe te voegen / te verwĳderen en dan query’s SELECT op de
database uitvoeren om te zien hoe de gegevens zĳn gewĳzigd.
Een laag van PostGIS laden in QGIS, gebruik de menuoptie Laag ► PostGIS-laag toevoegen of de knop op de
werkbalk:

Dit zal het dialoogvenster openen:

16.2. Les: Eenvoudig object model 509



QGIS Training Manual

Klik op de knop Nieuw om dit dialoogvenster te openen:
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Definieer dan een nieuwe verbinding, bĳv.:

Name: myPG
Service:
Host: localhost
Port: 5432
Database: address
User:
Password:

Klik op Test verbinding om te zien of QGIS de database address heeft gevonden en of uw gebruikersnaam en
wachtwoord juist zĳn. Als het werkt, selecteer dan de vakken naastGebruikersnaam opslaan enWachtwoord opslaan.
Klik dan op OK om deze verbinding te maken.
Terug in het dialoogvenster PostGIS-tabel(len) toevoegen, klik op Verbinden en voeg de lagen zoals gewoonlĳk toe
aan uw project.
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��� Probeer zelf:

Formuleer een query die de naam, straatnaam en positie (vanuit de kolom geom) weergeeft als gewone tekst.

Antwoord

select people.name,
streets.name as street_name,
st_astext(people.geom) as geometry

from streets, people
where people.street_id=streets.id;

Resultaat:

name | street_name | geometry
--------------+-------------+---------------
Roger Jones | High street |
Sally Norman | High street |
Jane Smith | Main Road |
Joe Bloggs | Low Street |
Fault Towers | Main Road | POINT(33 -33)

(5 rows)

Zoals u kunt zien staat onze beperking toe om waarden null toe te voegen aan de database.

16.2.8 Conclusie

U heeft gezien hoe u ruimtelĳke objecten toevoegt aan uw database en ze bekĳkt in GIS-software.

16.2.9 Wat volgt?

Vervolgens zult u zien hoe u gegevens importeert naar en exporteert vanuit uw database.

16.3 Les: Importeren en exporteren

Natuurlĳk zou een database zonder eenvoudige manier voor het in en uit migreren van gegevens niet van veel nut
zĳn. Gelukkig zĳn er een aantal gereedschappen die u gegevens eenvoudig in en uit PostGIS laten verplaatsen.

16.3.1 shp2pgsql

shp2pgsql is een gereedschap voor de opdrachtregel om ESRI-Shapefiles in de database te importeren. Onder Unix
kunt u de volgende opdracht gebruiken voor het importeren van een nieuwe tabel van PostGIS:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> | \
psql -d <databasename> -h <hostname> -U <username>

Onder Windows dient u het proces van importeren in twee stappen uit te voeren:

shp2pgsql -s <SRID> -c -D -I <path to shapefile> <schema>.<table> > import.sql
psql psql -d <databasename> -h <hostname> -U <username> -f import.sql

U zou deze fout kunnen tegenkomen:
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ERROR: operator class "gist_geometry_ops" does not exist for access method
"gist"

Dit is een bekend probleem met betrekking tot het in situ maken van een ruimtelĳke index voor de gegevens die u
importeert. Sluit de parameter -I uit om deze fout te vermĳden. Dit zal betekenen dat er niet direct een ruimtelĳke
index wordt gemaakt, en u zult die in de database moeten maken nadat de gegevens zĳn geïmporteerd. (Het maken
van een ruimtelĳke index zal worden behandeld in de volgende les.)

16.3.2 pgsql2shp

pgsql2shp is een programma voor de opdrachtregel om tabellen, weergaven of SQL SELECT-query’s vanuit PostGIS
te exporteren. Dit doen onder Unix:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> <databasename> <table | view>

De gegevens exporteren met behulp van een query:

pgsql2shp -f <path to new shapefile> -g <geometry column name> \
-h <hostname> -U <username> "<query>"

16.3.3 ogr2ogr

ogr2ogr is een zeer krachtig gereedschap om gegevens naar en vanuit PostGIS te converteren in vele indelingen.
ogr2ogr is deel van de GDAL bibliotheek en moet afzonderlĳk worden geïnstalleerd. U kunt deze opdracht gebruiken
om een tabel vanuit PostGIS naar GML te exporteren:

ogr2ogr -f GML export.gml PG:'dbname=<databasename> user=<username>
host=<hostname>' <Name of PostGIS-Table>

16.3.4 DB Manager

U heeft misschien al een andere optie opgemerkt in het menuDatabase gelabeldDBManager. Dat is een gereedschap
dat een eenduidige interface verschaft voor het werken met ruimtelĳke databases inclusief PostGIS. Het stelt u ook
in staat om vanuit databases naar andere indelingen te importeren en exporteren. Omdat de volgende module voor
een groot deel is toegespitst op dit gereedschap, zullen we het hier slechts kort vermelden.

16.3.5 Conclusie

Importeren en exporteren van gegevens naar en vanuit de database kan op vele verschillendemanieren worden gedaan.
In het bĳzonder bĳ het gebruiken van verscheidene gegevensbronnen, zult u waarschĳnlĳk deze functies gebruiken
(of andere soortgelĳke) op een regelmatige basis.
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16.3.6 Wat volgt?

Vervolgens zullen we kĳken hoe we de gegevens bevragen die we eerder hebben gemaakt.

16.4 Les: Ruimtelijke query’s

Ruimtelĳke query’s zĳn niet anders dan andere query’s voor databases. U kunt de kolom voor geometrie net zo
gebruiken als elke andere kolom in een database. Met de installatie van PostGIS in onze database, hebben we
aanvullende functies om onze database te bevragen.
het doel voor deze les: Zien hoe ruimtelĳke functies worden geïmplementeerd, soortgelĳk aan “normale” niet
ruimtelĳke functies.

16.4.1 Ruimtelijke operatoren

Wanneer u wilt weten welke punten binnen een afstand van 2 graden vanaf een punt(X,Y) liggen, kunt dat doen met:

select *
from people
where st_distance(geom,'SRID=4326;POINT(33 -34)') < 2;

Resultaat:

id | name | house_no | street_id | phone_no | geom
----+--------------+----------+-----------+---------------+---------------

6 | Fault Towers | 34 | 3 | 072 812 31 28 | 01010008040C0
(1 row)

Notitie: waarde geom hierboven werd afgebroken voor ruimte op deze pagina. Als u het punt in voor mensen leesbare
coördinaten wilt zien, probeer dan iets soortgelĳks als wat u eerder deed in het gedeelte “Bekĳk een punt als WKT”.

Hoe weten we dat de query hierboven alle punten binnen 2 graden teruggeeft? Waarom geen 2 meter? Of elke andere
maateenheid, nu we het er toch over hebben?

Antwoord
De eenheden die worden gebruikt in de voorbeeldquery zĳn graden, omdat het CRS dat de laag gebruikt WGS 84
is. Dit is een geografisch CRS, wat betekent dat de eenheden ervan in graden zĳn. Een geprojecteerd CRS, zoals de
UTM-projecties, is in meters.
Onthoud dat wanneer u een query schrĳft, u moet weten in welke eenheden het CRS van de laag is. Dat zal u in staat
stellen een query te schrĳven die de resultaten zal teruggeven die u verwacht.
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16.4.2 Ruimtelijke indexen

We kunnen ook ruimtelĳke indexen definiëren. Een ruimtelĳke index maakt uw ruimtelĳke query’s veel sneller.
Gebruik, om een ruimtelĳke index op de kolom voor geometrie te maken:

CREATE INDEX people_geo_idx
ON people
USING gist
(geom);

\d people

Resultaat:

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+----------------------------------------
id | integer | not null default

| | nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_geo_idx" gist (geom) <-- new spatial key added
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) = 'ST_Point'::text
OR geom IS NULL)

Foreign-key constraints:
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

16.4.3 Probeer zelf: ���

Pas de tabel cities zo aan dat zĳn kolom voor geometrie ruimtelĳk wordt geïndexeerd.

Antwoord

CREATE INDEX cities_geo_idx
ON cities
USING gist (geom);

16.4.4 Demonstratie ruimtelijke functies van PostGIS

We zullen een nieuwe database maken die enkele (fictionele) gegevens bevat om de ruimtelĳke functies van PostGIS
te demonstreren.
Maak, om te beginnen, eerst een nieuwe database (verlaat eerst de shell van psql):

createdb postgis_demo

Vergeet niet de extensies voor PostGIS te installeren:

psql -d postgis_demo -c "CREATE EXTENSION postgis;"
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Importeer vervolgens de gegevens die worden verschaft in demapexercise_data/postgis/. Bekĳk de vorige
les voor de instructies, maar onthoud dat u een nieuwe PostGIS verbinding moet maken naar de nieuwe database. U
kunt de gegevens importeren vanuit de terminal of via SPIT. Importeer de bestanden in de volgende tabellen van de
database:

• points.shp in building
• lines.shp in road
• polygons.shp in region

Laad deze drie lagen van de database in QGIS via het dialoogvenster PostGIS-laag toevoegen, zoals gewoonlĳk.
Wanneer u hun attributentabellen opent, zult u merken dat zĳ alle een veld id en een veld gid hebben, gemaakt
door het importeren met PostGIS.
Nu de tabellen zĳn geïmporteerd, kunnen we PostGIS gebruiken om de gegevens te bevragen. Ga terug naar uw
terminal (opdrachtregel) en voer bĳ de prompt van psql in:

psql postgis_demo

We zullen enkele van deze argumenten SELECT demonstreren door er weergaven van te maken, zodat u ze in QGIS
kunt openen en hun resultaten kunt zien.

Selecteren op plaats

Alle gebouwen in de regio KwaZulu verkrĳgen:

SELECT a.id, a.name, st_astext(a.geom) as point
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Resultaat:

id | name | point
----+------+------------------------------------------
30 | York | POINT(1622345.23785063 6940490.65844485)
33 | York | POINT(1622495.65620524 6940403.87862489)
35 | York | POINT(1622403.09106394 6940212.96302097)
36 | York | POINT(1622287.38463732 6940357.59605424)
40 | York | POINT(1621888.19746548 6940508.01440885)

(5 rows)

Of, als we er een view van maken:

CREATE VIEW vw_select_location AS
SELECT a.gid, a.name, a.geom
FROM building a, region b

WHERE st_within(a.geom, b.geom)
AND b.name = 'KwaZulu';

Voeg de view als een laag toe en bekĳk deze in QGIS:
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Buren selecteren

Geef een lĳst weer van de namen van alle regio’s die naast de regio Hokkaido liggen:

SELECT b.name
FROM region a, region b
WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

Resultaat:

name
--------------
Missouri
Saskatchewan
Wales

(3 rows)

Als een view:

CREATE VIEW vw_regions_adjoining_hokkaido AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE st_touches(a.geom, b.geom)
AND a.name = 'Hokkaido';

In QGIS:
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Merk de ontbrekende regio op (Queensland). Dit zou kunnen komen door een fout in de topologie. Artefacten zoals
dit kunnen ons waarschuwen voor potentiële problemen in de gegevens. Om dit enigma op te lossen zonder verstrikt
te raken in de afwĳkingen in de gegevens die de gegevens zouden kunnen hebben, zouden we in plaats daarvan een
‘buffer intersect’ kunnen gebruiken:

CREATE VIEW vw_hokkaido_buffer AS
SELECT gid, ST_BUFFER(geom, 100) as geom
FROM region

WHERE name = 'Hokkaido';

Dit maakt een buffer van 100 meter rondom de regio Hokkaido.
Het donkere gebied is de buffer:
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Selecteer met behulp van de buffer:

CREATE VIEW vw_hokkaido_buffer_select AS
SELECT b.gid, b.name, b.geom
FROM
(

SELECT * FROM
vw_hokkaido_buffer

) a,
region b
WHERE ST_INTERSECTS(a.geom, b.geom)
AND b.name != 'Hokkaido';

In deze query wordt de originele view van de buffer gebruikt zoals elke andere tabel gebruikt zou worden. Het is het
alias a gegeven en het veld voor de geometrie ervan, a.geom, wordt gebruik om elke polygoon in de tabel region
(alias b) te selecteren waarmee deze kruist. Echter, Hokkaido zelf wordt uitgesloten van dit argument SELECT,
omdat we die niet willen; we willen alleen de regio’s die er naast liggen.
In QGIS:
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Het is ook mogelĳk alle objecten binnen een bepaalde afstand te selecteren, zonder de extra stap van te maken door
eerst een buffer te creëren:

CREATE VIEW vw_hokkaido_distance_select AS
SELECT b.gid, b.name, b.geom
FROM region a, region b

WHERE ST_DISTANCE (a.geom, b.geom) < 100
AND a.name = 'Hokkaido'
AND b.name != 'Hokkaido';

Dit levert hetzelfde resultaat op, zonder de noodzaak van een tussenliggende stap voor de buffer:
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Unieke waarden selecteren

Toon een lĳst van alle unieke namen van steden voor alle gebouwen in de regio Queensland:

SELECT DISTINCT a.name
FROM building a, region b
WHERE st_within(a.geom, b.geom)
AND b.name = 'Queensland';

Resultaat:

name
---------
Beijing
Berlin
Atlanta

(3 rows)

Meer voorbeelden …

CREATE VIEW vw_shortestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_SHORTESTLINE(a.geom, b.geom)) as text,
ST_SHORTESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;

CREATE VIEW vw_longestline AS
SELECT b.gid AS gid,

ST_ASTEXT(ST_LONGESTLINE(a.geom, b.geom)) as text,
ST_LONGESTLINE(a.geom, b.geom) AS geom

FROM road a, building b
WHERE a.id=5 AND b.id=22;
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CREATE VIEW vw_road_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM road a

WHERE a.id = 1;

CREATE VIEW vw_region_centroid AS
SELECT a.gid as gid, ST_CENTROID(a.geom) as geom
FROM region a

WHERE a.name = 'Saskatchewan';

SELECT ST_PERIMETER(a.geom)
FROM region a
WHERE a.name='Queensland';

SELECT ST_AREA(a.geom)
FROM region a
WHERE a.name='Queensland';

CREATE VIEW vw_simplify AS
SELECT gid, ST_Simplify(geom, 20) AS geom
FROM road;

CREATE VIEW vw_simplify_more AS
SELECT gid, ST_Simplify(geom, 50) AS geom
FROM road;

CREATE VIEW vw_convex_hull AS
SELECT
ROW_NUMBER() over (order by a.name) as id,
a.name as town,
ST_CONVEXHULL(ST_COLLECT(a.geom)) AS geom
FROM building a
GROUP BY a.name;

16.4.5 Conclusie

U heeft gezien hoe u ruimtelĳke objecten kunt bevragen met behulp van de nieuwe databasefuncties van PostGIS.

16.4.6 Wat volgt?

Vervolgens gaan we de structuren van meer complexe geometrieën onderzoeken en hoe ze te maken met behulp van
PostGIS.

16.5 Les: Construeren van geometrie

In dit gedeelte duiken we een beetje dieper in hoe eenvoudige geometrieën worden geconstrueerd in SQL. In de
realiteit zou u waarschĳnlĳk een GIS zoals QGIS gebruiken om complexe geometrieën te maken met behulp van hun
gereedschappen voor digitaliseren; echter, begrĳpen hoe zĳ worden geformuleerd kan handig zĳn bĳ het schrĳven
van query’s en begrĳpen hoe de database is samengesteld.
Het doel van deze les: Beter begrĳpen hoe ruimtelĳke entiteiten direct in PostgreSQL/PostGIS te maken.
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16.5.1 Lijnen maken

Terug naar onze database address, laten we zorgen dat onze tabel streets overeenkomt met de andere; d.i. een
beperking hebben op de geometrie, een index en een item in de tabel geometry_columns.

16.5.2 Probeer zelf: ���

• Pas de tabel streets zo aan dat die een kolom voor geometrie bevat van het type ST_LineString.
• Vergeet niet een update uit te voeren om de geometrie kolom te laten maken.
• Voeg een constraint toe om te voorkomen dat andere geometrie dan lĳnen of lege geometrie kan worden
ingevoerd.

• Maak een ruimtelĳke index op de nieuwe geometrie kolom

Antwoord

alter table streets add column geom geometry;
alter table streets add constraint streets_geom_point_chk check

(st_geometrytype(geom) = 'ST_LineString'::text OR geom IS NULL);
insert into geometry_columns values ('','public','streets','geom',2,4326,

'LINESTRING');
create index streets_geo_idx

on streets
using gist
(geom);

Laten we nu een lĳn in onze tabel streets maken. In dit geval zullen we een bestaand record voor een straat bĳwerken:

update streets
set geom = 'SRID=4326;LINESTRING(20 -33, 21 -34, 24 -33)'
where streets.id=2;

Bekĳk de resultaten in QGIS. (U moet misschien met rechts klikken op de laag streets in het paneel ‘Lagen’ en kiezen
voor ‘Op kaartlaag inzoomen’.)
Maak nu nog enkele items voor streets - enkele in QGIS en enkele vanaf de opdrachtregel.

16.5.3 Polygonen maken

Het maken van polygonen is net zo eenvoudig. Eén ding om te onthouden is dat, bĳ definitie, polygonen tenminste
vier hoekenpunten hebben, waarvan de eerste en laatste op één lĳn liggen:

insert into cities (name, geom)
values ('Tokyo', 'SRID=4326;POLYGON((10 -10, 5 -32, 30 -27, 10 -10))');

Notitie: Een polygoon vereist dat er dubbele haken rondom de lĳst met coördinaten staat; dat is om het voor u
mogelĳk te maken complex polygonen met meerdere niet verbonden gebieden toe te voegen. Bĳvoorbeeld

insert into cities (name, geom)
values ('Tokyo Outer Wards',

'SRID=4326;POLYGON((20 10, 20 20, 35 20, 20 10),
(-10 -30, -5 0, -15 -15, -10 -30))'

);
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Indien u deze stap volgde kunt u controleren wat die deed door de gegevensset cities te laden in QGIS, de
attributentabel ervan te openen en het nieuwe item te selecteren. merk op hoe de twee nieuwe polygonen zich gedragen
als één polygoon.

16.5.4 Oefening: Steden aan mensen koppelen

Voor deze oefening zou u het volgende moeten doen:
• Alle gegevens uit uw tabel people verwĳderen.
• Een kolom voor een vreemde sleutel, die verwĳst naar de primaire sleutel van de tabel cities, aan people
toevoegen.

• QGIS gebruiken om enkele steden vast te leggen.
• SQL gebruiken om enkele nieuwe records voor people in te voeren, er zorg voor dragend dat elk daarvan een
geassocieerde straat en stad heeft.

Uw bĳgewerkte schema voor people zou er ongeveer zo uit moeten zien:

\d people

Table "public.people"
Column | Type | Modifiers

-----------+-----------------------+--------------------------------------------
id | integer | not null

| | default nextval('people_id_seq'::regclass)
name | character varying(50) |
house_no | integer | not null
street_id | integer | not null
phone_no | character varying |
geom | geometry |
city_id | integer | not null

Indexes:
"people_pkey" PRIMARY KEY, btree (id)
"people_name_idx" btree (name)

Check constraints:
"people_geom_point_chk" CHECK (st_geometrytype(geom) =

'ST_Point'::text OR geom IS NULL)
Foreign-key constraints:

"people_city_id_fkey" FOREIGN KEY (city_id) REFERENCES cities(id)
"people_street_id_fkey" FOREIGN KEY (street_id) REFERENCES streets(id)

Antwoord

delete from people;
alter table people add column city_id int not null references cities(id);

(steden vastleggen in QGIS)

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Faulty Towers',

34,
3,
'072 812 31 28',
1,
'SRID=4326;POINT(13 -15)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('IP Knightly',

32,

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
1,
'071 812 31 28',
1,
'SRID=4326;POINT(18 -24)');

insert into people (name,house_no, street_id, phone_no, city_id, geom)
values ('Rusty Bedsprings',

39,
1,
'071 822 31 28',
1,
'SRID=4326;POINT(22 -25)');

Als u het volgende foutbericht ontvangt:

ERROR: insert or update on table "people" violates foreign key constraint
"people_city_id_fkey"

DETAIL: Key (city_id)=(1) is not present in table "cities".

dan betekent dat, dat tĳdens het experimenteren met het maken van polygonen voor de tabel cities, u enkele ervan
moet hebben verwĳderd en opnieuw moet beginnen. Controleer eenvoudigweg de items in uw tabel cities en gebruik
een id die bestaat.

16.5.5 Ons schema bekijken

Ons schema zou er nu ongeveer zo uit moeten zien:

16.5.6 Probeer zelf: ���

Maak stadsgrenzen door de minimum convex hull van alle adressen voor die stad te berekenen en een buffer rondom
dat gebied te berekenen.

Antwoord
• Voeg enkele mensen toe in de stad ‘Tokyo Outer Wards’

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Bad Aboum',

57,
2,

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
'073 712 31 21',
2,
'SRID=4326;POINT(22 18)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Pat Atra',

59,
2,
'074 712 31 25',
2,
'SRID=4326;POINT(23 14)');

INSERT INTO people (name, house_no, street_id, phone_no, city_id, geom)
VALUES ('Kat Herin',

65,
2,
'074 722 31 28',
2,
'SRID=4326;POINT(29 18)');

• Maak tabel myPolygonTable

CREATE TABLE myPolygonTable (
id serial NOT NULL PRIMARY KEY,
city_id int NOT NULL REFERENCES cities(id),
geom geometry NOT NULL

);

ALTER TABLE myPolygonTable
ADD CONSTRAINT myPolygonTable_geom_polygon_chk
CHECK (st_geometrytype(geom) = 'ST_Polygon'::text );

• Maak en laad de bolle schillen

INSERT INTO myPolygonTable (city_id, geom)
SELECT * FROM
(
SELECT

ROW_NUMBER() over (order by city_id)::integer AS city_id,
ST_CONVEXHULL(ST_COLLECT(geom)) AS geom
FROM people
GROUP BY city_id

) convexHulls;

16.5.7 Toegang tot sub-objecten

Met de functies voor het SFS-model heeft u een breed scala aan opties om toegang te verkrĳgen tot sub-objecten van
geometrieën van SFS. Wanneer u het eerste vertexpunt van elke geometrie polygoon in de tabel myPolygonTable wilt
selecteren, moet u dat op de volgende manier doen:

• Transformeer de randen van de polygoon naar een lĳn:

select st_boundary(geom) from myPolygonTable;

• Selecteer het eerste vertexpunt van de resulterende lĳn:

select st_startpoint(myGeometry)
from (

(Vervolgt op volgende pagina)
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(Vervolgd van vorige pagina)
select st_boundary(geom) as myGeometry
from myPolygonTable) as foo;

16.5.8 Gegevens verwerken

PostGIS ondersteunt alle standaard conforme functies van OGC SFS/MM. Al deze functies beginnen met ST_.

16.5.9 Clippen

U kunt de functie ST_INTERSECT() gebruiken om een sub-gedeelte van uw gegevens te clippen. Vermĳd lege
geometrieën door te gebruiken:

where not st_isempty(st_intersection(a.geom, b.geom))

select st_intersection(a.geom, b.geom), b.*
from clip as a, road_lines as b
where not st_isempty(st_intersection(st_setsrid(a.geom,32734),

b.geom));
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16.5.10 Geometrieën uit andere geometrieën bouwen

vanuit een opgegeven punttabel wilt u een lĳn genereren. De volgorde van de punten wordt gedefinieerd door hun
id. Een andere methode van sorteren zou een tĳdstempel kunnen zĳn, zoals die welke u krĳgt wanneer u waypoints
vastlegt met een GPS-ontvanger.
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U kunt de volgende opdracht gebruiken om een lĳn uit een nieuwe puntlaag, genaamd ‘points’, te maken:

select ST_LineFromMultiPoint(st_collect(geom)), 1 as id
from (

select geom
from points
order by id

) as foo;

U zou deze opdracht ook uit kunnen voeren op de laag ‘people’, hoewel dat natuurlĳk weinig nut binnen de echte
wereld zou hebben om dit te doen, om te zien hoe het werkt zonder een nieuwe laag te maken.

16.5. Les: Construeren van geometrie 529



QGIS Training Manual

16.5.11 Geometrie opruimen

U kunt meer informatie over dit onderwerp krĳgen in dit blog-item.

16.5.12 Verschillen tussen tabellen

U kunt het sleutelwoord voor PostgreSQL EXCEPT gebruiken om het verschil tussen twee tabellen met dezelfde
structuur te detecteren:

select * from table_a
except
select * from table_b;

Als resultaat zult u alle records uit table_a verkrĳgen die niet zĳn opgeslagen in table_b.
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16.5.13 Tabelruimten

U kunt definiëren waar Postgres zĳn gegevens op schĳf op zou moeten slaan dor tabelruimten te maken:

CREATE TABLESPACE homespace LOCATION '/home/pg';

U kunt u dan, wanneer u een database maakt, specificeren welke tabelruimte gebruikt moet worden, bĳv.:

createdb --tablespace=homespace t4a

16.5.14 Conclusie

U heeft geleerd hoe u meer complexe geometrieën maakt met behulp van argumenten van PostGIS. Onthoud dat dit
meer is om uw achtergrondkennis te verbeteren wanneer u werkt met voor geo ingeschakelde databases via een GIS
als startpunt. Gewoonlĳk hoeft u deze argumenten niet handmatig in te voeren, maar als u een algemeen idee heeft
van hun structuur zal dat u helpen wanneer u een GIS gebruikt, in het bĳzonder als u fouten tegenkomt die anders
nogal cryptisch zouden kunnen lĳken.

16.5. Les: Construeren van geometrie 531



QGIS Training Manual

532 Hoofdstuk 16. Module: Concepten van een ruimtelijke database met PostGIS



HOOFDSTUK17

De QGIS-gids voor Processing

Deze module is bĳgedragen door Victor Olaya en Paolo Cavallini.
Inhoud:

17.1 Introductie

Deze gids beschrĳft hoe het framework Processing in QGIS te gebruiken. Het gaat uit van geen eerdere kennis van
het framework Processing of één van de toepassingen waarop het vertrouwt. Het gaat voorts uit van basiskennis van
QGIS. De hoofdstukken over scripten gaan er van uit dat u enige basiskennis heeft van Python en misschien de Python
API van QGIS.
Deze gids is ontworpen voor zelfstudie of om te worden gebruikt in een uit te voeren workshop voor Processing.
Voorbeelden in deze gids gebruiken QGIS 3.4. Zĳ zouden niet kunnen werken of niet beschikbaar kunnen zĳn in
andere versies dan die.
Deze gids is samengesteld uit een verzameling kleine oefeningen met progressieve complexiteit. Indien u nog nooit het
framework Processing heeft gebruikt zou u vanaf het eerste begin moeten starten. Indien u enige eerdere ervaringen
heeft, het staat u vrĳ om lessen over te slaan. Zĳ zĳn min of meer onafhankelĳk van elkaar, en elke introduceert
enige nieuwe concepten of enige nieuwe elementen, welke worden aangegeven in de titel van het hoofdstuk en de
korte introductie aan het begin van elk hoofdstuk. Dat zou het eenvoudiger moeten maken lessen te lokaliseren die
een bepaald onderwerp behandelen.
Voor eenmeer systematische beschrĳving van alle componenten van het framework en hun gebruik, wordt aanbevolen
om het overeenkomstige hoofdstuk in de gebruikershandleiding te raadplegen. Gebruik het als ondersteunende tekst
naast deze gids.
Alle oefeningen in deze handleiding maken gebruik van dezelfde gratis en open dataset voor de gehele
trainingshandleiding en waarnaar wordt verwezen in het gedeelte Gegevens. Het te downloaden .zip-bestand bevat
verscheidene mappen voor elk van de lessen in deze gids. In elke map vindt u een QGIS projectbestand. Open het
bestand en u kunt met de oefening beginnen.
Veel plezier!
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17.2 Een belangrijke waarschuwing vóór het beginnen

Net zoals een handleiding voor een tekstverwerker u niet leert om een roman of een gedicht te schrĳven, of een
handleiding voor CAD u niet laat zien hoe u de grootte voor een balk voor een gebouw berekent, zal deze gids u geen
ruimtelĳke analyses leren. In plaats daarvan zal het u tonen hoe het framework Processing in QGIS te gebruiken, een
krachtig gereedschap voor het uitvoeren van ruimtelĳke analyses. Het is aan u om de vereiste concepten te leren die
nodig zĳn om dat type analyse te begrĳpen. Zonder dat heeft het geen zin om het framework en de algoritmes daarin
te gebruiken, hoewel u misschien in de verleiding komt om het te proberen.
Laten we dit eens aan de hand van een voorbeeld duidelĳk maken.
Met opgegeven verzameling punten en een waarde van een opgegeven waarde voor een variabele voor elk punt, kunt u
voor hen een rasterlaag berekenen met behulp van het geo-algoritme Kriging. Het dialoogvenster voor de parameters
van die module ziet eruit zoals het volgende.

Het ziet er ingewikkeld uit, niet?
Door deze handleiding te lezen zult u dingen leren zoals hoe die module te gebruiken, hoe het uit te voeren in een
batch-proces om rasterlagen uit honderden puntlagen te maken in één enkele uitvoering, of wat er gebeurd als op de
invoerlaag enkele punten zĳn geselecteerd. Echter, de parameters zelf worden niet uitgelegd. Een ervaren analist met
goede kennis van geo-statistieken zal geen probleem hebben de parameters te begrĳpen. Als u niet één van hen bent
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en sill, range, of nugget zĳn gene bekende concepten voor u, dan zou u de module Kriging niet moeten gebruiken.
Meer dan dat, u bent nog lang niet klaar om de module Kriging te gebruiken, omdat het leren vereist van concepten
zoals ruimtelĳke autocorrelatie of semi-variogrammen, waarvan u waarschĳnlĳk ook nooit eerder gehoord heeft, of
tenminste nog niet lang genoeg bestudeerd heeft. U zou ze eerst moeten bestuderen en begrĳpen, en dan terugkomen
naar QGIS om het feitelĳk uit te voeren en de analyse uit te voeren. Negeren hiervan zal leiden tot verkeerde resultaten
en slechte (en zeer waarschĳnlĳk nutteloze) analyse.
Hoewel niet alle algoritmes zo complex zĳn als Kriging (maar sommige ervan zĳn nog complexer!), vereisen de
meeste ervan het begrĳpen van de fundamentele analyse-ideeën waarop zĳ zĳn gebaseerd. Zonder die kennis zal het
gebruiken ervan zeer waarschĳnlĳk leiden tot slechts resultaten.
gebruiken van geo-algoritmes zonder een goede fundatie te hebben van ruimtelĳke analyse is als het proberen een
roman te schrĳven zonder iets af te weten van grammatica of syntaxis, en gene kennis hebben over het vertellen van
verhalen. U zou een resultaat kunnen krĳgen, maar het is waarschĳnlĳk dat er helemaal geen waarde wordt verkregen.
Houd uzelf niet voor de gek door te denken dat u na het lezen van deze gids u al in staat bent een ruimtelĳke analyse
uit te voeren en degelĳke resultaten te krĳgen. U zult ook de ruimtelĳke analyse moeten bestuderen.
Hier is een goede verwĳzing die u kunt lezen om meer te leren over ruimtelĳke gegevensanalyse.
Geospatial Analysis (3rd Edition): A Comprehensive Guide to Principles, Techniques and Software Tools Michael
John De Smith, Michael F. Goodchild, Paul A. Longley
Het is hier online beschikbaar.

17.3 Het framework Processing instellen

Het eerste om te doen, vóór het framework Processing te kunnen gebruiken, is om het te configureren. Er is niet veel
in te stellen, dus dit is een eenvoudige taak.
Later zullen we laten zien hoe de externe toepassingen te configureren die worden gebruikt om de lĳst met beschikbare
algoritmes uit te breiden, maar voor nu gaan we alleen met het framework zelf werken.
Het framework Processing is een bronplug-in voor QGIS, wat betekent dat, het al op uw systeem geïnstalleerd zou
moeten zĳn, omdat het is opgenomen in QGIS. In het geval dat het actief is zou u een menu, genaamd Processing, in
uw menubalk moeten zien. Daar kunt u toegang krĳgen tot alle componenten van het framework.

Als u dat menu niet kunt vinden, dient u de plug-in in te schakelen door te gaan naar Beheer en installeer plug-ins en
het te activeren.
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Het belangrĳkste element waarmee we zullen gaan werken is de Toolbox. Klik op het overeenkomende item van het
menu en u zult de vastgezette Toolbox zien aan de rechterkant van het venster van QGIS.
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De Toolbox bevat een lĳst van alle beschikbare algoritmes, opgedeeld in groepen, zogenaamde Providers. Providers
kunnen worden ge(de)activeerd in het Extra ► Options ► Processing. We zullen dat dialoogvenster later in deze
handleiding bespreken.
Standaard zĳn alleen providers die niet afhankelĳk zĳn van toepassingen van derde partĳen (dat is, die welke alleen
elementen van QGIS nodig hebben om te worden uitgevoerd) actief. Algoritmes die externe toepassingen nodig
hebben zouden een aanvullende configuratie nodig kunnen hebben. Configureren van providers wordt in een later
hoofdstuk van deze handleiding uitgelegd.
Als u dit punt heeft bereikt bent u er klaar voor om geo-algoritmes te gebruiken. Er is op dit moment geen noodzaak
om nog iets anders te configureren. We kunnen ons eerste algoritme al gaan uitvoeren, wat we ook zullen doen in de
volgende les.

17.4 Uw eerste algoritme uitvoeren. De Toolbox

Notitie: In deze les zullen we ons eerste algoritme uitvoeren, en ons eerste resultaat daaruit verkrĳgen.

Zoals we al hebben besproken kan het framework Processing algoritmes uit andere toepassingen uitvoeren, maar het
bevat ook eigen algoritmes die geen externe software nodig hebben om te worden uitgevoerd. We gaan één van deze
eigen algoritmes uitvoeren om te beginnen met het verkennen van het framework Processing. In het bĳzonder gaan
we de middelpunten berekenen van een verzameling polygonen.
Open eerst het project vanQGIS dat correspondeertmet deze les. Het bevat slechts één enkele laagmet twee polygonen

Ga nu naar het tekstvak boven in de Toolbox. Dat is het zoekvak en als u tekst daarin typt, zal het de lĳst met
algoritmes filteren, zodat slechts die, welke de ingevoerde tekst bevatten worden weergegeven. Als er algoritmes zĳn
die overeenkomen met uw zoekactie, maar toebehoren aan een provider die niet actief is, zal een aanvullend label
worden weergegeven in het onderste gedeelte van Toolbox.
Typ centroids en u zou iets zoals dit moeten zien.
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Het zoekvak is een zeer praktische manier om het algoritme te zoeken dat u nodig hebt. Aan de onderzĳde van het
dialoogvenster wordt een aanvullend label weergegeven dat vermeldt dat er algoritmes zĳn die overeenkomen met uw
zoekactie, maar aan een provider behoren die niet actief is. Als u klikt op de koppeling in dat label, zal de lĳst met
algoritmes ook de resultaten van die niet actieve providers bevatten, die lichtgrĳs zullen worden weergegeven. Ook
een koppeling om de niet actieve provider te activeren wordt weergegeven. We zullen later zien hoe andere providers
te activeren.

U hoeft slechts te dubbelklikken op de naam in de Toolbox om een algoritme uit te voeren. Als u dubbelklikt op het
algoritme Polygon centroids, zult u het volgende dialoogvenster zien.
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Alle algoritmes hebben een soortgelĳke interface, die als basis parameters voor invoer bevat die u moet invullen en
voor uitvoer die u moet selecteren om de plaats voor opslaan te kiezen. In dit geval is de enige invoer die we hebben
een vectorlaag met polygonen.
Selecteer de laag Polygons als invoer. Het algoritme heeft één enkele uitvoer, wat de laag Centroids is. Er zĳn twee
opties om te definiëren waar uitvoer van gegevens wordt opgeslagen: voer ofwel een bestandspad in of sla het op naar
een tĳdelĳke bestandsnaam
In het geval dat u een bestemming wilt instellen, en het resultaat niet wilt opslaan in een tĳdelĳk bestand,
wordt de indeling van de uitvoer gedefinieerd door de extensie van de bestandsnaam. Selecteer eenvoudigweg de
corresponderende bestandsextensie (of voeg die toe, als u in plaats daarvan het bestandspad direct intypt) om
een indeling te selecteren. Als de extensie van het bestandspad dat u invoerde niet overeenkomt met een van de
ondersteunde indelingen, zal een standaard extensie (gewoonlĳk .dbf voor tabellen, .tif voor rasterlagen en .
shp voor vectorlagen) worden toegevoegd aan het bestandspad, en de bestandsindeling die correspondeert met die
extensie zal worden gebruikt om de laag of de tabel op te slaan.
In alle oefeningen in deze handleiding zullen we de resultaten opslaan naar een tĳdelĳk bestand, omdat er geen reden
is ze op te slaan voor later gebruik. Het staat u uiteraard vrĳ om ze op een permanente locatie op te slaan als u dat
wilt.

Waarschuwing: Tĳdelĳke bestanden worden verwĳderd als u QGIS afsluit. Als u een project maakte met een
uitvoer die werd opgeslagen als een tĳdelĳk bestand, zal QGIS klagen als u later het project weer wilt openen,
omdat het uitvoerbestand niet meer bestaat.

Als u eenmaal het dialoogvenster voor het algoritme heeft geconfigureerd, druk dan op Run om het algoritme uit te
voeren.
U zult de volgende uitvoer krĳgen.
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De uitvoer heeft hetzelfde CRS als de invoer. Geo-algoritmes gaan er van uit dat alle invoerlagen hetzelfde CRS delen
en projecteert niets opnieuw. Behalve in het geval van enkele speciale algoritmes (bĳvoorbeeld die voor opnieuw
projecteren), de uitvoer zal ook datzelfde CRS hebben. We zullen hier snel meer van zien.
Probeer het zelf op te slaan in verschillende bestandsindelingen (gebruik bĳvoorbeeld .shp en geojson als
extensies). Ook kunt u, als u niet wilt dat de laag zal worden geladen in QGIS nadat die is gegenereerd, het keuzevak
deselecteren dat staat onder het vak voor het pad van de uitvoer.

17.5 Meer algoritmes en gegevenstypen

Notitie: In deze les zullen we nog drie algoritmes uitvoeren, leren hoe andere typen voor invoer te gebruiken, en
uitvoer configureren om automatisch te worden opgeslagen in een bepaalde map.

Voor deze lessen zullen we een tabel en een laag voor polygonen nodig hebben. We zullen een puntenlaag gaan maken
gebaseerd op coördinaten in de tabel, en dan het aantal punten in elke polygoon tellen. Als u het project voor QGIS
opent dat correspondeert met deze les, zult u een tabel vinden met X- en Y-coördinaten, maar u zult geen laag voor
polygonen vinden. Geen zorgen, die zullen we maken met behulp van een geo-algoritme van Processing.
Het eerste dat we zullen gaan doen is een puntenlaag maken uit de coördinaten in de tabel, met behulp van het
algoritme Points layer from table. U weet nu hoe u het zoekvak kunt gebruiken, dus zou het voor u niet zo moeilĳk
moeten zĳn om dat op te zoeken. Dubbelklik erop om het uit te voeren en u krĳgt het volgende dialoogvenster.
Dit algoritme, net zoals dat uit de vorige les, genereert slechts één enkele uitvoer, en het heeft drie invoeren:

• Invoerlaag: de tabel met de coördinaten. U zou hier de tabel uit de gegevens voor de les moeten selecteren.
• X- en Y-velden: deze twee parameters zĳn gekoppeld aan de eerste. De overeenkomende selectie zal de naam
weergeven van de velden die beschikbaar zĳn in de geselecteerde tabel. Selecteer het veld XCOORD voor de
parameter X, en het veld YYCOORD voor de parameter Y.

• doel-CRS: Omdat dit algoritme geen invoerlagen heeft, kan het geen CRS aan de uitvoerlaag toewĳzen die daar
op is gebaseerd. In plaats daarvan vraagt het u om handmatig het CRS te selecteren dat de coördinaten in de
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tabel gebruiken. Klik op de knop aan de rechterkant om de selectie van CRS voor QGIS te openen, en selecteer
EPSG:4326 als het CRS voor de uitvoer. We gebruiken dat CRS omdat de coördinaten in de tabel in dat CRS
staan.

Uw dialoogvenster zou er nu zo uit moeten zien.

Druk nu op de knop Run om de volgende laag te krĳgen (u moet misschien volledig inzoomen om de kaart rondom
de nieuw gemaakte punten te laten zien):
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Het volgende dat we nodig hebben is de polygoonlaag. We gaan een rechthoekig raster van polygonen maken met
behulp van het algoritme Create grid, wat het volgende dialoogvenster voor de parameters heeft.
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Waarschuwing: De opties zĳn eenvoudiger in recent versies van QGIS; u hoeft slechts de min en max voor X
en Y in te voeren (voorgestelde waarden: -5.696226,-5.695122,40.24742,40.248171)

De vereiste invoeren voor het maken van het raster zĳn allemaal getallen. Wanneer u een numerieke waarde dient in
te voeren heeft u twee opties: het direct typen in het overeenkomende vak of klikken op de knop aan de rechterkant
om een dialoogvenster te krĳgen zoals dat hieronder wordt weergegeven.
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Het dialoogvenster bevat een eenvoudige calculator, dus u kunt expressies typen zoals 11 * 34.7 + 4.6, en
het resultaat zal worden berekend en in het overeenkomende vak in het dialoogvenster van de parameters worden
geplaatst. Het bevat ook constanten die u kunt gebruiken en waarden uit andere beschikbare lagen.
In dit geval willen we een raster maken dat het bereik van de puntenlaag voor invoer bedekt, dus zouden we de
coördinaten daarvan moeten gebruiken om de coördinaat van het midden van het raster te berekenen en de breedte
en hoogte daarvan, omdat dat de parameters zĳn die het algoritme nodig heeft om het raster te kunnen maken. met
een beetje rekenkundige hulp, probeer dat zelf eens te doen met behulp van het dialoogvenster met de calculator en
de constanten van de puntenlaag van de invoer.
Selecteer Rectangles (polygons) in het veld Type.
Net zoals in het geval van het laatste algoritme moeten we hier ook het CRS invullen. Selecteer EPSG:4326 als het
doel-CRS, zoals we al eerder deden.
Uiteindelĳk zou u een dialoogvenster voor parameters moeten hebben zoals dit:
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(Het is beter om één afstand toe te voegen voor breedte en hoogte: Horizontal spacing: 0.0001, Vertical spacing:
0.0001, Width: 0.001004, Height: 0.000651, Center X: -5.695674, Center Y: 40.2477955) Het geval van X center
is een beetje gevoelig, zie: -5.696126+(( -5.695222+ 5.696126)/2)
Druk op Run en u zult de laag met het raster krĳgen.
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De laatste stap is om de punten te tellen in elke rechthoek van dat raster. We zullen het algoritme Count points in
polygons gebruiken.

Nu hebben we het resultaat dat we zochten.
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Vóórdat we deze les beëindigen: hier is een snelle tip om uw leven eenvoudiger te maken voor het geval u uw gegevens
steeds wilt opslaan. Als u wilt dat al uw gegevens voor de uitvoer worden opgeslagen in één bepaalde map, hoeft u
niet elke keer de naam van de map te typen. Ga, in plaats daarvan, naar het menu Processing en selecteer het item
Opties en configuratie. dat zal het dialoogvenster voor configuratie openen.

In het item Output folder dat u zult vinden in de groep General, typt u het pad naar uw doelmap.
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Wanneer u nu een algoritme uitvoert, gebruik dan slechts de bestandsnaam in plaats van het volledige pad.
Bĳvoorbeeld, met de hierboven weergegeven configuratie, als u graticule.shp invoert als het pad voor
uitvoer voor het algoritme dat we zojuist hebben gebruikt, zal het resultaat worden opgeslagen in D:\
processing_output\graticule.shp. U kunt nog steeds een volledig pad invoeren voor de gevallen waarin
u wilt dat het resultaat wordt opgeslagen in een andere map.
Probeer zelf het algoritme Create grid met verschillende grootten raster, en ook met verschillende typen raster.

17.6 CRS-en opnieuw.projecteren

Notitie: In deze les zullen we bespreken hoe Processing CRS-en gebruikt.We zullen ook een zeer bruikbaar algoritme
bekĳken: opnieuw projecteren.

CRS-en zĳn een grote bron van verwarring voor gebruikers van Processing in QGIS, dus zĳn er enkele algemene
regels over hoe zĳ worden afgehandeld door geo-algoritmes bĳ het maken van een nieuwe laag.

• Als er invoerlagen zĳn, zal het het CRS van de eerste laag gebruiken. Aangenomen wordt dat dat het CRS is van
alle invoerlagen, omdat zĳ allemaal hetzelfde zouden moeten hebben. Als u lagen gebruikt met CRS-en die niet
overeenkomen, zal QGIS u daarover waarschuwen. Merk op dat het CRS van invoerlagen wordt weergegeven,
tezamen met de naam, in het dialoogvenster voor de parameters.
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• Als er geen invoerlaag is, zal het het CRS van het project gebruiken, tenzĳ het algoritme een specifiek veld
voor het CRS bevat (zoals gebeurde in de laatste les met het algoritme voor het raster)

Open het project dat correspondeert met dezes les en u zult twee lagen zien, genaamd 23030 en 4326. Zĳ bevatten
beide dezelfde punten, maar zĳn in verschillende CRS-en (EPSG:23030 en EPSG:4326). Zĳ verschĳnen op dezelfde
plaats omdat QGIS direct opnieuw projecteert naar het CRS van het project (EPSG:4326), maar in feite zĳn zĳ niet
dezelfde laag.
Open het algoritme Export/Add geometry columns.

Dit algoritme voegt nieuwe kolommen toe aan de attributentabel van een vectorlaag. De inhoud van de kolommen is
afhankelĳk van het type geometrie van de laag. In het geval van punten, voegt het nieuwe kolommen toe met de X-
en Y-coördinaten van elk punt.
In de lĳst met beschikbare lagen die u kunt vinden in het veld voor de invoerlaag, zult u elk zien met zĳn
overeenkomend CRS. Dat betekent dat, hoewel zĳ op dezelfde plaats in uw kaartvenster verschĳnen, zĳ verschillend
zullen worden behandeld. Selecteer de laag 4326.
De andere parameter van het algoritme maakt het mogelĳk in te stellen hoe het algoritme coördinaten gebruikt om de
nieuwe waarde te berekenen die zal worden toegevoegd aan de resulterende lagen. De meeste algoritmes hebben geen
optie zoals dit, en gebruiken eenvoudigweg direct de coördinaten. Selecteer de laagoptie Layer CRS om de coördinaten
slechts te gebruiken zoals zĳ zĳn. Dit is hoe bĳna alle geo-algoritmes werken.
U zou een nieuwe laag moeten krĳgen met exact dezelfde punten als de andere twee lagen. Als u met rechts klikt op
de naam van de laag en de eigenschappen ervan opent, zult u zien dat het hetzelfde CRS van de invoerlaag deelt, dat
is, EPSG:4326. Wanneer de laag wordt geladen in QGIS, zult u worden gevraagd het CRS van de laag in te voeren,
omdat QGIS daar al van weet.
Als u de attributentabel van de nieuwe laag opent zult u zien dat het nu twee nieuwe velden bevat met de X- en
Y-coördinaten van elk punt.
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Deze waarden voor de coördinaten zĳn in het CRS van de laag, omdat we die optie kozen. Echter, zelfs als u een
andere optie kiest, zou het CRS van de uitvoer van de laag hetzelfde zĳn, omdat het CRS van de invoer is gebruikt
om het CRS van de uitvoerlaag in te stellen. Kiezen van een andere optie zal er voor zorgen dat de waarden anders
zĳn, maar zal het resulterende punt niet wĳzigen of het CRS van de uitvoerlaag te laten verschillen van het CRS van
die van de invoer.
Doe nu dezelfde berekening met behulp van de andere laag. U zou moeten zien dat de resulterende laag op exact
dezelfde plaats is gerenderd als de andere, en het zal het CRS EPSG:23030 hebben, omdat dat die van de invoerlaag
was.
Als u naar de attributentabel ervan gaat, zult u zien dat die anders zĳn dan die uit de eerste laag die we maakten.

Dit komt omdat de originele gegevens anders zĳn (het gebruikt een ander CRS), en deze coördinaten komen daar uit.
Wat zou u hieruit moeten leren?Het belangrĳkste idee achter deze voorbeelden is dat geo-algoritmes de laag gebruiken
zoals die is in zĳn originele gegevensbron, en het opnieuw projecteren dat QGIS zou kunnen doen vóór het renderen
volledig negeert. Met andere woorden, vertrouw niet wat u ziet in uw kaartvenster, maar onthoud dat altĳd de originele
gegevens zullen worden gebruikt. Dat is in dit geval niet zo belangrĳk, omdat we slechts één laag per keer gebruiken,
maar in een algoritme dat ermeerdere nodig heeft (zoals een algoritme om te clippen), zouden lagen die overeenkomen
of over elkaar liggen ver uit elkaar kunnen liggen, omdat ze verschillende CRS-en zouden kunnen hebben.
Algoritmes voeren projecteren niet opnieuw (behalve in het algoritme voor opnieuw projecteren dat we hierna zullen
zien), dus is het aan u om er voor te zorgen dan de lagen overeenkomende CRS-en hebben.
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Een interessante module die werkt met CRS-en is die voor opnieuw projecteren. Het vertegenwoordigt een bĳzonder
geval, omdat het een invoerlaag heeft (die welke opnieuw moet worden geprojecteerd), maar het zal niet het
CRSaarvan gebruiken voor de uitvoer.
Open het algoritme Reproject layer.

Selecteer een van de lagen als invoer, en selecteer EPSG:23029 als het doel-CRS. Voer het algoritme uit en u zult
een nieuwe laag krĳgen die identiek is aan die van de invoer, maar met een ander CRS. Het zal op dezelfde regio
in het kaartvenster verschĳnen, net als de andere, omdat QGIS het direct opnieuw zal projecteren, maar de originele
coördinaten ervan zĳn anders. U kunt dat zien door het algoritme Export/Add geometry columns uit te voeren met
deze nieuwe laag als invoer en verifiëren dat de toegevoegde coördinaten verschillen van die in de attributentabellen
van de beide andere twee lagen die we eerder hadden berekend.

17.7 Selectie

Notitie: In deze les zullen we zien hoe algoritmes van Processing selecties in vectorlagen afhandelen die worden
gebruikt als invoer, en hoe een selectie te maken met behulp van een bepaald type algoritme.

Anders dan in andere plug-ins voor analyse in QGIS, zult u in geo-algoritmes van Processing geen keuzevak “Alleen
geselecteerde objecten gebruiken” of iets dergelĳks vinden. Het gedrag met betrekking tot selecteren is ingesteld voor
de gehele plug-in en al zĳn algoritmes, en niet voor de uitvoering van elk algoritme. Algoritmes volgen de volgende
eenvoudige regels bĳ het gebruiken van een vectorlaag.

• Als de laag een selectie heeft, worden alleen geselecteerde objecten gebruikt.
• Als er geen selectie is worden alle objecten gebruikt.
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Onthoud dat u dit gedrag kunt wĳzigen door de relevante optie te deselecteren in het menu Processing ► Opties ►
Algemeen`.
U kunt dat zelf testen door enkele punten van een van de lagen, die we gebruikten in het laatste hoofdstuk, te selecteren,
en het algoritme voor opnieuw projecteren daarmee uit te voeren. De opnieuw geprojecteerde laag die u zult krĳgen
zal alleen de geselecteerde punten bevatten, tenzĳ er geen selectie was, wat er voor zal zorgen dat de resulterende laag
alle punten uit de originele laag zal bevatten.
U kunt alle beschikbare methoden en gereedschappen in QGIS gebruiken om een selectie te maken. U kunt echter
ook een algoritme gebruiken om dat te doen. Algoritmes voor het maken van een selectie kunnen worden gevonden
in de Toolbox onder Vector/Selection

Open het algoritme Random selection.

Met de standaard waarden zal het 10 punten selecteren uit de huidige laag.
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Het zal u opvallen dat dit algoritme geen uitvoer produceert, maar de invoerlaag aanpast (niet de laag zelf, maar
de selectie ervan). Dit is afwĳkend gedrag, omdat alle andere algoritmes nieuwe lagen zullen produceren en niet de
invoerlagen wĳzigen.
Omdat de selectie geen deel is van de gegevens zelf, maar iets dat alleen bestaat binnen GIS, moeten deze algoritmes
voor selectie alleen worden gebruikt voor het selecteren van een laag die is geopend in QGIS, en niet met de optie
voor het selecteren van een bestand dat u vindt in het overeenkomende vak voor de waarde van de parameter.
De selectie die we zojuist hebben gemaakt, net zoals de meeste andere zoals die worden gemaakt door de rest van de
algoritmes voor selectie, kan ook handmatig vanuit QGIS worden gemaakt, dus u zou zich af kunnen vragen wat het
nut is van het gebruiken van een algoritme daarvoor. Hoewel dat op dit moment misschien niet zinvol lĳkt voor u,
zullen we later zien hoe we modellen en scripts maken. Als u een selectie in het midden van een model wilt maken
(wat een werkstroom voor verwerking definieert), kan alleen een geo-algoritme worden toegevoegd aan een model,
en andere elementen van QGIS en bewerkingen kunnen niet worden toegevoegd. Dat is de reden waarom enkele
algoritmeen voor Processing functionaliteit dupliceren die ook beschiknbaar is in andere elementen van QGIS.
Onthoud op dit moment alleen dat selecties kunnen worden gemaakt met behulp van processing geo-algoritmes voor
Processing, en dat algoritmes alleen de geselecteerde objecten gebruiken als er een selectie aanwezig is, anders worden
alle objecten gebruikt.

17.8 Een extern algoritme uitvoeren

Notitie: In deze les zullen we zien hoe we algoritmes gebruiken die afhankelĳk zĳn van een toepassing van een derde
partĳ, in het bĳzonder SAGA, die één van de belangrĳkste providers van algoritmes is.

Alle algoritmes die we tot dusverre hebben uitgevoerd maken deel uit van het framework Processing. Dat is, zĳ zĳn
eigen algoritmes die zĳn geïmplementeerd in de plug-in en worden uitgevoerd door QGIS net zoals de plug-in zelf
wordt uitgevoerd. Echter, één van de grootste mogelĳkheden van het framework Processing is dat het algoritmes kan
gebruiken van externe toepassingen en de mogelĳkheden van die toepassingen kan uitbreiden. Dergelĳke algoritmes
zĳn verpakt en opgenomen in de Toolbox, zodat u ze eenvoudig vanuit QGIS kunt gebruiken, en gegevens van QGIS
kunt gebruiken om ze uit te voeren.
Sommig algoritmes die u ziet in de vereenvoudigde weergave vereisen dat toepassingen van derde partĳen zĳn
geïnstalleerd op uw systeem. Een provider van algoritmes die speciale aandacht behoeft is SAGA (System for
Automated Geospatial Analysis). Eerst moeten we alles configureren zodat QGIS SAGA op de juiste wĳze kan
aanroepen. Dit is niet moeilĳk, maar het is belangrĳk te weten hoe dit werkt. Elke externe toepassing heeft zĳn
eigen configuratie, en later in deze zelfde handleiding zullen we enkele van de andere bespreken, maar SAGA zal ons
belangrĳkste backend zĳn, dus zullen we dat hier bespreken.
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Als u op Windows werkt, is de beste manier om met externe algoritmes te werken om QGIS te installeren met
behulp van het zelfstandige installatieprogramma. Dat zal zorg dragen voor het installeren van alle benodigde
afhankelĳkheden, inclusief SAGA, dus als u het heeft gebruikt, is er niets anders te doen. U kunt het dialoogvenster
Instellingen openen en naar de groep Providers/SAGA gaan.

Het pad SAGA zou reeds moeten zĳn geconfigureerd en moeten wĳzen naar de map waar SAGA is geïnstalleerd.
Als u QGIS heeft geïnstalleerd zonder het zelfstandige installatieprogramma, dan moet u daar het pad naar uw
installatie van SAGA invoeren (wat u afzonderlĳk zou moeten hebben geïnstalleerd). De vereiste versie is SAGA
2.1 [dit wĳzigt overeenkomstig de uitgaven van SAGA].
Voor het geval u Linux gebruikt hoeft u het pad naar uw installatie van SAGA niet in te stellen in de configuratie
van processing. In plaats daarvan moet u SAGA installeren en er voor zorgen dat de map van SAGA in PATH staat,
zodat het kan worden aangeroepen vanaf de console (open eenvoudigweg een console en typ saga_cmd om het te
controleren). Onder Linux is de doelversie van SAGA ook 2.1, maar in sommige installaties (zoals de OSGeo Live
DVD) heeft u misschien alleen 2.0.8 beschikbaar. er zĳn enkele pakketten voor 2.1 beschikbaar, maar zĳ worden niet
algemeen geïnstalleerd en zouden enkele problemen kunnen hebben, dus als u liever de meer algemene en stabielere
2.0.8 zou willen gebruiken, dan kunt u dat doen door compatibiliteit voor 2.0.8 in te schakelen in het dialoogvenster
voor configuratie, onder de groep SAGA.
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Als SAGA eenmaal is geïnstalleerd, kunt u een algoritme van SAGA starten door dubbel te klikken op de naam ervan,
net als met elk ander algoritme. Omdat we de vereenvoudigde interface gebruiken, weet u niet welke algoritmes zĳn
gebaseerd op SAGA of een andere externe toepassing, maar als dubbelklikt op een er van en de overeenkomende
toepassing is niet geïnstalleerd, zult u iets soortgelĳks als dit zien.

In ons geval, en er van uit gaande dat SAGA juist is geïnstalleerd en geconfigureerd, zou u dit venster niet zien, en u
zou in plaats daarvan naar het dialoogvenster voor de parameters gaan.
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Laten we het eens proberen met een algoritme dat is gebaseerd op SAGA, dat welke is genaamd Split shapes layer
randomly.

Gebruik de puntenlaag in het project dat bedoeld is voor deze les als invoer, en de standaard waarden voor de
parameters, en u zult iets zoals dit krĳgen (de splitsing is willekeurig, dus uw resultaat zou anders kunnen zĳn).

De invoerlaag is gesplitst in twee lagen, elk met hetzelfde aantal punten. Dit resultaat is berekend door SAGA, en
later overgenomen door QGIS en toegevoegd aan het project van QGIS.
Als alles goed gaat zult u geen verschil merken tussen dit op SAGA gebaseerde algoritme en een van de andere die we
eerder uitgevoerd hebben. Echter, SAGA zou, om enige reden, niet in staat kunnen zĳn een resultaat te produceren
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en niet het bestand genereren dat QGIS verwacht. In dat geval zullen er problemen zĳn om het resultaat toe te voegen
aan het project van QGIS, en een foutbericht zoals dit zal worden weergegeven.

Dit soort problemen zouden kunnen voorkomen, zelfs als SAGA (of enige andere toepassing die we aanroepen vanuit
het framework Processing) correct is geïnstalleerd, en het is belangrĳk te weten hoe dit af te handelen. Laten we eens
een van deze foutberichten produceren.
Open het algoritme Create graticule en gebruik de volgende waarden.
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We gebruiken waarden voor breedte en hoogte die groter zĳn dan het gespecificeerde bereik, dus kan SAGA
geen uitvoer produceren. Met andere woorden, de waarden van de parameters zĳn verkeerd, maar zĳ worden niet
gecontroleerd totdat SAGA ze krĳgt en probeert het raster te maken. Omdat het het niet kan maken, zal het niet de
verwachte laag produceren, en u zult het foutbericht dat hierboven wordt weergegeven zien.

Notitie: In SAGA >= 2.2.3 zal de opdracht automatisch verkeerde gegevens voor invoer aanpassen, zodat u geen
fout krĳgt. Gebruik negatieve waarden voor delen om een fout uit te lokken.

Het begrĳpen van dit soort problemen zal u helpen ze op te lossen en een verklaring te vinden voor wat er gebeurt.
Zoals u in het foutbericht kunt zien wordt een test uitgevoerd om te controleren of de verbinding met SAGA correct
werkt, wat voor u een indicatie zou kunnen zĳn dat er een probleem zou kunnen zĳn in hoe het algoritme werd
uitgevoerd. Dit is niet alleen van toepassing op SAGA, maar ook op andere externe toepassingen.
In de volgende les zullen we het log van de verwerking introduceren, waar informatie over opdrachten, uitgevoerd
door geo-algoritmes, wordt bĳgehouden, en u zult zien hoe u meer details verkrĳgt als problemen zoals deze optreden.
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17.9 Het log van de verwerking

Notitie: Deze les beschrĳft het log van de verwerking.

Alle analyses die worden uitgevoerd met het framework Processing wordt gelogd in zĳn het systeem voor loggen in
QGIS. Dit stelt u in staat meer te weten te komen over wat er met de gereedschappen voor Processing is gedaan, om
problemen op te lossen als zĳ voorkomen, en ook om eerder uitgevoerde bewerkingen opnieuw uit te voeren, omdat
het systeem voor loggen ook enige interactiviteit implementeert.
Klik op de ballon rechtsonder op de statusbalk van QGIS om het log te openen. Sommige algoritmes zouden hier
informatie achter kunnen laten over hun uitvoering. Bĳvoorbeeld: die algoritmes die een externe toepassing aanroepen
loggen gewoonlĳk de uitvoer van de console van die toepassing in dit item. Als u er naar kĳkt zult u zien dat de uitvoer
van het algoritme van SAGA dat we zojuist hebben uitgevoerd (en die mislukte omdat de gegevens voor de invoer
niet juist waren) hier is opgeslagen.
Dit is behulpzaam om te begrĳpen wat er aan de hand is. Gevorderde gebruikers zullen in staat zĳn die uitvoer te
analyseren om uit te zoeken waarom het algoritme faalde. Als u geen gevorderde gebruiker bent, zal dit bruikbaar
zĳn om anderen u te laten helpen het probleem dat u heeft te diagnosticeren, wat een probleem zou kunnen zĳn in de
installatie van de externe software of een probleem met de gegevens die u verschafte.
Zelfs als het algoritme zou kunnen worden uitgevoerd, zouden sommige algoritmes waarschuwingen achter kunnen
laten in het geval dat het resultaat niet juist zou kunnen zĳn. Bĳvoorbeeld bĳ het uitvoeren van een algoritme voor
interpolatie met een zeer klein aantal punten, het algoritme kan worden uitgevoerd en zal een resultaat produceren,
maar het is aannemelĳk dat het niet juist zal zĳn, omdat meer punten zouden moeten worden gebruikt. Het is een
goed idee om regelmatig op dit type waarschuwingen te controleren als u niet zeker bent van bepaalde aspecten van
een bepaald algoritme.
In het menu Processing ► Geschiedenis…, vindt u algoritmes die zĳn uitgevoerd, ongeacht of zĳ worden uitgevoerd
vanuit de GUI of vanuit de console (wat later in deze handleiding zal worden uitgelegd). De uitvoering wordt in dit
dialoogvenster opgeslagen als een aanroep van de console. Dat betekent dat elke keer dat u een algoritme uitvoert,
een opdracht voor de console wordt toegevoegd aan het log, en u een volledige geschiedenis heeft van uw werksessie.
Hier is hoe die geschiedenis er uit ziet:
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Dit kan erg bruikbaar zĳn bĳ het beginnen te werken met de console, om te leren over de syntaxis van algoritmes.
We zullen het gebruiken wanneer we bespreken hoe opdrachten voor analyses vanuit de console uit te voeren.

17.9.1 ��� Volgen

De geschiedenis is ook interactief, en u kunt elk eerder algoritme uitvoeren door eenvoudigweg op het item ervan te
dubbelklikken. Dit is een eenvoudige manier voor het herhalen van werk dat we al eerder gedaan hebben.
Probeer bĳvoorbeeld het volgende:

1. Open de gegevens die corresponderenmet het eerste hoofdstuk van deze handleiding en voer het daar uitgelegde
algoritme uit.

2. Ga dan naar het dialoogvenster Geschiedenis en zoek naar het laatste algoritme in de lĳst, dat correspondeert
met het algoritme dat u zojuist hebt uitgevoerd.

3. Dubbelklik erop en een nieuw resultaat zou moeten worden geproduceerd, net zoals wanneer u het in het
normale dialoogvenster gebruikt en aanroept vanuit de Toolbox.

560 Hoofdstuk 17. De QGIS-gids voor Processing



QGIS Training Manual

17.9.2 ��� Volgen

U kunt het algoritme ook aanpassen.
1. Kopieer de aanroep van het algoritme
2. Open de Plug-ins ► Python Console

3. Plak uw kopie om de analyse uit te voeren; wĳzig de parameters zoals u dat wilt.
4. U zou, om het resulterende bestand weer te geven, processing.run in de geplakte opdracht willen

vervangen door processing.runAndLoadResults.

17.10 De Raster calculator. Waarden Geen gegevens

Notitie: In deze les zullen we zien hoe we de Raster calculator gebruiken om enkele bewerkingen op rasterlagen uit
te voeren. We zullen ook uitleggen wat waarden Geen gegevens zĳn en hoe de berekeningen en andere algoritmes die
behandelen

De Raster calculator is een van de meest krachtige algoritmes die u zult tegenkomen. Het is een enorm flexibel en
veelzĳdig algoritme dat voor veel verschillende berekeningen kan worden gebruikt, en een dat snel een belangrĳk
deel van uw gereedschapskist zal zĳn.
In deze les zullen we enkele berekeningen met Raster calculator uitvoeren, de meeste daarvan redelĳk eenvoudig.
Dat zal ons laten zien hoe het wordt gebruikt en hoe het enkele bĳzondere situaties behandelt die het zou kunnen
tegenkomen. Dat begrĳpen is belangrĳk om later de verwachte resultaten te krĳgen bĳ het gebruiken van Raster
calculator, en ook om bepaalde technieken te begrĳpen die er algemeen mee toegepast worden.
Open het project voor QGIS voor deze les en u zult zien dat het verschillende rasterlagen bevat.
Open nu de Toolbox en open het dialoogvenster dat correspondeert met de Raster calculator.
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Notitie: De interface is anders in recente versies.

Het dialoogvenster bevat 2 parameters.
• De voor de analyse te gebruiken lagen. Dit is een meervoudige invoer, wat betekent dat u zoveel lagen kunt
selecteren als u wilt. Klik op de knop aan de rechterkant en selecteer dan de lagen die u wilt gebruiken in het
dialoogvenster dat verschĳnt.

• De toe te passen formule. De formule gebruikt de lagen die zĳn geselecteerd in de parameter hierboven, die
worden vermeld met letters uit het alfabet (a, b, c...) of g1, g2, g3... als namen voor variabelen.
Dat is, de formule a + 2 * b is hetzelfde als g1 + 2 * g2 en zal de som van de waarde in de eerste laag
plus twee keer de waarde van de tweede laag berekenen. De volgorde van de lagen is dezelfde volgorde als die
welke u ziet in het dialoogvenster voor de selectie.

Waarschuwing: De calculator is hoofdlettergevoelig.

We zullen, om mee te beginnen, de eenheden van de DEM wĳzigen van meters naar voet. De formule die we nodig
hebben is de volgende:

h' = h * 3.28084

Selecteer de DEM in het veld voor de lagen en typ a * 3.28084 in het veld voor de formule.

Waarschuwing: Voor niet Engelse gebruikers: gebruik altĳd “.”, niet “,”.

Klik op Run om het algoritme uit te voeren. U zult een laag krĳgen die er hetzelfde uitziet als de invoerlaag, maar met
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andere waarden. De invoerlaag die we gebruikten had geldige waarden in al zĳn cellen, dus heeft de laatste parameter
in het geheel geen effect.
Laten we nu een andere berekening uitvoeren, deze keer op de laag accflow. Deze laag bevat waarden van een
geaccumuleerde stroom, een hydrologische parameter. Het bevat alleen die waarden binnen het gebied van een
bepaalde waterkering, zonder waarden geen gegevens daarbuiten. Zoals u kunt zien, is het renderen niet erg
informatief, vanwege de manier waarop de waarden zĳn verdeeld. Gebruiken van de logaritme van die accumulatie
van die stroom zal een veel meer informatieve weergave opleveren. We kunnen die berekenen met behulp van de
Raster calculator.
Open opnieuw het dialoogvenster voor het algoritme, selecteer de laag accflow als de enige laag voor de invoer, en
voer de volgende formule in: log(a).
Hier is de laag die u zult krĳgen.

Als u het gereedschap Object identificeren selecteert om de waarde van een laag op een bepaald punt te weten te
komen, selecteer de laag die we zojuist hebben gemaakt en klik op een punt buiten het bassin, u zult zien dat het een
waarde Geen gegevens bevat.
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Voor de volgende oefening gaan we twee lagen gebruiken in plaats van een, en we zullen een DEM gaan krĳgen
met alleen geldige waarden binnen het bassin, gedefinieerd in de tweede laag. Open het dialoogvenster voor de
calculator en selecteer beide lagen van het project in het veld voor de invoerlagen. Voer de volgende formule in
het corresponderende veld in:

a/a * b

a verwĳst naar de laag met de geaccumuleerde stroom (omdat het de eerste in de lĳst is) en b verwĳst naar de DEM.
Wat we hier in het eerste deel van de formule gaan doen is de laag met de geaccumuleerde stroom delen door zichzelf,
wat zal resulteren in een waarde 1 binnen het bassin, en een waarde Geen gegevens daarbuiten. Dan vermenigvuldigen
we met de DEM, om de hoogtewaarden in de cellen binnen het bassin te krĳgen (DEM * 1 = DEM) en de waarden
Geen gegevens daarbuiten (DEM * no_data = no_data)
Hier is de resulterende laag.

Deze techniek wordt regelmatig gebruikt om waarden in een rasterlaag te maskeren, en is bruikbaar wanneer u
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berekeningen uit wilt voeren op een andere regio dan de willekeurige rechthoekige regio die wordt gebruikt door
de rasterlaag. Een hoogte-histogram bĳvoorbeeld van een rasterlaag heeft weinig betekenis. Als het echter berekend
met alleen de waarden die overeenkomen met een bassin (zoals in het bovenstaande geval), is het resultaat dat we
verkrĳgen een betekenisvolle die in feite informatie geeft over de configuratie van het bassin.
Los van de waarden Geen gegevens en hoe zĳ worden afgehandeld zĳn er andere interessante dingen met betrekking
tot dit algoritme dat we zojuist hebben uitgevoerd. Als u eens kĳkt naar de bereiken van de lagen die we hebben
vermenigvuldigd (u kunt dat doen door te dubbelklikken op de naam van de laag in de inhoudsopgave en hun
eigenschappen bekĳken), zult u zien dat zĳ niet hetzelfde zĳn, omdat het bereik dat wordt bedekt door de laag van
de geaccumuleerde stroom kleiner is dan het bereik van de volledige DEM.
Dat betekent dat deze lagen niet overeenkomen, en dat zĳ niet direct kunnen worden vermenigvuldigd zonder die
grootten en bereiken te homogeniseren door één of beide lagen te resamplen. Wĳ deden echter helemaal niets.
QGIS handelt deze situatie af en resampled automatisch invoerlagen als dat nodig is. Het bereik van de uitvoer is het
minimale bedekte bereik dat wordt berekend vanuit de invoerlagen, en de minimale celgrootte van hun celgrootten.
In dit geval (en in de meeste gevallen), produceert dit de gewenste resultaten, maar u zou zich altĳd bewust moeten
zĳn van de aanvullende bewerkingen die plaatsvinden, omdat zĳ het resultaat zouden kunnen beïnvloeden. In gevallen
wanneer dit gedrag niet gewenst is, zou van tevoren handmatig moeten worden geresampled. In latere hoofdstukken
zullen we meer zien over het gedrag van algoritmes indien gebruikt met meerdere rasterlagen.
Laten we deze les afsluiten met een andere oefening in maskeren. We gaan de helling berekenen voor alle gebieden
met een hoogte tussen 1000 en 1500 meter.
In dit geval hebben we geen laag die we als masker kunnen gebruiken, maar die kunnen we maken met behulp van
de calculator.
Voer de calculator uit met behulp van de DEM als enige invoerlaag en de volgende formule

ifelse(abs(a-1250) < 250, 1, 0/0)

Zoals u kunt zien gebruiken we de calculator niet alleen om eenvoudige algebraïsche bewerkingen uit te voeren, maar
ook om meer complexe berekeningen uit te voeren die voorwaardelĳke zinnen in zich hebben, zoals die hierboven.
Het resultaat heeft een waarde van 1 binnen het bereik waarmee we willen werken, en Geen gegevens in cellen
daarbuiten.

De waarde geen gegevens komt uit de uitdrukking 0/0. Omdat dat een onbepaalde waarde is, zal SAGA een waarde
NaN (Not a Number) toevoegen, die in feite wordt behandeld als een waarde Geen gegevens. Met deze kleine truc
kunt u een waarde Geen gegevens instellen, zonder dat u hoeft te weten wat de waarde geen gegevens van de cel is.
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Nu hoeft u het nog slechts te vermenigvuldigen met de laag van de helling die is opgenomen in het project, en zult u
het gewenste resultaat verkrĳgen.
Dit kan allemaal worden gedaan in één enkele bewerking met de calculator. We laten dat als een oefening voor de
lezer.

17.11 Vectorcalculator

Notitie: In deze les zullen we zien hoe we nieuwe attributen toevoegen aan een vectorlaag, gebaseerd op een
rekenkundige uitdrukking, met behulp van de vectorcalculator.

We weten al hoe we de raster calculator moeten gebruiken om nieuwe lagen te maken met behulp van rekenkundige
uitdrukkingen. Een soortgelĳk algoritme is beschikbaar voor vectorlagen, en genereert een nieuwe laag met dezelfde
attributen van de invoerlaag, plus een aanvullende met het resultaat van de ingevoerde uitdrukking. Het algoritme
heet Veld calculator en heeft het volgende dialoogvenster voor parameters.

Notitie: In nieuwere versies van Processing is de interface aanzienlĳk gewĳzigd, hĳ is krachtiger en eenvoudiger te
gebruiken.

Hier zĳn enkele voorbeelden van het gebruik van dat algoritme.
Laten we eerst de bevolkingsdichtheid berekenen van blanke mensen in elke polygoon, wat een census weergeeft. We
hebben twee velden in de attributentabel die we daarvoor kunnen gebruiken, namelĳk WHITE en SHAPE_AREA.
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Wemoeten ze alleen delen en vermenigvuldigen met 1 miljoen (om de dichtheid per vierkante km te verkrĳgen), dus
we kunnen de volgende formule in het overeenkomstige veld gebruiken

( "WHITE" / "SHAPE_AREA" ) * 1000000

Het dialoogvenster voor de parameters zou moeten worden gevuld zoals hieronder weergegeven.

Dit zal een nieuw veld genereren, genaamd WHITE_DENS
Laten we nu de ratio berekenen tussen de velden MALES en FEMALES om een nieuw veld te maken dat aangeeft of
de mannelĳk bevolking numeriek domineert boven de vrouwelĳke bevolking.
Voer de volgende formule in

"MALES" / "FEMALES"

Deze keer zou het venster met de parameters er zo uit moeten zien voordat op de knop OK wordt gedrukt.
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In een eerdere versie zou, omdat beide velden van het type integer zĳn, het resultaat worden afgebroken tot een integer.
In dit geval zou de formule : 1.0 * "MALES" / "FEMALES" moeten zĳn, om aan te geven dat we een getal
floating point als resultaat willen hebben.
We kunnen voorwaardelĳke functies gebruiken om een nieuw veld met tekststrings male of female te krĳgen in
plaats van de waarden voor de ratio, met behulp van de volgende formule:

CASE WHEN "MALES" > "FEMALES" THEN 'male' ELSE 'female' END

Het venster voor de parameters zou er zo uit moeten zien.
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Een Python veldcalculator is beschikbaar in de “Advanced Python field calculator”, waarover we hier niet in detail
treden
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17.12 Bereiken definiëren

Notitie: In deze les zullen we zien hoe we bereiken definiëren, die bĳ sommige algoritmes nodig zĳn, in het bĳzonder
voor rasters.

Sommige algoritmes vereisen een bereik om het gebied te definiëren dat moet worden bedekt door de analyse die zĳ
uitvoeren, en gewoonlĳk ook om het bereik van de resulterende laag te definiëren.
Wanneer een bereik wordt vereist, kan het handmatig gedefinieerd worden door de vier waarden die het definieert
in te voeren (min X, min Y, max X, max Y), maar er zĳn ook meer praktische en interessantere manieren om dat te
doen. We zullen ze allemaal zien in deze les.
Laten we eerst een algoritme openen dat vereist dat een bereik wordt gedefinieerd. Open het algoritme Rasterize, wat
een rasterlaag uit een vectorlaag maakt.
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Alle parameters, met uitzondering van de laatste twee, worden gebruikt om te definiëren welke laag moet worden
omgezet naar een raster, en configureren hoe het proces van het omzetten naar raster zou moeten werken. De twee
laatste parameters, aan de andere kant, definiëren de karakteristieken voor de uitvoerlaag. Dat betekent dat zĳ het
gebied definiëren dat wordt bedekt (wat niet noodzakelĳkerwĳze hetzelfde gebied is als dat wat wordt bedekt door
de invoerlaag), en de resolutie/celgrootte (die niet kan worden afgeleid vanuit de vectorlaag, omdat vectorlagen geen
celgrootten hebben).
Het eerste dat u kunt doen is de 4 waarden voor de definitie, zoals hierboven besproken, in te typen, gescheiden door
komma’s.

Dat behoeft geen nadere extra uitleg. Hoewel dit de meest flexibele optie is, is het in sommige gevallen ook minder
praktisch, en dat is waarom ander opties werden geïmplementeerd. U moet op de knop aan de rechterkant van het
tekstvak voor het bereik klikken om daar toegang toe te krĳgen.

Laten we eens kĳken wat elk ervan doet.
De eerste optie is Use layer/canvas extent, wat het dialoogvenster voor selectie zal weergeven dat hieronder staat.
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Hier kunt u het bereik voor het kaartvenster selecteren (het bereik dat wordt bedekt door de huidige zoom), of het
bereik van elk van de beschikbare lagen. Selecteer het en klik op OK, en het tekstvak zal automatisch worden gevuld
met de overeenkomende waarden.
De tweede optie is Select extent on canvas. In dit geval verdwĳnt het dialoogvenster van het algoritme en kunt u in het
kaartvenster van QGIS klikken en slepen om het gewenste bereik te definiëren.

Als u de muisknop weer loslaat zal het dialoogvenster weer verschĳnen en zal het tekstvak al de waarden bevatten die
overeenkomen met het gedefinieerde bereik.
De laatste optie is Use min covering extent from input layers, wat de standaard optie is. Dit zal de minimale bedekte
bereik berekenen van alle lagen die gebruikt zullen worden om het algoritme uit te voeren, en er is geen reden om enige
waarde in het tekstvak in te voeren. In het geval van één enkele invoerlaag, zoals in het algoritme dat we uitvoeren,
kan hetzelfde bereik worden verkregen door diezelfde invoerlaag te selecteren in Use layer/canvas extent die we al
eerder zagen. Echter, wanneer er verscheidene invoerlagen zĳn, correspondeert het minimale bedekte bereik niet met
enig bereik van de invoerlaag, omdat het uit alle tezamen wordt berekend.
We zullen deze laatste methode gebruiken om ons algoritme voor het omzetten naar raster uit te voeren.
Vul het dialoogvenster voor de parameters zoals hieronder weergegeven en druk op OK.
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Notitie: In dit geval is het beter een Integer (1 byte) te gebruiken in plaats van een Floating point (4 byte), omdat
de NAME een integer is met de maximale waarde=64. Dit zal resulteren in een kleinere bestandsgrootte en snellere
berekeningen.

U zult een rasterlaag verkrĳgen die exact het gebied bedekt dat wordt bedekt door de originele vectorlaag.
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In sommige gevallen zou de laatste optie, Use min covering extent from input layers, niet beschikbaar kunnen zĳn. Dit
zal gebeuren bĳ die algoritmes die geen invoerlagen hebben, maar slechts parameters van andere typen. In dat geval
zult u de waarde handmatig moeten invoeren of een van de andere opties gebruiken.
Onthoud dat, wanneer een selectie bestaat, het bereik van de laag dat van de gehele verzameling objecten is, en de
selectie wordt niet gebruikt voor de berekening van het bereik, zelfs hoewel het rasteriseren werd uitgevoerd op alleen
de geselecteerde items. In dat geval wilt u misschien een nieuwe laag maken van de selectie, en die dan gebruiken als
invoer.

17.13 HTML-uitvoer

Notitie: In deze les leren we hoe QGIS uitvoer in de indeling HTML afhandelt, die wordt gebruikt om uitvoer als
tekst en afbeeldingen te produceren.

Alle uitvoer die we tot dusverre hebben geproduceerd waren lagen (zowel raster als vector). Echter, sommige
algoritmes genereren uitvoer in de vorm van tekst en afbeeldingen. Al deze uitvoer wordt verpakt in in HTML-
bestanden en weergegeven in het zogenaamde venster Resultaten, wat een ander element is van het framework
Processing.
Laten we eens naar één van die algoritmes kĳken om te begrĳpen hoe die werken.
Open het project met de gegevens die in de les moeten worden gebruikt en open dan het algoritme Basic statistics for
numeric fields.
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Het algoritme is nogal eenvoudig, en u hoeft slechts de laag te selecteren die moet worden gebruikt en één veld daarvan
(een numeriek veld). De uitvoer is van het type HTML, maar het overeenkomstige vak werkt exact zoals dat wat u
zult vinden in het geval van een uitvoer als raster of vector. U kunt ofwel een bestandspad invoeren of het leeg laten
om naar een tĳdelĳk bestand op te slaan. In dit geval, zĳn echter alleen de extensies html en htm toegestaan, dus is
er geen manier om de indeling van de uitvoer te wĳzigen door een andere te gebruiken.
Voer het algoritme uit door de enige laag in het project als invoer te selecteren, en het veld POP2000, en een nieuw
dialoogvenster zoals dat wat hieronder wordt weergegeven zal verschĳnen zodra het algoritme is uitgevoerd en het
dialoogvenster voor de parameters wordt gesloten.
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Dit is het venster Resultaten. Het bevat alle HTML-resultaten die zĳn gegenereerd gedurende de huidige sessie,
eenvoudig toegankelĳk, dus u kunt ze snel controleren wanneer u ze maar nodig heeft. Net zoals met lagen, als u de
uitvoer hebt opgeslagen naar een tĳdelĳk bestand, zal het worden verwĳderd als u QGIS afsluit. Als u hebt opgeslagen
naar een niet tĳdelĳk pad, wordt het bestand behouden, maar het zal niet verschĳnen in het venster Resultaten als u
de volgende keer QGIS opent.
Sommige algoritmes genereren tekst die niet kan worden opgedeeld in meer gedetailleerde uitvoer. Dat is het geval
als, bĳvoorbeeld, het algoritme de tekstuitvoer vastlegt vanuit een extern proces. In andere gevallen wordt de uitvoer
gepresenteerd als tekst, maar wordt intern opgedeeld in verscheidene kleinere uitvoeren, gewoonlĳk in de vorm van
numerieke waarden. Het algoritme dat we zojuist hebben uitgevoerd is er daar één van. Elk van deze waarden wordt
afgehandeld als één enkele uitvoer, en opgeslagen in een variabele. Dit heeft op dit moment geen enkel belang, maar
als we eenmaal doorgaan naar Modelontwerper, zult u zien dat het ons zal toestaan die waarden te gebruiken als
numerieke invoer voor andere algoritmes.
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17.14 Eerste voorbeeld analyse

Notitie: In deze les zullen we enkele echte analyses uitvoeren met behulp van alleen de Toolbox, zodat u meer bekend
raakt met de elementen van het framework Processing.

Nu alles is geconfigureerd en we externe algoritmes kunnen gebruiken, hebben we een zeer krachtig gereedschap om
ruimtelĳke analyses uit te voeren. Het is tĳd om een wat grotere oefening met gegevens uit de echte wereld uit te
werken.
We zullen de welbekende gegevensset gebruiken die John Snow gebruikte in zĳn baanbrekende werk in 1854 (https:
//en.wikipedia.org/wiki/John_Snow_%28physician%29), en we zullen enkele interessante resultaten verkrĳgen. De
analyse van deze gegevensset is redelĳk helder en er is geen noodzaak voor ingewikkelde GIS-technieken om te
eindigen met goede resultaten en conclusies, maar het is een goede manier om weer te geven hoe deze ruimtelĳke
problemen kunnen worden geanalyseerd en opgelost door verschillende gereedschappen van Processing.
De gegevensset bevat shapefiles met choleradoden en pomplocaties, en een OSM gerenderde kaart in de indeling
TIFF. Open het overeenkomstige project van QGIS voor deze les.

Het eerste dat moet worden gedaan is het Voronoi-diagram berekenen (ook bekend als. Thiessen polygonen) van de
laag Pumps, om de zone van invloed voor elke pomp te verkrĳgen. Het algoritme Voronoi Diagram kan daarvoor
worden gebruikt.
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Redelĳk eenvoudig, maar het geeft ons al interessante informatie.
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Duidelĳk, de meeste gevallen liggen binnen een van de polygonen
We kunnen het aantal doden in elk polygoon tellen om een meer kwantitatief resultaat te verkrĳgen,. omdat elk
punt een gebouw weergeeft waar doden vielen, en het aantal doden is opgeslagen in een attribuut, kunnen we niet
eenvoudigweg de punten tellen. We hebben een gewogen telling nodig, dus zullen we het gereedschap Count points in
polygon (weighted) gebruiken.

17.14. Eerste voorbeeld analyse 579



QGIS Training Manual

Het nieuwe veld zal DEATHS worden genoemd, en we gebruiken het veld COUNT als het te wegen veld. De
resulterende tabel geeft duidelĳk aan dat het aantal doden in de polygoon die overeenkomt met de eerste pomp
veel groter is dan in de andere.
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Een andere goede manier om de afhankelĳkheid van elk punt op de laag Cholera_deaths te visualiseren met een
punt in de laag Pumps is om een lĳn te tekenen naar het dichtstbĳzĳnde. Dit kan worden gedaan met het gereedschap
Distance to nearest hub, en de hieronder getoonde configuratie te gebruiken.
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Het resultaat ziet er uit als dit:
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Hoewel het aantal lĳnen groter is in het geval van de centrale pomp, vergeet niet dat dit niet het aantal doden weergeeft,
maar het aantal locaties waar choleragevallen werden aangetroffen. Het is een representatieve parameter, maar het
houdt geen rekening met het feit dat sommige locaties meer gevallen zouden kunnen hebben dan andere.
Een laag voor dichtheid zal ons ook een zeer helder beeld geven van wat er gebeurt. We kunnen die maken met het
algoritme Kernel density. Door de laag Cholera_deaths te gebruiken, het veld COUNT daarvan als veld om te wegen,
met een straal van 100, het bereik en de celgrootte van de rasterlaag Streets, krĳgen we zoiets als dit.
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Onthoud dat, om het bereik voor uitvoer te krĳgen, u die niet hoeft in te voeren. Klik op de knop aan de rechterkant
en selecteer Use layer/canvas extent.
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Selecteer de rasterlaag Streets en het bereik daarvan zal automatisch worden toegevoegd aan het tekstveld. U moet
hetzelfde doen voor de celgrootte, door ook de celgrootte van die laag te selecteren.
Door dit te combineren met de laag Pumps, zien we dat er slechts één pomp duidelĳk in de hotspot ligt waar de
maximale dichtheid van dodelĳke gevallen is gevonden.

17.15 Rasterlagen clippen en samenvoegen

Notitie: In deze les zullen we een ander voorbeeld van ruimtelĳke voorbereiding zien, om het gebruiken van geo-
algoritmes in scenario’s van de echte wereld te vervolgen.

Voor deze les gaan we een hellingslaag berekenen voor een gebied dat een stedelĳk gebied omsluit, wat is opgegeven
in een vectorlaag met één enkele polygoon. De basis DEM is opgedeeld in twee rasterlagen die, tezamen, een veel
groter gebied bedekken dan dat rondom de stad waarmee we willen werken. Als u het project opent dat overeenkomt
met deze les, zult u iets zoals dit zien.
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Deze lagen hebben twee problemen:
• Zĳ bedekken een gebied dat veel te groot is voor wat we willen (we zĳn geïnteresseerd in een kleinere regio
rondom het centrum van de stad)

• Zĳ staan in twee verschillende bestanden (de stadsgrenzen vallen precies binnen één enkele rasterlaag, maar,
zoals gezegd, we willen er wat extra gebied rondom bĳ).

Beide zĳn eenvoudig op te lossen met behulp van de toepasselĳke geo-algoritmes.
Eerst willen we een rechthoek maken die het gebied definieert dat we willen. We maken, om dit te doen, een laag
die het begrenzingsvak van de laag met de grenzen van het stedelĳk gebied bevat, en dan bufferen we die, om een
rasterlaag te verkrĳgen die iets meer bedekt dan strikt noodzakelĳk.
We kunnen het algoritme Polygon from layer extent gebruiken om het begrenzingsvak te berekenen.
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We gebruiken het algoritme Fixed distance buffer, met de volgende waarden voor de parameters om het te bufferen.
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Waarschuwing: Syntaxis is in recente versies gewĳzigd; stel zowel Afstand als Boogpunt in op .25

Hier is het resulterende begrenzingsvak dat is verkregen met behulp van de hierboven weergegeven parameters

Het is een afgerond vak, maar we kunnen eenvoudig het equivalente vak met vierkante hoeken verkrĳgen door het
algoritme Polygon from layer extent er op uit te voeren. We zouden eerst de stadsgrenzen hebben kunnen bufferen,
en dan de rechthoek van het bereik berekenen, wat ons één stap bespaart.

Het zal u opvallen dat de rasters een verschillende projectie dan de vector hebben. We zouden ze daarom opnieuw
moeten projecteren, met behulp van het gereedschapWarp (Herprojecteren), voordat we verder gaan.
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Notitie: Recente versies hebben een meer complexe interface. Zorg er voor dat tenminste één methode voor
compressie is geselecteerd.

Met deze laag, die het begrenzingsvak bevat van de rasterlaag die we willen verkrĳgen, kunnen we beide rasterlagen
bĳsnĳden, met behulp van het algoritme Clip raster with polygons.
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Als de lagen eenmaal zĳn bĳgesneden, kunnen zĳ worden samengevoegd met behulp van het algoritme van SAGA
Mosaic raster layers.
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Notitie: Ukunt tĳd besparen door eerst samen te voegen en dan bĳ te snĳden, en u zult voorkomen dat u het algoritme
voor clippen tweemaal moet aanroepen. Als er echter meerdere lagen zĳn die moeten worden samengevoegd en zĳ
zĳn van een nogal aanzienlĳke grootte, dan zult u eindigenmet een grote laag die later misschienmoeilĳk te verwerken
is. In dat geval dient u misschien het algoritme voor clippen meerder malen aan te roepen, wat tĳd zou kunnen vergen,
maar maak u geen zorgen, we zullen snel zien dat er enkele aanvullende gereedschappen zĳn om die bewerking te
automatiseren. In dit voorbeeld hebben we slechts twee lagen, dus u zou zich daar nu geen zorgen over moeten maken.

Daarmee krĳgen we de uiteindelĳke DEM die we willen.
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Nu is het tĳd om de hellingslaag te berekenen.
Een hellingslaag kan worden berekendmet het algoritme Slope, Aspect, Curvature, maar de in de laatste stap verkregen
DEM is niet geschikt als invoer, omdat de waarden voor de hoogte in meters zĳn, maar de celgrootte is niet uitgedrukt
in meters (de laag gebruikt een CRS met geografische coördinaten). Opnieuw projecteren is nodig. Het algoritme
Warp (herprojecteren) kan opnieuw worden gebruikt om een rasterlaag opnieuw te projecteren. We projecteren
opnieuw naar een CRS met meters als eenheden (bĳv. 3857), zodat we daarna de helling correct kunen berekenen,
met ofwel SAGA of GDAL.
Met de nieuwe DEM kan de helling nu worden berekend.
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En hier is de uiteindelĳke hellingslaag.

17.15. Rasterlagen clippen en samenvoegen 593



QGIS Training Manual

De door het algoritme Slope, Aspect, Curvature geproduceerde helling kan worden uitgedrukt in graden of radialen,
maar graden zĳn eenmeer praktische en algemenere eenheid. In het geval u het berekende in radialen zal het algoritme
Metric conversions zal ons helpen de conversie uit te voeren (maar voor het geval u niet wist dat dat algoritme bestond,
kunt u de Raster calculator gebruiken die we al eerder hebben gebruikt).
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We krĳgen de uiteindelĳke laag die we willen door de geconverteerde hellingslaag opnieuw terug te projecteren met
Reproject raster layer.

Waarschuwing: todo: Afbeelding toevoegen

De processen voor opnieuw projecteren zouden er voor hebben kunnen zorgen dat de uiteindelĳke laag gegevens bevat
die buiten het begrenzingsvak liggen dat we in een van de eerste stappen hebben berekend. Dit kan worden opgelost
door het opnieuw te clippen, zoals we hebben gedaan om de basis DEM te krĳgen.

17.16 Hydrologische analyse

Notitie: In deze les zullen we een hydrologische analyse uitvoeren. Deze analyse zal worden gebruikt in enkele van
de volgende lessen, omdat het bestaat uit een goed voorbeeld van een werkstroom voor een analyse, en we het zullen
gebruiken voor het demonstreren van enkele geavanceerde mogelĳkheden.

Doelen: Beginnend met een DEM, zullen we een netwerk van kanalen gaan uitnemen, waterbergingen uittekenen en
enkele statistieken berekenen.

1. Het eerste is om het project te laden met de gegevens voor de les, wat slechts een DEM bevat.
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2. De eerste module die moet worden uitgevoerd is Catchment area (in sommige versies van SAGA wordt hĳ
Flow accumulation (Top Down) genoemd). U kunt elk van de andere, genaamd Catchment area, gebruiken. Zĳ
hebben verschillende onderliggende algoritmes, maar de resultaten zĳn in de basis hetzelfde.

3. Selecteer de DEM in het veld Elevation, en laat de rest van de parameters staan op de standaardwaarden.
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Sommige algoritmes berekenen vele lagen, maar de laag Catchment Area is de enige die we zullen gebruiken.
U kunt de andere verwĳderen als u dat wilt.
Het renderen van de laag is niet erg informatief.
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U kunt, om te weten waarom, naar het histogram kĳken en u zult zien dat de waarden niet evenredig zĳn
verdeeld (er zĳn enkele cellen met een zeer hoge waarde, die welke overeenkomen met het netwerk van
kanalen). Gebruik het algoritme Raster calculator om de logaritme te berekenen van de waarde van het
opvanggebied en u zult een laag met veel mer informatie krĳgen.
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4. Het opvanggebied (ook bekend als flow accumulation), kan worden gebruikt om een drempel in te stellen voor
het initiëren van kanalen. Dit kan worden gedaan met behulp van het algoritme Channel network.

• Initiation grid: gebruik de laag Catchment Area en niet die van de logaritme.
• Initiation threshold: 10.000.000
• Initiation type: Greater than

Als u de waarde Initiation threshold verhoogt, zult u een schaarser netwerk van kanalen verkrĳgen. Als u het
verlaagt, zult u een dichter verkrĳgen. Dit is wat u krĳgt met de voorgestelde waarde.
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De afbeelding hierboven geeft slechts de resulterende vectorlaag en de DEM weer, maar er zou ook een
rasterlaag moeten zĳn met hetzelfde netwerk van kanalen. Die rasterlaag zal, in feite, de laag zĳn die we zullen
gaan gebruiken.

5. Nu zullen we het algoritmeWatersheds basins gaan gebruiken om de subbassins uit te tekenen die overeenkomen
met dat netwerk van kanalen, waarbĳ we alle kruisingen daarin gebruiken als uitlaatpunt. Hier staat hoe u het
overeenkomende dialoogvensters met parameters moet instellen.
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En dit is wat u zult krĳgen.
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6. Dit is een resultaat als raster. U kunt het vectoriseren met het algoritme Vectorising grid classes.
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Laten we nu eens proberen statistieken te berekenen over de hoogtewaarden in één van de subbassins. Het idee is om
een laag te krĳgen die slechts de hoogte binnen dat subbassin weergeeft en die dan doorgeeft naar de module die die
statistieken berekent.

1. Laten we eerst de originele DEM clippen met de polygoon die een subbassin weergeeft. We zullen het algoritme
Clip raster with polygon gebruiken. Als we één enkele polygoon voor een subbassin selecteren en dan het
algoritme voor het clippen aanroepen, kunnen we de DEM clippen tot het gebied dat wordt bedekt door die
polygoon, omdat het algoritme zich bewust is van de selectie.
1. Selecteer een polygoon
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2. Roep het algoritme om te clippen aan met de volgende parameters:
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Het geselecteerde element in het invoerveld is, natuurlĳk, de DEM die we willen clippen.
U zult iets krĳgen zoals dit.

2. Deze laag is gereed om te worden gebruikt in het algoritme Raster layer statistics.
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De resulterende statistieken zĳn de volgende.

We zullen zowel de procedure voor het berekenen van het bassin gebruiken als de berekeningen voor statistieken uit
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andere lessen, om uit te zoeken hoe andere elementen ons kunnen helpen om beide te automatiseren en meer effectief
te werken.

17.17 Beginnen met Modelontwerper

Notitie: In deze les zullen we Modelontwerper gebruiken, een krachtige component die we kunnen gebruiken om
een werkstroom te definiëren en een reeks algoritmes uit te voeren.

Een normale sessie met de gereedschappen voor Processing omvat meer dan het uitvoeren van één enkel algoritme.
gewoonlĳk worden verscheidene ervan uitgevoerd om een resultaat te krĳgen, en de uitvoer van sommige van die
algoritmes worden gebruikt als invoer voor sommige van de andere.
Door het gebruiken van Modelontwerper kan die werkstroom worden geplaatst in een model, wat in één enkele keer
alle noodzakelĳke algoritmes zal uitvoeren, aldus het gehele proces vereenvoudigend en het automatiseren.
We gaan, om deze les te beginnen, een parameter berekenen, genaamd Topographic wetness index. Het algoritme dat
dit berekent is genaamd Topographic wetness index (twi).

Zoals u kunt zien zĳn er twee verplichte invoeren: Slope en Catchment area. Er is ook een optionele invoer, maar die
zullen we niet gebruiken, dus kunnen we die negeren.
De gegevens voor deze les bevat slechts een DEM, dus we hebben geen van de vereiste invoeren. We weten echter
hoe we die beide kunnen berekenen vanuit die DEM, omdat we al algoritmes hebben gezien om de helling en het
opvanggebied te berekenen. We kunnen dus eerst die lagen berekenen en ze dan gebruiken voor het algoritme TWI.
Hier zĳn de dialoogvensters voor de parameters die u zou moeten gebruiken om de 2 tussenliggende lagen te
berekenen.
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Notitie: Helling moet worden berekend in radialen, niet in graden.
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En dit is hoe u het dialoogvenster voor de parameters van het algoritme TWI zou moeten instellen.
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Dit is het resultaat dat u zult verkrĳgen (het standaard geïnverteerde palet enkelband pseudokleur is gebruikt voor het
renderen). U kunt de verschafte stĳl twi.qml gebruiken.
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Wat we nu zullen proberen te doen is om een algoritme te maken dat de TWI berekent vanuit een DEM in slechts één
enkele stap. Dat zal ons werk besparen voor het geval we later een laag TWI moeten berekenen uit een andere DEM,
omdat we slechts één stap nodig hebben om het te doen in plaats van de drie bovenstaande. Alle processen die we
nodig hebben zĳn te vinden in de Toolbox, dus wat we moeten doen is de werkstroom definiëren om ze te verpakken.
Dat is waar Modelontwerper van pas komt.

1. Open Modelontwerper door het menu-item daarvan te selecteren in het menu Processing.

Twee dingen zĳn nodig om een model te maken: de benodigde invoer instellen en het algoritme definiëren dat
het bevat. Beide worden gedaan door elementen toe te voegen uit de twee tabs aan de linkerkant van het venster
Modelontwerper: Invoer en Algoritmes.

2. Laten we beginnen met de invoer. In dit geval hebben we niet veel toe te voegen. We hebben slechts een
rasterlaag nodig met de DEM en dat zullen onze enige gegevens voor invoer zĳn.

3. Dubbelklik op de invoer Raster layer en u zult het volgende dialoogvenster zien.
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4. Hier moeten we de invoer definiëren die we willen:
1. Omdat we verwachten dat deze rasterlaag een DEM zal zĳn, zullen we die DEM noemen. Dat is de naam

die de gebruiker van het model zal zien bĳ het uitvoeren.
2. We zullen het definiëren als een vereiste laag, omdat we die laag nodig hebben om te kunnen werken.

Hier is hoe het dialoogvenster zou moeten zĳn geconfigureerd.

5. Klik op OK en de invoer zal verschĳnen in het kaartvenster van Modelontwerper.

6. Laten we nu naar de tab Algoritmes gaan.
7. Het eerste algoritme dat we moeten uitvoeren is het algoritme Slope, aspect, curvature. Zoek het op in de lĳst

met algoritmes, dubbelklik erop en u zult het dialoogvenster zien dat hieronder wordt weergegeven.
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Dit dialoogvenster lĳkt erg op dat wat u krĳgt als u het algoritme uitvoert vanuit de Toolbox, maar het element
dat u kunt gebruiken als waarde voor de parameters worden niet uit het huidige project van QGIS genomen,
maar vanuit het model zelf. Dat betekent dat, in dit geval, we niet alle rasterlagen van ons project beschikbaar
hebben voor het veld Elevation, maar slechts die welke zĳn gedefinieerd in ons model. Omdat we slechts één
enkele rasterinvoer hebben toegevoegd, genaamd DEM, zal dat de enige rasterlaag zĳn die we zullen zien in de
lĳst die correspondeert met de parameter Elevation.
Uitvoer gemaakt door een algoritme wordt een beetje anders afgehandeld als het algoritme wordt gebruikt
als deel van een model. In plaats van het bestandspad te selecteren waar u elke uitvoer wilt opslaan, hoeft
u slechts te specificeren dat de uitvoer een tussenliggende laag is (en dat u het niet wilt behouden nadat het
model is uitgevoerd), of dat het het uiteindelĳke is. In dit geval zĳn alle door dit algoritme geproduceerde lagen
tussenliggende. We zullen er slechts één van gebruiken (de hellingslaag), maar we willen die niet behouden,
omdat we die slechts nodig hebben om de laag TWI te berekenen, die het uiteindelĳke resultaat is dat we willen
verkrĳgen.
Wanneer lagen geen uiteindelĳk resultaat zĳn, zou u het corresponderende veldmoeten laten zoals het is. Anders
moet u een naam invoeren die zal worden gebruikt om de laag te identificeren in het dialoogvenster voor de
parameters dat zal worden weergegeven wanneer u het model later uitvoert.

8. Er is niet veel te selecteren in dit eerste dialoogvenster, omdat we slechts één laag in ons model hebben (De
invoer DEM die we gemaakt hebben). In feite is de standaard configuratie van het dialoogvenster in dit geval
de juiste, dus u hoeft alleen maar op OK te drukken. Dit is wat u nu zult hebben in het kaartvenster van
Modelontwerper.
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9. Het tweede algoritme dat we moeten toevoegen aan ons model is het algoritme Catchment area. We zyllen
het algoritme, genaamd Catchment area (Paralell) gebruiken. We zullen opnieuw de laag DEM gebruiken als
invoer, en geen van de uitvoeren die het produceert is de uiteindelĳke, dus hier is hoe u het overeenkomstige
dialoogvenster in moet vullen.
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Uw model zou er nu ongeveer zo uit moeten zien.
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10. De laatste stap is om het algoritme Topographic wetness index toe te voegen, met de volgende configuratie.

In dit geval zullen we niet de DEM gebruiken als invoer, maar in plaats daarvan zullen we de lagen voor de
helling en het opvanggebied gebruiken die zĳn berekend door de algoritmes die we eerder toevoegden. Als u
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nieuwe algoritmes toevoegt, komt de uitvoer die zĳ produceren beschikbaar voor andere algoritmes, en door
ze te gebruiken koppelt u de algoritmes, wat de werkstroom maakt.

11. In dit geval is de uitvoerlaag TWI de uiteindelĳke laag, dus moeten we dat aangeven. Voer, in het
overeenkomstige tekstvak, de naam in die u wilt hebben weergegeven voor deze uitvoer.
Nu is uw model voltooid en zou er zo uit moeten zien.

12. Voer een naam en een naam voor de groep, in het bovenste gedeelte van het venster Modelontwerper, in.

13. Sla het op door te klikken op de knop Opslaan. U kunt het overal opslaan waar u wilt en het later openen, maar
als u het opslaat in de map Models (wat de map is die u zult zien als het dialoogvenster Opslaan verschĳnt), zal
uw model ook in de Toolbox beschikbaar zĳn. Blĳf dus in die map en sla het model op onder de bestandsnaam
die uw voorkeur heeft.

14. Sluit nu het dialoogvenster Modelontwerper en ga naar de Toolbox. In het item Modellen zult u uw model
vinden.
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15. U kunt het net als elk normaal algoritme uitvoeren, door erop te dubbelklikken.

Zoals u kunt zien bevat het dialoogvensters voor de parameters de invoer die u had toegevoegd aan het
model, tezamen met de uitvoer die u als uiteindelĳk heeft ingesteld bĳ het toevoegen van de overeenkomstige
algoritmes.

16. Voer het uit met behulp van de DEM als invoer en u zult de laag TWI in slechts één stap krĳgen.
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17.18 Meer complexe modellen

Notitie: In deze les zullen we werken met een meer complex model in Modelontwerper.

Het eerste model dat we hebben gemaakt in het vorige hoofdstuk was een heel eenvoudig, met slechts één invoer
en drie algoritmes. Meer complexe modellen kunnen worden gemaakt, met verschillende typen voor invoer en die
meerdere stappen bevatten. Voor dit hoofdstuk zullen we werken met een model dat een vectorlaag met waterkering
maakt, gebaseerd op eenDEMen een drempelwaarde. Dat zal zeer bruikbaar zĳn voor het berekenen van verscheidene
vectorlagen die overeenkomen met verschillende drempelwaarden, zonder elke stap elke keer te hoeven herhalen.
Deze les bevat geen instructies over hoe uw model te maken. U kent de noodzakelĳke stappen al (we zagen ze al in
eerdere les) en u heeft de basisideeën voor het bouwen van modellen al gezien, dus u zou het zelf moeten proberen.
Spendeer een paar minuten aan het proberen te maken van uw eigen model, en maak u geen zorgen over eventuele
fouten die u maakt. Onthoud om eerst de invoer toe te voegen en voeg dan de algoritmes toe die ze gebruiken om de
werkstroom te maken.

Notitie: Voor het geval u het volledige model niet zelf kon bouwen en u heeft wat extra hulp nodig, de map met
gegevens die overeenkomt met deze les bevat een ‘bĳna gereed’ voltooide versie ervan. Open Modelontwerper en
open het bestand van het model dat u zult vinden in de map met gegevens. U zou iets als dit moeten zien.

Dit model bevat alle stappen die nodig zĳn om de berekening te voltooien, maar het heeft slechts één invoer: de
DEM. Dat betekent dat de drempel voor de definitie van het kanaal een vaste waarde gebruikt, wat het model niet zo
bruikbaar maakt als zou kunnen. Dat is geen probleem, omdat we het model kunnen bewerken en dat is precies wat
we zullen gaan doen.

1. Laten we als eerste een numerieke invoer toevoegen. Die zal de gebruiker vragen naar een numerieke invoer
die we kunnen gebruiken wanneer een dergelĳke waarde nodig is in een van de algoritmes die zĳn opgenomen
in ons model.

2. Klik op het item Number in de boom voor de Invoer, en u zult het overeenkomende dialoogvenster zien.
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3. Vul het met de volgende waarden.
• Naam parameter: Threshold for channel definition

• Standaardwaarde: 1,000,000

Uw model zou er nu ongeveer zo uit moeten zien.

De invoer die we zojuist hebben toegevoegd is niet gebruikt, dus is het model in feite niet veranderd.
We moeten die invoer koppelen aan het algoritme dat het gebruikt, in dit geval is dat Channel network.
Dubbelklik eenvoudigweg op het overeenkomstige vak in het kaartvenster om een algoritme, dat al bestaat
in Modelontwerper, te bewerken.

4. Klik op het algoritme Channel network en u zult iets zien zoals dit.
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Het dialoogvenster is gevuld met de huidige waarden die door het algoritme gebruikt worden. U kunt zien dat
de parameter voor de Initiation threshold een vast waarde heeft van 1.000.000 (dit is ook de standaardwaarde
van het algoritme, maar elke andere waarde kan daar ingevoerd worden). U zou echter kunnen opmerken dat
de parameter niet is ingevoerd in een algemeen tekstvak, maar in een keuzelĳst.

5. Vouw het menu voor de parameter drempelwaarde uit en u zult iets zien zoals dit.
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De invoer die we hebben toegevoegd is daar en we kunnen die selecteren. Wanneer een algoritme in een model
een numerieke waarde vereist, kunt u die hard coderen en er direct in typen, of u kunt een van de beschikbare
invoeren en waarden gebruiken (onthoud dat sommige algoritmes single numerieke waarden genereren. We
zullen hier snel meer van zien). In het geval van een parameter string, zult u ook invoer voor tekenreeksen zien
en u u zult in staat zĳn er één van te selecteren of de gewenste vaste waarde in te typen.

6. Selecteer de invoer Threshold for channel definition in de parameter Initiation threshold.
7. Klik op OK om de wĳzigingen op uw model toe te passen. Nu zou het ontwerp van het model er zo uit moeten

zien.
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8. Het model is nu compleet. Voer het uit met de DEM die we in eerdere lessen hebben gebruikt, en met
verschillende drempelwaarden.
Hieronder staat een voorbeeld van het resultaat dat is verkregen voor verschillende waarden. U kunt het
vergelĳken met het resultaat voor de standaardwaarde, wat die is welke we hebben verkregen in de les over
hydrologische analyse.

Fig. 17.1: Threshold = 100.000
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Fig. 17.2: Threshold = 1.0000.000

17.19 Numerieke berekeningen in Modelontwerper

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we numerieke uitvoer gebruiken in Modelontwerper

Voor deze les gaan we het hydrologische model, dat we en het laatste hoofdstuk maakten, aanpassen (open het in
Modelontwerper om te beginnen), zodat we de berekening van een geldige drempelwaarde kunnen automatiseren en
we de gebruiker niet hoeven te vragen die in te voeren. Omdat die waarde verwĳst naar de variabele in de drempel
rasterlaag, zullen we die uitnemen uit die laag, gebaseerd op enkele eenvoudige statistische analyses.
Laten we, beginnend met het eerder vermelde model, de volgende aanpassingen doen:
Bereken eerst de statistieken van de laag flow accumulation met behulp van het algoritme Raster layer statistics.
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Dit zal een statistische waarden genereren die nu beschikbaar zullen komen voor alle numerieke velden in andere
algoritmes.
Als u het algoritme Channel network bewerkt, zoals we deden in de laatste les, zult u zien dat u nu andere opties heeft,
naast de numerieke invoer die u had toegevoegd.
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Echter, geen van deze waarden is geschikt om te worden gebruikt als geldige drempelwaarde, omdat zĳ zullen
resulteren in netwerken van kanalen die niet erg realistisch zullen zĳn. We kunnen, in plaats daarvan, enkele nieuwe
parameters, daarop gebaseerd, afleiden, om een beter resultaat te verkrĳgen. We kunnen bĳvoorbeeld het gemiddelde
plus 2 keer de standaard afwĳking gebruiken.
We kunnen de calculator gebruiken die u zult vinden in de groep Geoalgorithms/modeler/modeler-tools om
een rekenkundige bewerking toe te voegen. Deze groep bevat algoritmes die niet erg bruikbaar zĳn buiten
Modelontwerper, maar dat verschaft enige bruikbare functionaliteit bĳ het maken van een model.
Het dialoogvenster voor de parameters van het algoritme Calculator zier er als volgt uit:
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Zoals u kunt zien is het dialoogvenster afwĳkend van dat welke we eerder hebben gezien, maar u heeft daar dezelfde
variabelen als die welke beschikbaar waren in het veldThreshold in het algoritmeChannel network. Voer bovenstaande
formule in en klik op OK om het algoritme toe te voegen.

Als u het item voor de uitvoer uitbreidt, zoals hierboven weergegeven, zult u zien dat het model is verbonden met
twee van de waarden, namelĳk het gemiddelde en de standaard afwĳking, wat die zĳn die we in de formule hebben
gebruikt.
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Toevoegen van dit nieuwe algoritme zal een nieuwe numerieke waarde toevoegen. Als u opnieuw naar het algoritme
Channel network gaat, kunt u nu die waarde selecteren in de parameter Threshold.

Klik op OK en uw model zou er nu zo uit moeten zien.
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We gebruiken niet de numerieke invoer die we aan het model hadden toegevoegd, dus die kan worden verwĳderd.
Klik er met rechts op en selecteer Remove

Waarschuwing: todo: Afbeelding toevoegen

Ons nieuwe model is nu voltooid.

17.20 Een model binnen een model

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: In deze les zullen we zien hoe we een model gebruiken binnen een groter model.

We hebben al een aantal modellen gemaakt en in deze les gaan we zien hoe we ze kunnen combineren tot één groter.
Ee model gedraagt zich net als alle andere algoritmes, wat betekent dat u een model kunt toevoegen dat u al eerder
heeft gemaakt als deel van een ander dat u daarna maakte.
In dit geval gaan we ons hydrologische model uitbreiden, door het toevoegen van de gemiddelde TWI-waarde in elk
van de bassins die het als resultaat genereert. Wemoeten, om dat te kunnen doen, de TWI uitrekenen en de statistieken
berekenen. Omdat we al een model hebben gemaakt om de TWI vanuit een DEM te berekenen, is het een goed idee
om dat model opnieuw te gebruiken in plaats van de individuele algoritmes toe te voegen die het bevat.
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Laten we beginnen met het model dat we gebruikten als beginpunt voor de laatste les.

Waarschuwing: todo: Afbeelding toevoegen

eerst zullen we het TWI-model toevoegen. Het zou, om beschikbaar te kunnen zĳn, moeten zĳn opgeslagen in de map
Modellen, omdat het anders niet wordt weergegeven in de Toolbox of de lĳst met algoritmes inModelontwerper. Zorg
er voor dat het beschikbaar is.
Voeg het toe aan het huidige model en gebruik de invoer DEM als de invoer ervan. De uitvoer is een tĳdelĳke, want
we willen alleen dat de laag TWI de statistieken berekent. De enige uitvoer van dit model dat we maken is nog steeds
de vectorlaag met de waterbergingen.
Hier is het corresponderende dialoogvenster voor de parameters:

Waarschuwing: todo: Afbeelding toevoegen

Nu we een laag TWI hebben die we kunnen gebruiken naast de vectorlaag met waterbergingen, om een nieuwe te
genereren die de waarden voor de TWI bevat die corresponderen met elke waterberging.
Deze berekening wordt uitgevoerd met het algoritme Grid statistics in polygons. Gebruik de hierboven vermelde lagen
als invoer om het uiteindelĳke resultaat te maken.

Waarschuwing: todo: Afbeelding toevoegen

De uitvoer van het algoritme Vectorize grid classes was oorspronkelĳk onze uiteindelĳke uitvoer, maar nu willen we
het slechts als een tussenliggend resultaat. We moeten het algoritme bewerken om dat te wĳzigen. Dubbelklik er
eenvoudigweg op om het dialoogvenster voor de parameters te zien, en verwĳder de naam van de uitvoer. Dat zal het
een tĳdelĳke uitvoer maken, zoals het standaard is.

Waarschuwing: todo: Afbeelding toevoegen

Dit is hoe het uiteindelĳke model er uit zou moeten zien:

Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet is het gebruiken van een model in een ander model niets speciaals, en u kunt het toevoegen net zoals u
een ander algoritme toevoegt, zolang het model is opgeslagen in de map Models en beschikbaar is in de Toolbox.

17.21 Specifiek modelleergereedschap gebruiken om een model
te maken

Notitie: Deze les laat zien hoe enkele algoritmes te gebruiken die alleen beschikbaar zĳn in Modelontwerper, om
aanvullende functionaliteiten te verschaffen aan modellen.

Het doel van deze les is om Modelontwerper te gebruiken om een algoritme voor interpolatie te maken dat rekening
houdt met de huidige selectie, niet slechts om alleen de geselecteerde objecten te gebruiken, maar om het bereik van
die selectie te gebruiken om de geïnterpoleerde rasterlaag te maken.
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Het proces voor interpolatie omvat twee stappen, zoals al eerder is uitgelegd in eerdere lessen: rasteriseren van
de puntenlaag en de waarden geen gegevens vullen die in die gerasteriseerde laag verschĳnen. In het geval dat de
puntenlaag een selectie heeft, zullen alleen de geselecteerde punten worden gebruikt, maar als het uitvoerbereik is
ingesteld op automatisch aanpassen, zal het volledige bereik van de laag worden gebruikt. Dat is, het bereik van
de laag wordt altĳd beschouwd als het volledige bereik van alle objecten, niet die welke slechts zĳn berekend uit
de geselecteerde. We zullen dat proberen te repareren door enkele aanvullende gereedschappen te gebruiken in ons
model.
Open Modelontwerper en start het model door de vereiste invoer toe te voegen. In dit geval hebben we een vectorlaag
nodig (beperkt tot punten) en een attribuut ervan, met de waarden die we zullen gebruiken voor het rasteriseren.

De volgende stap is om het bereik van de geselecteerde objecten te berekenen. Dat is waar we het Specifiek
modelleergereedschap, genaamd Vectorlaag-extent kunnen gebruiken. Eerst zullen we een laag moeten maken die
het bereik van die geselecteerde objecten heeft. Daarna kunnen we dit gereedschap op die laag gebruiken.
Een gemakkelĳke manier om een laag te maken met het bereik van de geselecteerde objecten is om een convex hull
te berekenen van de puntenlaag voor de invoer. Dat zal alleen de geselecteerde punten gebruiken, dus zal de convex
hull hetzelfde begrenzingsvak hebben als de selectie. Daarna kunnen we het algoritme Vectorlaag-extent toevoegen,
en de laag van de convex hull gebruiken als invoer. Het zou er in het venster van Modelontwerper zo uit moeten zien:
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Het resultaat van Vectorlaag-extent is een verzameling van vier numerieke waarden en een object Bereik. We zullen
zowel de numerieke uitvoer als het bereik voor deze oefening gebruiken.

We kunnen nu het algoritme toevoegen dat de vectorlaag rasteriseert, met behulp van het bereik van het algoritme
Vectorlaag-extent als invoer.
Vul de parameters van het algoritme in zoals hieronder weergegeven:
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Het venster zou er nu zo uit moeten zien.
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Vul tenslotte de waarden Geen gegevens van de rasterlaag met behulp van het algoritme Close gaps.

Het algoritme is nu klaar om te worden opgeslagen en om te worden toegevoegd aan de Toolbox. U kunt het uitvoeren
en het zal een rasterlaag genereren middels het interpoleren van de geselecteerde punten in de invoerlaag, en de laag
zal hetzelfde bereik hebben als de selectie.
Hier is een verbetering voor het algoritme. We hebben een hard gecodeerde waarde gebruikt voor de grootte van de
cel bĳ het rasteriseren. Deze waarde is prima voor onze test-invoerlaag, maar dat zou niet zo hoeven zĳn in andere
gevallen. We zouden een nieuwe parameter kunnen toevoegen, zodat de gebruiker de gewenste waarde kan invullen,
maar een betere benadering zou zĳn om die waarde automatisch te laten berekenen.
We kunnen het Specifiek modelleergereedschap Calculator gebruiken, en die waarde laten berekenen uit de
coördinaten van het bereik. We kunnen, om bĳvoorbeeld een laag te maken met een vaste breedte van 100 pixels, de
volgende formule in de Calculator gebruiken.
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Nu moeten we het algoritme voor het rasteriseren bewerken, zodat het de uitvoer van de Calculator gebruikt in plaats
van de hard gecodeerde waarde.
Het uiteindelĳke algoritme zou er als volgt uit moeten zien:
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17.22 Interpolatie

Notitie: Dit hoofdstuk geeft weer hoe puntgegevens te interpoleren, en zal u een andere echt voorbeeld tonen van
het uitvoeren van ruimtelĳke analyses

In deze les gaan we puntgegevens interpoleren om een rasterlaag te verkrĳgen. Vóórdat we dat gaan doen, zullen we
wat voorbereidingen aan de gegevens moeten doen, en na het interpoleren zullen we wat extra verwerking toepassen
om de resulterende laag aan te passen, zodat we een volledige analyseroutine hebben.
Open de voorbeeldgegevens voor deze les, wat er zo uit zou moeten zien.

De gegevens corresponderen met gegevens voor de opbrengst van een oogst, zoals geproduceerd door een moderne
oogstmachine, en we zullen dat gebruiken om een rasterlaag voor de opbrengst van de oogst te verkrĳgen. We zĳn
niet van plan om nog meer analyses met die laag uit te voeren, maar slechts te gebruiken als een achtergrondlaag om
eenvoudige de meest productieve gebieden te identificeren en ook die waar de productiviteit kan worden verbeterd.
Het eerste om te doen is het opruimen van de laag, omdat het herhalende punten bevat. Deze worden veroorzaakt door
de verplaatsing van de oogstmachine, op plaatsen waar die een bocht moet maken of om enige reden zĳn snelheid
wĳzigt. Het algoritme Points filter zal hier bruikbaar voor zĳn. We zullen het tweemaal gebruiken, om punten te
verwĳderen die uitschieters kunnen worden geacht in zowel het bovenste als onderste gedeelte van de verdeling.
Gebruik de volgende waarden voor de parameters bĳ de eerste uitvoering.
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Gebruik voor de volgende uitvoering de configuratie die hieronder is weergegeven.
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Onthoud dat we niet de originele laag aks invoer gebruiken, maar in plaats daarvan de uitvoer van de eerste uitvoering.
De uiteindelĳke gefilterde laag, met een verminderd aantal punten, zou er soortgelĳk koeten uitzien als de originele,
maar het bevat een kleiner aantal punten. U kunt dat controleren door hun attributentabellen te vergelĳken.
Laten we nu de laag rasterizeren met behulp van het algoritme Rasterize.
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De laag Filtered points verwĳst naar de resulterende van het tweede filter. Het heeft dezelfde naam als die welke
werd geproduceerd door het eerste filter, omdat het de naam is die wordt toegewezen door het algoritme, maar u
zou de eerste niet moeten gebruiken. Omdat we die ook niet ergens anders voor gaan gebruiken kunt u hem veilig
verwĳderen uit uw project om verwarring te voorkomen, en alleen de laatste gefilterde laag laten staan.
De resulterende rasterlaag ziet er zo uit.
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Het is al een rasterlaag, maar er ontbreken gegevens in enkele van zĳn cellen. Het bevat alleen geldige waarden in die
cellen die een punt bevatten uit de vectorlaag die we zojuist gerasteriseerd hebben, en een waarde Geen gegevens in
alle andere. We kunnen het algoritme Close gaps gebruiken om de ontbrekende waarden in te vullen.
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De laag ziet er zo uit zonder zonder waarden Geen gegevens.
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We kunnen de rasterlaag clippen met de verstrekte laag Limits om het gebied dat wordt bedekt door de gegevens te
beperken tot slechts het gebied waar de opbrengst van de oogst werd gemeten.
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En voor een gladder resultaat (minder nauwkeurig maar beter voor het renderen op de achtergrond als een
ondersteuningslaag), kunnen we een Gaussiaans filter op de laag toepassen.
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Met de bovenstaande parameters zult u het volgende resultaat verkrĳgen
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17.23 Meer interpolatie

Notitie: Dit hoofdstuk geeft een ander praktisch geval weer waar algoritmes voor interpolatie werden gebruikt.

Interpolatie is een veel voorkomende techniek, en het kan worden gebruikt om verscheidene technieken te
demonstreren die kunnen worden toegepast met behulp van het framework Processing van QGIS. Deze les gebruikt
enkele algoritmes voor interpolatie dia al werden besproken, maar het heeft een andere benadering.
De gegevens voor deze les bevat ook een puntenlaag, in dit geval met hoogtegegevens. We gaan het in grote mate op
dezelfde manier interpoleren zoals we in de eerdere les deden, maar deze keer zullen we een deel van de originele
gegevens opslaan om die te gebruiken om de kwaliteit van het proces van interpolatie te beoordelen.
We moeten eerst de puntenlaag rasterizeren en de resulterende cellen met Geen gegevens vullen, maar met behulp
van slechts een fractie van de punten op de laag. We zullen 10% van de punten opslaan voor een latere controle, dus
moeten we 90% van de punten klaarmaken voor de interpolatie.We zouden, om dat te doen, het algoritme Split shapes
layer randomly kunnen gebruiken, wat we al in een eerdere les hebben gebruikt, maar er is een betere manier om het
te doen, zonder dat we een nieuwe tussenliggende laag zouden moeten maken. In plaats daarvan hoeven we slechts
de punten die we willen gebruiken voor de interpolatie te selecteren (het gedeelte van 90%), en dan het algoritme uit
te voeren. Zoals we al hebben gezien zal het algoritme voor het rasterizeren alleen de geselecteerde punten gebruiken
en de rest negeren. De selectie kan worden gedaan met het algoritme Random selection. Voer dat uit met de volgende
parameters.
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Dat zal 90% van de punten in de laag selecteren om te rasterizeren
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De selectie is willekeurig, dus zou uw selectie af kunnen wĳken van de selectie die in bovenstaande afbeelding wordt
weergegeven.
Voer nu het algoritme Rasterize uit om de eerste rasterlaag te krĳgen, en voer dan het algoritme Close gaps uit om de
cellen met Geen gegevens te vullen [Celresolutie: 100 m].

We kunnen nu de punten gebruiken die niet zĳn geselecteerd om de kwaliteit van de interpolatie te controleren.
Op dit punt weten we de echte hoogte (de waarde in de puntenlaag) en de geïnterpoleerde hoogte (de waarde in de
geïnterpoleerde rasterlaag). We kunnen die twee vergelĳken door de verschillen tussen die waarden te berekenen.
Omdat we de punten gaan gebruiken die niet zĳn geselecteerd, laten we dus eerst de selectie omdraaien.
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De punten bevatten de originele waarden, maar niet de geïnterpoleerde. We kunnen het algoritme Add raster values
to points gebruiken om ze toe te voegen aan een nieuw veld
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De rasterlaag om te selecteren (het algoritme ondersteunt meerdere rasters, maar we hebben er slechts één nodig) is
de resulterende van de interpolatie. We hebben die hernoemd naar interpolate en die laagnaam is die welke zal worden
gebruikt als naam voor het veld dat zal worden toegevoegd.
Nu hebben we een vectorlaag die beide waarden bevat, met punten die niet werden gebruikt voor de interpolatie.

Nu zullen we Veldcalculator gebruiken voor deze taak. Open het algoritme Field calculator en voer dat uit met de
volgende parameters.
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Als uw veld met de waarden uit de rasterlaag een andere naam heeft, zou u de hierboven vermelde formule
overeenkomstig moeten aanpassen. Door het uitvoeren van dit algoritme zult u een nieuwe laag verkrĳgen met
slechts de punten die we niet hebben gebruikt voor de interpolatie, waarvan elk het verschil bevat tussen de twee
hoogtewaarden.
Weergeven van die laag overeenkomstig die waarde zal ons een eerste idee geven over waar de grootste verschillen te
vinden zullen zĳn.
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Interpoleren van die laag zal u een rasterlaag geven met de geschatte fout in alle punten van het geïnterpoleerde
gebied.
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U kunt dezelfde informatie (verschil tussen originele puntwaarden en de geïnterpoleerde) ook direct krĳgen met
GRASS ► v.sample.
Uw resultaten zouden af kunnen wĳken van deze, omdat er een willekeurige component werd geïntroduceerd bĳ het
uitvoeren van de willekeurige selectie, aan het begin van deze les.

17.24 Herhalend uitvoeren van algoritmes

Notitie: Deze les toont u een andere manier voor het uitvoeren van algoritmes die vectorlagen gebruiken, door ze
herhalend uit te voeren, doorlopend over de objecten in een vectorlaag als invoer

We kennen al Modelontwerper, wat één manier is van het automatiseren van taken voor Processing. In sommige
situaties zou echter Modelontwerper niet kunnen zĳn wat we nodig hebben om een bepaalde taak te automatiseren.
Laten we eens naar zo’n situatie kĳken en hoe eenvoudig die op te lossen is met een andere functionaliteit: het
herhalend uitvoeren van algoritmes.
Open de gegevens die overeenkomen voor dit hoofdstuk. Het zou er zo uit moeten zien.

U zult onze welbekende DEM herkennen uit eerdere hoofdstukken en een daaruit uitgenomen verzameling
waterbergingen. Veronderstel dat u de DEM dient op te delen in verscheidene kleinere lagen, die elk slechts de
hoogtegegevens bevatten van slechts één waterberging. Dat zou handig kunnen zĳn als u later enkele parameters wilt
berekenen die gerelateerd zĳn aan elke waterberging, zoals de gemiddelde hoogte of de hypsografische curve ervan.
Dit kan een lange en saaie taak zĳn, speciaal als het aantal waterbergingen groot is. Het is echter, zoals we zullen
zien, een taak die eenvoudig geautomatiseerd kan worden.
Het algoritme om te gebruiken voor het clippen van een rasterlaag met een polygoonlaag is genaamd Clip raster with
polygons, en heeft het volgende dialoogvenster voor de parameters.
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U kunt het uitvoeren met de lagen van waterbergingen en de DEM als invoer, en u zult het volgende resultaat
verkrĳgen.
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Zoals u kunt zien wordt het gebied, dat bedekt is door alle polygonen van de waterbergingen, gebruikt.
U kunt de DEM clippen met slechts één enkele waterberging door de gewenste waterberging te selecteren en dan het
algoritme uit te voeren zoals we eerder deden.

Omdat alleen geselecteerde objecten worden gebruikt, zal alleen de geselecteerde polygoon worden gebruikt om de
rasterlaag bĳ te snĳden.
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Door dit voor alle waterbergingen te doen zal dat het resultaat produceren waar we naar op zoek zĳn, maar het lĳkt
niet een praktischemanier om het te doen. Laten we, in plaats daarvan, eens zien hoe we die selecteer en snĳ bĳ-routine
kunnen automatiseren.
Verwĳder als eerste de eerdere selectie, zodat opnieuw alle polygonen zullen worden gebruikt. Open nu het algoritme
Clip raster with polygon en selecteer dezelfde invoer als hiervoor, maar klik deze keer op de knop aan de rechterkant
van de invoer voor de vectorlaag waar u de laag watersheds heeft geselecteerd.

Deze knop zal er voor zorgen dat de geselecteerde invoerlaag zal worden gesplitst in net zoveel lagen als er objecten
in gevonden worden, waarvan elk één enkele polygoon bevat. Daarmee zal het algoritme herhaaldelĳk worden
aangeroepen, één keer voor elk van die lagen met één polygoon. Het resultaat, in plaats van slechts één rasterlaag
in het geval van dit algoritme, zal een verzameling rasterlagen zĳn, elk corresponderend met één van de uitvoeringen
van het algoritme.
Hier is het resultaat dat u zult krĳgen als u het algoritme voor het clippen uitvoert zoals is uitgelegd.
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Voor elke laag wordt het kleurenpalet zwart en wit, (of welk palet u dan ook gebruikt), anders aangepast, van zĳn
minimale tot zĳn maximale waarden. Dat is de reden waarom u kunt zien dat de onderscheidenlĳke stukken en de
kleuren niet lĳken overeen te komen met de grenzen tussen de lagen. De waarden komen echter overeen.
Als u een bestandsnaam voor de uitvoer invoert, zullen de resulterende bestanden worden benoemd met behulp van
die bestandsnaam en een getal dat correspondeert met elke iteratie als achtervoegsel.

17.25 Meer herhaalde uitvoering van algoritmes

Notitie: Deze les toont hoe de herhaalde uitvoering van algoritmes te combineren met Modelontwerper om meer
automatisering te verkrĳgen.

De herhaalde uitvoering van algoritmes is niet alleen beschikbaar voor ingebouwde algoritmes, maar ook voor de
algoritmes die u zelf kunt maken, zoals modellen. We gaan zien hoe een model en de herhaalde uitvoering van
algoritmes te combineren, zodat we eenvoudiger meer complexe resultaten kunnen verkrĳgen.
De gegevens die we voor deze les gaan gebruiken zĳn dezelfde als die we voor de laatste gebruikten. In dit geval,
in plaats van slechts de DEM te clippen met elk polygoon van een waterberging, zullen we enkele extra stappen
toevoegen en een hypsometrische curve berekenen voor elk daarvan, om te bestuderen hoe de hoogte is verdeeld
binnen de waterberging.
Omdat we een werkstroom hebben die verscheidene stappen omvat (clippen + berekenen van de hypsometrische
curve), zouden we naar Modelontwerper moeten gaan en het corresponderende model voor die werkstroom moeten
maken.
U vindt het reeds gebouwde model in de map met gegevens voor deze les, maar het zou goed zĳn als u het eerst
zelf probeert. De geclipte laag is in dit geval niet een uiteindelĳk resultaat, omdat we alleen zĳn geïnteresseerd in de
curves, dus dit model zal geen lagen genereren, maar slechts een tabel met de gegevens van de curves.
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Het model zou er zo uit moeten zien:

Voeg het model toe aan uw map met modellen, zodat het beschikbaar is in de Toolbox, en voer het uit.
De DEM en bassins voor waterberging selecteren.
Het algoritme zal tabellen maken voor alle bassins en ze plaatsen in de map voor de uitvoer.
We kunnen dit voorbeeld nog complexer maken door het model uit te breiden en enkele statistieken voor hellingen te
berekenen. Voeg het algoritme Slope toe aan het model en daarna het algoritme Raster statistics, wat de uitvoer voor
de hellingen als enige invoer zou moeten gebruiken.

Als u nu het model uitvoert, zult u, naast de tabellen, een aantal pagina’s met statistieken verkrĳgen. Deze pagina’s
zullen beschikbaar zĳn in het dialoogvenster Resultaten.
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17.26 De interface Batch-processing

Notitie: Deze les introduceert de interface voor Batch-processing, die het mogelĳk maakt één enkel algoritme uit te
voeren met een set van verschillende invoerwaarden.

Soms moet een bepaald algoritme herhaaldelĳk worden uitgevoerd met verschillende invoer. Dit is bĳvoorbeeld het
geval als een set invoerbestanden moeten worden geconverteerd vanuit de ene indeling naar een andere, of wanneer
verscheidene lagen in een bepaalde projectie moeten worden geconverteerd naar een andere projectie.
In dat geval is het herhaaldelĳk aanroepen van het algoritme vanuit de Toolbox niet de beste optie. In plaats daarvan
zou de interface Batch-processing moeten worden gebruikt, die het meerdere malen uitvoeren van een bepaald
algoritme enorm vereenvoudigd. Zoek het in de Toolbox en, in plaats van erop te dubbelklikken, klik met rechts
en selecteer Uitvoeren als batch-proces om een algoritme als een batch-proces uit te voeren,

Voor dit voorbeeld zullen we het algoritme Reproject algorithm gebruiken, dus zoek het op en doe zoals hierboven
beschreven. U zult het volgende dialoogvenster krĳgen.

Als u naar de gegevens voor deze les kĳkt, zult u zien dat het drie shapefiles bevat, maar geen projectbestand voor
QGIS. Dat is omdat, wanneer een algoritme wordt uitgevoerd als een batch-proces, invoer als lagen kunnen worden
geselecteerd ofwel vanuit het huidige project vanQGIS of vanuit bestanden. Datmaakt het eenvoudiger grote aantallen
lagen te verwerken, zoals, bĳvoorbeeld, alle lagen in een bepaalde map.
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Elke rĳ in het dialoogvenster van Batch-processing vertegenwoordigt één enkele uitvoering van het algoritme. Cellen
in een rĳ corresponderen met de benodigde parameter voor het algoritme, die niet boven elkaar zĳn geschikt zoals in
het normale dialoogvenster voor eenmalige uitvoering, maar horizontaal in die rĳ.
Definiëren van het uit te voeren batch-proces wordt gedaan door het vullen van de tabel met de corresponderende
waarden, en het dialoogvenster zelf bevat verscheidene gereedschappen om deze taak eenvoudiger te maken.
Laten we beginnen met het één voor één vullen van de velden. De eerste kolom om te vullen is die van de Input layer.
In plaats van de namen in te voeren van elk van de lagen die we willen verwerken, kunt u ze allemaal selecteren en het
dialoogvenster er één in elke rĳ laten plaatsen. Klik op de knop in de cel linksboven, en selecteer in het dialoogvenster
voor bestandsselectie dat zal verschĳnen, selecteer de drie bestanden om opnieuw te projecteren. Omdat één ervan
nodig is voor elke rĳ, zullen de resterende gebruikt worden om de rĳen eronder te vullen.

Het standaard aantal rĳen is 3, wat exact het aantal lagen is dat we moeten converteren, maar als u meer lagen
selecteert, zullen automatisch nieuwe rĳen worden toegevoegd. Als u de items handmatig wilt vullen, kunt u meer
rĳen toevoegen met behulp van de knop Add row.
We gaan al deze lagen converteren naar het CRS EPSG:23029, dus moeten we dat CRS selecteren in het tweede veld.
We willen hetzelfde voor alle rĳen, dus we hoeven het niet voor elke individuele rĳ te doen. In plaats daarvan, stel dat
CRS in voor de eerste rĳ (die bovenaan) met behulp van de knop in de overeenkomstige cel, en dubbelklik dan op de
kolomkop. Dat zorgt er voor dal alle cellen in de kolom worden gevuld met behulp van de waarde in de bovenste cel.
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Tenslotte zullen we een uitvoerbestand moeten selecteren voor elke uitvoering, wat de overeenkomstige opnieuw
geprojecteerde laag zal bevatten. Nogmaals, laten we dat doen voor alleen de eerste rĳ. Klik op de knop in de
bovenste cel en voer, in een map waar u uw uitvoerbestanden wilt plaatsen, een bestandsnaam in (bĳvoorbeeld
reprojected.shp).
Nu, wanneer u op OK klikt in het dialoogvenster voor bestandsselectie, wordt het bestand niet automatisch
weggeschreven naar de cel, maar in plaats daarvan wordt een invoervak weergegeven zoals dat wat hieronder wordt
getoond.

Indien u de eerste optie selecteert zal alleen de huidige cel worden gevuld. Als u een van de andere opties selecteert,
zullen alle rĳen daaronder worden gevuld met een bepaald patroon. In dit geval selecteren we de parameter-optie
Vullen met parameterwaarden, en voeren dan de waarde Input Layer in in het keuzemenu eronder. Dat zal er voor
zorgen dat de waarde in Input Layer (dat is de laagnaam) zal worden toegevoegd aan de bestandsnaam die we al
hebben toegevoegd, wat elke bestandsnaam voor de uitvoer anders maakt. De tabel voor het batch-proces zou er nu
zo uit moeten zien.
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De laatste kolom stelt in of de resulterende lagen al dan niet worden toegevoegd aan het huidige project van QGIS
project. Laat de standaard optie Yes staan, zodat u in dit geval uw resultaten kunt zien.
Klik op OK en het batch-proces zal worden uitgevoerd. Als alles goed ging zouden al uw lagen moeten zĳn verwerkt
en zouden 3 nieuwe lagen moeten zĳn gemaakt.

17.27 Modellen in de interface Batch-processing

Waarschuwing: Wees voorzichtig, dit hoofdstuk is nog niet goed getest, rapporteer problemen; afbeeldingen
ontbreken

Notitie: Deze les toont een ander voorbeeld van de interface Batch-processing, maar deze keer met behulp van een
model in plaats van een ingebouwd algoritme

Modellen zĳn hetzelfde als elk ander algoritme, en zĳ kunnen in de interface Batch-processing worden gebruikt. Hier
is een kort voorbeeld dat we kunnen uitvoeren met ons welbekende reeds bekende hydrologische model om dat te
demonstreren.
Zorg er voor dat u uw model heeft toegevoegd aan uw Toolbox, en voer het dan uit als een batch-proces. Dit is hoe
het dialoogvenster Batch-processing er uit zou moeten zien.

Waarschuwing: todo: Afbeelding toevoegen

Voeg rĳen toe tot een totaal van 5. Selecteer het bestand DEM dat correspondeert met deze les als de invoer voor alle
rĳen. Voer dan 5 verschillende drempelwaarden in, zoals hieronder weergegeven.
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Waarschuwing: todo: Afbeelding toevoegen

Zoals u ziet kan de interface Batch-processing niet alleen worden uitgevoerd om hetzelfde proces op verschillende
gegevenssets uit te voeren, maar ook op dezelfde gegevensset met verschillende parameters.
Klik op OK en u zou 5 nieuwe lagen moeten krĳgen met waterbergingen die corresponderen met de gespecificeerde
5 drempelwaarden.

17.28 Haken voor vóór- en na-uitvoering van scripts

Notitie: Deze les laat u zien hoe hooks te gebruiken vóór en na uitvoering, die het mogelĳk maken aanvullende
bewerkingen uit te voeren vóór en na de feitelĳke verwerking.

Hooks vóór en na uitvoering zĳn scripts voor Processing die worden uitgevoerd vóór en nadat de feitelĳke verwerking
van de gegevens wordt uitgevoerd. Dit kan worden gebruikt om taken te automatiseren die altĳd zouden moeten
worden uitgevoerd wanneer een algoritme wordt uitgevoerd.
De syntaxis van de hooks is identiek aan de syntaxis van scripts voor Processing, bekĳk het betreffende hoofdstuk in
de QGIS Gebruikersgids voor meer details.
In aanvulling op alle mogelĳkheden voor scripts, kunt u in hooks een speciale globale variabele genaamd alg
gebruiken, die staat voor het algoritme dat zojuist is (of zal worden) uitgevoerd.
Hier is een voorbeeld voor een script voor na uitvoering. Standaard slaat Processing resultaten van analyses op in
tĳdelĳke bestanden. Dit script zal de uitvoer kopiëren naar een specifieke map, dus zullen zĳ niet worden verwĳderd
bĳ het sluiten van QGIS.

import os
import shutil
from processing.core.outputs import OutputVector, OutputRaster, OutputFile

MY_DIRECTORY = '/home/alex/outputs'

for output in alg.outputs:
if isinstance(output, (OutputVector, OutputRaster, OutputFile)):

dirname = os.path.split(output.value)[0]
shutil.copytree(dirname, MY_DIRECTORY)

In de eerste twee regels importeren we de vereiste pakketten van Python: os— voor manipulaties aan het pad, bĳv.
het uitnemen van de bestandsnaam, en shutil— voor verscheidene bewerkingen voor het bestandssysteem zoals
het kopiëren van bestanden. In de derde regel importeren we uitvoer van Processing. Dit zal later meer in detail in
deze les worden uitgelegd.
Daarna definiëren we een constante MY_DIRECTORY, die het pad is naar de map waar we de resultaten van de
analyses naartoe willen kopiëren.
Aan het einde van het script staat de hoofdcode voor de hook. In de loop gaan we door alle uitvoer van het algoritme
en controleren of deze uitvoer een uitvoer is die op een bestand is gebaseerd en of die kan worden gekopieerd. Als dat
zo is bepalen we de map op het hoogste niveau waarin de bestanden zĳn opgeslagen en kopiëren dan alle bestanden
naar onze map.
We moeten, om deze hook te activeren, de opties van Processing te openen, het item Na-uitvoering script in de groep
Algemeen, en daar de naam specificeren van het script van de hook. de gespecificeerde hook zal na elk algoritme van
Processing worden uitgevoerd.
Op dezelfde manier kunnen we hooks vóór uitvoering implementeren. Laten we bĳvoorbeeld een hook maken om
invoervectoren voor fouten in geometrieën te controleren.
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from qgis.core import QgsGeometry, QgsFeatureRequest
from processing.core.parameters import ParameterVector

for param in alg.parameters:
if isinstance(param, ParameterVector):

layer = processing.getObject(param.value)
for f in layer.getFeatures(QgsFeatureRequest().setSubsetOfAttributes([])):

errors = f.geometry().validateGeometry()
if len(errors) > 0:

progress.setInfo('One of the input vectors contains invalid␣
↪→geometries!')

Net als in het vorige voorbeeld importeren we eerst de vereiste pakketten voor QGIS en Processing.
Daarna gaan we door alle parameters van het algoritme en als een parameter ParameterVector wordt gevonden, halen
we we het daarbĳ behorende object van de vectorlaag op. We lopen door alle objecten van de laag en controleren ze
op fouten in de geometrie. Als tenminste één object een ongeldige geometrie bevat, drukken we een waarschuwing
af.
We moeten, om deze hook te activeren, de optie Vóór-uitvoering script te openen in het dialoogvenster voor
configuratie van Processing. De hook zal vóór het uitvoeren van elk algoritme van Processing worden uitgevoerd.

17.29 Andere programma’s

Module bĳgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe aanvullende programma’s kunnen worden gebruikt vanuit Processing. U moet,
om het te voltooien, de relevante pakketten, met de gereedschappen van uw besturingssysteem, hebben geïnstalleerd.

17.29.1 GRASS

GRASS is een gratis en open bron softwarepakket voor GIS voor het beheren van geo-ruimtelĳke gegevens en
analyses, verwerking van afbeeldingen, productie van afbeeldingen en kaarten, ruimtelĳk modelleren en visualisatie.
Het wordt standaard geïnstalleerd op Windows door middel van het OSGeo4W zelfstandige installatiepakket (32 en
64 bit), en het is verpakt voor alle grote distributies van Linux.

17.29.2 R

R is een gratis en open bron software-omgeving voor statistische berekeningen en grafieken.
Het moet afzonderlĳk worden geïnstalleerd, samen met een aantal noodzakelĳke bibliotheken (LIST). De plug-in
Processing R Provider moet ook zĳn geïnstalleerd om het gebruiken van R in QGIS in te schakelen.
Het mooie van de implementatie van Processing is dat u uw eigen scripts kunt toevoegen, eenvoudige of complexe,
en dat zĳ dan kunnen worden gebruikt net als elke andere module, gepiped in meer complexe werkstromen, etc.
Test enkele van de reeds geïnstalleerde voorbeelden als u R al heeft geïnstalleerd (vergeet niet de modules van R te
activeren in de configuratie General van Processing).
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17.29.3 Andere

LASTools is een verzameling, gemend vrĳe en merkgebonden, opdrachten om gegevens van LiDAR te verwerken en
te analyseren. De beschikbaarheid varieert in de verschillende besturingssystemen.
Meer gereedschappen zĳn beschikbaar door middel van aanvullende plug-ins, bĳv.:

• LecoS: een pakket voor statistieken van landgebruik en ecologie van landschappen
• lwgeom: eerder deel van PostGIS, deze bibliotheek bevat een aantal bruikbare gereedschappen voor het
opknappen van geometrie

• Animove: gereedschappen om het leefbereik van dieren te analyseren.
Er zullen er nog meer komen.

17.29.4 Vergelijking tussen programma’s

Buffers en afstanden

Laten we points.shp laden en typ buf in het filter van de Toolbox, dubbelklik dan op:
• Fixed distance buffer: Distance 10000
• Variable distance buffer: veld Distance SIZE
• v.buffer.distance: distance 10000
• v.buffer.column: bufcolumn SIZE
• Shapes Buffer: fixed value 10000 (uitnemen en niet), attribuutveld (met schaal)

Zie hoe de snelheid nogal verschilt en hoe de verschillende opties beschikbaar zĳn.
Oefening voor de lezer: zoek de verschillen in de uitvoer van geometrie tussen de verschillende methoden.
Nu, buffers en afstanden voor rasters:

• Laad eerst en rasteriseer de vector rivers.shp met GRASS ► v.to.rast.value; LET OP: celgrootte moet
worden ingesteld op 100 m, anders zal de berekeningstĳd enorm zĳn; de resulterende kaart zal 1-en en NULL-
en hebben

• hetzelfde met SAGA ► Shapes to Grid ► COUNT (resulterende kaart: 6 tot en met 60)
• dan proximity (value= 1 voor GRASS, een lĳst met rivers ID voor SAGA), r.buffer met parameters
1000,2000,3000, r.grow.distance (de eerste van de twee kaarten, de tweede zal de gebieden weergeven die
tot elke rivier behoren, indien uitgevoerd op het raster van SAGA).

Samensmelten

Neem objecten uit, gebaseerd op een gemeenschappelĳk attribuut:
• GRASS ► v.dissolve municipalities.shp op PROVINCIA
• QGIS ► Dissolve municipalities.shp op PROVINCIA
• OGR ► Dissolve municipalities.shp op PROVINCIA
• SAGA► Polygon Dissolve municipalities.shp op PROVINCIA (NB: Keep inner boundariesmoet niet
zĳn geselecteerd)

Notitie: De laatste is defect in SAGA <=2.10

Oefening voor de lezer: zoek de verschillen (geometrie en attributen) tussen de verschillende methoden.
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17.30 Interpolatie en contouren

Module bĳgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe verschillende programma’s te gebruiken om verschillende interpolaties te
berekenen.

17.30.1 Interpolatie

Het project toont een kleurverloop voor regenval, van zuid naar noord. Laten we verschillende methoden gebruiken
voor interpoleren, alle gebaseerd op de vector points.shp, parameter RAIN:

Waarschuwing: Stel de celgrootte voor alle analyses in op 500.

• GRASS ► v.surf.rst

• SAGA ► Multilevel B-Spline Interpolation

• SAGA► Inverse DistanceWeighted [Inverse distance to a power; Power: 4; Search radius: Global; Search range:
all points]

• GDAL ► Grid (Inverse Distance to a power) [Power:4]
• GDAL ► Grid (Moving average) [Radius1&2: 50000]

Meet dan de variatie tussen de methoden en correleer die met de afstanden tot de punten:
• GRASS ► r.series [Unselect Propagate NULLs, Aggregate operation: stddev]
• GRASS ► v.to.rast.value op points.shp
• GDAL ► Proximity

• GRASS ► r.covar om de correlatie-matrix weer te geven; controleer de significantie van de correlatie
bĳvoorbeeld met http://vassarstats.net/rsig.html.

Dus, gebieden ver van punten zullen minder nauwkeurige interpolatie hebben.

17.30.2 Contour

Verscheidene methoden om contourlĳnen te tekenen [altĳd stap= 10] op het raster stddev:
• GRASS ► r.contour.step

• GDAL ► Contour

• SAGA► Contour lines from grid [NB: in sommige oudere versies van SGA is output shp niet geldig, onbekend
probleem]
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17.31 Vereenvoudigen van vectoren en gladder maken

Module bĳgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toon hoe vectoren te vereenvoudigen en scherpe hoeken gladder te maken.

Soms hebben we een vereenvoudigde versie van een vector nodig, om een kleinere bestandsgrootte te krĳgen en
onnodige details weg te laten. Vele gereedschappen doen dit op een nogal ruwe manier, en missen de aansluitingen en
soms de topologische juistheid van polygonen. GRASS is het ideale gereedschap hiervoor: omdat het een topologisch
GIS is worden aansluitingen en juistheid behouden zelfs op hele hoge niveaus van vereenvoudiging. In ons geval
hebben we een vector die resulteert vanuit een raster, waardoor een “zaag”-patroon aan de randen wordt weergegeven.
Toepassen van een vereenvoudiging resulteert in rechte lĳnen:

• GRASS ► v.generalize [Maximale tolerantie waarde: 30 m]
We kunnen ook het tegenovergestelde doen en een laag meer complex maken, scherpe hoeken gladder makend:

• GRASS ► v.generalize [methode: chaiken]
Probeer deze tweede opdracht toe te passen op zowel de originele vector als op die uit de eerste analyse, en zie het
verschil. Merk op dat de aansluitingen niet verloren zĳn gegaan.
Deze tweede optie kan worden toegepast op bĳv. contourlĳnen die resulteren vanuit een grof raster, op GPS-sporen
met weinig punten, etc.

17.32 Zonnepanelen plannen

Module bĳgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk toont hoe verscheidene criteria te gebruiken om de geschikte gebieden vast te stellen voor
een fotovoltaïsche elektriciteitscentrale

Ten eerste, maak een kaart van het aspect vanuit DTM:
• GRASS ► r.aspect [Data type: int; cell size:100]

In GRASS wordt aspect berekend in graden, tegen de wĳzers van de klok beginnend vanuit het oosten. We kunnen
het opnieuw classificeren om alleen hellingen uit te nemen die uitkĳken op het zuiden (270 graden +- 45):

• GRASS ► r.reclass

met de volgende regels:

225 thru 315 = 1 south
* = NULL

U kunt het verschafte tekstbestand reclass_south.txt gebruiken. Onthoud dat we met deze eenvoduige
tekstbestanden ook zeer complexe opnieuw uitgevoerde classificaties kunnen maken.
We willen een grote centrale bouwen, dus selecteren we alleen grote (> 100 ha) aaneengesloten gebieden:

• GRASS ► r.reclass.greater

Tenslotte converteren we naar een vector:
• GRASS ► r.to.vect [Feature type: area; Smooth corners: yes]

Oefening voor de lezer: herhaal de analyse, vervang de opdrachten voor GRASS door analoge voor andere
programma’s.
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17.33 Scripts van R gebruiken in Processing

Module bĳgedragen door Matteo Ghetta - mogelĳk gemaakt door Scuola Superiore Sant’Anna
Processing (met de plug-in Processing R Provider) maakt het mogelĳk scripts voor R te schrĳven en uit te
voeren binnen QGIS.

Waarschuwing: R moet zĳn geïnstalleerd op uw computer en het PATH moet correct zĳn ingesteld. Meer nog,
Processing roept eenvoudigweg de externe pakketten van R aan, het kan ze niet installeren. Zorg er dus voor de
externe pakketten direct in R te installeren. Bekĳk het gerelateerde hoofdstuk in de gebruikershandleiding.

Notitie: Als u problemen met pakketten heeft, zĳn die misschien gerelateerd aan ontbrekende voorgeschreven
pakketten die zĳn vereist door Processing, zoals sp, rgdal en raster.

17.33.1 Scripts toevoegen

Toevoegen van een script is eenvoudig. De gemakkelĳkste manier is om de Toolbox van Processing te openen en te
kiezen voor Create new R script… uit het menu R (gelabeld met een pictogram R) aan de bovenzĳde van de Toolbox
van Processing. U kunt bĳvoorbeeld ook het script maken in een tekstbewerker en het opslaan in uw map voor R-
scripts (processing/rscripts). Als het daar werd opgeslagen, zal het beschikbaar zĳn voor bewerken door
met rechts te klikken op de naam van het script in de Toolbox van Processing en dan te kiezen Script bewerken…).

Notitie: Indien u R niet ziet in Processing, dient u het te activeren via Processing ► Opties ► Providers

Het opent een venster voor bewerken van scripts waarin u enkele parameters moet specificeren vóórdat u de tekst va
het script kunt toevoegen.
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17.33.2 Plots maken

In deze handleiding gaan we een boxplot maken van een veld van een vectorlaag.
Open het project van QGIS r_intro.qgs in de map exercise_data/processing/r_intro/.

Parameters voor scripts

Open de bewerker en begin met het schrĳven aan het begin ervan.
U moet enkele parameters specificeren vóór de tekst van het script:

1. De naam van de groep (plots in dit geval) waarin u uw script wilt plaatsen (als de groep niet bestaat, zal die
worden gemaakt):

##plots=group

U zult uw script terugvinden in de R groep plots in de Toolbox van Processing.
2. U moet Processing vertellen dat u een plot wilt weergeven (voor dit voorbeeld):

##showplots

U zult dan een koppeling vinden naar het plot in het paneel Resultaten bekĳken (kan worden in- /
uitgeschakeld in Beeld ► Panelen en met Processing ► Resultaten bekĳken).

3. U dient Processing ook over uw invoergegevens te vertellen. In dit voorbeeld willen we een plot maken uit een
veld van een vectorlaag:

##Layer=vector

Processing weet nu dat de invoer een vector is. De naam Laag is niet belangrĳk, wat van belang is is de
parameter vector.

4. Tenslotte moet u het invoerveld van de vectorlaag specificeren (gebruik de naam die u hierboven opgaf - Laag):

##X=Field Layer

Processing weet nu dat u een veld Laag nodig hebt, en dat u het X wilt noemen.
5. Het is ook mogelĳk de naam van uw script te definiëren met name:

##My box plot script=name

Indien niet gedefinieerd zal de naam van het bestand worden gebruikt als de naam van het script.
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Tekst van het script

Nu u de kop van het script heeft ingesteld kunt u de functie toevoegen:

boxplot(Layer[[X]])

boxplot is de naam van de functie van R, de parameter Laag is de naam die u hebt gedefinieerd voor de gegevensset
voor de invoer en X is de naam die u hebt gedefinieerd voor het veld van die gegevensset.

Waarschuwing: De parameter X moet binnen dubbele vierkante haken staan ([[]]).

Het uiteindelĳke script ziet er als volgt uit:

##Vector processing=group
##showplots
##Layer=vector
##X=Field Layer
boxplot(Layer[[X]])

Sla het script op in het standaard pad dat wordt voorgesteld door Processing (processing/rscripts). Als u geen name
hebt gedefinieerd in de kop van het script, zal de bestandsnaam die u kiest de naam van het script worden in de
Toolbox van Processing.

Notitie: U kunt het script opslaan in waar u maar wilt, maar Processing is dan niet in staat om ze automatisch op te
nemen in de Toolbox van Processing, dus dient u het handmatig te uploaden.

Voer het nu eenvoudigweg uit met behulp van de knop aan de bovenzĳde van het venster van de bewerker:
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Gebruik, als het venster van de bewerker eenmaal is gesloten, het tekstvak van Processing om uw script te zoeken:

U kunt nu de vereiste parameters invoeren in het venster Algoritme van Processing:
• voor Laag kies sample_points

• voor het veld X kies value
Klik op Run.
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Het venster Resultaten zou automatisch moeten worden geopend, indien niet, klik eenvoudigweg op Processing ►
Resultaten bekĳken….
Klik op de koppeling in Resultaten bekĳken en u zult zien:
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Notitie: U kunt de afbeelding openen, kopiëren en opslaan door met rechts te klikken op het plot.

17.33.3 Een vector maken

U kunt ook een vectorlaag maken en die automatisch laden in QGIS.
Het volgende voorbeeld is afkomstig uit het script Random sampling grid dat te vinden is in de online collectie
van R-scripts (de scripts in deze online collectie zĳn te vinden op https://github.com/qgis/QGIS-Processing/tree/
master/rscripts).
Het doel van deze oefening is om een willekeurige punten vectorlaag te maken met een invoer vectorlaag om het
bereik te beperken met behulp van de functie spsample van het pakket sp.
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Parameters voor scripts

Net als eerder moeten we, vóór de tekst van het script, enkele parameters instellen:
1. Specificeer de naam van de groep waarin u uw script wilt opslaan, in dit geval Point pattern analysis:

##Point pattern analysis=group

2. Definieer een invoerparameter (een vectorlaag) die de plaatsing van de willekeurige punten zal beperken:

##Layer=vector

3. Stel een invoerparameter in voor het aantal punten dat moet worden gemaakt (Size, met een standaardwaarde
10):

##Size=number 10

Notitie: Omdat een standaardwaarde (10) is gedefinieerd, kan de gebruiker dit aantal wĳzigen of de parameter
zonder een getal kan laten.

4. Specificeer dat er een uitvoer vectorlaag is (genaamd Output):

##Output=output vector

Tekst van het script

Nu kunt u de tekst van de functie toevoegen:
1. Gebruik de functie spsample:

pts=spsample(Layer, Size, type="random")

De functie gebruikt de Laag om de plaatsing van de punten te beperken (als het een lĳnlaag is, moet een punt
op een van de lĳnen in de laag liggen, als het een polygoonlaag is, moet een punt binnen een polygoon liggen).
Het aantal punten wordt genomen uit de parameter Size. De methode van samplen is willekeurig.

2. Genereer de uitvoer (de parameter Output):

Output=SpatialPointsDataFrame(pts, as.data.frame(pts))

Het uiteindelĳke script ziet er als volgt uit:

##Point pattern analysis=group
##Layer=vector
##Size=number 10
##Output=output vector
pts=spsample(Layer, Size, type="random")
Output=SpatialPointsDataFrame(pts, as.data.frame(pts))
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Sla het op en voer het uit door te klikken op de knop Script uitvoeren.
Typ in het nieuwe venster de juiste parameters in:

en klik op Run.
De laag met resultaten zal worden toegevoegd aan de inhoudsopgave en de punten ervan zullen worden weergegeven
in het kaartvenster:
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17.33.4 Tekst en grafische uitvoer vanuit R - syntaxis

Processing (met de plug-in Processing R Provider) gebruikt speciale syntaxis om de resultaten uit R te
verkrĳgen:

• > vóór uw opdracht, zoals in >lillie.test(Layer[[Field]]) betekent dat het resultaat moet worden
verzonden naar uitvoer voor R (Resultaten bekĳken)

• + na een plot schakelt overliggende plots in. Bĳvoorbeeld plot(Layer[[X]], Layer[[Y]]) +
abline(h=mean(Layer[[X]]))

17.34 Landverschuivingen voorspellen

Module bĳgedragen door Paolo Cavallini - Faunalia

Notitie: Dit hoofdstuk geeft weer hoe een erg vereenvoudigd model te maken om de waarschĳnlĳkheid van
landverschuivingen te voorspellen.

eerst berekenen we de helling (kies uit verscheidene programma’s; de geïnteresseerde lezer kan het verschil tussen de
uitvoeren berekenen):

• GRASS ► r.slope

• SAGA ► Slope, Aspect, Curvature

• GDAL Slope

Dan maken we een model van voorspelde neerslag, gebaseerd op de interpolatie van waarden voor neerslag van
meetstations:

• GRASS ► v.surf.rst (resolutie: 500 m)
De waarschĳnlĳkheid van een landverschuiving zal zeer ruw zĳn, gerelateerd aan zowel de neerslag als de helling
(natuurlĳk zal een echt model meer lagen gebruiken, en toepasselĳke parameters), laten we zeggen (neerslag *
helling )/100:
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• SAGA ► Raster calculator rain, slope: (a*b)/100 (of: GRASS ► r.mapcalc)
• laten we dan de plaatsen berekenen met het grootste berekende risico op neerslag: SAGA ► Raster statistics

with polygons (de interessante parameters zĳn Maximum en Mean)
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Module: Ruimtelijke databases in QGIS gebruiken

In deze module zult u leren hoe ruimtelĳke databases te gebruiken met QGIS om gegevens in de database te beheren,
weer te geven en te bewerken, als ook het uitvoeren van analyses door bevragingen. We zullen primair PostgreSQL
en PostGIS gebruiken (die in eerdere gedeelten werden behandeld), maar dezelfde concepten zĳn van toepassing op
andere implementaties van ruimtelĳke databases inclusief SpatiaLite.

18.1 Les: Werken met databases in de QGIS Browser

In de voorafgaande 2 modules hebben we gekeken naar de basisconcepten, mogelĳkheden en functies van relationele
databases, als ook naar uitbreidingen die ons ruimtelĳke gegevens op laten slaan, beheren, bevragen en bewerken in
een relationele database. Dit gedeelte zal dieper duiken in hoe effectief ruimtelĳke databases te gebruiken in QGIS.
Het doel voor deze les: Leren over interactie met ruimtelĳke databases met behulp van de interface browser in QGIS.

18.1.1 ��� Volgen: Toevoegen van tabellen van databases aan QGIS met de
Browser

We hebben al even kort gekeken naar hoe we tabellen uit een databases toevoegen als lagen aan QGIS, laten we hier
nu eens iets meer in detail naar kĳken en kĳken naar de verschillende manieren waarop dat kan worden gedaan in
QGIS. Laten we beginnen met te kĳken naar de nieuwe interface Browser.

• Begin een nieuwe lege kaart in QGIS.
• Open de Browser door te klikken op de tab Browser onder in het paneel Lagen
• Open het gedeelte PostGIS van de boom en u zult uw eerder geconfigureerde verbinding beschikbaar vinden
(u moet misschien op de knop Bĳwerken drukken oven in het venster Browser).
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• Dubbelklikken op een van de hier vermelde tabellen/lagen zal dat toevoegen aan het kaartvenster.
• Met rechts klikken op een tabel/laag in deze weergave zal u een aantal opties geven. Klik op het item

Eigenschappen om de eigenschappen van de laag te bekĳken.
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Notitie: Natuurlĳk kunt u deze interface ook gebruiken om databases van PostGIS die worden gehost op een externe
server te verbinden met uw werkstation. Met rechts klikken op het item PostGIS in de boom zal u in staat stellen
parameters voor de verbinding te specificeren voor een nieuwe verbinding.

18.1.2 ��� Volgen: Toevoegen van een gefilterde set records als een laag

Nu we hebben gezien hoe een gehele tabel als een laag aan QGIS toe te voegen, zou het leuk zĳn om te leren hoe een
set gefilterde records uit een tabel kan worden toegevoegd als een laag door query’s te gebruiken die we in eerdere
gedeelten geleerd hebben.

• Begin een nieuwe lege kaart zonder lagen.
• Klik op de knop PostGIS-laag toevoegen of selecteer Kaartlagen ► PostGIS-laag toevoegen uit het menu.
• In het dialoogvensterPostGIS-tabel(len) toevoegen dat verschĳnt, verbindtmet de verbindingpostgis_demo.
• Breidt public schema uit en u zou daar de drie tabellen moeten vinden waar we eerder mee hebben
gewerkt.

• Klik op de laag lines om die te selecteren, maar in plaats van die toe te voegen, klik op de knop Filter
instellen om het dialoogvenster Querybouwer naar voren te brengen.

• Construeer de volgende expressie met behulp van de knoppen of door hem direct in te voeren:

"roadtype" = 'major'
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• Klik op OK om het bewerken van het filter te voltooien en klik op Toevoegen om de gefilterde laag aan uw
kaart toe te voegen.

• Hernoem de laag lines in de boom naar roads_primary.
Het zal u opvallen dat alleen de Primary roads zĳn toegevoegd aan uw kaart in plaats van de gehele laag.

18.1.3 Conclusie

U heeft gezien hoe u interactief kunt werken met ruimtelĳke databases met behulp van de Browser van QGIS en hoe
u lagen aan uw kaart toevoegt, gebaseerd op een queryfilter.
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18.1.4 Wat volgt?

Vervolgens zult u zien hoe te werken met de interface DB Manager in QGIS voor een meer complete set van
beheerstaken voor databases.

18.2 Les: DB Manager gebruiken om te werken met ruimtelijke
databases in QGIS

We hebben al gezien hoe we veel bewerkingen aan databases kunnen uitvoeren met QGIS, als ook met andere
gereedschappen, maar nu is het tĳd om te kĳken naar het gereedschap DBManager wat veel dezelfde functionaliteiten
verschaft en ook meer op beheer georiënteerde gereedschappen.
Het doel voor deze les: Te leren hoe interactief te werken met ruimtelĳke databases met behulp van de DBManager
in QGIS.

18.2.1 ��� Volgen: Een database van PostGIS beheren met DB Manager

U zou eerst de interface van de DB Manager moeten openen door te selecteren Database ► DB Manager ► DB

Manager in het menu of door het pictogram DB Manager te selecteren op de werkbalk.
U zou de eerdere verbindingen die we hebben geconfigureerd al moeten zien en in staat zĳn het gedeelte myPG en
het schema public uit te breiden om de tabellen te zien waarmee we in eerdere gedeelten hebben gewerkt.
Het eerste dat u zou moeten opvallen is dat u nu enkele metadata kunt zien over de schema’s die zĳn opgenomen in
uw database.
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Schema’s zĳn een manier om gegevenstabellen en andere objecten in een database van PostgreSQL te groeperen en
een container voor rechten en andere beperkingen. het beheren van schema’s van PostgreSQL valt buiten het bereik
van deze handleiding, maar u kunt er meer informatie over vinden in de PostgreSQL documentation on Schemas.
U kunt DB Manager gebruiken om nieuwe schema’s te maken, maar u zult een gereedschap als pgAdmin III of de
interface voor de opdrachtregel moeten gebruiken om ze effectief te beheren.
DB Manager kan ook worden gebruikt om de tabellen in uw database te beheren. We hebben al gekeken naar de
verscheidene manieren om tabellen te maken en te beheren via de opdrachtregel, maar laten we nu eens kĳken hoe
dat te doen in DB Manager.
Eerst is het handig om te kĳken naar de metadata van een tabel door te klikken op zĳn naam in de boom en te kĳken
op de tab Info.

In dit paneel kunt u de Algemene info over de tabel zien als ook de informatie die de extensie PostGIS onderhoudt
over de geometrie en het ruimtelĳke referentiesysteem.
Als u naar beneden scrollt op de tab Info, kunt u meer informatie zien over de Velden, Beperkingen en Indexen voor
de tabel die u bekĳkt.
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Het is ook zeer handig om DB Manager te gebruiken om eenvoudig naar de records in de database te kĳken op
nagenoeg dezelfde manier als u zou doen door de attributentabel van een laag te bekĳken in de boom van Lagen. U
kunt door de gegevens bladeren door de tab Tabel te selecteren.
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Er is ook een tab Voorvertoning die u de gegevens van de laag in een voorbeeldkaart laat zien.
Klikken met rechts op een laag in de boom en klikken op Aan kaartvenster toevoegen zal deze laag toevoegen aan uw
kaart.
Tot dusverre hebben we alleen gekeken naar de schema’s en tabellen van de database en hun metadata, maar wat als
we de tabel willen veranderen door misschien een aanvullende kolom toe te voegen? DB Manager stelt u in staat om
dat direct te doen.

1. Selecteer de tabel die u wilt bewerken in de boom
2. Selecteer Tabel ► Tabel bewerken uit het menu om het dialoogvenster Tabel-eigenschappen te openen.
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U kunt dit dialoogvenster gebruiken om kolommen toe te voegen, geometrie-kolommen toe te voegen, bestaande
kolommen te bewerken of om een kolom volledig te verwĳderen.
Door de tab Beperkingen te gebruiken kunt u beheren welke velden gebruikt moeten worden als de primaire sleutel
of om bestaande beperkingen te verwĳderen.
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De tab Indexen kan worden gebruikt om zowel ruimtelĳke als normale indexen te verwĳderen.
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18.2.2 ��� Volgen: Een nieuwe tabel maken

Laten we, nu we door het proces van werken met bestaande tabellen in onze database zĳn gegaan, DB Manager
gebruiken om een nieuwe tabel te maken.

1. Als het al niet geopend is, open het venster DB Manager en breidt de boom uit totdat u de lĳst met tabellen
ziet die al in uw database aanwezig zĳn.

2. Selecteer uit het menu Tabel –> Tabel maken om het dialoogvenster Tabel maken naar voren te halen.
3. Gebruik het standaard schema Public en noem de tabel places.
4. Voeg de velden id, place_name en elevation toe, zoals hieronder weergegeven
5. Zorg er voor dat het veld id is ingesteld als de primaire sleutel.
6. Klik op het keuzevak Geometriekolom maken en zorg er voor dat het is ingesteld op een type POINT` en

laat de naam als ``geom en specificeer 4326 als het SRID.
7. Klik op het keuzevak Ruimtelĳke index aanmaken en klik op Aanmaken om de tabel te maken.

18.2. Les: DB Manager gebruiken om te werken met ruimtelijke databases in QGIS 687



QGIS Training Manual

8. Sluit het dialoogvenster dat u laat weten dat de tabel werd gemaakt en klik op Close om het dialoogvenster
Tabel maken te sluiten.

U kunt nu uw tabel in DB Manager inspecteren en u zult natuurlĳk vinden dat er geen gegevens in staan. Vanaf hier
kunt u Bewerken aan/uitzetten in het menu van de Lagen en beginnen met het toevoegen van plaatsen aan uw tabel.

18.2.3 ��� Volgen: Basisbeheer voor database

DB Manager zal u ook in staat stellen enkele basis beheerstaken voor de database uit te voeren. Het is zeker geen
vervanging voor een meer compleet gereedschap voor databasebeheer, maar het verschaft enige functionaliteit die u
kunt gebruiken om uw database te onderhouden.
Databasetabellen kunnen vaak vrĳ groot worden en tabellen die regelmatig worden bĳgewerkt kunnen achterblĳfselen
van records bevatten die niet langer nodig zĳn voor PostgreSQL. De opdracht VACUUM zorgt voor een soort
afvalverwerking om uw tabellen te verkleinen en optioneel te analyseren voor betere uitvoering.
Laten we eens kĳken hoe we een opdracht VACUUM ANALYZE kunnen uitvoeren vanuit DB Manager.

1. Selecteer één van uw tabellen in de boom van DB Manager
2. Selecteer Tabel ► Vacuüm Analyze uitvoeren uit het menu

PostgreSQL zal nu de bewerking uitvoeren. Afhankelĳk van de grootte van uw tabel, zou dit enige tĳd kunnen vergen
om te voltooien.
U vindt meer informatie over het proces VACUUM ANALYZE in de PostgreSQL Documentation on VACUUM
ANALYZE
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18.2.4 ��� Volgen: Query’s van SQL uitvoeren met DB Manager

DB Manager verschaft ook een manier om query’s voor uw databasetabellen te schrĳven en om de resultaten te
bekĳken. We hebben dit type functionaliteit al gezien in het paneel Browser, maar laten we er hier nog eens naar
kĳken met DB Manager.

1. Selecteer de tabel lines in de boom.
2. Selecteer de knop SQL-venster in de werkbalk van DB Manager.

3. Voer de volgende SQL query in de daarviior bestemde ruimte in:

select * from lines where roadtype = 'major';

4. Klik op de knop Uitvoeren (F5) om de query uit te voeren.
5. U zou nu, in het paneel Resultaat, de records moeten zien die overeenkomen.

6. Klik op het keuzevak Als nieuwe laag laden om de resultaten aan uw kaart toe te voegen.
7. Selecteer de kolom id als de Kolom met unieke integer-waarden en de kolom the_geom als de

Geometriekolom.
8. Voer roads_primary in als de Laagnaam (prefix).
9. Klik op Nu laden! om de resultaten als een nieuwe laag in uw kaart te laden.
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De lagen die overeenkomen met uw query worden nu weergegeven in uw kaart. U kunt natuurlĳk dit gereedschap
voor query gebruiken om enige willekeurige opdracht voor SQL uit te voeren, inclusief veel van die waarnaar we
hebben gekeken in eerdere modules en gedeelten.

18.2.5 Gegevens in een database importeren met DB Manager

We hebben al gekeken naar hoe we gegevens in een een ruimtelĳke database importeren met behulp van de
gereedschappen voor de opdrachtregel, dus laten we nu leren hoe DB Manager te gebruiken om te importeren.

1. Klik op de knop Laag/bestand importeren op de werkbalk in het dialoogvenster DB Manager.

2. Selecteer het bestand urban_33S.shp uit exercise_data/projected_data als de gegevensset
voor invoer

3. Klik op de knop Opties vernieuwen om enkele van de waarden in het formulier vooraf in te vullen.
4. Zorg er voor dat de optie Nieuwe tabel makem is geselecteerd
5. Specificeer Bron SRID als 32722 en het Doel SRID as 4326.
6. Selecteer het keuzevak Ruimtelĳke index aanmaken

7. Klik op OK om het importeren uit te voeren
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8. Sluit het dialoogvenster dat u laat weten dat het importeren is voltooid
9. Klik op de knop Bĳwerken op de werkbalk van DB Manager.

U kunt nu de tabel in uw database inspecteren door op de naam te klikken in de boom. Verifieer dat de gegevens
opnieuw zĳn geprojecteerd door te controleren of Ruimtelĳk refsys: is vermeld als WGS 84 (4326)
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Klik met rechts op de tabel in de boom en selecteren van Aan kaartvenster toevoegen zal de tabel als een laag aan uw
kaart toevoegen.

18.2.6 Gegevens uit een database exporteren met DB Manager

Natuurlĳk kan DB Manager ook worden gebruikt om gegevens vanuit uw ruimtelĳke databases te exporteren, laten
we dus eens kĳken hoe dat moet worden gedaan.

1. Selecteer de laag lines in de boom en klik op de knop Naar bestand exporteren op de werkbalk om het
dialoogvenster Naar vectorbestand exporteren te openen.

2. Klik op de knop … om het Uitvoerbestand te selecteren en sla de gegevens op in uw map exercise_data
als urban_4326.

3. Stel het Doel SRID in als 4326.
4. Klik op OK om het exporteren te initialiseren.
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5. Sluit het dialoogvenster dat u laat weten dat het exporteren is voltooid en sluit DB Manager.
U kunt nu het shapefile dat u heeft gemaakt inspecteren in het paneel Browser.
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18.2.7 Conclusie

U heeft nu gezien hoe u de interface DB Manager kunt gebruiken in QGIS om uw ruimtelĳke databases te beheren,
om SQL-query’s uit te voeren op uw gegevens en hoe gegevens te im- en exporteren.

18.2.8 Wat volgt?

Vervolgens zullen we kĳken hoe we veel van deze zelfde technieken gebruiken met databases van SpatiaLite.

18.3 Les: Werken met databases van SpatiaLite in QGIS

Waar PostGIS over het algemeen op een server wordt gebruikt om mogelĳkheden voor ruimtelĳke databases te
verschaffen voor meerdere gebruikers tegelĳkertĳd, Ondersteunt QGIS ook het gebruiken van een bestandsindeling
genaamd SpatiaLite wat een lichtgewicht draagbare manier is een gehele ruimtelĳke database in één enkel bestand op
te slaan. Uiteraard zouden deze 2 typen ruimtelĳke databasesmoeten worden gebruikt voor verschillende doelen, maar
dezelfde basisprincipes en technieken zĳn op beide van toepassing. Laten we een nieuwe database voor SpatiaLite
maken en de functionaliteit verkennen die wordt verschaft om met deze databases in QGIS te werken.
Het doel voor deze les: leren hoe interactief te werken met databases van SpatiaLite met behulp van de interface
Browser van QGIS.

18.3.1 ��� Volgen: Een database van SpatiaLite maken met de Browser

Met behulp van het paneel Browser kunnen we een nieuwe database voor SpatiaLite maken en die instellen voor
gebruik in QGIS.

1. Klik met rechts op het item SpatiaLite in de boom van de Browser en selecteer Database maken.
2. Specificeer waar op uw bestandssysteem u het bestand wilt opslaan en noem het qgis-sl.db.
3. Klik opnieuw met rechts op het item SpatiaLite in de boom van de Browser en selecteer nu het item Nieuwe

verbinding. Zoek het bestand dat u in de laatste stap maakte en open het.
Nu u uw nieuwe database heeft geconfigureerd zult u zien dat dat item in de boom van de Browser tree er niets onder
heeft en dat het enige dat u op dit moment kunt doen is de verbinding te verwĳderen. Dat komt natuurlĳk omdat we
nog geen tabellen aan deze database hebben toegevoegd. Laten we doorgaan en dat doen.

1. Zoek de knop om een nieuwe laag te maken en gebruik het keuzemenu om een nieuwe laag voor SpatiaLite te
maken, of selecteer Kaartlagen ► Laag maken ► Nieuwe SpatiaLite-laag….

2. Selecteer de database die we in de eerder stappen gemaakt hebben in het keuzemenu.
3. Geef de laag de naam places.
4. Selecteer het keuzevak naast Maak een automatisch ophogend primair sleutelveld aan.
5. Voeg twee attributen toe zoals hieronder weergegeven
6. Klik op OK om de tabel te maken.

694 Hoofdstuk 18. Module: Ruimtelijke databases in QGIS gebruiken



QGIS Training Manual

7. Klik op de knop Bĳwerken boven in de Browser en u zou nu uw tabel places vermeld moeten zien.
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U kunt met rechts op de tabel klikken en de eigenschappen ervan bekĳken zoals we in de eerdere oefening
deden.

vanaf hier kunt u een sessie voor bewerken beginnen en beginnen met het direct toevoegen van gegevens aan uw
nieuwe database.
We leerden ook hoe gegevens te importeren in een database met behulp van DB Manager en u kunt deze zelfde
techniek gebruiken gegevens in uw nieuwe database van SpatiaLite te importeren.

18.3.2 Conclusie

U heeft gezien hoe databases voor SpatiaLite te maken, daaraan tabellen toe te voegen en deze tabellen als lagen te
gebruiken in QGIS.
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Appendix: Bijdragen aan deze handleiding

U moet de richtlĳnen in deze Appendix volgen om materiaal aan deze cursus toe te voegen. Het is niet toegestaan
de voorwaarden in deze Appendix te wĳzigen, behalve om ze te verduidelĳken. Dat is om er voor te zorgen dat de
kwaliteit en consistentie van deze handleiding kunnen worden onderhouden.

19.1 Bronnen downloaden

De bron van dit document is beschikbaar op GitHub. Consulteer GitHub.com voor instructies over hoe het
versiebeheerssysteem GIT te gebruiken.

19.2 Indeling handleiding

Deze handleiding is geschreven met behulp van Sphinx, een Python documentgenerator door middel van de
opmaaktaal reStructuredText . Instructies over hoe deze gereedschappen te gebruiken zĳn beschikbaar op hun
respectievelĳke sites.

19.3 Een module toevoegen

Een nieuwe module toevoegen:
1. Maak eerst een nieuwe map (direct onder het bovenste niveau van de map qgis-training-manual) met

de naam voor de nieuwe module.
2. Maak, onder deze nieuwe map, een bestand genaamd index.rst. Laat dit voor nu blanco.
3. Open het bestand index.rst in de map van het bovenste niveau. De eerste regels daarvan zĳn:

.. toctree::
:maxdepth: 2

foreword/index
introduction/index
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Het zal u opvallen dat dit een lĳst met namen van mappen is, gevolgd door de naam index. Dit verwĳst
het index-bestand op het bovenste niveau naar de indexbestanden in elke map. De volgorde waarin zĳ
staan bepaalt de volgorde die zĳ in het document zullen hebben.

1. Voeg de naam van uw nieuwe module (d.i. de naam die u aan de nieuwe map gaf), gevolgd door /index, aan
die lĳst toe, waar u wilt dat uw module zou moeten verschĳnen.

2. Onthoud om de volgorde van de modules logisch te houden, en wel zo dat latere modules zĳn gebouwd op de
in eerder modules gepresenteerde kennis.

3. Open het indexbestand van uw eigen module ([naam_module]/index.rst).
4. Maak, aan de bovenzĳde van de pagina, de koptekst voor de module:

1. schrĳf eerst een regel met asterisken (*).
2. Vervolg deze regel met een regel die de frase voor opmaak Module: bevat, gevolgd door de naam van

uw module.
3. Sluit dit af met nog een regel met hetzelfde aantal asterisken.

Notitie: De onderregel en bovenregel zouden niet korter moeten zĳn dan de regel die de titel van de module
bevat.

5. Laat hieronder een regel open.
6. Schrĳf een korte alinea die het doel en de inhoud van de module uitlegt.
7. Laat één regel open en voeg dan de volgende tekst toe:

.. toctree::
:maxdepth: 2

lesson1
lesson2

…waar les1, les2, etc., de namen zĳn van uw geplande lessen.
Het indexbestand op het niveau van de module zal er zo uitzien dit:

*******************************************************************************
Module: Module Name
*******************************************************************************

Short paragraph describing the module.

.. toctree::
:maxdepth: 2

lesson1
lesson2
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19.4 Een les toevoegen

Een les toevoegen aan een nieuwe of bestaande module:
1. Open de map van de module.
2. Open het bestand index.rst (hierboven gemaakt in het geval van nieuwe modules).
3. Zorg er voor dat de naam van de geplande les is vermeld onder de vermelding toctree, zoals hierboven

weergegeven.
4. Maak een nieuw bestand aan in de map van de module.
5. Noem dit bestand exact hetzelfde als de naam die u heeft vermeld in het bestand index.rst van de module,

en voeg de extensie .rst toe.

Notitie: Voor bewerkingsdoeleinden werkt een .rst-bestand exact hetzelfde als een normaal
tekstbestand (.txt).

1. Schrĳf de frase voor opmaak Les, gevolgd door de naam van de les, om te beginnen met het schrĳven van de
les.

2. Schrĳf, op de volgende regel, een regel van is gelĳk aan-tekens (=), niet korter dan de titel van de les.
3. Laat hieronder een regel open.
4. Schrĳf een korte omschrĳving van het beoogde doel van de les.
5. Neem een algemene introductie op voor het onderwerp. Bekĳk de bestaande lessen in de handleiding voor

voorbeelden.
6. Begin hieronder een nieuwe alinea, beginnend met deze frase:

**The goal for this lesson:**

7. Leg in het kort de bedoelde leerdoelen uit van het voltooien van deze les.
8. Als u het doel van de les niet kunt uitleggen in één of twee zinnen, overweeg dan om het onderwerp op te delen

in meerdere lessen.
Elke les zal worden opgedeeld in meerdere gedeelten, die hierna zullen worden besproken.

19.5 Een gedeelte toevoegen

Er zĳn twee typen gedeelten: “follow along” en “try yourself”.
• Een gedeelte “follow along” is een gedetailleerde verzameling aanwĳzingen die zĳn bedoeld om de lezer te
leren hoe een bepaald aspect van QGIS te gebruiken. Dit wordt over het algemeen gedaan door zo duidelĳk
mogelĳke klik-na-klik aanwĳzingen te geven, afgewisseld met schermafdrukken.

• Een gedeelte “try yourself” geeft de lezer een korte opdracht om zelf te proberen. Het wordt gewoonlĳk
geassocieerd met een item in het vak met antwoorden eronder, wat zal weergeven of verklaren hoe de opdracht
te voltooien, en zal, indien mogelĳk, de verwachte uitvoer weergeven.

Elk gedeelte heeft een niveau van moeilĳkheid. Een eenvoudig gedeelte wordt vermeld als ★☆☆, gemiddeld door ★★☆,
en moeilĳk door ★★★.
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19.5.1 Een gedeelte “follow along” toevoegen

1. Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilĳkheidsgraad (zoals
hierboven weergegeven).

2. Plaats een spatie en schrĳf dan Volgen:.
3. Plaats nog een spatie en vermeld de naam van het gedeelte (gebruik alleen een hoofdletter aan het begin, en

voor eigennamen).
4. Schrĳf, op de volgende regel, een regel van tekens minus/streepjes (-), niet korter dan de titel van het gedeelte.
5. Schrĳf een korte introductie voor het gedeelte, die het doel ervan uitlegt. Geef dan gedetailleerde (klik-na-klik)

instructies over de procedure die moet worden gedemonstreerd.
6. Neem in elk gedeelte de benodigde interne links, externe links en schermafdrukken op.
7. Probeer elk gedeelte af te sluiten met een korte alinea met een conclusie en die op natuurlĳke wĳze leidt naar

het volgende gedeelte, indien mogelĳk.

19.5.2 Een gedeelte “try yourself” toevoegen

1. Vermeld, om dit gedeelte te beginnen, de frase voor opmaak van de bedoelde moeilĳkheidsgraad (zoals
hierboven weergegeven).

2. Plaats een spatie en schrĳf dan Probeer zelf:.
3. Schrĳf, op de volgende regel, een regel van tekens minus/streepjes (-), niet korter dan de titel van het gedeelte.
4. Leg de oefening uit die u de lezer wilt laten voltooien. Verwĳs, indien nodig, naar eerdere gedeelten, lessen of

modules.
5. Neem schermafdrukken op om de vereisten te verduidelĳken als een heldere tekstuele omschrĳving niet

duidelĳk is.
In de meeste gevallen zult u een antwoord willen verschaffen met betrekking tot hoe de in dit gedeelte vermelde
opdracht zou moeten worden voltooid. U zult een blok met antwoorden onder de instructies moeten toevoegen om
dat te doen.

1. Maak eerst het in te klappen widget dat de antwoorden bevat:

.. admonition:: Answer
:class: dropdown

2. Met inspringen om rekening te houden met bovenstaand blok, schrĳf de instructies over hoe de opdracht te
voltooien, gebruik, waar nodig, koppelingen en afbeeldingen.

19.6 Een conclusie toevoegen

Een les beëindigen:
1. Schrĳf de frase Conclusie, gevolgd door een nieuwe regel van tekens minus/streepjes (-).
2. Schrĳf een conclusie voor de les, die uitlegt welke concepten in de les werden behandeld.

700 Hoofdstuk 19. Appendix: Bijdragen aan deze handleiding



QGIS Training Manual

19.7 Een gedeelte Meer informatie toevoegen

Dit gedeelte is optioneel.
• Schrĳf de frase Lees verder, gevolgd door een nieuwe regel van tekens minus/streepjes (-).
• Neem koppelingen op naar de van toepassing zĳnde externe websites.

19.8 Een gedeelte Wat nu toevoegen

1. Schrĳf de frase Wat volgt?, gevolgd door een nieuwe regel van tekens minus/streepjes (-).
2. Leg uit hoe deze les studenten heeft voorbereid voor de volgende les of module.
3. Onthoud om het gedeelte “what’s next” van de vorige les indien nodig te wĳzigen, zodat die verwĳst naar uw

nieuwe les. Dit zal nodig zĳn als u een nieuwe les tussen bestaande lessen heeft ingevoegd, of na een bestaande
les.

19.9 Opmaak gebruiken

U zult standaard opgemaakte tekst zullen moeten toevoegen aan uw tekst om de standaarden van dit document te
volgen,

19.9.1 Nieuwe concepten

Als u een nieuw concept uitlegt, zult u de naam van het nieuwe concept cursief moeten schrĳven door het te omsluiten
met asterisken (*).

This sample text shows how to introduce a *new concept*.

19.9.2 Benadrukken

• Een cruciale term benadrukken die geen nieuw new concept is, schrĳf de term vet door die te omsluiten met
dubbele asterisken (**).

• Gebruik dit spaarzaam! Als u dit teveel gebruikt kan het voor de lezer lĳken of u schreeuwt of neerbuigend
doet.

This sample text shows how to use **emphasis** in a sentence. Include the
punctuation mark if it is followed by a **comma,** or at the **end of the
sentence.**

19.9.3 Afbeeldingen

• Bĳ het toevoegen van een afbeelding, sla die op in een map img naast het bestand met de les.
• Neem die als volgt op in het document:

.. figure:: img/image_file.extension
:align: center

• Onthoud om een lege regel over te laten boven en onder de opmaak voor de afbeelding.
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19.9.4 Interne koppelingen

• Schrĳf, om een anker voor een koppeling te maken, de volgende regel boven de plaats waar u wilt dat de
koppeling naar verwĳst:

.. _link-name:

• Onthoud om een lege regel boven en onder deze regel te houden.
• Een link maken, verwĳs ernaar zoals hieronder:

:ref:`Descriptive link text <link-name>`

19.9.5 Externe koppelingen

• Schrĳf, om een externe koppeling te maken, die als volgt uit:

`Descriptive link text <link-url>`_

19.9.6 Mono gespatieerde tekst gebruiken

• Wanneer u tekst schrĳft die de gebruiker moet invoeren, een padnaam, of de naam van een element van een
database, zoals een naam van een tabel of kolom, moet u die schrĳven in mono gespatieerde tekst.
Bĳvoorbeeld:

Enter the following path in the text box: ``path/to/file``.

19.9.7 Items voor de GUI labelen

• Indien u verwĳst naar een item van de GUI, zoals een knop, moet u de naam ervan schrĳven in de opmaak
voor label van de GUI. Bĳvoorbeeld:

To access this tool, click on the :guilabel:`Tool Name` button.

• Dit is ook van toepassing als u de naam van een gereedschap vermeld, zonder dat de gebruiker op een knop
hoeft te drukken.

19.9.8 Menuselecties

• Als u een gebruiker door menu’s leidt, moet u de indeling menu ► selectie ► gebruiken. Bĳvoorbeeld:

To use the :guilabel:`Tool Name` tool, go to :menuselection:`Plugins -->
Tool Type --> Tool Name`.
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19.9.9 Opmerkingen toevoegen

• U wilt misschien een opmerking aan de tekst toevoegen, die extra details uitlegt die niet eenvoudig deel van de
les kunnen worden gemaakt. Dit is de opmaak:

[Normal paragraph.]

.. note:: Note text.
New line within note.

New paragraph within note.

[Unindented text resumes normal paragraph.]

19.9.10 Een opmerking voor sponsors/auteurs toevoegen

Als u een nieuwe module, les of gedeelte schrĳft ten behoeve van een sponsor, moet u een kort bericht van de sponsor
opnemen, naar hun keuze. Dit moet de gebruiker attenderen op de naam van de sponsor en moet onder de kop van
de module, les of gedeelte, dat zĳ sponsoren, verschĳnen. Het mag echter geen advertentie voor hun bedrĳf zĳn.
Als u op vrĳwillige basis, op eigen titel, een module, les of gedeelte, schrĳft, en niet ten behoeve van een sponsor, mag
u een opmerking over de auteur opnemen onder de kop van de module, les of het gedeelte dat u schreef. Dat moet
in de vorm Deze [module/les/gedeelte] is bijgedragen door [naam auteur]. Voeg geen
verdere tekst, contactdetails, etc. toe. Dergelĳke details dienen te worden toegevoegd in het gedeelte “Contributors”
van het Voorwoord, tezamen met de namen van de gedeelte(n) die u heeft toegevoegd. Als u alleen verbeteringen,
correcties en/of toevoegingen heeft gemaakt, vermeldt u zichzelf als een editor.

19.10 Dank u wel!

Dank u voor uw bĳdrage aan dit project! Hierdoor maakt u QGIS meer toegankelĳk voor gebruikers en voegt u
waarde toe aan het project QGIS als geheel.
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Voorbereiden gegevens voor oefeningen

Belangrĳk: Dit proces is bedoeld voor makers van cursussen, of meer ervaren gebruikers van QGIS die
gelokaliseerde voorbeeldgegevens voor hun cursus willen maken. Standaard voorbeeldgegevens worden met de
trainingshandleiding verschaft, maar u kunt deze instructies volgens als u de standaard gegevenssets wilt vervangen.

De voorbeeldgegevens die worden verschaft met de trainingshandleiding verwĳzen naar de stad Swellendam en de
omgeving ervan. Swellendam bevindt zich op ongeveer 2 uur oostelĳk van Kaapstad in deWestkaap van Zuid-Afrika.
De gegevensset bevat namen van objecten in zowel het Engels als Afrikaans.
Iedereen kan deze gegevensset zonder problemen gebruiken, maar het zou uw voorkeur kunnen hebben om gegevens
te gebruiken uit uw eigen land of stad. Als u daarvoor kiest, uw gelokaliseerde gegevens zullen worden gebruikt in
alle lessen van module 3 tot en met module 7.2. Latere modules gebruiken meer complexe gegevensbronnen, die al
dan niet beschikbaar zouden kunnen zĳn voor uw regio.

Notitie: Deze instructies gaan er van uit dat u goede kennis heeft van QGIS en zĳn niet bedoeld te worden gebruikt
als lesmateriaal.

20.1 Op OSM gebaseerde vectorbestanden maken

Als u voor uw cursus de standaard voorbeeldgegevens wilt vervangen door gelokaliseerde gegevens, kan dat eenvoudig
worden gedaan met behulp van de gereedschappen die zĳn ingebouwd in QGIS. De regio die u kiest om te gebruiken
zou een goede mix moeten zĳn van stedelĳke en landschappelĳk gebieden, wegen van verschillende significantie
moeten bevatten, gebiedsgrenzen (zoals natuurreservaten of boerderĳen) en oppervlaktewater, zoals stromen en
rivieren.

1. Open een nieuw project in QGIS
2. Selecteer Kaartlagen ► Databonnen beheren om het dialoogvenster Databronnen beheren te openen
3. Op de tab Browser, vergroot het keuzemenu van XYZ Tiles en dubbelklik op het item OpenStreetMap.
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Een kaart van de wereld wordt nu zichtbaar in het kaartvenster.
4. Sluit het dialoogvenster Databronnen beheren.
5. Verplaats naar het gebied dat u nader wilt bekĳken

Nu we het gebied hebben waarvan we de gegevens willen uitnemen, kunnen we de gereedschappen voor uitnemen
inschakelen.

1. Ga naar Plug-ins ► Plug-ins beheren en installeren…

2. Typ, op de tab Alles, QuickOSM in het zoekvak
3. Selecteer de plug-in QuickOSM, druk op Plug-in installeren en dan Close het dialoogvenster.
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4. Voer de nieuwe plug-in uit vanuit het menu Vector ► QuickOSM ► QuickOSM…

5. Selecteer, op de tab Snelle query, building in het keuzemenu Sleutel

6. Laat het veldWaarde leeg, wat betekent dat u alle gebouwen wilt opvragen.
7. Selecteer Canvas Extent in de volgende keuzelĳst
8. Vergroot de groep Geavanceerd onder en deselecteer alle typen geometrie aan de rechterkant, uitgezonderd

Multipolygonen.
9. Druk op Query uitvoeren

Een nieuwe laag building is toegevoegd aan het paneel Lagen die de gebouwen weergeeft in het
geselecteerde bereik.

10. Ga door zoals hierboven om andere gegevens uit te nemen:
1. Sleutel = landuse en type geometrie Multipolygonen.
2. Sleutel = boundary, Waarde = protected_area en type geometrie Multipolygonen.
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3. Sleutel = natural, Waarde = water and type geometrie Multipolygonen.
4. Sleutel = highway en selecteer de typen geometrie Lijnen en Multilijnen.
5. Sleutel = waterway, Waarde = river en selecteer de typen geometrie Lijnen en

Multilijnen.
6. Sleutel = place en type geometrie Punten.

Dit proces voegt de lagen toe als tĳdelĳke bestanden (aangegeven door het pictogram naast hun naam).

U kunt een monster nemen van de gegevens die uw regio bevat om te zien welke resultaten uw regio zal opleveren.
We dienen nu de resulterende gegevens op te slaan om gedurende onze cursus te gebruiken. We zullen indelingen
ESRI Shapefile, GeoPackage en SpatiaLite gebruiken, afhankelĳk van de gegevens.
De tĳdelĳke laag place converteren naar een andere indeling:

1. Klik op het pictogram naast de laag place om het dialoogvenster Tĳdelĳke tekenlaag opslaan te openen.

Notitie: Wanneer u een van de eigenschappen (CRS, bereik, velden…) van de tĳdelĳke tekenlaag dient te
wĳzigen, gebruik dan in plaats hiervan het contextmenu Exporteren ► Objecten opslaan als…, en zorg er voor
dat de optie Voeg opgeslagen bestand toe aan kaart is geselecteerd. Dit voegt een nieuwe laag toe.

2. Selecteer de indeling ESRI Shapefile

3. Gebruik de knop… om te bladeren naar de map exercise_data/shapefile/ en sla het bestand op als
places.shp.
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4. Klik op OK

In het paneel Lagen wordt de tĳdelĳke tekenlaag place vervangen door de opgeslagen Shapefile-laag places en
het pictogram voor tĳdelĳk ernaast wordt verwĳderd.

5. Dubbelklik op de laag om zĳn tab Laag Eigenschappen ► Bron te openen en de eigenschap Laagnaam bĳ te
werken zodat die overeenkomt met de bestandsnaam.

6. Herhaal het proces voor de andere lagen, hernoem ze als volgt:
• natural_water naar water
• waterway_river naar rivers
• boundary_protected_area naar protected_areas

Elke resulterende gegevensset zou moeten worden opgeslagen in de map exercise_data/shapefile/.
De volgende stap is om een bestand voor GeoPackage te maken uit de laag building om te gebruiken tĳdens de cursus:

1. Klik op het pictogram naast de laag building

2. Selecteer de indeling GeoPackage

3. Sla het bestand op als training_data.gpkg in de map exercise_data/
4. Standaard wordt de Laagnaam gevuld met de bestandsnaam. Vervang die door buildings.
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5. Klik op OK

6. Hernoem de laag in zĳn dialoogvenster voor de eigenschappen
7. Herhaal het proces met de laag highway, sla die op als roads in dezelfde database van GeoPackage.

De laatste stap is om het resterende tĳdelĳke bestand op te slaan als een bestand voor SpatiaLite.

1. Klik op het pictogram naast de laag landuse

2. Selecteer de indeling SpatiaLite

3. Sla het bestand op als landuse.sqlite in de map exercise_data/. Standaard wordt de Laagnaam
gevuld door de bestandsnaam. Wĳzig die niet.
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4. Klik op OK

U zou nu een kaart moeten hebben die er ongeveer uitziet zoals deze (de symbologie zal zeker heel anders zĳn, omdat
QGIS willekeurig kleuren toewĳst als lagen worden toegevoegd aan de kaart):

Het belangrĳkste is dat u 7 vectorlagen heeft die overeenkomenmet die hierboven en dat al deze lagen enkele gegevens
hebben.
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20.2 SRTM DEM tiff-bestanden maken

Voor de modules Module: Vectorgegevens maken en Module: Rasters, heeft u ook rasterafbeeldingen nodig (SRTM
DEM) die de regio bedekken die u heeft geselecteerd voor uw cursus.
De CGIAR-CGI verschaft enkele SRTM DEM’s die u kunt downloaden vanaf https://srtm.csi.cgiar.org/srtmdata/.
U zult afbeeldingen nodig hebben die de gehele regio bedekken die u heeft gekozen om te gebruiken. Voor het bepalen
van de coördinaten van het bereik, ga in QGIS , zoom naar het bereik van de grootste laag en selecteer de waarden
in het vak Bereik van de statusbalk. Behoud de indeling GeoTiff. Als het formulier helemaal is ingevuld, klik
dan op de knop Search en download het/de bestand(en).
Als u eenmaal de vereiste bestand(en) heeft gedownload, zouden zĳ moeten worden opgeslagen in de map
“exercise_data” in de submappen van “raster/SRTM”.

20.3 Tiff-afbeeldingsbestanden maken

In module Module: Vectorgegevens maken, geeft les ��� Volgen: Databronnen close-up afbeeldingen van drie
sportvelden van een school waarvan studenten wordt gevraagd die te digitaliseren. U zult daarom die drie afbeeldingen
dienen te reproduceren met behulp van uw nieuwe SRTM DEM tiff-bestand(en). Het is geen verplichting om
sportvelden van de school te gebruiken: alle drie types landuse voor school kunnenworden gebruikt (bĳv. verschillende
schoolgebouwen, speelplaatsen of parkeerplaatsen).
Ter verwĳzing, de afbeelding in de voorbeeldgegevens is:
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20.4 Tokens vervangen

Nadat u uw gelokaliseerde gegevensset heeft gemaakt, is de laatste stap om de tokens in het bestand
substitutions.txt te vervangen zodat de toepasselĳke namen zullen verschĳnen in uw gelokaliseerde versie
van de trainingshandleiding.
De tokens die u dient te vervangen zĳn de volgende:

• majorUrbanName: dit is standaard “Swellendam”. Vervang die door de belangrĳkste stad in uw regio.
• schoolAreaType1: dit is standaard “athletics field”. Vervang die door de naam van het grootste type
schoolgebied in uw regio.

• largeLandUseArea: dit is standaard “Bontebok National Park”. Vervang dit door de naam van de grootste
polygoon voor landuse in uw regio.

• srtmFileName: dit is standaard srtm_41_19.tif. Vervang deze door de naam van uw SRTM DEM-
bestand.

• localCRS: dit is standaard WGS 84 / UTM 34S. U zou deze moeten vervangen door het juiste CRS voor
uw regio.
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